
Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tato příručka popisuje konfiguraci a obsluhu kamery ILME-FR7/ILME-FR7K Interchangeable Lens Digital Camera.

Podle potřeby si přečtěte tuto uživatelskou příručku a pokyny k použití souvisejících zařízení.

Přehled

Příklady typického použití

Konfigurace systému

Ovládání jedné jednotky pomocí dodaného infračerveného dálkového ovladače

Ovládání jedné jednotky pomocí tabletu nebo počítače

Ovládání jedné jednotky pomocí externího dálkového ovladače

Ovládání několika jednotek pomocí externího dálkového ovladače

Umístění a funkce ovládacích prvků

Pohled zepředu

Pohled zezadu

Blok konektorů

Pohled z boku

Pohled shora

Pohled zespodu

Podpěra objektivu

Umístění a funkce součástí infračerveného dálkového ovladače (součást dodávky)

Obrazovka webové aplikace

Přehled obrazovky webové aplikace

Struktura společné oblasti obrazovek

Struktura obrazovky živého provozu

Struktura obrazovky přehrávání

Struktura obrazovky nastavení
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Příprava

Nabídka kamery

Zobrazení obrazovky kamery

Montáž jednotky

Montáž ve svislé poloze na pevném místě

Montáž ve svislé poloze na vysokém, pevném místě

Montáž na strop

Upevnění/sejmutí objektivu

Bezpečnostní opatření při upevnění/sejmutí objektivu

Kontrola spínačů objektivu

Bezpečnostní opatření při použití objektivu s proměnlivou ohniskovou vzdáleností

Upevnění objektivu

Sejmutí objektivu

Propojovací kabely

Připojení jednotky k síťovému zařízení prostřednictvím kabelového připojení

Připojení napájecího zdroje

Použití zdroje střídavého proudu

Použití napájení PoE++

Resetování posunu/naklápění

Konfigurace před snímáním

Inicializace jednotky pomocí webové aplikace

Přístup k webové aplikaci z webového prohlížeče

Inicializace jednotky

Konfigurace základní obsluhy

Příprava paměťových karet

Podporované paměťové karty

Vložení paměťových karet

Vysunutí paměťové karty
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Snímání

Formátování (inicializace) paměťových karet

Kontrola zbývajícího času záznamu

Obnovení paměťových karet

Základní obsluha

Spuštění/zastavení záznamu

Přepínání mezi paměťovými kartami

Kontrola zvuku

Zadání dat času

Prohlížení záznamu (Rec Review)

Nastavení seřízení obrazu

Obrazovka nastavení seřízení obrazu

Nastavení směru snímání

Nastavení směr snímání pomocí webové aplikace

Nastavení provozní rychlosti posunu/naklápění

Nastavení zrychlení provozu posunu/naklápění

Nastavení směru snímání pomocí dodaného infračerveného dálkového ovladače

Nastavení zoomu

Nastavení typu zoomu

Nastavení zoomu pomocí webové aplikace

Nastavení provozní rychlosti zoomu

Nastavení zoomu pomocí dodaného infračerveného dálkového ovladače

Uložení/obnovení orientace posunu / naklápění / zoomu kamery (přednastavená poloha)

Kalibrace objektivu E-Mount

Uložení/obnovení posunu/naklápění kamery, polohy zoomu a nastavení zaostření pomocí webové aplikace

Přejmenování přednastavených poloh pomocí webové aplikace

Nahrazení uložené předvolené polohy novou polohou pomocí webové aplikace

Odstranění uložené přednastavené polohy pomocí webové aplikace

Synchronizace provozu posunu/naklápění a zoomu/zaostření při obnovení přednastavené polohy
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Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy

Uložení/obnovení posunu/naklápění a polohy zoomu pomocí dodaného infračerveného dálkového ovladače

Operace seřízení obrazu kamery nahrávání/přehrávání (PTZ Trace)

Záznam operací seřízení obrazu kamery pomocí webové aplikace

Přehrávání operací seřízení obrazu kamery pomocí webové aplikace

Odstranění operací seřízení obrazu zaznamenanými kamerou pomocí webové aplikace

Záznam operací seřízení obrazu kamery pomocí dodaného infračerveného dálkového ovladače

Přehrávání operací seřízení obrazu kamery pomocí dodaného infračerveného dálkového ovladače

Nastavení zaostření

Obrazovka nastavení zaostření

Ruční nastavení zaostření (Manual Focus)

Ruční nastavení pomocí webové aplikace

Ruční nastavení pomocí dodaného infračerveného dálkového ovladače

Zaostření zadáním polohy zaostření (bodové zaostření)

Dočasné použití funkce automatického zaostřování (Push Auto Focus (AF))

Použití automatického zaostřování jedním záběrem (Push Auto Focus (AF-S))

Automatické nastavení zaostření (Auto Focus)

Automatické nastavení pomocí webové aplikace

Automatické nastavení pomocí dodaného infračerveného dálkového ovladače

Nastavení oblasti/polohy automatického zaostřování (Focus Area)

Rychlá změna oblasti zaostření (Focus Setting)

Přesunutí rámečku oblasti zaostření pomocí dotykového ovládání (oblast zaostření dotykem)

Úprava činnosti automatického zaostřování (rychlost přechodu AF, citlivost posunu objektu AF)

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App

Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače

Dočasné použití ručního zaostření během automatického zaostřování (Push Manual Focus)

Sledování pomocí detekce obličeje a očí (Face/Eye Detection AF)

Sledování stanoveného předmětu (režim sledování AF v reálném čase)

Nastavení jasu
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Užitečné funkce

Obrazovka nastavení jasu

Nastavení základní citlivosti

Nastavení cílové úrovně pro automatické nastavení jasu

Nastavení clony

Automatické nastavení clony

Ruční nastavení clony

Nastavení zesílení

Automatické nastavení zesílení (AGC)

Ruční nastavení zesílení

Nastavení závěrky

Automatické nastavení závěrky

Ruční nastavení závěrky

Nastavení úrovně osvětlení (filtr ND)

O filtru ND

Nastavení v režimu předvolby

Automatické nastavení v proměnném režimu

Ruční nastavení v proměnném režimu

Nastavení pro přirozené barvy (vyvážení bílé)

Obrazovka nastavení vyvážení bílé barvy

Automatické nastavení vyvážení bílé

Ruční nastavení vyvážení bílé

Spuštění automatického vyvážení bílé

Konfigurování zvuku pro záznam

Obrazovka konfigurace zvuku

Výběr vstupního zvukového zařízení

Automatická úprava úrovně hlasitosti záznamu zvuku

Ruční úprava úrovně hlasitosti záznamu zvuku

Ovládání přímé nabídky
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Přiřaditelná tlačítka

Pomalý a rychlý pohyb

Přerušované nahrávání videa (Interval Rec)

Nahrávání obrázků do mezipaměti (Picture Cache Rec)

Současné nahrávání na paměťové karty A a B. (2-slot Simul Rec)

Monitor video signálu

Značky klipu

Kompenzace dýchání

Proxy záznam

Přehled proxy záznamu

Záznam proxy

Snímání s požadovaným vzhledem

Přehled vzhledu

Výběr vzhledu

Importování požadovaného základního vzhledu

Přizpůsobení vzhledu

Uložení vzhledu

Odstranění základního vzhledu

Snímání s úpravou vzhledu v postprodukci

Snímání s úpravou vzhledu v postprodukci

Použití LUT pro výstup HDMI a streamování

Změna LUT

Změna rozložení tmavých a světlých míst v zaznamenaném snímku

Záznam RAW

Záznam videa ve formátu RAW

Záznam videa RAW v režimu pomalého a rychlého pohybu

Nastavení efektu bokeh (funkce řízení efektu bokeh)

Zapínání/vypínání funkce řízení efektu bokeh
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Síťové funkce

Obrazovka miniatur

Nabídka kamery a podrobná nastavení

Nastavení stupeň efektu bokeh

Ukládání a načítání dat konfigurace

Přehled ukládání a načítání dat konfigurace

Ukládání souboru ALL

Načítá ALL soubor

Přenos souborů

O přenosu souborů

Registrace cílového umístění pro přenos souborů

Výběr souboru a nahrávání

Nahrávání proxy souboru na paměťovou kartu z obrazovky miniatur

Nahrávání původního souboru na paměťovou kartu z obrazovky miniatur

Kontrola stavu přenosu souborů

Odesílání pomocí protokolu Secure FTP

Konfigurování streamování

O streamování

Nastavení formátu streamování

Nastavení video kodeku pro streamování

Nastavení zvukového kodeku pro streamování

Spuštění/zastavení streamování

Obrazovka miniatur

Přehrávání klipů a další operace s klipy

Přehrávání zaznamenaných klipů

Operace se zaznamenanými klipy

Konfigurace nabídky kamery

Ovládání nabídky kamery

Ovládání nabídky kamery
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Zadání řetězce znaků

Nabídka User

User

Nabídka Edit User

Edit User

Nabídka Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Nabídka Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Nabídka Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Nabídka Pan-Tilt

P/T Acceleration

Nabídka TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Nabídka Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Nabídka Audio
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Audio Input

Audio Output

Nabídka Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Nabídka Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Nabídka Network

Wired LAN

File Transfer

Nabídka Maintenance

Language

Clock Set

Hours Meter

Nastavení nabídky Shooting a výchozí hodnoty

Nastavení možnosti ISO/Gain a výchozí hodnoty
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Webová nabídka a podrobná nastavení

Nastavení možnosti AGC Limit a výchozí hodnoty

Nastavení kvality obrazu uložená pro každý režim snímání

Konfigurace webové nabídky

Operace ve webové nabídce

Nabídka Shooting

Focus

Nabídka Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Nabídka Paint/Look

Base Look

Nabídka Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Nabídka Monitoring

Output Format

Output Display

Nabídka Audio

Audio Input
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Audio Output

Nabídka Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Nabídka Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 až 3

SSL

Referer Check

Brute Force Attack Protection

Nabídka Stream

Stream

Video Stream

Audio Stream

Nabídka Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Připojení externího zařízení

Dodatek

Service

EULA

Software

Připojení externích monitorů a záznamových zařízení

Připojení RCP/MSU (volitelné)

Připojení k RCP/MSU

Propojení jeden-na-jednoho mezi jednotkou a RCP

Použití jednotky v prostředí více kamer se softwarem pro dálkové ovládání MSU/kamery

Seznam podporovaných funkcí

Ovládání pomocí dálkového ovladače RM-IP500 (volitelné)

O ovládání pomocí dálkového ovladače RM-IP500 (volitelné)

Připojení dálkového ovladače RM-IP500

Synchronizace s externím zařízením

O synchronizaci s externím zařízením

Synchronizace fáze videosignálu (kombinace obrazových signálů)

Uzamčení časového kódu pro jiná zařízení

Připojení externího mikrofonu nebo externího zvukového zařízení

Správa/úprava klipů pomocí počítače

Výstup optického signálu

Připojení indikačního signálu

Výstup sledovacích dat (free-d)

Připojení ovladače objektivu

Nastavení zoomu pomocí ovladače objektivu

Bezpečnostní opatření k použití

Výstupní formáty a omezení

Odstraňování poruch

Chybové/výstražné zprávy
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Seznam položek nabídky

Přednastavená pozice uložených položek

Bloková schémata

Aktualizace softwaru objektivu E-Mount

Připevnění krytu uvolňovacího tlačítka objektivu

Licence

Technické údaje

Obchodní známky
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfigurace systému

Tuto jednotku můžete kombinovat s periferními zařízeními a vytvářet tak různé konfigurace systému.

Objektiv E-Mount1.

LA-EA3 / LA-EA4 Adaptér A-mount2.

Infračervený dálkový ovladač (součást dodávky)3.

Paměťové karty CFexpress Type A / paměťové karty SDXC4.

Čtečka karet CFexpress Type A / Čtečka karet SD5.

Mikrofon ECM-680S, ECM-678*, ECM-674*6.
Je vyžadován 3kolíkový → 5kolíkový adaptérový kabel XLR EC-0.5X3F5M.*

Síťový adaptér (součást dodávky)7.

Video monitor8.

Dálkový ovladač RM-IP5009.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládání jedné jednotky pomocí dodaného infračerveného dálkového ovladače

Pomocí dodaného infračerveného dálkového ovladače můžete dálkově ovládat jednu jednotku.

 Videosignál
 Tok signálu

5-041-958-43(1) Copyright 2022 Sony Corporation

Infračervený dálkový ovladač (součást dodávky)1.

Video monitor2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládání jedné jednotky pomocí tabletu nebo počítače

K jednotce můžete připojit tablet nebo počítač a poté ji ovládat pomocí webového prohlížeče.

 Videosignál
 Signál dálkového ovládání

  Tok signálu

5-041-958-43(1) Copyright 2022 Sony Corporation

Video monitor1.

Tablet2.

Počítač3.

Přístupový bod4.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládání jedné jednotky pomocí externího dálkového ovladače

Pomocí externího dálkového ovladače můžete jednotku dálkově ovládat.

 Videosignál
 Signál dálkového ovládání

  Tok signálu

5-041-958-43(1) Copyright 2022 Sony Corporation

Video monitor1.

Dálkový ovladač RM-IP5002.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládání několika jednotek pomocí externího dálkového ovladače

Pomocí externího dálkového ovladače můžete dálkově ovládat až 100 jednotek.

 Videosignál
 Signál dálkového ovládání
 Indikační/kontaktní signál

  Tok signálu

5-041-958-43(1) Copyright 2022 Sony Corporation

Video monitor1.

Přepínač videa2.

Ethernetový rozbočovač3.

Dálkový ovladač RM-IP5004.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohled zepředu

Toto téma popisuje umístění a funkci součástí na přední straně jednotky.

Tip

Tento popis odkazuje na obrázek jednotky bez připojeného objektivu.

Hlavice kamery

Poznámka

Zamezte vystavení hlavy kamery silným nárazům.

1.

Kontrolka záznamu/indikace
Při nakonfigurování jako kontrolka záznamu se kontrolka při záznamu na paměťovou kartu rozsvítí červeně.
Kontrolka bliká, když je zbývající volné místo na záznamovém médiu nízké nebo když nastane chyba.

2.
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Další informace naleznete v části „Chybové/výstražné zprávy“.

Při nakonfigurování jako kontrolka indikace se kontrolka po přijetí externího indikačního signálu rozsvítí červeně nebo
zeleně.

Podrobnosti viz také kapitola „Připojení indikačního signálu“.
Obrazový snímač

Poznámka

Nedotýkejte se jich přímo rukou.

3.

Tlačítko uvolnění objektivu
Stiskněte pro vyjmutí objektivu.

Podrobnosti viz také kapitola „Sejmutí objektivu“.

4.

Signální kontakty objektivu

Poznámka

Nedotýkejte se jich přímo rukou.

5.

Kontrolka POWER6.

Kontrolka NETWORK
Stav jednotky je indikován kombinací barvy displeje a stavu svícení (svítí, bliká, nesvítí) kontrolek POWER a
NETWORK.

7.

Kontrolka
POWER

Kontrolka
NETWORK Stav jednotky

Svítí zeleně*1
Svítí zeleně Zapnuto (připojeno k síti)

Nesvítí Zapnuto (nepřipojeno k síti)

Bliká zeleně Nesvítí Probíhá proces zapínání

Svítí oranžově Nesvítí Stav pohotovostního napájení

Blikající žlutá Nesvítí Probíhá aktualizace softwaru

Bliká pomalu
oranžově*2

Bliká pomalu
zeleně*2

Jednotka nemůže pracovat normálně. Podrobnosti naleznete v systémovém
protokolu. Pokud problém přetrvává i po uvedení jednotky do pohotovostního
režimu nebo vypnutí a následném opětovném zapnutí, kontaktujte servisního
zástupce společnosti Sony.

Bliká rychle
oranžově*3

Bliká rychle
zeleně*3 Vyskytla se porucha jednotky. Kontaktujte servisního zástupce společnosti Sony.

Bliká zeleně, když je obdržen příkaz z dodaného infračerveného dálkového ovladače.*1

Bliká pomalu: bliká jednou za sekundu*2

Bliká rychle: bliká čtyřikrát za sekundu*3

Snímač infračerveného dálkového ovladače
Přijímá řídicí signál z dodaného infračerveného dálkového ovladače.

8.

Vstup vzduchu9.
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Příbuzné téma

Chybové/výstražné zprávy

Připojení indikačního signálu

Sejmutí objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Poznámka

Nezakrývejte průtok vzduchu. Pokud tak učiníte, může dojít k poruše.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohled zezadu

Toto téma popisuje umístění a funkci součástí na zadní straně jednotky.

Příbuzné téma

Pohled z boku

5-041-958-43(1) Copyright 2022 Sony Corporation

Zamykací páka hlavy kamery
Zamyká pohyb hlavy kamery dopředu/dozadu.

Poznámka

Pokud objektiv neměníte, vždy jej nastavte do uzamčené polohy.

Během přepravy jednotky vždy sejměte objektiv a nastavte uzamčenou polohu.

Před použitím uzamykací páky vypněte napájení jednotky a hlavu kamery uzamkněte vodorovně pomocí páky pro
posun/naklápění, aby nedošlo ke zranění způsobenému sevřením prstů. Další informace o zamykací páce posunu/naklápění
naleznete v části „Zamykací páka posunu/naklápění“ v části „Pohled z boku“.

1.

Posuvná základna2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Blok konektorů

Toto téma popisuje umístění a funkci součástí v bloku konektorů jednotky.

 (Zemnicí) spojení
Připojení k uzemnění prostřednictvím připojení k zemnicí svorce zásuvky nebo k zemnicí tyči.

1.

Konektor DC IN (standardní konektor DC)
Připojení k síťovému adaptéru.

Poznámka

Nepoužívejte žádný jiný síťový adaptér než dodaný adaptér. Připojení jiného adaptéru může způsobit požár nebo poruchu.

2.

Konektor  LAN (RJ-45)
Připojte síťový kabel (kategorie 5e nebo lepší) pro síťovou komunikaci a napájení PoE++*.

Stavová kontrolka LED rychlosti připojení
Indikuje stav rychlosti síťového spojení.

3.

PoE++: Power over Ethernet Plus Plus. Ve shodě s normou IEEE802.3bt (typ 4, třída 8). Podrobnosti o připojování naleznete v uživatelské
příručce napájecího zdroje.

*
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Stavová kontrolka LED spojení/ACT
Indikuje stav síťových spojení.

Poznámka

V případě připojování tohoto produktu k Internetu se připojte pomocí systému, který poskytuje funkci ochrany, jako je
například směrovač nebo brána firewall. V případě připojení bez takové ochrany se mohou vyskytnout problémy se
zabezpečením.

Displej Rychlost spojení

Nesvítí
Připojení 10 Mbps

Připojení 100 Mbps

Svítí oranžově Připojení 1000 Mbps

Displej Stav připojení

 Nesvítí Žádné spojení

Bliká zeleně Spojení navázáno, data aktivní

Svítí zeleně Aktivní spojení

Konektor TC IN
Vstup externího referenčního signálu časového kódu.

Podrobnosti naleznete v části „Uzamčení časového kódu pro jiná zařízení“.

4.

Konektor HDMI
Odesílá video z jednotky jako signál HDMI.

Podrobnosti naleznete v části „Konektor HDMI (konektor Type A)“ v části „Připojení externích monitorů a
záznamových zařízení“.

5.

Upevňovací šroub upevňovací desky kabelu HDMI
Abyste zabránili odpojení kabelu HDMI, připevněte dodanou upevňovací desku kabelu HDMI pomocí dodaného
upevňovacího šroubu (M2.6 ×6) a kabel HDMI stáhněte pomocí komerčně dostupné kabelové spony nebo pásky.

Podrobné informace o připojení upevňovací desky kabelu HDMI viz „Propojovací kabely“.

6.

Konektor OPTION
Použijte k připojení indikačního signálu z externího zařízení nebo ovladače objektivu.

Podrobnosti viz také kapitola „Připojení indikačního signálu“ a „Připojení ovladače objektivu“.

7.

Svorka kabelu
Používá se k upevnění kabelu napájecího adaptéru.

8.

Spínač RESET
Stiskněte na dobu nejméně 5 sekund pomocí hrotu pera nebo podobného zařízení a resetujte nastavení jednotky na
výchozí tovární hodnoty.
Můžete zvolit, zda chcete resetovat pouze nastavení síťového propojení nebo všechna nastavení pomocí přepínače
SETUP 1.

9.

Výstupní konektor OPTICAL
Výstup signálu SDI je převeden na optický formát, když je připojen modul SFP+ (volitelně).

10.
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Podrobnosti viz také kapitola „Výstup optického signálu“.
Přepínače SETUP

Konfiguruje následující nastavení.
Spínač 1: Nastaví, která nastavení se RESET, když stisknete spínač RESET.

Spínač 2: Nastavuje, zda je během připojení zvukového vstupního zařízení zapnuto/vypnuto napájení +48 V
(zdánlivé napájení). Nastavení je použito okamžitě.
Tato funkce je povolena, když je možnost [Audio] > [Audio Input] > [AUDIO IN Select] nastavena na [MIC] v nabídce
kamery.

Poznámka

Nastavení spínače 2 do polohy ON a připojením mikrofonu, který není kompatibilní s napájecím zdrojem +48 V, můžete
poškodit připojené zařízení. Před připojením zařízení zkontrolujte nastavení.

Spínač 3: Povolujte/zakazujte komunikaci VISCA over IP. Nastavení se použijí, když je kamera zapnutá.
Nastavte do polohy ON, chcete-li použít jednotku, když je připojena k dálkovému ovladači (RM-IP500).

Poznámka

Není-li heslo správce nakonfigurováno, je komunikace VISCA over IP zakázána, bez ohledu na nastavení spínače. Podrobné
informace o konfiguraci hesla správce naleznete v kapitole „Inicializace jednotky“.

Spínač 4: Mění rychlost operací posunu/naklápění, odesílaných z infračerveného dálkového ovladače. Nastavení je
použito okamžitě.

11.

Nastavení Popis

OFF
(výchozí)

Resetuje pouze nastavení síťového spojení. Síťová nastavení, bezpečnostní nastavení a informace
o uživateli (uživatelské jméno a heslo) jednotky budou resetovány.

ON Resetuje všechna nastavení na příslušná výchozí tovární nastavení.

Nastavení Popis

OFF
(výchozí)

Nepřipojujte napájení +48 V (zdánlivé napájení). Tuto konfiguraci nastavte při použití externího
zvukového zařízení (například směšovač), dynamického mikrofonu nebo mikrofonu s vestavěnou
baterií.

ON
Napájení +48 V (zdánlivé napájení) mikrofonu kompatibilního se zdánlivým napájením, připojeného
ke konektoru AUDIO IN (CH-1 nebo CH-2).

Nastavení Popis

OFF (výchozí) Nereaguje na příkazy VISCA over IP.

ON Přijímá příkazy VISCA over IP.

27



Příbuzné téma

Uzamčení časového kódu pro jiná zařízení

Připojení externích monitorů a záznamových zařízení

Propojovací kabely

Připojení indikačního signálu

Připojení ovladače objektivu

Výstup optického signálu

Inicializace jednotky

Synchronizace fáze videosignálu (kombinace obrazových signálů)

Připojení externího mikrofonu nebo externího zvukového zařízení

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavení Popis

OFF (výchozí) Pracuje normální rychlostí.

ON Pracuje maximální rychlostí.

Konektor SDI OUT
Odesílá video z jednotky jako signál 12G/6G/3G/HD-SDI.
Jednotku lze také nakonfigurovat pro výstup signálu RAW.

Podrobnosti naleznete v části „Konektor SDI OUT (konektor Type BNC)“ v části „Připojení externích monitorů a
záznamových zařízení“.

12.

 Snímač infračerveného dálkového ovladače (zadní)
Infračervený snímač pro dodaný infračervený dálkový ovladač.

13.

Výstup ventilátoru/vzduchu
Odvádí teplo zevnitř jednotky.

Poznámka

Nezakrývejte výstup vzduchu. Pokud tak učiníte, může dojít k poruše.

Všimněte si, že oblast v blízkosti výstupu vzduchu se může zahřívat.

14.

Konektor GENLOCK
Používá se pro vstup externího synchronizačního signálu.

Podrobnosti naleznete v části „Synchronizace fáze videosignálu (kombinace obrazových signálů)“.

15.

Konektor AUDIO IN (typ XLR, 5kolíkový)
Používá se pro vstup signálu z externího mikrofonu nebo zvukového zařízení.
Plní funkci konektoru AUDIO IN CH-1 nebo AUDIO IN CH-2.

Další informace naleznete v části „Připojení externího mikrofonu nebo externího zvukového zařízení“.

16.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohled z boku

Toto téma popisuje umístění a funkci součástí na boční straně jednotky.

Tip

Tento popis odkazuje na obrázek jednotky bez připojeného objektivu.

Zamykací páka posunu/naklápění
Uzamkne mechanismus posunu/naklápění jednotky. Použijte v následujících případech.

Při přepravě nebo balení jednotky.
Při nasazování nebo snímání objektivu. Podrobnosti viz také kapitola „Upevnění objektivu“ nebo „Sejmutí
objektivu“.
Pokud používáte objektiv, který nepodporuje ovládání posunu/naklápění (například objektivy Sony
SEL100400GM / SEL200600G / SEL400F28GM /SEL600F40GM).
Během přepravy jednotky vždy sejměte objektiv a nastavte uzamčenou polohu.

1.
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Příbuzné téma

Upevnění objektivu

Sejmutí objektivu

Vložení paměťových karet

Přístup k webové aplikaci z webového prohlížeče

5-041-958-43(1) Copyright 2022 Sony Corporation

Tip

Pohyb posunu/naklápění lze aretovat v následujících úhlech.

Posuvná základna2.

Otvory pro šrouby pro externí zařízení (4 pozice)
Pro šrouby M3 o délce do 6 mm.

Poznámka

Nepoužívejte šrouby delší než 6 mm. Pokud tak učiníte, může dojít k poruše.

3.

Indikátor přístupu A4.

Indikátor přístupu B
Indikátor svítí nebo bliká při vložení záznamového média.

Podrobnosti viz kapitola „Vložení paměťových karet“.

5.

Slot pro karty CFexpress Type A / SD (A)6.

Slot pro karty CFexpress Type A / SD (B)
Používá se pro vložení záznamového média.

Podrobnosti viz kapitola „Vložení paměťových karet“.

7.

QR kód pro připojení k síti
Používá se pro konfiguraci počátečních nastavení.

Podrobnosti viz kapitola „Přístup k webové aplikaci z webového prohlížeče“.

8.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohled shora

Toto téma popisuje umístění a funkci součástí na horní straně jednotky.

Tip

Tento popis odkazuje na obrázek jednotky bez připojeného objektivu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Otvory pro šrouby pro externí zařízení (2 pozice)
Kompatibilní se šrouby 1/4-20 UNC pro stativ.
Maximální délka 6 mm.

1.

ɸ (značka obrazového snímače)
Značka obrazového snímače je ve stejné rovině jako obrazový snímač.
Chcete-li přesně změřit vzdálenost mezi jednotkou a snímaným objektem, použijte tuto značku obrazového snímače
jako referenční bod.

2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohled zespodu

Toto téma popisuje umístění a funkci součástí na dolní straně jednotky.

Tip

Tento popis odkazuje na obrázek jednotky bez připojeného objektivu.

Otvory pro upevňovací šrouby stropního držáku (6 pozic, efektivní hloubka závitu 5,5 mm)
Při montáži jednotky na strop nebo polici ve vysoké poloze připevněte držák těla (volitelně) k základně jednotky
pomocí šesti upevňovacích šroubů držáku těla zasunutých do těchto otvorů pro šrouby.

Podrobnosti o montáži viz „Montáž ve svislé poloze na vysokém, pevném místě“ a „Montáž na strop“.

1.

Upevňovací šrouby stativu (2 pozice)
Používá se při montáži jednotky na stativ kamery (volitelně šroubů 1/4-20 UNC o délce až 5,5 mm).

Poznámka

2.
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Příbuzné téma

Montáž ve svislé poloze na vysokém, pevném místě

Montáž na strop

5-041-958-43(1) Copyright 2022 Sony Corporation

Nepoužívejte šrouby delší než 5,5 mm. Pokud tak učiníte, může dojít k poruše.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Podpěra objektivu

Toto téma popisuje umístění a funkci součástí podpěry objektivu jednotky.

Tip

Tento popis odkazuje na obrázek jednotky bez připojeného objektivu.

Tyč podpěry objektivu (2)
Podporuje objektiv.
Lze jej také použít pro montáž běžného příslušenství pro tyč Ø15.

1.
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Jednotka podpěry objektivu
Podpěra objektivu se může posouvat dopředu/dozadu podle objektivu a poté zajistit.

2.

Upevňovací šroub stojanu podpěry objektivu
Upevňuje se ke stojanu podpěry objektivu. Výšku stojanu podpěry objektivu můžete nastavit odpovídajícím
způsobem pomocí šroubu nahoru/dolů.

3.

Upínací páka tyčové podpěry objektivu (2 pozice)
Zajišťuje přední/zadní polohu jednotky podpěry objektivu.

4.

Upínací páka upevňovacího šroubu stojanu podpěry objektivu
Zajišťuje svislou polohu upevňovacího šroubu stojanu podpěry objektivu.

Tip

Pokud je upínací páka v poloze, která znesnadňuje otáčení, uvolněte upínací páku a otočte ji pod úhlem, který usnadní
obsluhu. V požadované poloze pak upínací páku zavřete.

A: Upínací páka upevňovacího šroubu stojanu podpěry objektivu
B: Upínací páka tyčové podpěry objektivu

Poznámka

Pokud nepoužíváte jednotku podpěry objektivu, přesuňte ji proti hlavě kamery, aby nedošlo k narušení funkce
posunu/naklápění, a přesuňte upevňovací šroub stojanu podpěry objektivu do nejvyšší polohy (co nejblíže k objektivu).

5.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Umístění a funkce součástí infračerveného dálkového ovladače (součást dodávky)

Toto téma popisuje umístění a funkci součástí infračerveného dálkového ovladače (součást dodávky).

Tlačítko REC● (START/STOP záznamu)
Stisknutím spustíte nebo zastavíte záznam.

1.

Tlačítko MENU
Stisknutím tlačítka zobrazíte nebo skryjete nabídku kamery.

2.

Ovládací tlačítka grafického uživatelského rozhraní
Stisknutím tlačítka provedete operace v nabídce kamery, v dialogových oknech zpráv, které obsahují tlačítka, a
dalších funkcích zobrazení obrazovky.

3.

Tlačítko CANC/BACK
Stisknutím tlačítka zrušíte nastavení nebo se vrátíte na předchozí obrazovku nabídky kamery jednotky.

4.
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Baterie infračerveného dálkového ovladače

Infračervený dálkový ovladač vyžaduje dvě baterie AA (LR6).
Vložte baterie do infračerveného dálkového ovladače, jak je znázorněno na následujícím obrázku.

Ovládací tlačítka posunu a naklápění
Stiskněte tlačítka se šipkami pro ovládání posunu/naklápění kamery. Stiskněte tlačítko HOME a vraťte orientaci
kamery směrem dopředu.

5.

Přednastavená ovládací tlačítka polohy
Stiskněte a podržte tlačítko PRESET a stiskněte jedno z tlačítek 1 až 3 pro uložení směru kamery, zoomu a stavu
nastavení zaostření do stisknutého očíslovaného tlačítka.
Stisknutím číselného tlačítka s uloženými nastaveními vyvoláte uložený stav.

6.

Ovládací tlačítka ostření
Používají se k nastavení zaostření.
Chcete-li nastavit zaostření automaticky, stiskněte tlačítko AF.
Chcete-li nastavit zaostření ručně, stiskněte tlačítko MF, pak stiskněte tlačítko F (Far) pro zaostření na vzdálené
objekty, nebo tlačítko N (Near) pro zaostření na blízké objekty.

7.

Přiřaditelná tlačítka 1 až 3
Provádí funkce přiřazené přiřaditelným tlačítkům pomocí nabídky kamery.
Pokud přiřadíte funkci [Direct Menu] přiřaditelnému tlačítku, můžete pomocí ovládacích tlačítek grafického
uživatelského rozhraní upravit expozici, vyvážení bílé a další nastavení.

Podrobnosti o přiřazení pomocí nabídky kamery viz „Přiřaditelná tlačítka“.

Podrobné informace o přímé nabídce viz „Ovládání přímé nabídky“.

8.

Tlačítko  (napájení)
Stisknutím zapnete jednotku nebo přepnete napájení do pohotovostního stavu.

9.

Tlačítko THUMBNAIL
Zobrazí obrazovku s miniaturami zobrazující klipy zaznamenané na paměťové kartě jednotky.

Podrobné informace o obrazovce miniatur viz „Obrazovka miniatur“.

Pomocí ovládacích tlačítek grafického uživatelského rozhraní můžete vybírat klipy a ovládat přehrávání na obrazovce
miniatur.

Podrobnosti o výběru klipů a ovládání přehrávání viz „Přehrávání zaznamenaných klipů“ a „Operace se
zaznamenanými klipy“.

10.

Tlačítko SLOT SEL (výběr slotu pro paměťovou kartu (A)/(B))
Po vložení dvou paměťových karet stiskněte tlačítko pro přepínání mezi paměťovými kartami pro záznam.
Stisknutím tohoto tlačítka během zobrazení obrazovky miniatur přepnete zobrazení mezi paměťovými kartami.

11.

Tlačítko P/T RESET (reset posunu/naklápění)
Resetuje funkce posunu/naklápění. Stiskněte tlačítko, když kontrolka POWER a NETWORK blikají současně nebo
když je v ovládacím panelu seřízení obrazu ve webové aplikaci zobrazeno tlačítko [Execute Pan-Tilt Reset].

12.

Ovládací tlačítka zoomu
Pro přiblížení stiskněte tlačítko T (teleobjektiv).
Pro oddálení stiskněte tlačítko W (širokoúhle).

13.
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Poznámka

Nepoužívejte žádné jiné baterie než manganové nebo alkalické baterie, protože mohou prasknout.

Použité baterie zlikvidujte podle zákonů a předpisů vaší země nebo oblasti.

Příbuzné téma

Přiřaditelná tlačítka

Ovládání přímé nabídky

Obrazovka miniatur

Přehrávání zaznamenaných klipů

Operace se zaznamenanými klipy

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přehled obrazovky webové aplikace

Připojením tabletu nebo počítače můžete jednotku posouvat/naklápět, zoomovat, zaznamenávat, přehrávat záznam
videa a nakonfigurovat jednotku z webového prohlížeče (dále jen „webová aplikace“).

Podrobnosti o spouštění webové aplikace viz kapitola „Přístup k webové aplikaci z webového prohlížeče“.

Poznámka

Webová aplikace nepodporuje výstup zvuku kamery.

Když se spustí webová aplikace, zobrazí se následující obrazovka živého provozu.

Obrazovka živého provozu

Podrobné informace o obrazovce živého provozu viz „Struktura obrazovky živého provozu“.
Tlačítka a ikony společné pro obrazovku živého provozu a obrazovku přehrávání jsou zobrazeny v horní části
obrazovky.

Podrobné informace o společné oblasti obrazovek viz „Struktura společné oblasti obrazovek“.
Mezi obrazovkami můžete přepínat stisknutím karet přepínání obrazovek ve společné oblasti.
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Obrazovka přehrávání

Stisknutím karty [Playback] zobrazte obrazovku přehrávání.

Podrobné informace o obrazovce přehrávání viz „Struktura obrazovky přehrávání“.

Obrazovka nastavení

Stisknutím karty [Settings] zobrazte obrazovku nastavení (dále jen webová nabídka).
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Poznámka

Ve webové nabídce se nastavení nepoužijí, dokud nestisknete tlačítko [OK]. Pokud změníte nastavení na stránce, která má k
dispozici tlačítko [OK], nezapomeňte stisknout tlačítko [OK].

Podrobné informace o obrazovce nastavení viz „Struktura obrazovky nastavení“.
V tomto průvodci nápovědou se obrazovka nastavení webové aplikace nazývá webová nabídka.

Příbuzné téma
Přístup k webové aplikaci z webového prohlížeče

Struktura obrazovky živého provozu

Struktura společné oblasti obrazovek

Struktura obrazovky přehrávání

Struktura obrazovky nastavení

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura společné oblasti obrazovek

Toto téma popisuje strukturu společné oblasti obrazovek.

Název kamery
Zobrazí název kamery.
Název můžete změnit pomocí položek [Network] > [Camera Name] ve webové nabídce.
Barva pozadí se mění podle externího indikačního signálu.

1.

Spínač napájení
Když je jednotka zapnuta, zobrazí se zpráva [Power ON]. Chcete-li přepnout napájení jednotky do pohotovostního
stavu, stiskněte spínač a vyberte možnost [Power Standby].
Po zobrazení položky [Power Standby] můžete stisknout spínač a volbou [Power ON] zapnout napájení jednotky.

2.

Přepínání karet na obrazovce ovládání
Stisknutím karty zobrazte odpovídající obrazovku ovládání.
Karta [Live]: Zobrazí obrazovku živého provozu.
Karta [Playback]: Zobrazí obrazovku přehrávání.
Karta [Settings]: Zobrazí obrazovku nastavení (webová nabídka).

3.

Značka oznámení
Když je signalizována zpráva, indikace značky změní, jak je znázorněno níže.

 (Oznámení zapnuta)
Učiňte nezbytné kroky v souladu se zprávou zobrazenou v panelu obrazu kamery.

Poznámka

Zprávy se nezobrazují, když je možnost [Monitoring] > [Output Display] > [HDMI/Stream] nastavena na hodnotu [Off] ve
webové nabídce. Nastavte na hodnotu [On] pro kontrolu obsahu zpráv.

4.

Tlačítko  (Stav kamery)
Stisknutím tlačítka zobrazíte zaznamenaného obrazu / informace signálu výstupu, informace o objektivu a stavu
ovladače objektivu (volitelně) na samostatné obrazovce.

5.
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Pokud dojde k oznámení týkajícímu se ovladače objektivu (volitelně), indikace se změní, jak je znázorněno níže.

Spínač zámku ovládání obrazovky
 (Operace odemčení): Nastavte spínač do levé polohy pro ovládání obsluhy na obrazovce živého provozu a

obrazovce přehrávání.
 (Operace uzamčení): Nastavte spínač do pravé polohy pro uzamčení obsluhy na obrazovce živého provozu a

obrazovce přehrávání.

6.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura obrazovky živého provozu

Toto téma popisuje strukturu obrazovky živého provozu.

Přednastavený ovládací panel polohy
Zobrazuje polohu registrovanou v přednastavení pomocí miniatury. Poklepáním na miniaturu se vrátíte k poloze
uložené v přednastavení.

Podrobnosti o přednastavení polohy naleznete v části „Uložení/obnovení posunu/naklápění kamery, polohy
zoomu a nastavení zaostření pomocí webové aplikace“.
Další informace o funkci PTZ Trace naleznete v části „Záznam operací seřízení obrazu kamery pomocí webové
aplikace“.

1.

Panel obrazu kamery
Zobrazuje aktuální obraz kamery a stav jednotky.
Zobrazuje stejný obraz jako výstup HDMI.
Nad obrázkem se zobrazí následující stav. Okolo obrazu je také zobrazen červený nebo zelený rámeček podle
přijatého externího indikačního signálu.

2.
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Tlačítko [Display]
Stisknutím tohoto tlačítka zobrazíte informace o kameře na obrázku.
Opětovným stisknutím tlačítka při zobrazení informací o kameře tyto informace skryjete.

Kromě značek jsou zobrazeny některé indikátory a zprávy související s automatickým ostřením podle stavu a tyto
nelze skrýt stisknutím tlačítka [Display].

Další informace o zobrazených informacích o kameře naleznete v části „Zobrazení obrazovky kamery“.

Tlačítko zastavení sledování AF v reálném čase
Stisknutím tlačítka zastavíte sledování předmětu.

Č. Displej Popis

2-
1

Indikátor režimu zaostřování
Další informace naleznete v části „Indikátor režimu zaostřování“ v
„Zobrazení obrazovky kamery“.

2-
2

Režim záznamu, slot A/B, indikátor
intervalu záznamu (při intervalovém
záznamu)

Další informace naleznete v části „ Režim záznamu, slot A/B,
indikátor intervalu záznamu (při intervalovém záznamu)“ v
„Zobrazení obrazovky kamery“.

2-
3

Indikátor stavu streamování
Zobrazuje se během streamování (pokud je možnost [Stream
Setting] nastavena pouze na volbu [RTMP] nebo [SRT-Caller]).

2-
4

Indikátor stavu operace výstupu RAW Zobrazuje stav výstupu signálu RAW. Podrobnosti o videu RAW viz
„Záznam videa ve formátu RAW“.

2-
5

Indikátor zbývající kapacity média
Další informace naleznete v části „Indikátor zbývající kapacity
média“ v „Zobrazení obrazovky kamery“.

2-
6

Indikátor polohy zoomu

Další informace naleznete v části „Indikátor polohy zoomu“ v
„Zobrazení obrazovky kamery“.
Pokud je připojen ovladač objektivu (volba), zobrazí se . Pokud
se vyskytne chyba v ovladači objektivu (volitelně), zobrazí se .

2-
7

Indikátor režimu AE/úrovně AE Další informace naleznete v části „Indikátor režimu AE/úrovně AE“
v „Zobrazení obrazovky kamery“.

45



Další informace naleznete v části „Sledování stanoveného předmětu (režim sledování AF v reálném čase)“.
Tlačítko START/STOP záznamu
Stisknutím tohoto tlačítka spusťte záznam. Během záznamu se tlačítko START/STOP záznamu rozsvítí červeně.
Stiskněte během nahrávání a zastavte tak nahrávání.
Spínač Hold můžete nastavit do stavu podržení, abyste zabránili nesprávné funkci tlačítka START/STOP záznamu.

3.

Panel základní konfigurace kamery
Zobrazuje nastavení základních funkcí potřebných pro snímání přiřazených tlačítkům. Stisknutím tlačítka zobrazíte
odpovídající obrazovku nastavení pro každou funkci na níže uvedeném panelu základní konfigurace kamery (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Podrobnosti naleznete v popisu každé funkce.

4.

Funkce Reference

FPS „Pomalý a rychlý pohyb“

ISO/Gain
„Nastavení základní citlivosti“, „Automatické nastavení zesílení (AGC)“ a „Ruční nastavení
zesílení“ v části „Nastavení zesílení“

Exposure
Index

„Nastavení základní citlivosti“ a „Změna rozložení tmavých a světlých míst v zaznamenaném
snímku“

Shutter „Automatické nastavení závěrky“ a „Ruční nastavení závěrky“ v části „Nastavení závěrky“

Iris „Automatické nastavení clony“ a „Ruční nastavení clony“ v části „Nastavení clony“

ND Filter „O filtru ND“ v části „Nastavení úrovně osvětlení (filtr ND)“

Scene File „Přehled vzhledu“ a další témata v části „Snímání s požadovaným vzhledem“.

Base
Look/LUT

„Snímání s úpravou vzhledu v postprodukci“

White
Balance

„Obrazovka nastavení vyvážení bílé barvy“

Přiřaditelná tlačítka / Panel nastavení základní konfigurace kamery5.
46



Zobrazuje přiřaditelná tlačítka během normálního provozu. Stiskněte tlačítka panelu základní konfigurace kamery (4)
a zobrazte odpovídající položky nastavení. Stiskněte tlačítko [X] nebo znovu stiskněte tlačítko panelu nastavení
kamery a vraťte se na displej přiřaditelného tlačítka.

Další informace o přiřaditelných tlačítcích naleznete v části „Přiřaditelná tlačítka“.
Podrobnosti o panelu nastavení základní konfigurace kamery naleznete v popisu každé funkce.

Ovládací panel seřízení obrazu / ovládací panel grafického uživatelského rozhraní
Přepíná mezi ovládacím panelem seřízení obrazu a ovládacím panelem grafického uživatelského rozhraní pomocí
karet v horní části.
Ovládací panel můžete skrýt stisknutím tlačítka  (Zavřít) v pravém horním rohu obrazovky, čímž zabráníte
neúmyslnému spuštění. Pokud se ovládací panel nezobrazuje, stiskněte tlačítko  (Otevřít) a zobrazte jej.
Pomocí ovládacího panelu seřízení obrazu upravte seřízení obrazu. Stisknutím karty 
(Posun/naklápění/zoom) zobrazte ovládací panel seřízení obrazu.

Další informace o operaci naleznete v části „Nastavení seřízení obrazu“.

Tip

Joysticková část ovládacího panelu seřízení obrazu se zobrazí, jak je znázorněno níže, když je zakázána funkce
posunu/naklápění a když je vyžadována inicializace funkce posunu/naklápění.

Když je funkce posunu/naklápění uzamčena pomocí zamykací páky posunu/naklápění

Když funkce posunu/naklápění není inicializována

6.
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Když je funkci posunu/naklápění nutné resetovat

Když je funkce posunu/naklápění zakázána

Pokud operace posunu/naklápění není inicializována nebo je třeba ji resetovat, můžete rychle přistoupit k tlačítku 
(Posun/naklápění reset) v ovládacím panelu kamery stisknutím zprávy zobrazené pod joystickem.

Pomocí ovládacího panelu grafického uživatelského rozhraní můžete ovládat nabídku kamery, přehrávání klipu a
další funkce. Stisknutím karty  (GUI kamery) zobrazte ovládací blok grafického uživatelského rozhraní.

Další informace o obsluze naleznete v části „Ovládání nabídky kamery“ a „Přehrávání zaznamenaných klipů“.
Ovládací panel kamery
Používá se pro konfiguraci funkcí požadovaných pro ovládání kamery.
Přepíná mezi obrazovkami k zobrazení pomocí karet v horní části.
Ovládací panel můžete skrýt stisknutím tlačítka  (Zavřít) v pravém horním rohu obrazovky, čímž zabráníte
neúmyslnému spuštění. Pokud se ovládací panel nezobrazuje, stiskněte tlačítko  (Otevřít) a zobrazte jej.

7.
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Podrobnosti naleznete v popisu každé funkce.

Karta  (Main)
Zobrazí položky nastavení pro často používané funkce.
Funkce horního a dolního posuvníku lze změnit stisknutím tlačítka [▼] a výběrem ze zobrazeného seznamu. Lze
vybrat následující funkce.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Karta  (Focus)
Zobrazí položky nastavení související se zaostřováním.

Karta  (Audio)

Zobrazí položky nastavení související se zvukem.

Zobrazuje se podle nastavení nabídky.*
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Karta  (Stream)
Zobrazí položky nastavení související se streamováním.
Zobrazení položek se bude lišit v závislosti na nastavení formátu streamování.
Pokud je nastaveno na volbu [RTMP] nebo [SRT-Caller], lze na této obrazovce streamování spustit/zastavit.

Další informace naleznete v části „O streamování“ a další témata v části „Konfigurování streamování“.
Pokud dojde k výpadku připojení, zobrazí se informace o chybě. Podrobnosti o informacích o chybách naleznete
v části „Chybové/výstražné zprávy“.

Karta  (Others)
Zobrazí položky nastavení související s dalšími funkcemi.
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Příbuzné téma

Uložení/obnovení posunu/naklápění kamery, polohy zoomu a nastavení zaostření pomocí webové aplikace

Záznam operací seřízení obrazu kamery pomocí webové aplikace

Zobrazení obrazovky kamery

Záznam videa ve formátu RAW

Sledování stanoveného předmětu (režim sledování AF v reálném čase)

Pomalý a rychlý pohyb

Nastavení základní citlivosti

Automatické nastavení zesílení (AGC)

Ruční nastavení zesílení

Změna rozložení tmavých a světlých míst v zaznamenaném snímku

Automatické nastavení závěrky

Ruční nastavení závěrky

Automatické nastavení clony

Ruční nastavení clony

O filtru ND

Přehled vzhledu

Snímání s úpravou vzhledu v postprodukci

Obrazovka nastavení vyvážení bílé barvy

Přiřaditelná tlačítka

Přehrávání zaznamenaných klipů

Ovládání nabídky kamery

O streamování

Chybové/výstražné zprávy

5-041-958-43(1) Copyright 2022 Sony Corporation

Stisknutím tlačítka [Full Screen Display] se otevře nová záložka ve webovém prohlížeči a obraz z panelu obrazu
kamery se zobrazí na celé obrazovce.
Zobrazí se pouze zobrazení obrazu; automatické ostření dotykem a další funkce nejsou k dispozici.

Poznámka

Obrazovka živého provozu na původní kartě nadále pracuje. Doporučujeme zavřít kartu, abyste snížili počet současných
připojení, pokud není vyžadována žádná operace.

Stisknutím tlačítka  (Inicializovat ovladač objektivu) inicializujete ovladač objektivu (možnost třetí
strany). Toto tlačítko je povoleno, když je možnost [Technical] > [Lens Controller] > [Zoom] > [Setting] nastavena na
hodnotu [On] ve webové nabídce.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura obrazovky přehrávání

Toto téma popisuje strukturu obrazovky přehrávání.

Panel obrazu kamery
Zobrazuje obraz přehrávání a související informace. Když je přehrávání zastaveno, zobrazí se obrazovka obrazu
kamery.

1.
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1-1 Datum a čas snímání
1-2 Indikátor stavu přehrávání
1-3 Indikátor formátu přehrávání (velikost obrazu)
1-4 Indikátor formátu přehrávání (kodek)
1-5 Zobrazení názvu klipu
1-6 Číslo klipu / celkový počet klipů
1-7 Zobrazení názvu LUT
1-8 Indikátor stavu streamování
1-9 Indikátor formátu přehrávání (snímková frekvence a metoda skenování)
1-10 Indikátor vzhledu záznamu

Ovládací panel přehrávání

Zobrazuje ovládací tlačítka přehrávání.

Tlačítko [Display]
Stisknutím tlačítka přepnete mezi zobrazením obrazovky na snímku.
Tlačítko [Thumbnail]
Zobrazí klipy zaznamenané na paměťové kartě na panelu obrazu kamery jako miniatury.

2.

Tlačítko Funkce

Tlačítko  (Přehrát/Pozastavit) Přehrává klip. Během přehrávání pozastaví klip.

Tlačítko  (Rychle vpřed), tlačítko
 (Rychle vzad)

Přehraje klip vysokou rychlostí. Když stisknete toto tlačítko, změní se
rychlost přehrávání ve třech krocích.

Tlačítko  (Další), tlačítko 
(Předchozí)

Přejde na začátek klipu nebo předchozí/následující klip.

Tlačítko  (Stop) Zastavuje přehrávání.
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Příbuzné téma

Obrazovka miniatur

Přiřaditelná tlačítka

Přehrávání zaznamenaných klipů

5-041-958-43(1) Copyright 2022 Sony Corporation

Stisknutím tlačítka [Thumbnail] během zobrazení obrazovky miniatur zavřete tuto obrazovku miniatur a vrátíte se k
obrazu z kamery.

Podrobné informace o obrazovce miniatur viz „Obrazovka miniatur“.

Tlačítko [Slot Select]
Přepíná mezi cílovými médii pro přehrávání.

Přiřaditelná tlačítka
Zobrazuje přiřaditelná tlačítka přiřazená funkcím jednotky.

Další informace o přiřaditelných tlačítcích naleznete v části „Přiřaditelná tlačítka“.

3.

Ovládací panel grafického uživatelského rozhraní
Pomocí ovládacího panelu grafického uživatelského rozhraní můžete ovládat nabídku kamery, přehrávání klipu a
další funkce.

Další informace o obsluze naleznete v části „Ovládání nabídky kamery“ a „Přehrávání zaznamenaných klipů“.

4.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura obrazovky nastavení

Pomocí obrazovky nastavení nakonfigurujte různé položky nastavení jednotky, včetně počátečních nastavení, nastavení
sítě, nastavení snímání/přehrávání pomocí webové nabídky.

Poznámka

Ve webové nabídce se nastavení nepoužijí, dokud nestisknete tlačítko [OK] (obecné pravidlo). Pokud změníte nastavení na
stránce, která má k dispozici tlačítko [OK], nezapomeňte stisknout tlačítko [OK].

Další informace o obrazovce nastavení naleznete v části „Webová nabídka a podrobná nastavení“.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nabídka kamery

Stisknutím tlačítka [Menu] v ovládacím panelu grafického uživatelského rozhraní obrazovky živého provozu nebo
obrazovky ovládání přehrávání zobrazíte nabídku kamery v panelu obrazu kamery.

Nastavení potřebná pro snímání a přehrávání můžete nakonfigurovat pomocí nabídky kamery.
Stisknutím tlačítka [Menu] při zobrazení nabídky kamery ji skryjete.
Nabídka kamery se ovládá pomocí ovládacího panelu grafického uživatelského rozhraní.

Další informace o nabídce kamery naleznete v části „Nabídka kamery a podrobná nastavení“.

Poznámka

Je-li možnost [Monitoring] > [Output Display] > [HDMI/Stream] > nastavena na hodnotu Off ve webové nabídce (zakáže
překrývání informací na displeji), nabídka kamery se již na panelu obrazu kamery nezobrazí. Mějte však na paměti, že operace
nabídky v ovládacím panelu grafického uživatelského rozhraní jsou stále aktivní. Abyste se vyhnuli neúmyslné operaci, dbejte na
to, abyste neprovedli žádné operace nabídky pomocí ovládacího panelu grafického uživatelského rozhraní, pokud je možnost
[HDMI/Stream] nastavena na hodnotu Off.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zobrazení obrazovky kamery

Můžete zobrazit stav a nastavení jednotky proložené na výstupním obrazu z kamery. Výstupy, pro které je displej
obrazovky povolen, můžete nastavit pomocí položek [Monitoring] > [Output Display] ve webové nabídce.
Informace můžete zobrazit nebo skrýt pomocí tlačítka [Display]. I když jsou skryté, zobrazí se při provádění obsluhy
přímé nabídky.
Položky lze také skrýt/zobrazit samostatně pomocí možnosti [Monitoring] > [Display On/Off] v nabídce kamery.

Informace zobrazené na obrazovce během snímání

Indikátor nahrávání / indikátor zbývajících souborů

Podrobnosti o přenosu souborů naleznete v části „O přenosu souborů“ a další témata v části „Přenos souborů“.

1.

Indikátor oblasti zaostření
Zobrazí oblast zaostření pro automatické zaostřování.

Další informace o automatickém zaostření naleznete v části „Automatické nastavení pomocí webové aplikace“ a
další témata v části „Automatické nastavení zaostření (Auto Focus)“.

2.

Režim záznamu, slot A/B, indikátor intervalu záznamu (při intervalovém záznamu)

Podrobnosti o funkci Interval Rec viz „Přerušované nahrávání videa (Interval Rec)“.

3.

Displej Význam

●Rec Zaznamenávání

Stby Záznam/pohotovostní režim

Indikátor hloubky ostrosti4.

Indikátor režimu skenování obrazového snímače5.
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Pokud se vyskytuje neshoda mezi velikostí kruhu obrazu v objektivu a nastavením režimu skenování obrazového
snímače pro efektivní velikost obrazu, zobrazí se značka  (neshoda).
Pokud je možnost Imager Scan Mode nastavena na FF, v režimech s užším zorným úhlem (oříznutým) se zobrazí
značka „C“.
K oříznutí dochází v následujících režimech.

Pokud je formát záznamu 3840×2160 a snímková frekvence S&Q Motion je 100 snímků/s nebo 120 snímků/s.
Pokud je možnost [Codec] nastavena na RAW nebo RAW & XAVC-I, a výstupní formát RAW je 3840×2160
Podrobné informace o režimu skenování snímače naleznete v části „Nastavení režimu skenování obrazového
snímače“ v části „Konfigurace základní obsluhy“.

Indikátor stavu operace výstupu RAW
Zobrazuje stav výstupu signálu RAW.

Podrobnosti o videu RAW viz „Záznam videa ve formátu RAW“.

6.

Indikátor snímkové frekvence snímání pomalého a rychlého pohybu

Podrobnosti o funkci pomalého a rychlého pohybu naleznete v části „Pomalý a rychlý pohyb“.

7.

Indikátor polohy zaostření

Zobrazí polohu zaostření.

8.

Indikátor režimu zaostřování

Face/Eye Detection AF

Další informace o automatickém zaostřování s detekcí obličeje/očí naleznete v části „Sledování pomocí detekce
obličeje a očí (Face/Eye Detection AF)“.

9.

Displej Význam

Focus Hold Režim Focus Hold

MF Režim MF

AF Režim AF

 (Režim sledování AF v reálném čase) Režim sledování AF v reálném čase

Displej Význam

 (Automatického zaostřování s detekcí
obličeje/očí)

Označuje, že automatické zaostřování s detekcí obličeje/očí je
aktivní

 (Automatické zaostřování v režimu Face/Eye
Only AF)

Označuje, že je aktivní režim automatického zaostřování
pouze obličeje/očí

 (Uložená plocha sledování) Označuje, že byla uložena plocha sledování

 (Pozastavení AF) Označuje, že automatické zaostřování bylo pozastaveno*

Zobrazí se, když není uložen žádný sledovaný obličej a žádný obličej není ani detekován, nebo pokud je uložen sledovaný obličej a cílový
sledovaný obličej není detekován.

*

Indikátor polohy zoomu
Zobrazuje polohu zoomu v rozsahu 0 (širokoúhlý záběr) až 99 (teleobjektiv) (je-li nasazen objektiv podporující
zobrazení polohy zoomu).

10.
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Indikátor můžete také změnit na zobrazení lišty nebo zobrazení ohniskové vzdálenosti pomocí nastavení [Technical]
> [Lens] > [Zoom Position Display] v nabídce kamery.
Po aktivaci funkce Clear Image Zoom se na displej přidají následující položky.

Další informace o zoomu naleznete v části „Nastavení typu zoomu“ a další témata v části „Nastavení zoomu“.

Displej Význam

 (Funkce Clear Image Zoom je povolena) Funkce Clear Image Zoom je povolena

Hodnota zvětšení Při použití funkce Clear Image Zoom

Indikátor režimu stabilizace obrazu11.

Indikátor stavu Rec Control výstupu SDI / výstupu HDMI
Zobrazuje stav výstupu řídicího signálu REC.

Podrobnosti naleznete v části „Připojení externích monitorů a záznamových zařízení“.

12.

Indikátor zaostření

Další informace naleznete v části „Použití automatického zaostřování jedním záběrem (Push Auto Focus (AF-S))“
v části „Nastavení zaostření“.

13.

Indikátor zbývající kapacity média
Pokud je paměťová karta chráněna proti zápisu, zobrazí se ikona  (ochrana).

14.

Indikátor režimu vyvážení bílé15.

Displej Význam

 (ATW) Automatický režim

 (ATW Hold) Automatický režim pozastaven

W:P Režim předvolby

W:A Režim paměti A

Indikátor externího zámku časového kódu / datový displej času
Zobrazuje „EXT-LK“, když je provedeno uzamčení k časovému kódu externího zařízení.

Další informace o časovém kódu naleznete v části „Zadání dat času“.

16.

Indikátor filtru ND

Další informace o filtrech ND naleznete v části „Nastavení úrovně osvětlení (filtr ND)“.
Další informace o ovládání režimu bokeh naleznete v části „Nastavení efektu bokeh (funkce řízení efektu bokeh)“.

17.

Displej Význam

 (A) Automatický režim

 (B) Režim řízení efektu bokeh

Indikátor souboru scény18.
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Další informace o souborech scény naleznete v části „Přehled vzhledu“ a další témata v části „Snímání s
požadovaným vzhledem“.

Indikátor clony
Zobrazuje polohu clony (hodnota F) (je-li nasazen objektiv podporující zobrazení nastavení clony).

Další informace o cloně naleznete v části „Automatické nastavení clony“ a „Ruční nastavení clony“.

19.

Výstražný indikátor úrovně videosignálu20.

Indikátor zesílení
Zobrazuje hodnotu EI v režimu Cine EI/Cine EI Quick.

Další informace o zesílení naleznete v části „Automatické nastavení zesílení (AGC)“ a „Ruční nastavení zesílení“.
Další informace o režimu Cine EI/Cine EI Quick naleznete v části „Nastavení režimu snímání“ v části „Konfigurace
základní obsluhy“.

21.

Displej Význam

 (A) Automatický režim

L Režim předvolby L

 (Režim dočasného nastavení) Režim dočasného nastavení

 (B) Režim řízení efektu bokeh

Zobrazení názvu klipu
Zobrazuje název nahraného klipu nebo název, který má být zaznamenán jako další.
Pokud dochází k blikání, vyskytuje se neshoda mezi posledním klipem na záznamovém médiu a nastavením
[Camera ID] nebo [Reel Number]. Podrobnosti naleznete v popisu [Clip Name Format] > [Auto Naming].

22.

Indikátor závěrky

Další informace o závěrce naleznete v části „Automatické nastavení závěrky“ a „Ruční nastavení závěrky“.

23.

Indikátor režimu AE/úrovně AE

Další informace o automatické expozici naleznete v části „Nastavení cílové úrovně pro automatické nastavení
jasu“.

24.

Indikátor vodováhy
Zobrazuje vodorovnou úroveň v přírůstcích ±1° až ±15°.

25.

Měřič úrovně zvuku
Zobrazuje úroveň zvuku každého kanálu.

26.

Monitor video signálu
Zobrazuje křivku, vektorový osciloskop a histogram.
Oranžová čára označuje nastavenou hodnotu značky úrovně jasu.
V režimech snímání Log se nad displejem zobrazí typ cílová hodnota LUT monitoru.

Podrobnosti viz kapitola „Monitor video signálu“.
Další informace o režimu snímání Log naleznete v části „Nastavení režimu snímání“ v části „Konfigurace základní
obsluhy“.

27.

Indikátor Base Sensitivity / indikátor Base ISO28.
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Informace zobrazené na obrazovce během přehrávání

Následující informace se překrývají s přehrávaným obrazem.

V režimu Custom se zobrazuje základní citlivost nastavená pomocí tlačítka [ISO/Gain/Exposure Index] v panelu
základní konfigurace kamery, nebo v položce [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] v nabídce kamery.
V režimu snímání Log se zobrazuje citlivost Base ISO nastavená pomocí tlačítka [ISO/Gain/Exposure Index] v panelu
základní konfigurace kamery, nebo v položce [Shooting] > [ISO/Gain/EI] > [Base ISO] v nabídce kamery.

Další informace o základní citlivosti naleznete v části „Volba základní citlivosti“.
Další informace o režimu snímání Log naleznete v části „Nastavení režimu snímání“ v části „Konfigurace základní
obsluhy“.

Indikátor vzhledu monitorování
V režimech snímání Log zobrazuje nastavení monitoru LUT.

Další informace o nastavení LUT naleznete v části „Snímání s úpravou vzhledu v postprodukci“ a souvisejících
tématech.
Další informace o režimu snímání Log naleznete v části „Nastavení režimu snímání“ v části „Konfigurace základní
obsluhy“.

29.

Indikátor základního vzhledu / vzhledu záznamu
Zobrazí nastavení základního vzhledu.
V režimu snímání Log zobrazuje video signál pro záznam na paměťové karty.

Další informace o základním vzhledu naleznete v části „Přehled vzhledu“, „Snímání s požadovaným vzhledem“.
Další informace o režimu snímání Log naleznete v části „Nastavení režimu snímání“ v části „Konfigurace základní
obsluhy“.

30.

Indikátor stavu proxy31.

Indikátor formátu záznamu (kodek)
Zobrazuje název formátu pro záznam na paměťové karty.
Nastavte formát záznamu (kodek) pomocí možnosti [Project] > [Rec Format] > [Codec] ve webové nabídce nebo v
nabídce kamery.

32.

Indikátor formátu záznamu (snímková frekvence a metoda skenování)33.

Indikátor formátu záznamu (velikost obrazu)
Zobrazuje velikost obrazu pro záznam na paměťové karty.
Nastavte formát záznamu (velikost obrazu) pomocí možnosti [Project] > [Rec Format] > [Codec] ve webové nabídce
nebo v nabídce kamery.

34.

Indikační kontrolka
Okolo obrazu zobrazuje červený nebo zelený rámeček podle přijatého externího indikačního signálu.

35.
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Příbuzné téma

O přenosu souborů

Automatické nastavení pomocí webové aplikace

Přerušované nahrávání videa (Interval Rec)

Konfigurace základní obsluhy

Záznam videa ve formátu RAW

Pomalý a rychlý pohyb

Indikátor nahrávání / indikátor zbývajících souborů1.

Clip Number2.

Indikátor stavu přehrávání3.

Indikátor formátu přehrávání (snímková frekvence a metoda skenování)4.

Indikátor formátu přehrávání (velikost obrazu)5.

Indikátor formátu přehrávání (kodek)6.

Indikátor média
Pokud je paměťová karta chráněna proti zápisu, zobrazí se ikona  (ochrana).

7.

Zobrazení údajů o čase8.

Zobrazení názvu klipu9.

Indikátor podpory zobrazení gama10.

Měřič úrovně zvuku
Zobrazuje úroveň hlasitosti přehrávání.

11.

Indikátor základního vzhledu / vzhledu záznamu12.

Indikační kontrolka13.
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Sledování pomocí detekce obličeje a očí (Face/Eye Detection AF)

Nastavení typu zoomu

Připojení externích monitorů a záznamových zařízení

Použití automatického zaostřování jedním záběrem (Push Auto Focus (AF-S))

Zadání dat času

Přehled vzhledu

Automatické nastavení clony

Ruční nastavení clony

Automatické nastavení zesílení (AGC)

Ruční nastavení zesílení

Automatické nastavení závěrky

Ruční nastavení závěrky

Nastavení cílové úrovně pro automatické nastavení jasu

Monitor video signálu

Snímání s úpravou vzhledu v postprodukci

Clip Name Format

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montáž ve svislé poloze na pevném místě

Toto téma popisuje montáž jednotky na pracovní plochu nebo stativ.

Poznámka k instalaci
Abyste ochránili objektiv a blok konektoru objektivu jednotky, ponechte víčko a kryt jednotky nasazené, dokud
nenasadíte samotný objektiv.
Nedržte během práce jednotlivé součásti objektivu, aby nedošlo k poruše objektivu.
Nedržte během práce hlavu kamery, aby nedošlo k poruše jednotky.

Zkontrolujte upevňovací prostor.

Při montáži na pracovní plochu
Jednotku namontujte na rovný povrch s ohledem na prostor potřebný pro otáčení objektivu a kabeláže na zadní
straně jednotky.

Poznámka

Namontujte jednotku na stabilní místo, které není vystaveno vibracím. Místa s vibracemi mohou způsobit vibrace obrazu.

Pokud musí být jednotka namontována na nakloněném povrchu, udržujte ji v rozmezí ±15° od vodorovné roviny a proveďte
opatření, aby nedošlo k pádu jednotky.

Při montáži na stativ
Připevněte stativ k upevňovacímu otvoru stativu na spodní straně.
Použijte upevňovací šroub stativu s následujícím počtem výčnělků z upevňovacího povrchu a dotáhněte jej ručním
šroubovákem.

A: Upevňovací šrouby stativu 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Výčnělek (4,5 mm až 5,5 mm)

1
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Pak nasaďte objektiv. Viz část „Upevnění objektivu“, která zohledňuje informace v části „Bezpečnostní opatření při
upevnění/sejmutí objektivu“, „Kontrola spínačů objektivu“ a „Bezpečnostní opatření při použití objektivu s proměnlivou
ohniskovou vzdáleností“.

Příbuzné téma

Bezpečnostní opatření při upevnění/sejmutí objektivu

Kontrola spínačů objektivu

Bezpečnostní opatření při použití objektivu s proměnlivou ohniskovou vzdáleností

Upevnění objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Pro montáž jednotky na vysoko umístěné místo nepoužívejte stativové šrouby.

Poznámka

Vyberte stativ, který se nepřevrátí ani při otočení objektivu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montáž ve svislé poloze na vysokém, pevném místě

Toto téma popisuje postup při montáži jednotky ve svislé poloze na vysoké místo pomocí stropního držáku (CIB-PCM1
(volitelné)).

Montáž jednotky na vysoko umístěné místo si objednejte u profesionálního dodavatele.
Při montáži na vysoko umístěné místo se ujistěte, že upevňovací povrch a montážní materiál (s výjimkou
příslušenství) unesou 200 kg nebo vyšší hmotnost a namontujte jednotku tak, jak je popsáno v této příručce
nápovědy. Pokud není montáž dostatečně pevná, jednotka může spadnout a způsobit těžké zranění.
Připojte dodané ocelové lanko ochrany proti pádu ke stropnímu držáku CIB-PCM1 (volitelně), aby nedošlo k pádu
jednotky.
Při montáži jednotky na vysoko umístěné místo jednou za rok zkontrolujte, zda se upevnění neuvolnilo. Zkraťte
interval kontroly podle podmínek použití.

Poznámka k instalaci
Abyste ochránili objektiv a blok konektoru objektivu jednotky, ponechte kryt objektivu a kryt jednotky nasazené, dokud
nenasadíte samotný objektiv.
Nedržte během práce jednotlivé součásti objektivu, aby nedošlo k poruše objektivu.
Nedržte během práce hlavu kamery, aby nedošlo k poruše jednotky.

Zkontrolujte upevňovací příslušenství pro vysoko umístěné místo a montážní prostor.

Sada stropního držáku CIB-PCM1 (volitelně)
Než začnete, zkontrolujte, zda máte následující součásti.

Držák těla (1)
Stropní držák (1)
Kryt uvolňovacího tlačítka objektivu (1)
Drátěné lano proti pádu (1)
Šrouby +PSW M3×8 (9)
Šroub z nerezové oceli pro ocelové lanko ochrany proti pádu +PSW M4×8 (1)

1
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Poznámka

Ocelové lanko ochrany proti pádu je navrženo tak, aby při zavěšení drželo jednotku. Nezatěžujte jej žádnou jinou zátěží než
je hmotnost jednotky.

Montážní prostor
Postupujte podle níže uvedeného výkresu, stanovte montážní umístění a směru a zvažte prostor potřebný pro
otáčení objektivu a kabeláže na zadní straně jednotky.

A: Rozsah pohybu hlavy kamery (například SEL70200GM2 (s připojeným SEL20TC): Ø370)
B: Stropní držák (otvor v upevňovacím povrchu (Ø150))
C: Vyrovnávací otvor montáže

Poznámka

Namontujte jednotku na stabilní místo, které není vystaveno vibracím. Místa s vibracemi mohou způsobit vibrace obrazu.

Pokud musí být jednotka namontována na nakloněném povrchu, udržujte ji v rozmezí ±15° od vodorovné roviny a proveďte
opatření, aby nedošlo k pádu jednotky.

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.2
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Poznámka

Pokud se posun/naklápění hlavy kamery nearetuje, když je zamykací páka v poloze LOCK, pohybujte hlavou kamery ručně,
dokud se nezajistí v požadované poloze.

Připevněte držák těla ke spodní straně jednotky pomocí šesti dodaných šroubů (M3×8).3
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Použijte dodané šrouby. Použití jiných šroubů než dodaných šroubů může poškodit vnitřek jednotky.

Připojte ocelové lanko ochrany proti pádu k držáku těla.4
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A: Dodávané ocelové lanko 
B: Dodávaný křížový šroub (M4×8)
C: Smyčka ocelového lanka

Použijte dodaný šroub. Použití jiného šroubu než dodaného může snížit účinnost funkce ocelového lanka.

Připevněte stropní držák k povrchu, například k polici, kde bude jednotka namontována.5
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A: Zeď 
B: Značka △ (směr kamery vpřed)
C: Otvor pro připojení lanek
D: Police nebo jiný upevňovací povrch

Připojte ocelové lanko ochrany proti pádu k místu v blízkosti upevňovacího povrchu.

Použijte šroub s vnitřním šestihranem M5 (3/16 palce) (volitelně) a připevněte jej k předmětu v blízkosti police nebo
povrchu, ke kterému je připevněn stropní držák.

6

71



A: Ocelové lanko 
B: Šroub s vnitřním šestihranem (M5, 3/16 palce)

Vyrovnejte otvor pro 〇 šroub na přední straně držáku karoserie s otvorem ◇ na stropním držáku, zasuňte
jednotku a dočasně upevněte držák těla ve stropním držáku otáčením jednotky po směru hodinových
ručiček.

7
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A: Otvor 〇
B: Otvor ◇

Připevněte držák těla a stropní držák pomocí tří dodaných šroubů zámku otáčení (M3×8).8
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Pak nasaďte objektiv. Viz část „Upevnění objektivu“, která zohledňuje informace v části „Bezpečnostní opatření při
upevnění/sejmutí objektivu“, „Kontrola spínačů objektivu“ a „Bezpečnostní opatření při použití objektivu s proměnlivou
ohniskovou vzdáleností“.

Poznámka

Po nasazení objektivu zkontrolujte, zda je objektiv bezpečně připevněn.
Objektiv nemá žádnou ochranu proti pádu. Společnost Sony nemůže převzít žádnou odpovědnost za vypadnutí objektivu z
jednotky.

Příbuzné téma
Bezpečnostní opatření při upevnění/sejmutí objektivu

Kontrola spínačů objektivu

Bezpečnostní opatření při použití objektivu s proměnlivou ohniskovou vzdáleností

Upevnění objektivu

Zkontrolujte stav upevnění.

Konkrétně zkontrolujte následující položky. 

Upevňovací šrouby jsou správně připevněny.
Ocelové lanko ochrany proti pádu je správně připevněno a není zkroucené.
Jednotka je namontována ve vodorovné poloze (bez náklonu nebo kývání).
Jednotka se při otočení volně neotáčí.

9
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montáž na strop

Toto téma popisuje postup při montáži jednotky na strop pomocí stropního držáku (CIB-PCM1 (volitelné)).

Montáž jednotky na strop si objednejte u profesionálního dodavatele.
Při montáži na strop se ujistěte, že upevňovací povrch a montážní materiál (s výjimkou příslušenství) unesou 200 kg
nebo vyšší hmotnost a namontujte jednotku tak, jak je popsáno v této příručce nápovědy. Pokud není montáž
dostatečně pevná, jednotka může spadnout a způsobit těžké zranění.
Připojte dodané ocelové lanko ochrany proti pádu ke stropnímu držáku CIB-PCM1 (volitelně), aby nedošlo k pádu
jednotky.
Při montáži jednotky na strop jednou za rok zkontrolujte, zda se upevnění neuvolnilo. Zkraťte interval kontroly podle
podmínek použití.

Poznámka k instalaci
Abyste ochránili objektiv a blok konektoru objektivu jednotky, ponechte kryt objektivu a kryt jednotky nasazené, dokud
nenasadíte samotný objektiv.
Nedržte během práce jednotlivé součásti objektivu, aby nedošlo k poruše objektivu.
Nedržte během práce hlavu kamery, aby nedošlo k poruše jednotky.

Zkontrolujte upevňovací příslušenství pro strop a montážní prostor.

Sada stropního držáku CIB-PCM1 (volitelně)
Než začnete, zkontrolujte, zda máte následující součásti.

Držák těla (1)
Stropní držák (1)
Kryt uvolňovacího tlačítka objektivu (1)
Drátěné lano proti pádu (1)
Šrouby +PSW M3×8 (9)
Šroub z nerezové oceli pro ocelové lanko ochrany proti pádu +PSW M4×8 (1)

1
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Poznámka

Ocelové lanko ochrany proti pádu je navrženo tak, aby při zavěšení drželo jednotku. Nezatěžujte jej žádnou jinou zátěží než
je hmotnost jednotky.

Montážní prostor
Postupujte podle níže uvedeného výkresu, stanovte montážní umístění a směru a zvažte prostor potřebný pro
otáčení objektivu a kabeláže na zadní straně jednotky.

A: Rozsah pohybu hlavy kamery (například SEL70200GM2 (s připojeným SEL20TC): Ø370)
B: Stropní držák (otvor na straně stropu (Ø150))
C: Vyrovnávací otvor montáže

Poznámka

Namontujte na strop (například beton) s dostatečnou pevností.

Pro montáž jednotky na strop s nedostatečnou pevností zajistěte dostatečnou výztuhu.

Namontujte jednotku na stabilní místo, které není vystaveno vibracím. Místa s vibracemi mohou způsobit vibrace obrazu.

Pokud musí být jednotka namontována na nakloněném povrchu, udržujte ji v rozmezí ±15° od vodorovné roviny a proveďte
opatření, aby nedošlo k pádu jednotky.

Strana naproti otvoru △ na stropním držáku je směr snímání (přední strana kamery).

Posuňte zamykací páku posunu/naklápění do polohy UNLOCK pro odemčení hlavy kamery o 180° ve směru
naklápění.

2

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.3

77



Hlava kamery otočená o 180°

Poznámka

Pokud se posun/naklápění hlavy kamery nearetuje, když je zamykací páka v poloze LOCK, pohybujte hlavou kamery ručně,
dokud se nezajistí v požadované poloze.

Připevněte držák těla ke spodní straně jednotky pomocí šesti dodaných šroubů (M3×8).4
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Použijte dodané šrouby. Použití jiných šroubů než dodaných šroubů může poškodit vnitřek jednotky.

Připevněte stropní držák k upevňovací desce (volitelně) a poté desku připevněte ke stropu.5
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A: Stropní držák
B: Strop
C: Upevňovací deska
D: Otvor △
Upevněte držák podle orientace stropního držáku
Povšimněte si, že při montáži na strop se přední část kamery nachází na opačné straně stropního držáku ve
srovnání s běžnou montáží ve svislé poloze. Upevněte správně podle schématu znázorňujícího směr montáže.

A: Směr vpřed pro svislou montáž (orientace otvoru △)
B: Směr vpřed pro montáž na strop

Poznámka

V odpovědnosti zákazníka je materiál upevňovacího povrchu.

Připojte ocelové lanko ochrany proti pádu ke stropu.6
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A: Stropní držák
B: Šroub s vnitřním šestihranem (M5, 3/16 palce)
C: Ocelové lanko (součást dodávky)
D: Upevňovací deska
E: Strop

Protáhněte ocelové lanko ochrany proti pádu otvorem ve středu stropního držáku a připojte jej k držáku
těla.

Veďte ocelové lanko ochrany proti pádu kovovou smyčkou ocelového lanka v držáku těla a řádně jej připevněte k
držáku pomocí dodaného šroubu z nerezové oceli (M4×8).

A: Dodávané ocelové lanko
B: Dodávaný křížový šroub (M4×8)
C: Smyčka ocelového lanka

7
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Použijte dodaný šroub. Použití jiného šroubu než dodaného může snížit účinnost funkce ocelového lanka.

Poznámka

Doporučujeme, aby jednotku držela jedna osoba, jak je znázorněno na následujícím obrázku, zatímco jiná osoba ji bude
upevňovat.

Při montáži jednotky nedržte hlavu kamery ani držák objektivu. V případě upuštění nebo pádu jednotky hrozí nebezpečí
poškození nebo zranění.

Při zapojení dbejte na to, aby elektrické konektory a kabely nebyly zkratovány ocelovým lankem ochrany proti pádu.

Držák může nést zavěšenou hmotnost až 8,8 kg (včetně objektivu). Aby nedošlo k pádu jednotky, nepřekračujte maximální
očekávanou hmotnost.

Vyrovnejte otvor pro šroub (A) na držáku těla s otvorem ◇ (B) na stropním držáku, zasuňte jednotku a
otáčejte jí asi o 60 stupňů po směru hodinových ručiček, dokud se nevyrovná otvor pro šroub (A) a otvor
pro šroub (C).

8
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A: Otvor pro šroub na držáku těla
B: Otvor pro šroub na stropním držáku (otvor ◇)
C: Otvor pro šroub
D: Strop
E: Upevňovací deska

Připevněte držák těla a stropní držák pomocí tří dodaných šroubů zámku otáčení (M3×8).9
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Pak nasaďte objektiv. Viz část „Upevnění objektivu“, která zohledňuje informace v části „Bezpečnostní opatření při
upevnění/sejmutí objektivu“, „Kontrola spínačů objektivu“ a „Bezpečnostní opatření při použití objektivu s proměnlivou
ohniskovou vzdáleností“.

Poznámka

Pro správné ovládání posunu/naklápění, když je jednotka namontována na stropě, nastavte možnost [Pan-Tilt] > [Direction] >
[Ceiling] na hodnotu [On] ve webové nabídce.

Po nasazení objektivu zkontrolujte, zda je objektiv bezpečně připevněn.
Objektiv nemá žádnou ochranu proti pádu. Společnost Sony nemůže převzít žádnou odpovědnost za vypadnutí objektivu z
jednotky.

Příbuzné téma

Zkontrolujte stav upevnění.

Konkrétně zkontrolujte následující položky.

Upevňovací šrouby jsou správně připevněny.
Ocelové lanko ochrany proti pádu je správně připevněno a není zkroucené.
Jednotka je namontována ve vodorovné poloze (bez náklonu nebo kývání).
Jednotka se při otočení volně neotáčí.

10
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Bezpečnostní opatření při upevnění/sejmutí objektivu

Kontrola spínačů objektivu

Bezpečnostní opatření při použití objektivu s proměnlivou ohniskovou vzdáleností

Upevnění objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bezpečnostní opatření při upevnění/sejmutí objektivu

Neponechávejte objektiv na místě, kde na něj dopadá přímé sluneční záření. Přímé sluneční záření může proniknout
objektivem, který zaostří paprsky do jednotky a hrozí tak vznik požáru.

Poznámka

Připojte nebo odeberte objektiv, když je jednotka vypnutá.

Objektiv je velmi přesná součást. Nepokládejte objektiv na povrch, pokud je upevňovací čelo objektivu otočen směrem dolů.
Nasaďte dodaný kryt upevňovacího čela objektivu.

Tip

Podrobné informace o objektivech podporovaných jednotkou získáte u servisního zástupce společnosti Sony.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola spínačů objektivu

V závislosti na typu objektivu jsou vyžadovány následující kontroly a nastavení.

Pro objektiv se spínačem zaostřování

Nastavte spínač do polohy AF/MF nebo AF.
Pokud je spínač nastaven do polohy MF nebo Full MF, lze zaostření nastavit pouze pomocí kroužku na objektivu.

Poznámka

Při použití objektivu A-mount nemusí být k dispozici ruční nastavení pomocí jednotky dálkového ovladače.

Pro objektiv se spínačem zoomu

Nastavte spínač do polohy SERVO.
Pokud je přepínač nastaven do polohy MANUAL, lze zoom nastavit pouze pomocí kroužku zoomu na objektivu. Ovládání
zoomu z jednotky nemá žádný účinek.

Pro objektiv se spínačem Auto Iris

Nastavte spínač do polohy AUTO.
Pokud možnost není nastavena do polohy AUTO, lze clonu nastavit pouze pomocí kroužku na objektivu. Ovládání clony
z jednotky nemá žádný účinek.

Pro objektiv se spínačem stabilizace obrazu

Nastavte spínač do polohy OFF.
Pokud je spínač nastaven do polohy ON, může během operace posunu/naklápění dojít k neočekávanému chování.

SELP28135G

A: Posuňte zaostřovací kroužek do přední polohy (režim AF/MF).
B: Nastavte spínač ZOOM do polohy SERVO.
C: Nastavte kroužek clony do polohy „A“ a spínač IRIS LOCK do polohy LOCK.
D: Přepněte spínač stabilizátoru obrazu do polohy OFF.

87



5-041-958-43(1) Copyright 2022 Sony Corporation

88



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bezpečnostní opatření při použití objektivu s proměnlivou ohniskovou vzdáleností

Pokud používáte jiný objektiv s proměnlivou ohniskovou vzdáleností než elektrický objektiv s proměnlivou ohniskovou
vzdáleností, může se poloha zoomování měnit v závislosti na prostředí upevnění. Zajistěte zoomovací kroužek v
požadované poloze pomocí pásky podle účelu použití.

Plastová fóliová páska: 471 BLA 50 nebo ekvivalentní

5-041-958-43(1) Copyright 2022 Sony Corporation

89



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Upevnění objektivu

Toto téma popisuje, jak připojit objektiv E-mount nebo objektiv A-mount.

Poznámka

Nepřepravujte jednotku s namontovaným objektivem.

Při použití objektivu A-Mount se clona nastavuje ručně a zaostření je nastaveno na MF.

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.

Poznámka

Pokud se posun/naklápění hlavy kamery nearetuje, když je zamykací páka v poloze LOCK, pohybujte hlavou kamery ručně,
dokud se nezajistí v požadované poloze.

1

Otočte upínací pákou upevňovacího šroubu stojanu podpěry objektivu proti směru hodinových ručiček,
abyste uvolnili zámek, a poté přesuňte upevňovací šroub stojanu podpěry objektivu do polohy, která
nekoliduje s objektivem.

2
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A: Správně
B: Nesprávně

Otočením zamykací páky hlavy kamery po směru šipky odemkněte hlavu kamery.

Poznámka

Dokud se hlava kamery znovu nearetuje, existuje riziko, že se může pohybovat vlivem své vlastní hmotnosti. Při provádění
úkolu podepřete hlavu kamery rukou.

3

Posuňte hlavu kamery do mezní přední polohy.4

Otočením zamykací páky hlavy kamery po směru šipky uzamkněte hlavu kamery.5
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Poznámka

Ujistěte se, že páka zámku hlavy kamery nepřijde do kontaktu s jinými částmi, aby nedošlo k narušení provozu naklápění.

Sejměte příslušné víka a kryty z objektivu a jednotky.6

Vyrovnejte montážní značku objektivu (bílou) s jednotkou, opatrně nasaďte objektiv do hlavy kamery a poté
otočte objektiv po směru hodinových ručiček, dokud neuslyšíte zacvaknutí v uzamčené poloze.

A: Montážní značky (bílé)

Poznámka

Chcete-li použít objektiv A-Mount, připevněte upevňovací adaptér na objektiv (volitelně) k jednotce a poté objektiv A-Mount
nasaďte.

7

Otočením zamykací páky hlavy kamery po směru šipky odemkněte hlavu kamery.8
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Poznámka

Dokud se hlava kamery znovu nearetuje, existuje riziko, že se může pohybovat vlivem své vlastní hmotnosti. Při provádění
úkolu podepřete hlavu kamery rukou.

Udržujte rovnováhu hlavy kamery ve směru dopředu/dozadu tak, aby byla posuvná základna vodorovně.

Pokud používáte jeden z následujících objektivů, můžete zhruba vyvážit jednotku a objektiv podle stupnice na
posuvné základně.

9

Poloha stupnice Název objektivu

0,5 SEL70200GM (s připojeným SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (s připojeným SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Poznámka

Použijte základní stupnici jako referenci pro hrubé vyvážení.

Při připojování objektivu proveďte příslušné úpravy vyvážení, aby se jednotka nenakláněla dopředu a dozadu.

Nastavte vyvážení na vodorovném povrchu.

Při používání přístroje SELC1635G vyjměte opěrnou jednotku objektivu.

Poloha stupnice Název objektivu

5,0 nebo vyšší SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Otočením zamykací páky hlavy kamery po směru šipky uzamkněte hlavu kamery.

Poznámka

Ujistěte se, že páka zámku hlavy kamery nepřijde do kontaktu s jinými částmi, aby nedošlo k narušení provozu naklápění.
Metoda potvrzení: Posuňte zámek otáčení/naklápění do polohy UNLOCK, otočte blok kamery tak, aby směřoval ručně
nahoru, a vizuálně potvrďte, že není v kontaktu s jinými částmi. Pokud dojde ke kontaktu, otočte páku zámku hlavy kamery
znovu po směru šipky.

10

Otočte upínacími pákami podpěry objektivu proti směru hodinových ručiček, abyste jednotku podpěry
objektivu uvolnili.

11
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A: Upínací páka tyčové podpěry objektivu (2 pozice)
B: Jednotka podpěry objektivu

Posuňte jednotku podpěry objektivu tak, aby byl stojan podpěry objektivu vyrovnán s upevňovacím
šroubem stojanu podpěry objektivu, poté otočte šroubem po směru hodinových ručiček, abyste stojan
podpěry objektivu upevnili.

Poznámka

Ujistěte se, že stojan podpěry objektivu je kolmý k upevňovacímu šroubu stojanu podpěry objektivu, a poté dotáhněte.

12

Otočte upínací pákou upevňovacího šroubu stojanu podpěry objektivu po směru hodinových ručiček,
abyste upevňovací šroub stojanu podpěry objektivu aretovali.

A: Upevňovací šroub stojanu podpěry objektivu
B: Otvor pro upevňovací šroub
C: Upínací páka upevňovacího šroubu stojanu podpěry objektivu

Tip

Pokud je upínací páka v poloze, která znesnadňuje otáčení, uvolněte upínací páku a otočte ji pod úhlem, který usnadní
obsluhu. V požadované poloze pak upínací páku zavřete.

13

95



Příbuzné téma

Kalibrace objektivu E-Mount

5-041-958-43(1) Copyright 2022 Sony Corporation

A: Upínací páka upevňovacího šroubu stojanu podpěry objektivu
B: Upínací páka tyčové podpěry objektivu

Otočte dvěma upínacími pákami tyčové podpěry objektivu po směru hodinových ručiček, abyste jednotku
podpěry objektivu zajistili.

14

Zkontrolujte, zda jsou obě páky dotažené a neuvolněné, zda je objektiv správně připevněn a zda jsou
spínače objektivu nastaveny správně.

Pokud je páka uvolněná nebo objektiv není připevněn správně, může objektiv spadnout a poškodit se.
Pokud používáte elektrický zoomovací objektiv E-mount, musí být objektiv kalibrován také samostatně, aby se
přesně obnovily polohy zoomování uložené v kameře jako přednastavené polohy. Podrobnosti viz také kapitola
„Kalibrace objektivu E-Mount“.

15
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sejmutí objektivu

Sejměte objektiv pomocí obráceného postupu nasazení objektivu.

Poznámka

Uchopte objektiv pevně do ruky, abyste zabránili jeho pádu.

Pokud nebude okamžitě nasazen jiný objektiv, vždy na tělo přístroje nasaďte krytku.

Příbuzné téma

Upevnění objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Zkontrolujte uzamčení posunu/naklápění.1

Otočte upínací pákou upevňovacího šroubu stojanu podpěry objektivu proti směru hodinových ručiček, a
povolte aretování.

2

Demontujte upevňovací šroub stojanu podpěry objektivu na jednotce podpěry objektivu a přesuňte jej do
polohy, která nekoliduje s objektivem.

3

Odemkněte hlavu kamery a posuňte ji do mezní přední polohy.

Podrobnosti viz také kroky 3 až 5 v kapitole „Upevnění objektivu“.

4

Stiskněte a podržte tlačítko pro uvolnění objektivu a otáčejte objektivem proti směru hodinových ručiček,
přičemž objektiv pevně držte.

5

Při zarovnání montážních značek (bílých) kamery a objektivu vytáhněte objektiv směrem dopředu.6
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Průvodce nápovědou
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Propojovací kabely

Toto téma popisuje kabelová připojení.

5-041-958-43(1) Copyright 2022 Sony Corporation

Připojte požadované kabely ke konektorům na zadním panelu.

Abyste zabránili odpojení kabelu HDMI, demontujte upevňovací šroub upevňovací desky kabelu HDMI (M2.6×6,
černý) z bloku konektorů a upevněte dodanou upevňovací desku kabelu HDMI pomocí upevňovacího šroubu. Kabel
HDMI připevněte k upevňovací desce kabelu HDMI pomocí běžně dostupné kabelové spony nebo stahovací pásky.

A: Upevňovací šroub upevňovací desky kabelu HDMI (M2.6×6, černý)
B: Běžně dostupná kabelová spona nebo stahovací páska
C: Upevňovací deska kabelu HDMI (součást dodávky)

1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Připojení jednotky k síťovému zařízení prostřednictvím kabelového připojení

Toto téma popisuje připojení jednotky k síťovému zařízení prostřednictvím kabelového připojení.

5-041-958-43(1) Copyright 2022 Sony Corporation

Připojte jednotku k síťovému zařízení (jako je přístupový bod sítě Wi-Fi nebo přepínač) pomocí kabelu sítě
LAN kategorie 5e nebo vyšší.

1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Použití zdroje střídavého proudu

Toto téma popisuje postup při napájení jednotky střídavým proudem.

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.1

Připojte napájecí adaptér (součást dodávky) ke konektoru DC IN na jednotce a napájecí kabel (je součástí
dodávky) připojte ke zdroji střídavého proudu.

A: Konektor DC IN
B: Napájecí kabel
C: Síťový adaptér

2

Pokud chcete zabránit odpojení kabelu, zajistěte kabel síťového adaptéru pomocí kabelové svorky.

Odjistěte svorku kabelu, protáhněte kabel svorkou, jak je znázorněno níže, a svorku zajistěte.

3
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Poznámka

Nepoužívejte žádný jiný síťový adaptér nebo napájecí kabel, kromě těch, které jsou součástí jednotky. Připojení jiného adaptér
nebo napájecího kabelu může způsobit požár nebo poruchu.

Nepřipojujte napájecí adaptér a nepoužívejte jej v uzavřeném prostoru, například mezi stěnou a nábytkem.

Nezkratujte kovové části zástrčky napájecího adaptéru. Pokud tak učiníte, může dojít k poruše.

Připojte napájecí adaptér k nejbližšímu zdroji napájení. Pokud se během provozu vyskytne problém, okamžitě odpojte napájecí
kabel od zdroje střídavého proudu.

A: Svorka kabelu
B: Zámek svorky kabelu
C: Kabel síťového adaptéru

Zkontrolujte, zda se kontrolka POWER na předním panelu jednotky změní z blikající zelené na svítící
zelenou a zda bylo spuštění dokončeno.

Po normálním spuštění jednotky a připojení k síti se kontrolka NETWORK rozsvítí zeleně.

Pokud používáte objektiv, který nepodporuje posun/naklápění, aretujte zamykací páku posunu/naklápění a
vynechte následující kroky. Podrobné informace o objektivech podporujících posun/naklápění získáte u
servisního zástupce společnosti Sony.

4

Posuňte zamykací páku posunu/naklápění do polohy UNLOCK pro odemčení posunu/naklápění hlavy
kamery.

5

Resetujte posun/naklápění.

Další informace naleznete v části „Resetování posunu/naklápění“.

6
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Při odpojování napájecího adaptéru od přístroje uchopte zástrčku a vytáhněte ji rovně ven. Tažení za kabel můžete způsobit
poruchu.

Příbuzné téma

Resetování posunu/naklápění

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Použití napájení PoE++

Když je jednotka připojena k napájecímu zdroji kompatibilnímu s PoE++, napájení jednotky je zajištěno prostřednictvím
běžně dostupného síťového kabelu.
Tato metoda umožňuje napájení jednotky bez nutnosti samostatného elektrického napájení v prostředí, kde není v
blízkosti místa montáže žádná zásuvka.

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.1

Připojte jednotku a napájecí zdroj kompatibilní s PoE++ pomocí běžně dostupného síťového kabelu.

A: Síťový kabel
B: Napájecí zdroj kompatibilní s PoE++

2

Zkontrolujte, zda se kontrolka POWER na předním panelu jednotky změní z blikající zelené na svítící
zelenou a zda bylo spuštění dokončeno.

Po normálním spuštění jednotky a připojení k síti se kontrolka NETWORK rozsvítí zeleně.

Poznámka

3
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Poznámka

Jednotka je ve shodě s normou IEEE802.3bt (typ 4, třída 8). Další informace o ověřených napájecích zdrojů PoE++ vám
poskytne servisní zástupce společnosti Sony.

Jednotka je kompatibilní s měkkým ověřováním (LLDP), ale může být nutné síťová zařízení nakonfigurovat (IEEE802.3bt
kompatibilní).

Nepřipojujte síťový adaptér, pokud používáte napájecí zdroj PoE++ s povoleným měkkým ověřováním (LLDP).

Pokud je současně připojen napájecí adaptér a napájecí zdroj PoE++, napájení je zajištěno z napájecího adaptéru.

Pokud je napájení zajištěno přes PoE++, použijte síťový kabel kategorie 5e nebo vyšší.

Při napájení prostřednictvím PoE++ počkejte asi 10 sekund po opětovném zapnutí jednotky.

Pokud používáte napájecí zdroj PoE++, připojte zemnicí svorku k zemi.

Pokud napájení PoE++ provádíte prostřednictvím sítě, nemontujte kabeláž venku.

Příbuzné téma

Resetování posunu/naklápění

5-041-958-43(1) Copyright 2022 Sony Corporation

Pokud je napájení zajištěno prostřednictvím PoE++, provádí se počáteční ověření během intervalu, dokud není spuštění
dokončeno.

Pokud používáte objektiv, který nepodporuje posun/naklápění, aretujte zamykací páku posunu/naklápění a vynechte
následující kroky. Podrobné informace o objektivech podporujících posun/naklápění získáte u servisního zástupce
společnosti Sony.

Posuňte zamykací páku posunu/naklápění do polohy UNLOCK pro odemčení posunu/naklápění hlavy
kamery.

4

Resetujte posun/naklápění.

Další informace naleznete v části „Resetování posunu/naklápění“.

5
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Resetování posunu/naklápění

Posun/naklápění můžete resetovat, například při výměně objektivu, následujícím postupem.

5-041-958-43(1) Copyright 2022 Sony Corporation

Posuňte zamykací páku posunu/naklápění do polohy UNLOCK a zkontrolujte, zda je funkce
posunu/naklápění hlavy kamery odemčena.

1

Proveďte resetování posunu/naklápění.

Reset posunu/naklápění lze provést prostřednictvím infračerveného dálkového ovladače, webové aplikace nebo
dálkového ovladače RM-IP500 (volitelné).

Obsluha pomocí infračerveného dálkového ovladače: Stiskněte tlačítko P/T RESET.
Obsluha pomocí webové aplikace: Stiskněte tlačítko  (Posun/naklápění reset) na kartě  (Others) na
ovládacím panelu kamery na obrazovce živého provozu.
Obsluhha s RM-IP500: Viz uživatelská příručka k RM-IP500.

Poznámka

Resetování posunu/naklápění způsobí natočení hlavy kamery a objektivu. Před provedením zkontrolujte, zda není objektiv
zablokovaný.

Jednotka má funkci, která omezuje rozsah posunu/naklápění, ale tato funkce je deaktivována, když je jednotka zapnuta
nebo je proveden reset posunu/naklápění.

Tip

Po dokončení resetování posunu/naklápění se jednotka vrátí do polohy před provedením.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Přístup k webové aplikaci z webového prohlížeče

Připojením jednotky k tabletu nebo počítači můžete jednotku ovládat a nakonfigurovat z webového prohlížeče.

Zkontrolujte, zda váš tablet nebo počítač podporuje operace prostřednictvím webové aplikace.

Poznámka

Pokud požadované prostředí není splněno nebo v závislosti na použití tabletu/počítače, může to nepříznivě ovlivnit funkci
zobrazení videa ve webovém prohlížeči.

Webová aplikace této jednotky používá JavaScript. Pokud v tabletu/počítači používáte antivirový software, nemusí se
webová stránka zobrazovat správně.

1

Položka Požadavky

Displej
Doporučeno 1080×810 pixelů nebo větší
Doporučená velikost displeje tabletu: 10
palců nebo větší

Podporovaný operační systém a
webový prohlížeč

Windows

Operační
systém

Windows 10 nebo novější

Webový
prohlížeč

Google Chrome

Mac

Operační
systém

macOS 10.15 nebo novější

Webový
prohlížeč

Google Chrome
Safari

iPad

Operační
systém

iPadOS 15 nebo novější

Webový
prohlížeč

Google Chrome
Safari

Android

Operační
systém

Android 12 nebo novější

Webový
prohlížeč

Google Chrome

Zkontrolujte, zda jsou jednotka, tablet nebo počítač a periferní zařízení zapnuté.2

Zkontrolujte, zda jsou jednotka a tablet nebo počítač připojeny prostřednictvím sítě Wi-Fi nebo kabelové
sítě LAN.

3

Připojte se k jednotce z webového prohlížeče tabletu nebo počítače.4
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Poznámka

Pokud bylo číslo portu http změněno z hodnoty 80, do panelu adresy zadejte „http://IP adresa jednotky:číslo portu“.

Při připojování pomocí QR kódu nebo zadáním adresy URL do panelu adresy webového prohlížeče použijte zařízení, které

podporuje mDNS*.

Tip

Následně můžete k jednotce rychle přistupovat pomocí funkce záložky webového prohlížeče.

5-041-958-43(1) Copyright 2022 Sony Corporation

Připojení pomocí kódu QR
Pomocí fotoaparátu tabletu naskenujte QR kód vytištěný na zadní straně krytu médií jednotky.

Otevřete zobrazený odkaz na tabletu.
Webový prohlížeč tabletu se spustí a zobrazí obrazovku webové aplikace jednotky.

Připojení zadáním adresy URL do panelu adresy webového prohlížeče
Na tabletu nebo počítači spusťte webový prohlížeč a zadejte adresu URL vytištěnou na krytu média na boční straně
jednotky.
Webový prohlížeč by měl zobrazit obrazovku webové aplikace jednotky.

Připojení zadáním adresy IP do panelu adresy webového prohlížeče
Na tabletu nebo počítači spusťte webový prohlížeč a do panelu adresy zadejte „http://IP adresa jednotky“.
Webový prohlížeč by měl zobrazit obrazovku webové aplikace jednotky.

mDNS: Komunikační protokol používaný k určení IP adresy z názvu hostitele v místní síti.*
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Inicializace jednotky

Při prvním použití jednotky nezapomeňte jednotku nakonfigurovat následujícím postupem.

Tip

Pokud se záložní akumulátor zcela vybije, budete muset znovu nakonfigurovat počáteční nastavení.

Připojte se k jednotce z tabletu nebo počítače a spusťte webovou aplikaci.

Při prvním použití jednotky budete vyzváni k zadání uživatelského jména a hesla do webového prohlížeče. Zadejte
následující nastavení.

Uživatelské jméno: admin
Heslo: (ponechte prázdné)

Pro konfiguraci počátečního nastavení postupujte podle pokynů na obrazovce.

1

Zadejte uživatelské jméno (Administrator) a heslo a pak klepněte na tlačítko [OK].

1: Zadejte uživatelské jméno správce.
2: Nastavte heslo správce.
3: Pro potvrzení zadejte znovu stejné heslo.

Poznámka

V uživatelském jménu a hesle mohou být použity následující znaky. Heslo musí obsahovat alespoň jedno velké písmeno,
jedno malé písmeno a jedno číslo a musí mít délku 8 až 64 znaků.

Alfanumerické znaky

2
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Zobrazí se živá obrazovka pro operace snímání. Pokračujte v konfiguraci základní obsluhy jednotky podle provozního
režimu.

Tip

V některých případech, například při použití jednotky s tabletem jako párem, může být pro jednotku jednodušší použít pevnou IP
adresu.

Symboly (!$%`*+-./<=>?@[]^_{|}~)

Váš webový prohlížeč se znovu načte a zobrazí se výzva k zadání uživatelského jména a hesla.

Zadejte uživatelské jméno a heslo, které byly nakonfigurovány v kroku 2.

Zobrazí se obrazovka nastavení jazyka a hodin.

3

Zadejte následující položky a pak klepněte na tlačítko [OK].

[Language]
Vyberte jazyk pro zobrazení webové aplikace a obrazovky kamery. Změna jazyka změní jazyk zobrazení webové
aplikace.
[Date & Time Format]
Vybírá formát zobrazení pro datum a čas z následujících možností.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
„yyyy“ označuje rok, „mm“ označuje měsíc, „dd“ označuje den, „hh“ označuje hodinu, „mm“ označuje minutu a „ss“
označuje sekundu.
[12 h/24 h]
Pro zobrazení času vyberte možnost [12 h] (12hodinový čas) nebo [24 h] (24hodinový čas).
[Time Setting]
Vyberte metodu pro nastavení data/času.
[Synchronize with PC]: Synchronizace s datem/časem počítače nebo tabletu.
[Manual setting]: Ruční nastavení. Pokud je vybrána tato metoda, zobrazí se pole pro zadání data a času.
[Time Zone]
Vyberte časové pásmo.

4
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Chcete-li nastavit pevnou adresu IP, nejprve vypněte možnost [Network] > [Wired LAN] > [IPv4] > [DHCP] (posuvný přepínač v
levé poloze) ve webové nabídce.

Zobrazí se položky nastavení související s pevnou IP adresou. Nakonfigurujte položky a pak na obrazovce stiskněte tlačítko [OK].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Konfigurace základní obsluhy

Toto téma popisuje, jak nakonfigurovat jednotku pro základní obsluhu.

Nastavení režimu snímání

Lze vybrat režim snímání jednotky tak, aby odpovídal pracovnímu postupu.

Režim Custom: Flexibilní vytváření snímků během snímání.
Režim snímání Log: Zaznamenává obsah S-Log.

Režim Flexible ISO: Nastavení expozice je nastaveno úpravami hodnoty ISO odpovídajícími snímané scéně.
Režim Cine EI / režim Cine EI Quick: Jednotku provozujte podobně jako filmovou kameru (při snímání se plně
nevytvářejí snímky), přičemž záznam se vyvolává během postprodukce.

V režimu snímání Cine EI Quick je automaticky vybrána základní citlivost, která je vhodná pro nastavení parametru
Exposure Index.
Nastavte režim snímání pomocí možnosti [Project] > [Base Setting] > [Shooting Mode] ve webové nabídce nebo v
nabídce kamery.

Režim Custom
Můžete vybrat standard videa.
Přepněte pomocí možnosti [Project] > [Base Setting] > [Target Display] ve webové nabídce nebo v nabídce kamery.

[SDR(BT.709)]: Snímání podle standardu vysílání HD
[HDR(HLG)]: Snímání podle standardu vysílání 4K nové generace

Další informace naleznete v části „Přehled vzhledu“ a další témata v části „Snímání s požadovaným vzhledem“.

Režimy záznamu snímků
(režim Flexible ISO / režim Cine EI / režim Cine EI Quick)
V režimech snímání Log vyberete základní barevný gamut pro zaznamenané signály a výstupní signály. Zde vybraný
barevný gamut je barevný gamut výstupu videa, když je možnost [LUT On/Off] nastavena na volbu [MLUT Off].
Barevný gamut můžete přepnout pomocí položek [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] v nabídce kamery.

[S-Gamut3.Cine/SLog3]: Snadné nastavení barevného gamutu pro digitální kino (DCI-P3).
[S-Gamut3/SLog3]: Široký barevný gamut společnosti Sony, který pokrývá barevný gamut dle normy ITU-R BT.2020.

Další informace naleznete v části „Snímání s úpravou vzhledu v postprodukci“.
 
Podporované funkce v každém režimu snímání jsou uvedeny v následující tabulce.
●: Podporováno; –: Není podporováno

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (spojené s EI)
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Tip

V režimu Cine EI Quick a Cine EI probíhá snímání se základní citlivostí ISO bez použití zesílení, aby se maximalizoval výkon
obrazového snímače. Jas se nastavuje pomocí osvětlení a filtru ND pro seřízení množství světla, které dopadne na obrazový
snímač.

Nastavení systémové frekvence

Přepněte pomocí možnosti [Project] > [Rec Format] > [Frequency] ve webové nabídce nebo v nabídce kamery. Jednotka
se může po zapnutí automaticky restartovat, v závislosti na vybrané hodnotě.

Poznámka

Během nahrávání nebo přehrávání nelze systémovou frekvenci přepínat.

Nastavení režimu skenování obrazového snímače

Můžete nastavit efektivní velikost obrazu a rozlišení obrazového snímače.
Přepněte pomocí možnosti [Project] > [Rec Format] > [Imager Scan Mode] ve webové nabídce nebo v nabídce kamery.
[FF]: Velikost celého snímku.
[S35]: Velikost Super 35 mm.

Poznámka

Během nahrávání nebo přehrávání nelze režim skenování obrazového snímače přepínat.

Při nastavení na S35 je formát videa omezen na 1920×1080.

Nastavení kodeku

Můžete nastavit kodek pro záznam.
Přepněte pomocí možnosti [Project] > [Rec Format] > [Codec] ve webové nabídce nebo v nabídce kamery.

Poznámka

Během nahrávání nebo přehrávání nelze kodek přepínat.

Nastavení formátu videa

Můžete nastavit formát videa pro záznam a výstupní formát pro výstup z kamery.

Přepněte formát videa pro záznam pomocí možnosti [Project] > [Rec Format] > [Video Format] ve webové nabídce
nebo v nabídce kamery.

Custom Flexible ISO Cine EI Cine EI Quick

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(kromě Base Look)

● – – –
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Přepněte výstupní formát z konektorů SDI OUT a HDMI OUT pomocí položek [Monitoring] > [Output Format] ve
webové nabídce nebo v nabídce kamery.

Poznámka

Během nahrávání nebo přehrávání nelze formát videa přepínat.

V závislosti na nastavení formátu videa může být signál z konektorů SDI OUT a HDMI OUT omezen.

Příbuzné téma
Přehled vzhledu

Snímání s úpravou vzhledu v postprodukci

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Podporované paměťové karty

Jednotka zaznamenává zvuk a video na paměťové karty CFexpress Type A (k dispozici samostatně) nebo na paměťové
karty SDXC (k dispozici samostatně) vložené do slotů pro karty. Paměťové karty se také používají pro proxy záznam.

Paměťové karty CFexpress Type A

V jednotce používejte paměťové karty CFexpress Type A*, které jsou uvedené v části „Doporučená záznamová média“.
Podrobné informace o operacích s médii od jiných výrobců naleznete v uživatelské příručce média nebo v informacích
výrobce.

Paměťové karty SDXC

V jednotce používejte paměťové karty SDXC*, které jsou uvedené v části „Doporučená záznamová média“.

Doporučená záznamová média

Zaručené provozní podmínky se budou lišit v závislosti na nastaveních možností Rec Format a Recording.

CFexpress Type A
Kompatibilní s VPG400
Podporováno pro všechny formáty záznamu jednotky.

SDXC
Podporováno za podmínek uvedených v následující tabulce. „●“ znamená, že funkce byla ověřena, a „–“ znamená, že
funkce není zaručena.

RAW Out & XAVC-I, 4096×2160, třída 300, normální režim

RAW Out & XAVC-I, 3840×2160, třída 300, normální režim

V tomto dokumentu jsou označovány jako „karty CFexpress“.*

V tomto dokumentu jsou označovány jako „karty SD“.*

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160, třída 300, S&Q (60 fps nebo nižší)

RAW Out & XAVC-I, 3840×2160, třída 300, S&Q (100 fps, 120 fps)
Ověřená média nejsou k dispozici.

XAVC-I, 4096×2160 třída 300, normální režim

XAVC-I, 4096×2160, třída 300, S&Q (60 fps nebo nižší)

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 třída 300, normální režim

XAVC-I, 3840×2160, třída 300, S&Q (60 fps nebo nižší)

XAVC-I, 3840×2160, třída 300, S&Q (100 fps, 120 fps)
Ověřená média nejsou k dispozici.

XAVC-I, 1920×1080 třída 100, normální režim

XAVC-I, 1920×1080, třída 100, S&Q (60 fps nebo nižší)

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080, třída 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080, třída 100, S&Q (150 fps, 180 fps)
Ověřená média nejsou k dispozici.

XAVC-I, 1920×1080, třída 100, S&Q (200 fps, 240 fps)
Ověřená média nejsou k dispozici.

XAVC-L, 3840×2160, 420, normální režim

XAVC-L, 3840×2160, 420, S&Q (60 fps nebo nižší)

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160, 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080, HD50, normální režim

XAVC-L, 1920×1080, HD50, S&Q (60 fps nebo nižší)

XAVC-L, 1920×1080, HD50, S&Q (100 fps, 120 fps)

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080, HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080, HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080, HD35, normální režim

XAVC-L, 1920×1080, HD35, S&Q (60 fps nebo nižší)

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080, HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080, HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080, HD35, S&Q (200 fps, 240 fps)

5-041-958-43(1) Copyright 2022 Sony Corporation

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvence Třída 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vložení paměťových karet

Toto téma popisuje bezpečnostní opatření při vkládání paměťových karet.

Otevřete kryt médií v části slotů karet.1

Zasuňte paměťovou kartu.

U karet CFexpress štítek směřuje nahoru.

Poznámka

U jednotky namontované na strop štítek směřuje dolů.

U karet SD štítek směřuje dolů.

Poznámka

U jednotky namontované na strop štítek směřuje nahoru.

Indikátor přístupu svítí červeně a pokud je karta použitelná, změní se na zelenou.

2
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Poznámka

Paměťová karta, slot pro paměťovou kartu a obrazová data na paměťové kartě mohou být poškozeny, pokud je karta zasunuta do
slotu s nesprávnou orientací.

Při nahrávání na média vložená do slotů A a B pro karty CFexpress Type A / karty SD zasuňte médium do obou slotů, které jsou
doporučeny pro činnost s formátem záznamu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Poznámka

Pokud indikátor přístupu nepřetržitě bliká červeně a nezmění se na zelenou, dočasně vypněte jednotku, pak vyjměte a
znovu zasuňte paměťovou kartu.

Zavřete kryt médií.3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vysunutí paměťové karty

Otevřete kryt médií v části slotu karet a lehkým stisknutím paměťové karty dovnitř ji vysuňte.

Poznámka

Pokud je jednotka vypnutá nebo je paměťová karta vyjmuta během v době, kdy k ní systém přistupuje, může dojít k poškození dat
na kartě. Všechna data zaznamenaná na kartě mohou být nepoužitelná. Před vypnutím jednotky nebo vyjmutím paměťové karty
se vždy ujistěte, že indikátor přístupu svítí zeleně nebo je zhasnutý.

Při vyjmutí paměťové karty ihned po dokončení záznamu může být paměťová karta horká, to však neznamená žádný problém.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formátování (inicializace) paměťových karet

Pokud je vložena nenaformátovaná paměťová karta nebo paměťová karta naformátovaná s jinou specifikací, zobrazí se
v panelu obrazu kamery zpráva „Media Needs to be Formatted“.
Naformátujte kartu následujícím postupem.

Poznámka

Formátování paměťové karty smaže veškerá data, včetně nahraných videí a souborů nastavení.

Během provádění se mohou zobrazit některé zprávy, v závislosti na době formátování procesu.

Pokud se formátování nezdaří
Paměťové karty, které jednotka nepodporuje, nelze naformátovat.
Zobrazí se výstražná zpráva. Při výměně karty za podporovanou paměťovou kartu postupujte podle pokynů.

Použití karty naformátované ve slotu jiného zařízení v jednotce
Nejprve proveďte zálohování karty a poté přeformátujte kartu v zařízení, které chcete použít.

5-041-958-43(1) Copyright 2022 Sony Corporation

Vyberte možnost [TC/Media] > [Format Media] v nabídce kamery.1

Vyberte možnost Media(A) (slot A) nebo Media(B) (slot B) a poté vyberte metodu formátování (Full Format
nebo Quick Format).

Zobrazí se zpráva s potvrzením.
[Full Format]: Kompletně inicializuje médium, včetně informací o oblasti dat a správě dat.
[Quick Format]: Inicializuje informace o správě dat pouze pro médium.

2

Vyberte možnost [Execute].

Během formátování se zobrazí zpráva a indikátor přístupu svítí červeně.
Po dokončení formátování se zobrazí příslušná zpráva.

3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola zbývajícího času záznamu

Při snímání (záznam/pohotovostní režim) můžete sledovat zbývající kapacitu paměťové karty v každém slotu pomocí
indikátorů zbývající kapacity média ve slotu A/B v panelu obrazu kamery.
Zbývající čas záznamu se vypočítá podle zbývající kapacity média v každém slotu a aktuálního formátu záznamu
(přenosová rychlost záznamu); zobrazuje se v minutách.

Načasování výměny paměťové karty
Pokud celkový zbývající čas záznamu na obou paměťových kartách klesne pod 5 minut, zobrazí se zpráva „Media Near
Full“, začne blikat kontrolka záznamu/signalizace.
Vyměňte média za nové, s volnou kapacitou.
Pokud budete pokračovat v nahrávání, dokud celkový zbývající čas nahrávání nedosáhne nuly, zpráva se změní na
„Media Full“ a nahrávání se zastaví.

Poznámka

Na jednu paměťovou kartu lze zaznamenat až 600 klipů.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obnovení paměťových karet

Pokud by se z nějakého důvodu na paměťové kartě objevila chyba, je nutné kartu před použitím obnovit.
Po vložení paměťové karty, kterou je třeba obnovit, se v panelu obrazu kamery zobrazí zpráva s dotazem, zda chcete
kartu obnovit.

Obnovení karty
Pomocí tlačítek se šipkami v ovládacím bloku grafického uživatelského rozhraní vyberte možnost [Execute] a stiskněte
tlačítko [Set].
Během formátování se zobrazí zpráva, stav průběhu (%) a indikátor přístupu svítí červeně.
Po dokončení obnovování se zobrazí příslušná zpráva.

Pokud se obnovení nezdaří
Paměťové karty, na kterých se vyskytly chyby paměti, nelze obnovit. Zobrazí se výstražná zpráva. Při výměně
paměťové karty postupujte podle pokynů.
Paměťové karty, na kterých došlo k chybám paměti, mohou být použitelné, pokud je přeformátujete.
V některých případech mohou být některé klipy obnoveny, zatímco jiné nikoliv. Obnovené klipy lze přehrávat
normálně.

Poznámka

Chcete-li obnovit média zaznamenaná touto jednotkou, musíte použít právě tuto jednotku.

Média zaznamenaná jiným přístrojem než touto jednotkou nebo jednotkou jiné verze (i když stejného modelu) nemusí být pomocí
této jednotky obnovitelná.

Klipy kratší než 2 sekundy nelze obnovit.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spuštění/zastavení záznamu

Toto téma popisuje, jak spustit/zastavit záznam.

Připojte potřebná zařízení a zkontrolujte, zda jsou napájena.1

Vložte paměťové karty.2

Zkontrolujte stav napájení jednotky v levém horním rohu obrazovky webové aplikace.

Pokud je napájení zapnuté
Když je jednotka zapnuta, na spínači napájení v horní části obrazovky webové aplikace se zobrazí zpráva [Power
ON].

Kontrolka POWER se rozsvítí na předním panelu jednotky a obraz kamery se zobrazí na obrazovce živého provozu
webové aplikace.

Poznámka

Není-li nakonfigurováno heslo správce, zobrazí se obrazovka s výzvou ke konfiguraci hesla. Další informace naleznete v
části „Inicializace jednotky“.

Pokud je napájení v pohotovostním stavu
Pokud je napájení jednotky v pohotovostním stavu, na spínači napájení ve webové aplikaci se zobrazí zpráva
[Power Standby].

V tomto stavu stiskněte spínač napájení a vyberte možnost [Power ON]. Jednotka se zapne, kontrolka POWER se
rozsvítí zeleně na předním panelu jednotky a obraz kamery se zobrazí na obrazovce živého provozu webové
aplikace Web App.

Tip

3
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Chcete-li přepnout napájení jednotky do pohotovostního stavu
Stiskněte spínač napájení ve webové aplikaci a vyberte možnost [Power Standby], čímž napájecí zdroj jednotky
nastavíte do pohotovostního stavu.

Tip

Napájení můžete také nastavit do pohotovostního stavu pomocí tlačítka napájení na dodaném infračerveném dálkovém ovladači.

Jednotku můžete také zapnout pomocí tlačítka napájení na dodaném infračerveném dálkovém ovladači.

Stiskněte tlačítko START/STOP záznamu.

Spustí se záznam a rozsvítí se kontrolka záznamu/indikace (2 pozice) jednotky.
Během záznamu se tlačítko START/STOP záznamu rozsvítí. Zobrazí se také ikona pro cílové záznamové médium
a [●Rec].

4

Chcete-li záznam zastavit, stiskněte tlačítko START/STOP záznamu ještě jednou.

Zastaví se záznam a kontrolka záznamu/indikace (2 pozice) jednotky zhasne.
Během pohotovostního stavu záznamu se tlačítko START/STOP záznamu nerozsvítí. Zobrazí se také ikona pro
cílové záznamové médium a [Stby].

Tip

Můžete také spustit/zastavit záznam pomocí tlačítka START/STOP záznamu na dodaném infračerveném dálkovém
ovladači.

5
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Příbuzné téma
Inicializace jednotky

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přepínání mezi paměťovými kartami

Po vložení dvou paměťových karet mezi nimi můžete přepínat stisknutím tlačítka [Slot Select] na ovládacím panelu
přehrávání ve webové aplikaci.

Tip

Pro přepínání paměťových karet můžete také stisknout tlačítko SLOT SEL (výběr slotu paměťové karty (A)/(B)) na dodaném
infračerveném dálkovém ovladači.

Informace o předávání záznamu

Záznam se automaticky přepne na druhou paměťovou kartu těsně před úplným vyčerpáním zbývající kapacity první karty
na nulu (předání záznamu). Při přepínání paměťových karet můžete pokračovat v souvislém záznamu výměnou plné
paměťové karty za novou.

Poznámka

Během režimu přehrávání nelze mezi paměťovými kartami přepínat. Také není podporováno nepřetržité přehrávání klipu
umístěného na dvou médiích ve slotech A i B.

O zaznamenaných datech

Po ukončení nahrávání se video, zvuk a doprovodná data od začátku do konce záznamu uloží ve formě jednoho „klipu“
na paměťovou kartu.

Název klipu zaznamenaných dat

Název každého klipu zaznamenaného jednotkou se automaticky přiřadí pomocí položky [TC/Media] > [Clip Name
Format] v nabídce kamery.

Maximální délka klipu

Až 6 hodin na jeden klip.
Maximální čas nepřetržitého záznamu je stejný jako maximální čas trvání klipu. Pokud čas záznamu překročí maximální
čas trvání klipu, automaticky se vytvoří nový klip a záznam pokračuje. Nový klip se na obrazovce miniatur zobrazí jako
samostatný klip.
Během předávání záznamu se postupně nahrává více klipů, avšak záznam se automaticky zastaví asi po 24 hodinách.

Poznámka

Během záznamu paměťovou kartu nevysouvejte. Při záznamu měňte pouze paměťové karty ve slotech, pro které indikátor
přístupu na kartu nesvítí.

Pokud zbývající kapacita paměťové karty, na kterou se nahrává, klesne pod jednu minutu a do druhého slotu je vložena
paměťová karta s možností záznamu, zobrazí se zpráva „Will Switch Slots Soon“. Zpráva zmizí po přepnutí mezi sloty
paměťových karet.

Předávání záznamu nemusí fungovat, pokud je záznam spuštěn, když je zbývající kapacita paměťové karty kratší než jedna
minuta. Pro správné předávání záznamu zkontrolujte, zda je zbývající kapacita paměťové karty delší než jedna minuta před
zahájením záznamu.

Video vytvořené pomocí funkce předávání záznamu jednotky nelze na jednotce plynule přehrávat.
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Chcete-li zkombinovat video vytvořené pomocí funkce předávání záznamu jednotky, použijte software „Catalyst Browse“.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola zvuku

Zvuk je odesílán na výstup z konektorů SDI a HDMI jednotky. Vyberte kombinaci zvukových kanálů, které jsou odesílány
na výstup z konektoru HDMI pomocí položky [Audio] > [Audio Output] > [HDMI/Stream Output CH] v nabídce kamery.
CH1/CH2: Kombinace CH1 a CH2
CH3/CH4: Kombinace CH3 a CH4
Při monitorování zvuku ve webové aplikaci použijte zvukoměr v pravé dolní části obrazu kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zadání dat času

Toto téma popisuje, jak nastavit data času.

Nastavení časového kódu

Nastavte časový kód, který se má zaznamenat, a to pomocí položky [TC/Media] > [Timecode] v nabídce kamery.

Nastavení uživatelských bitů

Do zaznamenaného obrazu můžete přidat 8místné číslo v šestnáctkové soustavě jako uživatelské bity. Uživatelské bity
můžete také nastavit na aktuální čas. Přepněte pomocí možnosti [TC/Media] > [Users Bit] v nabídce kamery.

Zobrazení časových údajů

Nastavte časový kód, který se má zobrazit, a to pomocí položky [TC/Media] > [TC Display] > [Display Select] v nabídce
kamery.
Stisknutím přiřaditelného tlačítka s přiřazenou funkcí [DURATION/TC/U-BIT] přepnete zobrazení mezi časovým kódem,
uživatelskými bity a časem trvání v sekvenci.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Prohlížení záznamu (Rec Review)

Na obrazovce si můžete prohlédnout naposledy zaznamenaný klip (přehled záznamu).

Poznámka

Funkce Rec Review není podporována, pokud se po nahrání klipu změní formát videa.

Nastavení počáteční polohy funkce Rec Review

Počáteční polohu přehrávání můžete nastavit na jednu z následujících možností pomocí nastavení [Technical] > [Rec
Review] v nabídce kamery.

Poslední 3 sekundy klipu
Posledních 10 sekund klipu
Začátek klipu

Tip

Chcete-li po zaznamenání několika klipů prohlédnout určitý klip, stisknutím tlačítka [Thumbnail] zobrazte obrazovku miniatur a
výběrem klipu spusťte přehrávání.

Pro zobrazení obrazovky miniatur můžete také stisknout tlačítko THUMBNAIL na dodaném infračerveném dálkovém ovladači.

Metoda použití funkce Rec Review

Předem přiřaďte funkci Rec Review jednomu z přiřaditelných tlačítek na panelu nastavení základní konfigurace.

Další informace o přiřazení naleznete v části „Přiřaditelná tlačítka“ v „Užitečné funkce“.

Zastavte nahrávání a poté stiskněte přiřaditelné tlačítko s funkcí Rec Review pro zahájení přehrávání dříve
zaznamenaného klipu.
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Klip se přehraje až do konce, funkce Rec Review se ukončí a jednotka se vrátí do pohotovostního režimu Stby
(pohotovostní).

Zastavení funkce Rec Review
Stiskněte přiřaditelné tlačítko Rec Review, nebo stiskněte tlačítko [Cancel/Back].
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Tip

Pro zastavení funkce Rec Review můžete také stisknout tlačítko [Cancel/Back] na dodaném infračerveném dálkovém ovladači.

Příbuzné téma

Přiřaditelná tlačítka

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavení seřízení obrazu

Seřízení obrazu se nastavuje pomocí následujících částí obrazovky živého provozu.

Poznámka

V závislosti na směru kamery, ohniskové vzdálenosti objektivu a polohy zoomu může být část jednotky nebo kabely připojené ke
konektorovému bloku viditelná. Před snímáním zkontrolujte zorné pole objektivu a ohniskovou vzdálenost, kterou používáte.
Rozsah posunu/naklápění můžete také ovládat pomocí položek [Pan-Tilt] > [P/T Range Limit] ve webové nabídce. Je-li jednotka
zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Další informace naleznete v části
[Pan-Tilt] > [P/T Range Limit] ve webové nabídce.

Tip

Seřízení obrazu můžete také ovládat pomocí dodaného infračerveného dálkového ovladače.

5-041-958-43(1) Copyright 2022 Sony Corporation

Přednastavený ovládací panel polohy1.

Karta  (Main) / karta  (Others)2.

Ovládací panel seřízení obrazu3.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení směr snímání pomocí webové aplikace

Pohyb kamerou vodorovně se nazývá posouvání a pohyb kamerou svisle se nazývá naklápění.
Směr snímání můžete upravit pomocí operací posouvání/naklápění.

Tip

Pokud se pod joystickem zobrazí možnost [Execute Pan-Tilt Reset], došlo k nesrovnalostem v informacích o počátečním bodu
ovládání posunu/naklápění jednotky. Pro aktualizaci informací o počátku proveďte resetování posunu/naklápění. Další informace
naleznete v části „Resetování posunu/naklápění“.

Nastavení přední strany kamery směrem dopředu
Stiskněte tlačítko  (Posun/naklápění/zoom) na kartě  (Others) v ovládacím bloku kamery.

Poznámka

V závislosti na směru kamery, ohniskové vzdálenosti objektivu a polohy zoomu může být část jednotky nebo kabely připojené ke
konektorovému bloku viditelná. Před snímáním zkontrolujte zorné pole objektivu a ohniskovou vzdálenost, kterou používáte.
Rozsah posunu/naklápění můžete také ovládat pomocí položek [Pan-Tilt] > [P/T Range Limit] ve webové nabídce. Je-li jednotka
zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Další informace naleznete v části
[Pan-Tilt] > [P/T Range Limit] ve webové nabídce.

Příbuzné téma
Resetování posunu/naklápění
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Stisknutím karty  (Posun/naklápění/zoom) na ovládacím panelu seřízení obrazu zobrazíte joystick.1

Při monitorování panelu obrazu kamery přetáhněte střed joysticku ve směru, který chcete zobrazit.

Směr a rychlost kamery se mění v reakci na směr a úroveň tažení.
Posun/naklopení můžete přesněji nastavit stisknutím okrajových oblastí joysticku.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení provozní rychlosti posunu/naklápění

Provozní rychlost posunu/naklápění můžete změnit pomocí posuvníku [Pan-Tilt Speed] v ovládacím panelu kamery, a to
ovládáním joysticku v ovládacím panelu seřízení obrazu.

Poznámka

Pokud je v dosahu pohybu kamery stěna nebo jiná překážka, buďte opatrní, abyste během posunu/naklápění s kamerou nebo
objektivem nenarazili.

Zrychlení posunu/naklápění závisí na fyzických vlastnostech, jako je hmotnostní vyvážení objektivu. Nastavení zrychlení můžete
změnit pomocí položek [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] ve webové nabídce nebo v nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskněte kartu  (Main) v ovládacím panelu kamery.1

Vyberte posuvník [Pan-Tilt Speed] ze seznamu.

Pokud se posuvník [Pan-Tilt Speed] nezobrazuje, zvolte jedno ze dvou tlačítek pro výběr funkce posuvníku a
posuvník tak zobrazte.

2

Přesuňte ovladač posuvníku vlevo nebo vpravo.

Přesunutím ovladače vlevo se provozní rychlost sníží, přesunutím ovladače vpravo se provozní rychlost zvýší.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení zrychlení provozu posunu/naklápění

Nastavení zrychlení provozu můžete změnit v devíti stupních pomocí položek [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] ve webové nabídce nebo v nabídce kamery. Zvyšte hodnotu pro rychlejší změny rychlosti, nebo hodnotu snižte
pro nižší změny rychlosti.
Pro větší citlivost reakce při ovládání posunu/naklápění vyberte hodnotu v rozsahu 7 až 9.
Pro větší přesnost polohování na začátku/konci najetí do přednastavené polohy se doporučuje hodnota v rozsahu 1 až 6.

Podrobnosti o přednastavení polohy naleznete v části „Uložení/obnovení posunu/naklápění a polohy zoomu“.

Poznámka

Když je hodnota nastavena vysoko, funkce nemusí pracovat správně, pokud je připojen těžký objektiv. Před vlastním použitím
činnost zkontrolujte.

Vztah mezi nastavením [Ramp Curve] a operací posunu/naklápění

Když je ovládán posun/naklápění

Když je vyvolána přednastavená poloha
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení směru snímání pomocí dodaného infračerveného dálkového ovladače

Směr snímání můžete upravit pomocí tlačítek pro ovládání posunu/naklápění na dodaném infračerveném dálkovém
ovladači.

Nastavení přední strany kamery směrem dopředu
Stiskněte tlačítko HOME.

Poznámka

V závislosti na směru kamery, ohniskové vzdálenosti objektivu a polohy zoomu může být část jednotky nebo kabely připojené ke
konektorovému bloku viditelná. Před snímáním zkontrolujte zorné pole objektivu a ohniskovou vzdálenost, kterou používáte.
Rozsah posunu/naklápění můžete také ovládat pomocí položek [Pan-Tilt] > [P/T Range Limit] ve webové nabídce. Je-li jednotka
zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Další informace naleznete v části
[Pan-Tilt] > [P/T Range Limit] ve webové nabídce.
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Stiskněte tlačítka se šipkami pro ovládání posunu/naklápění.

Při monitorování obrazu kamery stiskněte tlačítko šipky ve směru, který chcete zobrazit.
Chcete-li se přesunout o krátkou vzdálenost, krátce stiskněte tlačítko se šipkou.
Chcete-li se přesunout o velkou vzdálenost, stiskněte a podržte tlačítko se šipkou.
Pro diagonální pohyb stiskněte a podržte tlačítko  (šipka nahoru) nebo  (šipka dolů) a pak stiskněte tlačítko

 (šipka doleva) nebo  (šipka doprava).

1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení typu zoomu

Nastavte typ zoomu, a to pomocí položky [Technical] > [Zoom] > [Zoom Type] v nabídce kamery.
Typ zoomu se bude lišit v závislosti na typu připojeného objektivu.

Poznámka

Funkce Clear Image Zoom není k dispozici v následujících případech.

Když je možnost [Shooting] > [S&Q Motion] > [Setting] nastavena na hodnotu On a nastavení možnosti [Frame Rate] v nabídce
kamery je vyšší než 60 fps
Když je možnost [Project] > [Rec Format] > [Codec] v nabídce kamery nastavena na položku [RAW] nebo na jinou položku,
která zahrnuje RAW.

Při použití volicího spínače SERVO/MANUAL na objektivu se obnoví zvětšení funkce Clear Image Zoom na hodnotu 1×.

Funkce AF-S není během funkce Clear Image Zoom podporována.

Funkce Clear Image Zoom

Jednotka je vybavena funkcí zoomu, která využívá zpracování signálu obrazu nazvané Clear Image Zoom. Je-li funkce
Clear Image Zoom zapnuta, je zoom podporován i u objektivů s pevnou ohniskovou vzdáleností. Lze jej také použít k
rozšíření dosahu mimo optický dosahu na objektivu s proměnlivou ohniskovou vzdáleností.
Maximální poměr zoomu (zvětšení/zmenšení) při použití funkce Clear Image Zoom se liší v závislosti na rozlišení
záznamu.

Pro rozlišení záznamu QFHD/4K: 1,5×
Pro HD rozlišení záznamu: 2×

5-041-958-43(1) Copyright 2022 Sony Corporation

Typ připojeného objektivu
Nastavení [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objektiv s pevnou ohniskovou vzdáleností /
ruční objektiv s proměnnou ohniskovou
vzdáleností

Provoz zoomu není
podporován.

Funkce Clear Image Zoom je
podporována.

Automatický objektiv s proměnlivou
ohniskovou vzdáleností

Podporována je pouze
funkce optického zoomu.

Podporováno je optické
zvětšení/zmenšení a funkce Clear
Image Zoom.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení zoomu pomocí webové aplikace

Zoom jednotky můžete nastavit pomocí optického zoomu nebo funkce Clear Image Zoom. Toto téma popisuje, jak
provést nastavení pomocí webové aplikace. Další informace o funkci Clear Image Zoom naleznete v části „Nastavení
typu zoomu“.

Poznámka

V závislosti na směru kamery, ohniskové vzdálenosti objektivu a polohy zoomu může být část jednotky nebo kabely připojené ke
konektorovému bloku viditelná. Před snímáním zkontrolujte zorné pole objektivu a ohniskovou vzdálenost, kterou používáte.
Rozsah posunu/naklápění můžete také ovládat pomocí položek [Pan-Tilt] > [P/T Range Limit] ve webové nabídce. Je-li jednotka
zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Další informace naleznete v části
[Pan-Tilt] > [P/T Range Limit] ve webové nabídce.

Skutečná rychlost a přesnost zoomu se bude lišit v závislosti na objektivu. Před použitím činnost zkontrolujte.

Tip

Zoom na objektivu s ručním zoomem můžete ovládat pomocí ovladače objektivu (volitelně), který je kompatibilní s touto
jednotkou. Podrobnosti naleznete v části „Připojení ovladače objektivu“ a „Nastavení zoomu pomocí ovladače objektivu“.

Příbuzné téma

Nastavení typu zoomu

Připojení ovladače objektivu

Nastavení zoomu pomocí ovladače objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Stisknutím karty  (Posun/naklápění/zoom) na ovládacím panelu seřízení obrazu zobrazíte ovládací
panel posunu/naklápění.

1

Posuňte posuvný knoflík [Zoom] ve směru [T] (Teleobjektiv) nebo [W] (Širokoúhlý), abyste nastavili zoom.

Rychlost zoomu se mění podle pohybu posuvníku.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení provozní rychlosti zoomu

Provozní rychlost zoomu posuvníku [Zoom] v ovládacím panelu seřízení obrazu můžete změnit pomocí posuvníku [Zoom
Speed] v ovládacím panelu kamery.

Poznámka

Skutečná rychlost a přesnost zoomu se bude lišit v závislosti na objektivu. Před použitím činnost zkontrolujte.

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskněte kartu  (Main) v ovládacím panelu kamery.1

Vyberte posuvník [Zoom Speed] ze seznamu.

Pokud se posuvník [Zoom Speed] nezobrazuje, zvolte jedno ze dvou tlačítek pro výběr funkce posuvníku a
posuvník tak zobrazte.

 

2

Přesuňte ovladač posuvníku [Zoom Speed] vlevo nebo vpravo.

Přesunutím ovladače vlevo se provozní rychlost sníží, přesunutím ovladače vpravo se provozní rychlost zvýší.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení zoomu pomocí dodaného infračerveného dálkového ovladače

Zoom jednotky můžete nastavit pomocí optického zoomu nebo funkce Clear Image Zoom. Toto téma popisuje, jak
provést nastavení pomocí dodaného infračerveného dálkového ovladače. Další informace o funkci Clear Image Zoom
naleznete v části „Nastavení typu zoomu“.

Poznámka

V závislosti na směru kamery, ohniskové vzdálenosti objektivu a polohy zoomu může být část jednotky nebo kabely připojené ke
konektorovému bloku viditelná. Před snímáním zkontrolujte zorné pole objektivu a ohniskovou vzdálenost, kterou používáte.
Rozsah posunu/naklápění můžete také ovládat pomocí položek [Pan-Tilt] > [P/T Range Limit] ve webové nabídce. Je-li jednotka
zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Další informace naleznete v části
[Pan-Tilt] > [P/T Range Limit] ve webové nabídce.

Tip

Zoom na objektivu s ručním zoomem můžete ovládat pomocí ovladače objektivu (volitelně), který je kompatibilní s touto
jednotkou. Podrobnosti naleznete v části „Připojení ovladače objektivu“ a „Nastavení zoomu pomocí ovladače objektivu“.

Příbuzné téma
Nastavení typu zoomu

Připojení ovladače objektivu

Nastavení zoomu pomocí ovladače objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Stisknutím tlačítka Zoom nastavte zoom.

Stiskněte tlačítko T (Teleobjektiv) nebo W (Širokoúhlý) a současně sledujte obrazovku, abyste nastavili zoom.
Pro přiblížení stiskněte tlačítko T.
Pro oddálení stiskněte tlačítko W.

1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kalibrace objektivu E-Mount

Kalibrace koriguje rozdíly v poloze zoomu v důsledku rozdílů v jednotlivých objektivech při použití elektrického objektivu s
proměnlivou ohniskovou vzdáleností E-mount.
Chcete-li přesně vypočítat polohu zoomu, kalibrujte objektiv pro korekci individuálních rozdílů v objektivu následujícím
postupem.

Data pro kalibraci
V jednotce lze uložit data pro kalibraci až pěti objektivů. Nejstarší data budou přepsána po kalibraci šestého nebo
následujícího objektivu.
Zda jsou k dispozici kalibrační údaje pro připojený objektiv můžete zkontrolovat stisknutím tlačítka  (Camera
Status) ve společné oblasti obrazovky webové aplikace a výběrem položek [Lens] > [Calibration Data].

5-041-958-43(1) Copyright 2022 Sony Corporation

Pokud má objektiv spínač SERVO/MANUAL, nastavte jej do polohy SERVO.

Poznámka

Pokud je přepínač nastaven do polohy MANUAL, nebude objektiv schopen přijímat pokyny k zoomování z jednotky.

1

Nastavte kalibraci pomocí položky [Technical] > [Lens] > [Lens Calibration] v nabídce kamery.

Během kalibrace se objektiv zoomu automaticky pohybuje a měří.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Uložení/obnovení posunu/naklápění kamery, polohy zoomu a nastavení zaostření
pomocí webové aplikace

Posun/naklápění, polohu zoomu a nastavení zaostření můžete uložit a v případě potřeby je vyvolat pomocí webové
aplikace (funkce přednastavené polohy).

Podrobné informace o položkách, které lze uložit/obnovit, naleznete v části „Přednastavená pozice uložených
položek“.

Poznámka

Přednastavenou polohu nelze uložit, pokud poměr funkce Clear Image Zoom překročí 1×.

Pokud je ve webové nabídce změněno nastavení [Pan-Tilt] > [P/T Direction] > [Ceiling], jsou všechny uložené přednastavené
polohy odstraněny.

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Určete polohu, kterou chcete uložit, pomocí operací posunu/naklápění a zoomu.2

Stiskněte tlačítko [+] v ovládacím panelu přednastavené polohy.

Obraz s uloženou polohou se zobrazí v ovládacím panelu přednastavené polohy.

Tip

Pokud se ovládací panel přednastavené polohy nezobrazuje, stiskněte tlačítko  (Otevřít) a zobrazte jej.

Polohy jsou uloženy v pořadí od [Preset1].

3
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Zrušení operace obnovení přednastavené polohy
Stisknutím tlačítka  (Zrušit obnovení) zobrazeného na ovládacím panelu přednastavené polohy během operace
obnovení přednastavené polohy zrušíte operaci obnovení. Pomocí joysticku a posuvníku [Zoom] upravte seřízení
obrazu.

Pokud jsou v sekvenci předvoleb nevyužité předvolby, budou v přednastaveních uloženy polohy, počínaje nevyužitými
přednastaveními. Pokud jsou například přednastavené polohy uloženy v pozici [Preset1] a [Preset3], ale nikoliv v [Preset2],
další přednastavené polohy budou uloženy v pozici [Preset2] a poté v [Preset4].

Uložit lze až 100 přednastavených poloh.

Můžete přejmenovat každou přednastavenou pozici. Podrobnosti viz kapitola „Přejmenování přednastavených poloh
pomocí webové aplikace“.

Obnovte uloženou polohu.

Dvakrát stiskněte miniaturu polohy, kterou chcete obnovit, v ovládacím panelu přednastavené polohy a obnovte
odpovídající úhel pohledu.

Tip

Můžete také obnovit polohu stisknutím obrázku, stisknutím tlačítka  (Nabídka přednastavené polohy), které se zobrazí, a
výběrem možnosti [Recall].

Rychlost přechodu na uloženou polohu je určena nastavením [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for
Common] ve webové nabídce při uložení polohy. Rychlost přechodu můžete upravit i po uložení. Podrobnosti viz kapitola
„Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy“.

Stupeň změny posunu/naklápění při najetí do přednastavené polohy lze nastavit pomocí nastavení rychlosti přechodu a
nastavení [Ramp Curve]. Podrobnosti naleznete v části „Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení
přednastavené polohy“ a „Nastavení zrychlení provozu posunu/naklápění“.

Pokud je během přednastaveného přehrávání vyvoláno jiné přednastavení, operace prvního vyvolaného přednastavení se
zastaví a spustí se operace následně vyvolaného přednastavení.

Poznámka

Pokud se mezi uložením přednastavené polohy a jejím opětovným přehráním teplota prostředí výrazně změnila, může dojít
k odchylce v seřízení obrazu.

Během obnovování přednastavené polohy nemůžete provádět žádné jiné operace než obnovení nebo zrušení
přednastavené polohy.

4
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Příbuzné téma

Přednastavená pozice uložených položek

Přejmenování přednastavených poloh pomocí webové aplikace

Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy

Nastavení zrychlení provozu posunu/naklápění

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přejmenování přednastavených poloh pomocí webové aplikace

Můžete přejmenovat uložené přednastavené pozice.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Stiskněte přednastavenou polohu, kterou chcete přejmenovat.

V pravém horním rohu obrazu se zobrazí tlačítko  (Nabídka přednastavené polohy).

2

Stiskněte tlačítko  (Nabídka přednastavené polohy) a v zobrazené nabídce vyberte položku [Rename].3

Zadejte nový název předvolby.4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nahrazení uložené předvolené polohy novou polohou pomocí webové aplikace

Uloženou přednastavenou polohu můžete nahradit novou polohou.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Určete polohu, kterou chcete uložit, pomocí operací posunu/naklápění a zoomu.2

Stiskněte polohu obrazu, kterou chcete nahradit, v ovládacím panelu přednastavené polohy.

V pravém horním rohu obrazu se zobrazí tlačítko  (Nabídka přednastavené polohy).

3

Stiskněte tlačítko  (Nabídka přednastavené polohy) a v zobrazené nabídce vyberte položku [Replace].

Nová poloha nahrazuje aktuální nastavení.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Odstranění uložené přednastavené polohy pomocí webové aplikace

Uložené přednastavené pozice můžete vymazat.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Stiskněte polohu obrazu, kterou chcete odstranit, a to v ovládacím panelu přednastavené polohy.

V pravém horním rohu obrazu se zobrazí tlačítko  (Nabídka přednastavené polohy).

2

Stiskněte tlačítko  (Nabídka přednastavené polohy) a v zobrazené nabídce vyberte položku [Delete].

Uložená poloha je odstraněna.

3

153



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronizace provozu posunu/naklápění a zoomu/zaostření při obnovení
přednastavené polohy

Operace posunu/naklápění a zoomu lze synchronizovat při obnovení uložené přednastavené polohy pro plynulejší
seřízení obrazu.

Tip

Předem můžete určit nastavení pro registraci přednastavené polohy. Nastavte možnost [Pan-Tilt] > [P/T Preset] > [Default] >
[Zoom Sync] na hodnotu [On] ve webové nabídce.

Je-li možnost [Pan-Tilt] > [P/T Preset] > [Speed Select] nastavena na hodnotu [Common], budou všechny přednastavené polohy
obnoveny s nastavenou rychlostí, a to pomocí položek [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po dokončení pohybu zoomu se kamera přesune do uložené polohy zaostření.

Po dokončení pohybu se [AF Transition Speed] vrátí k původnímu nastavení.

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Stiskněte obrázek pro přednastavenou pozici, pro kterou chcete změnit rychlost přechodu.

V pravém horním rohu obrazu se zobrazí tlačítko  (Nabídka přednastavené polohy).

2

Stiskněte tlačítko  (Nabídka přednastavené polohy) a v zobrazené nabídce vyberte položku [Edit…].

Zobrazí se obrazovka nastavení pro vybranou přednastavenou polohu.

3

Funkci zapnete posunutím přepínače [Zoom Sync] doprava a stisknutím tlačítka [OK].

Při příštím obnovení uložené polohy se kamera bude pohybovat nastavenou rychlostí.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené
polohy

Můžete změnit rychlost přechodu (operace posunu/naklápění, operace přiblížení, operace zaostření) při obnovení
uložené přednastavené polohy.

Tip

Je-li možnost [Pan-Tilt] > [P/T Preset] > [Speed Select] nastavena na hodnotu [Common], budou všechny polohy obnoveny s
nastavenou rychlostí, a to pomocí položek [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po dokončení pohybu zoomu se kamera přesune do uložené polohy zaostření.

Po dokončení pohybu se [AF Transition Speed] vrátí k původnímu nastavení.

Nastavte možnost [Pan-Tilt] > [P/T Preset] > [Speed Select] na hodnotu [Separate] ve webové nabídce.1

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

2

Stiskněte obrázek pro přednastavenou pozici, pro kterou chcete změnit rychlost přechodu.

V pravém horním rohu obrazu se zobrazí tlačítko  (Nabídka přednastavené polohy).

3

Stiskněte tlačítko  (Nabídka přednastavené polohy) a v zobrazené nabídce vyberte položku [Edit…].

Zobrazí se obrazovka nastavení pro vybranou přednastavenou polohu.

4

Nastavte rychlosti přechodu (posun-naklápění / zoom / ostření), které chcete změnit, pomocí posuvníků
nebo zadejte hodnoty přímo a stiskněte tlačítko [OK].

Při příštím obnovení uložené polohy se kamera bude pohybovat nastavenou rychlostí.

5
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Uložení/obnovení posunu/naklápění a polohy zoomu pomocí dodaného
infračerveného dálkového ovladače

Posun/naklápění a polohu zoomu můžete uložit a v případě potřeby je vyvolat pomocí dodaného infračerveného
dálkového ovladače.

Příbuzné téma

Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy

Nastavte posun/naklápění a zoom kamery.1

Nastavte režim PTZ Assist na [Pos.] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy ve webové aplikaci.

2

Stiskněte a podržte tlačítko PRESET a pak stiskněte jedno z tlačítek 1 až 3.

Poloha je uložena.

3

Obnovte uloženou polohu.

Stiskněte jedno z tlačítek 1 až 3 pro obnovení této přednastavené polohy.

Tip

Rychlost přechodu při obnovení přednastavené polohy je určena uloženou hodnotou [Pan-Tilt] > [P/T Preset] > [Pan-Tilt
Speed] ve webové nabídce. Po uložení hodnoty můžete změnit rychlost přechodu. Podrobnosti viz kapitola „Změna
rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy“.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Záznam operací seřízení obrazu kamery pomocí webové aplikace

Pomocí webové aplikace můžete zaznamenat zaznamenané operace seřízení obrazu kamery.

Nastavte počáteční provozní polohu kamery.1

Nastavte režim PTZ Assist na [Trace] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

2

Stiskněte tlačítko [+] v ovládacím panelu přednastavené polohy.

Přidá se miniatura a kamera se přepne do pohotovostního režimu záznamu.

Tip

Stisknutím tlačítka  (Zavřít) na miniatuře můžete ukončit pohotovostní režim nahrávání a vrátit se do normálního provozu.

3
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Tip

Zbývající čas záznamu se zobrazuje v horní části panelu snímků kamery během záznamu.

Poznámka

Zaznamenané operace seřízení obrazu budou vymazány, pokud přepnete na stropní držák

Přepnutí systémové frekvence může vymazat zaznamenané operace seřízení obrazu.

Provoz zoomu se nezaznamenává, když je připojen ovladač objektivu.

Maximální čas záznamu jedné operace seřízení obrazu je 3 minuty. Záznam se automaticky ukončí, když doba záznamu
dosáhne 3 minut.

Záznam operace seřízení obrazu nelze spustit, pokud je poměr funkce Clear Image Zoom větší než 1×.

Pokud je kamera ovládána z jiného zařízení při záznamu operace seřízení obrazu, bude zaznamenána i operace z jiného
zařízení. Podrobné informace o operacích záznamu pomocí dálkového ovladače třetí strany vám poskytne příslušný výrobce.

Tato funkce nezaznamenává nastavení zaostření a kvality obrazu.

Operace posunu / naklápění / zoomu zaznamenané při záznamu operace seřízení obrazu nelze přesně reprodukovat během
přehrávání obrazu.

Pokud po zaznamenání operace seřízení obrazu nastavíte limit rozsahu posunu/naklápění pomocí položek [Pan-Tilt] > [P/T
Range Limit] ve webové nabídce, limit rozsahu posunu/naklápění nebude během přehrávání snímků použit. Pokud chcete použít
operaci seřízení obrazu a funkci limitu posunu/naklápění společně, nastavte před zaznamenáním operace snímání limit rozsahu
posunu/naklápění.

Spusťte operaci seřízení obrazu pomocí joysticku a posuvníku [Zoom].

Záznam se spustí od okamžiku zahájení operace seřízení obrazu.

4

Stiskněte tlačítko  (Zastavit nahrávání) na miniatuře a nahrávání zastavte.5
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Zaznamenané operace seřízení obrazu nelze přehrávat, pokud je vybrán výstup RAW videa.

Zaznamenané operace seřízení obrazu nelze přehrávat, pokud video signál není odeslání na výstup z výstupního konektoru SDI.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přehrávání operací seřízení obrazu kamery pomocí webové aplikace

Pomocí webové aplikace můžete přehrát zaznamenanou operaci seřízení obrazu kamery.

Nastavte režim PTZ Assist na [Trace] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Vyberte miniaturu s operací seřízení obrazu, který chcete přehrát.

Na miniatuře se zobrazí tlačítko  (Připravit).

2

Stiskněte tlačítko  (Připravit).

Kamera se přesune do výchozí polohy seřízení obrazu a přepne se do pohotovostního režimu přehrávání.

3

Stiskněte tlačítko  (Přehrát) na miniatuře.4

163



Tip

V pohotovostním režimu přehrávání a během přehrávání můžete zrušit přehrávání a vrátit se do normálního provozu provedením
kterékoliv z následujících operací.

Stiskněte tlačítko  (Stop) na miniatuře nebo na ovládacím panelu přednastavené polohy.
Ovládejte joystick.
Stiskněte posuvník [Zoom].

Uplynulá doba přehrávání se zobrazuje v horní části panelu snímků kamery během přehrávání.

Poznámka

Pokud se nastavení funkce Clear Image Zoom liší mezi nahráváním a přehráváním operací seřízení obrazu, může dojít k
neočekávanému chování.

Přehrávání operace zoomu není podporováno, pokud je připojen ovladač objektivu. Ovládání zoomu zastaví přehrávání operací
seřízení obrazu.

Během přehrávání operace seřízení obrazu nemá změna limitu rozsahu posunu/naklápění pomocí položek [Pan-Tilt] > [P/T
Range Limit] ve webové nabídce žádný vliv. Před zaznamenáním operace seřízení obrazu nastavte limit rozsahu
posunu/naklápění.

5-041-958-43(1) Copyright 2022 Sony Corporation

Spustí se přehrávání operace seřízení obrazu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Odstranění operací seřízení obrazu zaznamenanými kamerou pomocí webové
aplikace

Zaznamenané operace seřízení obrazu kamery můžete odstranit pomocí webové aplikace.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte režim PTZ Assist na [Trace] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

1

Vyberte miniaturu s operací seřízení obrazu, který chcete odstranit.

Na miniatuře se zobrazí tlačítko  (Nabídka trasování).

2

Stiskněte tlačítko  (Nabídka trasování).

Zobrazí se nabídka.

3

Vyberte ze zobrazené nabídky možnost [Delete].

Vybraná operace seřízení obrazu je odstraněna.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Záznam operací seřízení obrazu kamery pomocí dodaného infračerveného dálkového
ovladače

Operace seřízení obrazu kamery můžete zaznamenat pomocí dodaného infračerveného dálkového ovladače.

Další informace o přehrávání zaznamenané operace seřízení obrazu naleznete v části „Přehrávání operací seřízení
obrazu kamery pomocí dodaného infračerveného dálkového ovladače“.

Poznámka

Maximální čas záznamu jedné operace seřízení obrazu je 3 minuty. Záznam se automaticky ukončí, když doba záznamu
dosáhne 3 minut.

Pokud je kamera ovládána z jiného zařízení při záznamu operace seřízení obrazu, bude jako součást operace seřízení obrazu
zaznamenána i operace z jiného zařízení.

Pokud je kvalita obrazu upravena během záznamu operace seřízení obrazu, tato změna se nezaznamenává.

Příbuzné téma

Přehrávání operací seřízení obrazu kamery pomocí dodaného infračerveného dálkového ovladače

5-041-958-43(1) Copyright 2022 Sony Corporation

Otevřete obrazovku živého provozu webové aplikace.1

Nastavte režim PTZ Assist na [Trace] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

2

Nastavte počáteční provozní polohu kamery pomocí infračerveného dálkového ovladače.3

Stiskněte a podržte tlačítko PRESET a pak stiskněte jedno z tlačítek POSITION1 až 3.

Kamera se přepne do pohotovostního režimu záznamu.

4

Proveďte operaci seřízení obrazu, který chcete zaznamenat.5

Chcete-li ukončit nahrávání, stiskněte a podržte tlačítko PRESET a stiskněte tlačítko POSITION vybrané v
kroku 4.

6
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přehrávání operací seřízení obrazu kamery pomocí dodaného infračerveného
dálkového ovladače

Pomocí dodaného infračerveného dálkového ovladače můžete přehrát zaznamenanou operaci seřízení obrazu kamery.

Poznámka

Ovládání posunu / naklápění / zoomu kamery zastaví přehrávání.

Příbuzné téma
Záznam operací seřízení obrazu kamery pomocí dodaného infračerveného dálkového ovladače

5-041-958-43(1) Copyright 2022 Sony Corporation

Otevřete obrazovku živého provozu webové aplikace.1

Nastavte režim PTZ Assist na [Trace] v rozevíracím seznamu v horní části ovládacího panelu přednastavené
polohy.

2

Vyberte a stiskněte jedno z tlačítek POSITION1 až 3, pro které byla zaznamenána operace seřízení obrazu.

Posun / naklápění / zoom kamery se přesune do výchozí polohy pro přehrávání.

3

Poté, co se kamera přesune do výchozí polohy přehrávání, znovu stiskněte stejné tlačítko POSITION.

Zahájí se přehrávání.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavení zaostření

Zaostření se nastavuje pomocí následujících částí obrazovky živého provozu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Panel obrazu kamery
Zaostření můžete upravit stisknutím obrazu kamery. Dotykovou obsluhu webové aplikace můžete zakázat vypnutím
spínače [Touch Focus] na kartě  (Focus) v ovládacím panelu kamery.

1.

Ovládací panel kamery – karta  (Focus)2.

Ovládací panel grafického uživatelského rozhraní3.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení pomocí webové aplikace

Zaostření můžete upravit ručně, například v následujících případech.

Objekty částečně zakryté kapkami vody
Objekty s nízkým kontrastem vůči pozadí
Objekty dále od blízkých objektů

Poznámka

Ruční zaostřování nelze ovládat z webové aplikace, zatímco probíhá operace přiblížení.

Tip

Automatické zaostřování můžete použít, když je hlavním způsobem obsluhy přístroje jeho ruční nastavení. Další informace
naleznete v části „Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App“.

Příbuzné téma

Kontrola spínačů objektivu

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App

5-041-958-43(1) Copyright 2022 Sony Corporation

Pokud je objektiv vybaven přepínačem volby zaostření, nastavte přepínač do polohy „AF/MF“ nebo „AF“.

Poznámka

Pokud je přepínač nastaven do polohy „Full MF“ nebo „MF“, nelze zaostřování objektivu ovládat z jednotky. Viz „Pro objektiv
se spínačem zaostřování“ v části „Kontrola spínačů objektivu“.

1

Pro vypnutí automatického ostření posuňte spínač [Auto Focus] do levé polohy v ovládacím panelu kamery.

Režim ručního zaostřování je aktivován.

 (MF)

2

Upravte pomocí posuvníku ve spodní části karty  (Focus).3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení pomocí dodaného infračerveného dálkového ovladače

Zaostření můžete nastavit ručně pomocí dodaného infračerveného dálkového ovladače.

Tip

Automatické zaostřování můžete použít, když je hlavním způsobem obsluhy přístroje jeho ruční nastavení. Další informace
naleznete v části „Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače“.

Příbuzné téma

Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskněte tlačítko MF na infračerveném dálkovém ovladači.1

Zaostření nastavte ručně pomocí tlačítka F (Far) a tlačítka N (Near).

Chcete-li zaostřit na vzdálený objekt, stiskněte tlačítko F.
Chcete-li zaostřit na blízký objekt, stiskněte tlačítko N.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zaostření zadáním polohy zaostření (bodové zaostření)

V režimu ručního zaostření můžete v panelu obrazu kamery nastavit polohu, ve které chcete zaostření nastavit.

Poznámka

Funkce bodového zaostření nepracuje, pokud je objektiv nastaven na ruční ostření.

Tip

V režimu přímého zaostřování můžete stisknout přiřaditelné tlačítko přiřazené funkci [Push AF/MF], abyste dočasně zastavili
přímé zaostřování a povolili automatické zaostřování při stisknutí tlačítka. Když tlačítko uvolníte, zaostření se vrátí do ručního
režimu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte možnost [Shooting] > [Focus] > [Touch Function in MF] na hodnotu [Spot Focus] ve webové
nabídce nebo v nabídce kamery.

1

Pro zapnutí posuňte spínač [Touch Focus] na kartě  (Focus) doprava.2

Pro vypnutí posuňte spínač [Auto Focus] na kartě  (Focus) doleva.3

Zadejte polohu zaostření.

Zobrazí se značka bodového zaostření a obraz se upraví tak, aby byl v dané poloze zaostřen.

Příklad zadání polohy dotykovým ovládáním

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Dočasné použití funkce automatického zaostřování (Push Auto Focus (AF))

V režimu ručního zaostřování můžete dočasně nastavit zaostřování pomocí funkce automatického zaostřování stisknutím
tlačítka [Push AF/MF], abyste zaostřili automaticky při stisknutí tlačítka.
To je užitečné, pokud chcete během ručního zaostřování pomalu přesouvat zaostření z jednoho objektu na jiný.

Poznámka

Funkce vynuceného automatického zaostřování nepracuje, pokud je objektiv nastaven na ruční ostření.

Tip

Stejná operace je podporována přiřaditelného tlačítka přiřazeného funkci [Push AF/MF].

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte možnost [Shooting] > [Focus] > [Push AF Mode] na hodnotu [AF] v nabídce kamery.1

Pro vypnutí posuňte spínač [Auto Focus] na kartě  (Focus) doleva.2

Stiskněte tlačítko [Push AF/MF].

Funkce automatického zaostřování je aktivní při stisknutí tlačítka.

Když tlačítko uvolníte, režim vynuceného automatického zaostřování a zaostření se vrátí do ručního režimu.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Použití automatického zaostřování jedním záběrem (Push Auto Focus (AF-S))

V režimu ručního zaostřování stiskněte tlačítko [Push AF/MF], a budete moci při stisknutí tlačítka ostřit automaticky
vysokou rychlostí.
Tato funkce je vhodná, pokud zaostříte na objekt před snímáním.

Poznámka

Funkce vynuceného automatického zaostřování nepracuje, pokud je objektiv nastaven na ruční ostření.

Když použijete tlačítko [Display], rámeček oblasti zaostření není skryt.

Nastavte možnost [Shooting] > [Focus] > [Push AF Mode] na hodnotu [Single-shot AF(AF-S)] ve webové
nabídce nebo v nabídce kamery.

1

Určete polohu, pro kterou chcete nastavit zaostření, pomocí položek [Shooting] > [Focus] > [Focus Area
(AF-S)] v nabídce kamery.

Tip

Polohu můžete změnit stisknutím přiřaditelného tlačítka s funkcí [Focus Setting] pro zobrazení oranžového rámečku kolem
oblasti zaostření a volbou polohy pomocí dotykového ovládání.

2

Pro vypnutí posuňte spínač [Auto Focus] na kartě  (Focus) doleva.3

Stiskněte tlačítko [Push AF/MF].

Pokud tlačítko uvolníte před dokončením zaostření, zastaví se stisknutí tlačítka automatického zaostření.

Během vynuceného automatického zaostřování se stav zaostření zobrazuje ve formě indikátoru zaostření.
Svítí: Ostření je pevně nastaveno v poloze zaostření.
Blikání: Není zaostřeno. Protože zaostření jednotky není automatické, změňte sestavení kompozice a zaostření
tak, abyste zaostření skutečně dosáhli.
Když tlačítko uvolníte, zaostření se vrátí do ručního režimu.

4
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Během operace Clear Image Zoom nelze nastavit polohu rámečku [Focus Area (AF-S)]. Během operace vynuceného
automatického zaostřování má operace AF také přednost před středovou částí.

Tip

Stejná operace je podporována přiřaditelného tlačítka přiřazeného funkci [Push AF/MF].

K přiřaditelnému tlačítku můžete také přiřadit funkci [Push AF Mode].

K přiřaditelnému tlačítku můžete také přiřadit funkci [Focus Area (AF-S)].

Rámeček oblasti zaostření můžete zobrazit/skrýt pomocí možnosti [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] v
nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení pomocí webové aplikace

Jednotka používá automatické zaostřování (AF) s fázovou detekcí pro rychlé zaostřování a kontrastní automatické
zaostřování pro vysoce přesné zaostřování.
Kombinace těchto dvou metod automatického zaostřování zajišťuje automatické zaostřování s vysokou rychlostí i
přesností.

Poznámka

Je vyžadován objektiv, který podporuje automatické zaostřování.

V závislosti na podmínkách snímání nemusí být přesnost dosažena.

Zaostření nelze nastavit automaticky na objektivu A-mount.

Tip

V režimu automatického zaostřování můžete nastavit zaostřování pomocí posuvníku Focus v ovládacím panelu kamery. Další
informace naleznete v části „Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App“.

Příbuzné téma
Kontrola spínačů objektivu

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App

5-041-958-43(1) Copyright 2022 Sony Corporation

Pokud je objektiv vybaven přepínačem volby zaostření, nastavte přepínač do polohy „AF/MF“ nebo „AF“.

Poznámka

Pokud je přepínač nastaven do polohy „Full MF“ nebo „MF“, nelze zaostřování objektivu ovládat z jednotky. Viz „Pro objektiv
se spínačem zaostřování“ v části „Kontrola spínačů objektivu“.

1

Pro zapnutí posuňte spínač [Auto Focus] do pravé polohy v ovládacím panelu kamery.

Režim automatického zaostřování je aktivován.

 (AF)

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení pomocí dodaného infračerveného dálkového ovladače

Zaostření můžete nastavit automaticky pomocí dodaného infračerveného dálkového ovladače.

Poznámka

Automatické zaostřování můžete použít, když je hlavním způsobem obsluhy přístroje jeho ruční nastavení. Další informace
naleznete v části „Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače“.

Příbuzné téma
Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskněte tlačítko AF na infračerveném dálkovém ovladači.

Zaměření na objekt je upraveno automaticky.

1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení oblasti/polohy automatického zaostřování (Focus Area)

Můžete nastavit cílovou oblast pro automatické zaostřování a upravit zaostřování pro tuto oblast.

Stisknutím tlačítka [Menu] ovládacího panelu grafického uživatelského rozhraní otevřete nabídku kamery.1

Nastavte cílovou oblast pro automatické zaostřování pomocí položek [Shooting] > [Focus] > [Focus Area] v
nabídce kamery.

[Wide]:
Při zaostřování vyhledává objekt v širokém úhlu záběru. Rámeček se nezobrazuje.

[Zone]:
Automaticky vyhledá pozici zaostření v zadané zóně.
Po výběru zadejte polohu pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní.

Můžete se vrátit do střední polohy stisknutím a podržením tlačítka [Set].
[Flexible Spot]:
Zaostří na stanovenou pozici v obraze.

2
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Poznámka

Když použijete tlačítko [Display] na panelu obrazu kamery, rámeček oblasti zaostření není skryt.

Během funkce Clear Image Zoom je oblast zaostření nastavena na volbu [Wide] (pevné).

Tip

Rámeček oblasti zaostření můžete zobrazit/skrýt pomocí možnosti [Monitoring] > [Display On/Off] > [Focus Area Indicator] v
nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation

Po výběru zadejte polohu pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní.

Můžete se vrátit do střední polohy stisknutím a podržením tlačítka [Set].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rychlá změna oblasti zaostření (Focus Setting)

Polohu a velikost oblasti automatického ostření můžete během snímání rychle změnit přiřazením funkce [Focus Setting]
přiřaditelnému tlačítku.

Další informace o přiřaditelných tlačítcích naleznete v části „Přiřaditelná tlačítka“.

Operace se liší v závislosti na nastavení oblasti zaostření.

Když je možnost [Shooting] > [Focus] > [Focus Area] nastavena na hodnotu [Flexible Spot]
nebo [Zone] v nabídce kamery

Polohu oblasti zaostření můžete změnit stisknutím přiřaditelného tlačítka s funkcí [Focus Setting] a nastavením
pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní. Polohu oblasti zaostření můžete
vrátit do středu při úpravě polohy stisknutím tlačítka [Set].
Velikost oblasti zaostření můžete změnit stisknutím a podržením přiřaditelného tlačítka s funkcí [Focus Setting]. Po
změně velikosti nastavte polohu oblasti zaostření stisknutím tlačítka [Set]. Po dokončení se stisknutím přiřaditelného
tlačítka s funkcí [Focus Setting] vraťte na původní obrazovku.

Když je možnost [Shooting] > [Focus] > [Focus Area] nastavena na hodnotu [Wide] v nabídce
kamery

Velikost oblasti zaostření můžete změnit pouze stisknutím a podržením přiřaditelného tlačítka s funkcí [Focus Setting].
Polohu lze také změnit tak, že nejprve změníte typ na [Flexible Spot] nebo [Zone].

Tip

Pokud je možnost [Shooting] > [Focus] > [Push AF Mode] nastavena na hodnotu [Single-shot AF(AF-S)] v nabídce kamery a
přepínač [Auto Focus] je nastaven do polohy Off (režim ručního zaostření), můžete změnit polohu oblasti zaostření [Focus Area
(AF-S)].

Pokud lze změnit polohu oblasti zaostření, rámeček oblasti zaostření se zobrazí oranžově.

Příbuzné téma

Přiřaditelná tlačítka

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přesunutí rámečku oblasti zaostření pomocí dotykového ovládání (oblast zaostření
dotykem)

Polohu oblasti zaostření můžete změnit stisknutím přiřaditelného tlačítka s funkcí [Focus Setting], čímž změníte
zobrazení oblasti zaostření na oranžovou, a poté přesuňte rámeček oblasti zaostření pomocí dotykového ovládání na
panelu obrazu kamery.
Klepnutím na obrazovku přesunete oblast zaostření se středem v místě, na které jste klepnuli. Přetažením prstu po
obrazovce přesuňte oblast zaostření na místo, na které jste přešli prstem.

Tip

Funkci zaostření dotykem na obrazovce snímání můžete aktivovat/deaktivovat pomocí přiřaditelného tlačítka s funkcí [Focus
Setting].

Klepněte na libovolné místo.

Poloha, na kterou klepnete, se stává středem oblasti zaostření.

1

Přetažením prstu po obrazovce přesuňte oblast zaostření na požadované místo.2
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Poznámka

Pokud na místo klepnete nebo přetáhnete oblast zaostření do místa, které přesahuje rozsah nastavení, oblast zaostření se
nastaví na horní / dolní / levý / pravý okraj rozsahu nastavení.

Tato funkce je k dispozici pouze za následujících okolností.

Je-li spínač [Touch Focus] v ovládacím panelu kamery vypnutý
Když je rámeček oblasti zaostření zobrazen šedě nebo není zobrazen vůbec

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Úprava činnosti automatického zaostřování (rychlost přechodu AF, citlivost posunu
objektu AF)

Operaci automatického zaostřování můžete nastavit změnou rychlosti přechodu a citlivosti posuvu objektu.

Nastavení rychlosti přechodu AF

Rychlost pohonu zaostřování můžete nastavit v případě, že se objekt mění, a to pomocí tlačítka [AF Transition Speed] v
ovládacím panelu kamery.

Vyberte rychlost z rozsahu [Speed 1] (Slow) až [Speed 7] (Fast) v přírůstcích po 1. Stiskněte tlačítko < a hodnotu snižte
(pomaleji), nebo stiskněte tlačítko > a hodnotu zvyšte (rychleji).
Při nastavení nízké rychlosti se ostření při změně zaostřeného objektu provádí pomalu, což umožňuje pořizovat působivě
vyjádřené obrazy.
Při nastavení vysoké rychlosti se ostření mezi objekty přepíná rychle. V níže uvedeném příkladu se zaměření rychle
mění z budovy na pozadí na osobu kráčející v popředí. Na objekt, který se přesune do záběru, je okamžitě zaostřeno,
takže toto nastavení je ideální pro natáčení dokumentárních filmů, které vyžadují rychlé zaostřování.

Citlivost posunu objektu AF

Citlivost na změnu mezi objekty můžete nastavit pomocí tlačítka [AF Subj. Shift Sens.] na ovládacím panelu kamery.
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Vyberte citlivost z rozsahu [Sens 1] (Locked On) až [Sens 5] (Responsive) v přírůstcích po 1. Stiskněte tlačítko < a
hodnotu snižte (pomalejší změna), nebo stiskněte tlačítko > a hodnotu zvyšte (rychlejší změna).
Při nastavení nízké citlivosti se zaostření pohotově neposune, ani když se před zaostřeným objektem pohybuje jiný
objekt.

Při nastavení vysoké citlivosti se zaostření posune, aby upřednostňovalo objekt, který se pohybuje vpředu.

Tip

Je-li přiřaditelnému tlačítku přiřazena funkce [AF Speed/Sens.], zobrazí se při každém stisknutí tlačítka na panelu obrazu kamery
v následujícím pořadí vodorovné pruhy pro nastavení hodnot. To umožňuje změnit nastavení rychlosti přechodu AF a citlivosti
posunu objektu AF.
Rychlost přechodu AF → citlivost posunu objektu AF → žádné zobrazení…

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace
Web App

Po přesunutí a ručním nastavení zaostření můžete předat ovládání zaostření na automatické zaostření pro nastavení
jemného zaostření.

Poznámka

Ve stavu asistovaného automatického zaostřování se posouvání zaostření stává obtížným, bez ohledu na nastavení [Shooting] >
[Focus] > [AF Subj. Shift Sens.] v nabídce kamery.

Stav asistovaného automatického zaostřování se zruší následujícím způsobem.

Pokud objekt zaostřený pomocí posuvníku [Focus] již není vidět
Při přepnutí na ruční zaostřování
Po spuštění funkce sledování automatického zaostřování v reálném čase

Tip

Stav asistovaného automatického zaostřování lze rychle zrušit pomocí přiřaditelného tlačítka přiřazeného funkci [Push AF/MF].

Nastavte možnost [Shooting] > [Focus] > [AF Assist] na hodnotu [On] v nabídce kamery.1

Nastavte možnost [Shooting] > [Focus] > [AF Assist Control] na hodnotu [On] ve webové nabídce.2

Pro zapnutí posuňte spínač [Auto Focus] do pravé polohy v ovládacím panelu kamery.

Režim automatického zaostřování je aktivován.

3

Cílené zaostřování nastavte pomocí posuvníku [Focus] v ovládacím panelu kamery.

[Near]: Zaostřeno na blízký objekt.
[Far]: Zaostřeno na vzdálený objekt.

Ve stavu AF Assist bude automaticky zaostřen objekt na vzdálenost nastavenou posuvníkem [Focus].

4
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Sledování automatického zaostřování v reálném čase se zastaví, když je použit posuvník [Focus].

V režimu Face/Eye Only AF automatické zaostřování ostří na obličej, který je nejblíže poloze posuvníku [Focus].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční zaostřování během automatického zaostřování pomocí dodaného
infračerveného dálkového ovladače

Když je možnost [Shooting] > [Focus] > [AF Assist] nastavena na hodnotu [On] v nabídce kamery, můžete použít tlačítko
F (Far) a tlačítko N (Near) na dodávaném infračerveném dálkovém ovladači i během automatického zaostřování pro
nastavení zaostření na objekt.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Dočasné použití ručního zaostření během automatického zaostřování (Push Manual
Focus)

V režimu automatického zaostřování stiskněte tlačítko [Push AF/MF], a budete moci při stisknutí tlačítka ostřit ručně.
Když tlačítko uvolníte, zaostření se vrátí do automatického režimu.
To vám umožní dočasně zastavit automatické zaostřování a ostřit ručně, pokud před objektem, který není předmětem
snímání, prochází jiný objekt.

Tip

Stejná operace je podporována přiřaditelného tlačítka přiřazeného funkci [Push AF/MF].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sledování pomocí detekce obličeje a očí (Face/Eye Detection AF)

Jednotka může detekovat obličeje a oči osob jako cíl pro sledování a poté upravit zaostření na obličeje a oči v oblasti
zaostření.
Při detekci obličejů se zobrazí šedé rámečky funkce detekce obličeje/očí. Pokud je možné automatické zaostřování,
barva rámečků se změní na bílou a začne sledování. Když jsou oči detekovány a je upraveno zaostření, na očích se
zobrazí rámeček detekce obličeje/očí. Při detekci více osob se automaticky určí hlavní objekt.
Tato funkce je k dispozici pouze v případě, že se režim zaostřování nachází v režimu AF nebo při vynuceném
automatickém zaostřování (push).

Tip

Pokud je oblast zaostření nastavena na možnost [Zone] nebo [Flexible Spot] a obličeje nebo oči se v rámci určené oblasti
zaostření překrývají, barva rámečků detekce obličeje/očí se změní na bílou a jednotka na tyto obličeje/oči zaostří automaticky.

Při použití vynuceného automatického zaostřování (push) (AF-s) se barva rámečků detekce obličeje/očí pro zaostřené
obličeje/oči změní na zelenou.

Nastavte pomocí [Face/Eye Detection AF] v ovládacím panelu kamery.

Stiskněte tlačítko [Face/Eye Detection AF] a nastavte funkci automatického zaostřování s detekcí obličeje/očí.

[Face/Eye Only AF]: Kamera detekuje obličeje/oči objektů (osob) a zaostřuje a sleduje pouze na jejich obličeje/oči.
Pokud obličej nebo oči nejsou detekovány, automatické zaostřování se dočasně zastaví a zobrazí se ikona pozastavení
automatického zaostřování režimu Face/Eye Only AF . Tento režim je účinný, pokud chcete automaticky zaostřit a
sledovat pouze na obličeje/oči.
[Face/Eye Priority AF]: Kamera detekuje obličeje/oči objektů (osob) a upřednostňuje zaostření/sledování na
obličeje/oči. Pokud není detekována obličej nebo oko, probíhá zaostřování v režimu automatického zaostřování (výchozí
nastavení).
[AF]: Funkce automatického zaostřování s detekcí obličeje/očí je deaktivována.

Poznámka

Během vynuceného automatického zaostřování (push) se aktivuje funkce [Face/Eye Priority AF], i když je aktuálně vybrána
možnost [Face/Eye Only AF].

Je-li přepínač [Auto Focus] nastaven do vypnuté polohy, automatické zaostřování s detekcí obličeje nebo očí je deaktivováno
(kromě režimu vynuceného automatického zaostřování (push)).
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Pokud videokameru vypnete a současně je vybrána možnost [Face/Eye Only AF], videokamera se při dalším zapnutí automaticky
přepne do režimu [Face/Eye Priority AF].

Tip

Funkci automatického zaostřování s detekcí obličeje/očí lze také nastavit pomocí [Shooting] > [Focus] > [Face/Eye Detection AF]
v nabídce kamery.

Skrytí rámečků detekce obličeje/očí
Rámečky detekce obličeje/očí lze také skrýt/zobrazit pomocí možnosti [Monitoring] > [Display On/Off] > [Face/Eye
Detection Frame] v nabídce kamery.

Poznámka

Zelené rámečky detekce obličeje/očí se zobrazí u těch obličejů a očí, které jsou zaostřeny pomocí funkce vynuceného
automatického zaostřování (AF-S) a nejsou skryty pomocí tlačítka [Display] nebo v případě, že je možnost [Face/Eye Detection
Frame] nastavena na volbu [Off].

Přepínání funkce automatického zaostřování s detekcí obličeje/očí přiřaditelným tlačítkem
Přiřaďte funkci [Face/Eye Detection AF] přiřaditelnému tlačítku. Poté můžete při každém stisknutí tohoto tlačítka přepnout
funkci automatického zaostřování s detekcí obličeje/očí v pořadí [Face/Eye Priority AF], [Face/Eye Only AF] a [AF].

Nastavení pomocí přímé nabídky

Funkci automatického zaostřování s detekcí obličeje/očí lze také nastavit pomocí přímé nabídky.

Podrobné informace o přímé nabídce viz „Ovládání přímé nabídky“.

Příbuzné téma
Ovládání přímé nabídky

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sledování stanoveného předmětu (režim sledování AF v reálném čase)

Zaměření na objekt můžete zachovat zadáním objektu dotykovým ovládáním nebo výběrem rámečku detekce obličeje v
ovládacím panelu kamery.
Když vyberete předmět, zobrazí se bílý sledovací rámeček a sledování začne.

Tip

Sledování probíhá v celé oblasti obrazu bez ohledu na nastavení oblasti zaostření.

Když je možnost [Shooting] > [Focus] > [Touch Function in MF] nastavena na hodnotu [Tracking AF] ve webové nabídce nebo v
nabídce kamery, je sledování automatického zaostřování v reálném čase podporováno, i když je režim zaostření nastaven na
režim MF.

V závislosti na provozním režimu nastavení automatického zaostřování s detekcí obličeje/očí se u sledovaného cíle
vyskytnou následující akce.

[Face/Eye Only AF] nebo [Face/Eye Priority AF]: Zaměření a sledování zadaného objektu.
Pokud je sledovaným cílem osoba a je detekován obličej/oči, kamera se zaostří na tento obličej/oči.
Když je detekován sledovaný cílový obličej/oko, sledovaný cílový obličej se uloží. Po uložení se zobrazí ikona 
(uložený sledovaný obličej).

Poznámka

Pokud se během ručního zaostřování spustí funkce sledování AF, cílový objekt sledování se neukládá.

[AF]: Používá se pro zaostření a sledování zadaného předmětu. Detekce obličeje/očí se nevyskytuje, ani když je
sledovaným cílem osoba.

Poznámka

Funkce sledování AF v reálném čase nepracuje, pokud je objektiv nastaven na ruční ostření.

Zahájení sledování AF v reálném čase

Když je jako sledovaný cíl zadán konkrétní předmět, začne se sledovat tento cíl.

Zadání dotykovým ovládáním
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Pro zapnutí posuňte spínač [Touch Focus] na kartě  (Focus) v ovládacím panelu kamery doprava a potom klepněte na
cílový objekt, který chcete sledovat, a to v kterémkoliv z následujících stavů.

Během ručního zaostřování nebo během ručního zaostřování a když je možnost [Shooting] > [Focus] > [Touch
Function in MF] nastavena na hodnotu [Tracking AF] ve webové nabídce nebo v nabídce kamery
Při automatickém zaostřování nebo při vynuceném automatickém zaostřování (AF)

Zadání výběrem rámečku pro rozpoznávání obličeje
Pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní přesuňte kurzor výběru obličeje
(oranžové podtržení) na cílový objekt, který chcete sledovat, a stiskněte tlačítko [Set].

A: Jiné rámečky detekce obličeje (šedé)
B: Sledovací rámeček
C: Kurzor výběru obličeje (oranžový)

Poznámka

Během ručního zaostřování nelze sledování spustit výběrem rámečku pro rozpoznávání obličeje.

Tip

Také můžete změnit cíl na sledování během sledování AF v reálném čase.

Zastavení sledování AF v reálném čase

Stiskněte tlačítko  (zastavení sledování AF v reálném čase).

Tip

Funkce sledování AF v reálném čase se zastaví v následujících případech:

Je-li přepínač [Auto Focus] nebo AUTO/MANUAL ovládání na objektivu zapnuto
Když se změní režim zaostřování
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Když je vykonána funkce AF Assist
Při změně nastavení oblasti zaostření nebo funkce automatického zaostřování s detekcí obličeje/očí
Když je stisknuto přiřaditelné tlačítko přiřazené funkci [Push AF/MF]
Když sledovaný cíl není v rámci snímací obrazovky nebo když je objekt na několik sekund rozostřený

Když je uložen sledovaný obličej (když se zobrazí ikona  (uložený sledovaný obličej)), obnoví se sledovací AF v reálném čase,
jakmile uložený sledovaný obličej vstoupí do oblasti obrazu. Chcete-li vymazat sledovaný obličej, zastavte sledování AF v
reálném čase, jak je popsáno výše.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavení jasu

Jas můžete nastavovat nastavením clony, zesílení, času závěrky a nastavením úrovně světla pomocí filtrů ND v
následujících ovládacích panelech obrazovky živého provozu webové aplikace. Podle potřeby můžete jas upravit
automaticky.

Poznámka

Zesílení nelze upravit, pokud je možnost [Shooting Mode] nastavena na hodnotu [Cine EI Quick] nebo [Cine EI]. Jas také nelze
nastavit automaticky pomocí času závěrky, když je nastavení na [Cine EI Quick] nebo [Cine EI]. Je podporováno automatické
nastavení jasu pomocí clony a filtru ND.

Tip

Ovládací panel kamery – karta  (Main)1.

Panel základní konfigurace kamery
Zobrazuje nastavení stavu základních funkcí potřebných pro snímání přiřazených tlačítkům. Stisknutím tlačítka
zobrazíte odpovídající obrazovku nastavení pro každou funkci na níže uvedeném panelu základní konfigurace
kamery.

2.

Panel nastavení základní konfigurace kamery
Zobrazí panel nastavení pro položku nastavení vybranou na panelu základní konfigurace kamery.

3.
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Režim Cine EI je určen pro snímání se základní citlivostí bez použití zesílení, aby se maximalizoval výkon obrazového snímače.
Jas se nastavuje pomocí osvětlení a filtru ND pro seřízení množství světla, které dopadne na obrazový snímač. Další informace o
Exposure Index (EI) naleznete v části „Změna rozložení tmavých a světlých míst v zaznamenaném snímku“.

Příbuzné téma

Změna rozložení tmavých a světlých míst v zaznamenaném snímku

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení základní citlivosti

Před zahájením úpravy jasu můžete nastavit základní citlivost.

Když je možnost [Shooting Mode] nastavena na volbu [Custom]

Stiskněte tlačítko [ISO/Gain] na panelu základní konfigurace kamery a na panelu pro nastavení ISO/Gain nastavte
možnost [Base Sensitivity] na hodnotu [High] nebo [Low].
Za normálních světelných podmínek zvolte možnost [Low] a při nízkém osvětlení zvolte [High].
Obrazovka, pokud je možnost [AGC] vypnuta

Obrazovka, pokud je možnost [AGC] zapnuta

Když je možnost [Shooting Mode] nastavena na volbu [Flexible ISO] nebo [Cine EI]

Stiskněte tlačítko [Base ISO/Exposure Index] na panelu základní konfigurace kamery a na panelu nastavení Base
ISO/Exposure Index nastavte možnost [Base ISO] na hodnotu [ISO 12800] nebo [ISO 800].
Za normálních světelných podmínek zvolte možnost [ISO 800] a při nízkém osvětlení zvolte [ISO 12800].

Tip
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Můžete to také nastavit na kartě  (Main) v ovládacím panelu kamery.

To lze také nastavit pomocí položek [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] nebo [Base ISO] v nabídce kamery.

K přiřaditelnému tlačítku můžete také přiřadit funkci [Base ISO/Sensitivity].

V režimu fotografování [Cine EI Quick] se základní citlivost automaticky nastaví podle nastavení indexu expozice.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení cílové úrovně pro automatické nastavení jasu

Cílová úroveň pro automatické nastavení jasu se nastavuje pomocí posuvníku [AE Level] v ovládacím panelu kamery.
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Stiskněte kartu  (Main) v ovládacím panelu kamery.

Pokud se posuvník [AE Level] nezobrazuje, zvolte jedno ze dvou tlačítek pro výběr funkce posuvníku a vyberte
posuvník [AE Level] ze seznamu.

Zobrazí se posuvník [AE Level].

1

Nastavte cílovou úroveň pomocí posuvníku.

Chcete-li obrázek ztmavit, přesuňte ovladač posuvníku vlevo. Chcete-li obrázek zesvětlit, přesuňte ovladač
posuvníku vpravo.

Tip

To lze také nastavit pomocí položek [Shooting] > [Auto Exposure] > [Level] v nabídce kamery.

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení clony

Tato funkce upravuje jas automaticky podle snímaného objektu. Je vyžadován kompatibilní objektiv.

Poznámka

Clonu nelze nastavit automaticky na objektivu A-mount.

Tip

K přiřaditelnému tlačítku můžete také přiřadit funkci [Auto Iris].
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Pokud je nasazen objektiv se spínačem Auto Iris, nastavte přepínač do polohy AUTO.1

Stiskněte tlačítko [Iris] v panelu základní konfigurace kamery.

Rám tlačítka [Iris] se změní na oranžový.

Zobrazí se panel nastavení Iris.

2

Pro zapnutí posuňte spínač [Auto] do pravé polohy.

Clona se přepne do režimu automatického nastavení. Automaticky nastavená hodnota clony se zobrazí na pravé
straně spínače.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení clony

Jas můžete nastavit ručně.

Dočasné automatické nastavení clony
Můžete také stisknout tlačítko [Push Auto] na panelu nastavení Iris a nastavit automaticky clonu během stisknutí tlačítka.

Pokud je nasazen objektiv se spínačem Auto Iris, nastavte přepínač do polohy AUTO.

Poznámka

Pokud je spínač Auto Iris objektivu nastaven do polohy MANUAL, funkce [Auto Iris] a [Push Auto Iris] na jednotce nemají
žádný vliv. Ruční nastavení clony na jednotce také nemá žádný vliv.

1

Stiskněte tlačítko [Iris] v panelu základní konfigurace kamery.

Rám tlačítka [Iris] se změní na oranžový.

Zobrazí se panel nastavení Iris.

2

Pro vypnutí posuňte spínač [Auto] do levé polohy.

Clona se přepne do režimu ručního nastavení.

3

Nastavte clonu pomocí posuvníku [Iris] nebo tlačítek pro nastavení [Iris].

Tip

Nastavení posuvníku a tlačítek nastavení jsou propojena.

Clonu můžete také přiřadit k posuvníku na kartě  (Main) v ovládacím panelu kamery.

4
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Tip

Stiskněte přiřaditelné tlačítko s funkcí [Push Auto Iris] a nastavte automaticky clonu během stisknutí tlačítka.
Když tlačítko uvolníte, clona se vrátí do ručního režimu.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení zesílení (AGC)

Jas můžete nastavit automaticky pomocí nastavení zesílení, když je možnost [Shooting Mode] nastavena na hodnotu
[Custom] nebo [Flexible ISO].
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Nastavte možnost [Project] > [Shooting Mode] na hodnotu [Custom] ve webové nabídce nebo v nabídce
kamery.

1

Stiskněte tlačítko [ISO/Gain] v panelu základní konfigurace kamery.

Rám tlačítka [ISO/Gain] se změní na oranžový.

Zobrazí se panel nastavení ISO/Gain.

2

Pro zapnutí posuňte spínač [AGC] do pravé polohy.

Zesílení se přepne do režimu automatického nastavení. Automaticky nastavená hodnota zesílení se zobrazí na
pravé straně spínače.

Tip

Stejnou akci můžete provést také nastavením možností [Shooting] > [Auto Exposure] > [AGC] na hodnotu [On] v nabídce
kamery.

K přiřaditelnému tlačítku můžete také přiřadit funkci [AGC].

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení zesílení

Jas můžete nastavit ručně pomocí nastavení zesílení, když je možnost [Shooting Mode] nastavena na hodnotu [Custom]
nebo [Flexible ISO].
Zesílení můžete ovládat, pokud chcete upravit expozici při použití pevného nastavení clony nebo pokud chcete zabránit
zvýšení zesílení v důsledku činnosti funkce AGC.

Postup dočasného ručního nastavení zesílení
Zesílení můžete také dočasně upravit přiřazením funkce [ISO/Gain] k tlačítku pro volbu funkce posuvníku na kartě 
(Main) v ovládacím panelu kamery a použitím posuvníku.
To je užitečné, pokud chcete upravit expozici o jeden krok bez změny hloubky ostrosti.
Výsledek nastavení se vrátí k přednastavené hodnotě nakonfigurované pomocí [ISO/Gain<L>] po provedení některé z
následujících operací.

Nastavte možnost [Project] > [Shooting Mode] na hodnotu [Custom] ve webové nabídce nebo v nabídce
kamery.

1

Stiskněte tlačítko [ISO/Gain] v panelu základní konfigurace kamery.

Rám tlačítka [ISO/Gain] se změní na oranžový.

Zobrazí se panel nastavení ISO/Gain.

2

Pro vypnutí posuňte spínač [AGC] do levé polohy.

Zesílení se přepne do režimu ručního nastavení.

3

Nastavte zesílení pomocí posuvníku [ISO/Gain] nebo tlačítek pro nastavení [ISO/Gain].

Tip

Nastavení posuvníku a tlačítek nastavení jsou propojena.

4
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Změna položek nastavení ISO/Gain
Přepínání základní citlivosti
Nastavte spínač AGC do polohy On
Přepnutí napájení jednotky do pohotovostního stavu

Dočasné automatické nastavení zesílení pomocí přiřaditelného tlačítka
Stiskněte přiřaditelné tlačítko s funkcí [Push AGC] a nastavte automaticky zesílení během stisknutí tlačítka.
Když tlačítko uvolníte, zesílení se vrátí do ručního režimu.
Výsledek nastavení se vrátí k přednastavené hodnotě nakonfigurované pomocí [ISO/Gain<L>] po provedení některé z
následujících operací.

Změna položek nastavení ISO/Gain
Přepínání základní citlivosti
Nastavte spínač AGC do polohy On
Přepnutí napájení jednotky do pohotovostního stavu

Poznámka

Tato funkce nemůže být vykonána, když je možnost [Shooting] > [Iris] > [Bokeh Control] nastavena na [On] v nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení závěrky

Závěrku můžete nastavit automaticky podle jasu obrazu.
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Stiskněte tlačítko [Shutter] v panelu základní konfigurace kamery.

Rám tlačítka [Shutter] se změní na oranžový.

Zobrazí se panel nastavení Shutter.

1

Stiskněte tlačítko [Shutter Type] a ze seznamu vyberte položku [Auto].

Tip

Stejnou akci můžete provést také nastavením možností [Shooting] > [Auto Exposure] > [Auto Shutter] na hodnotu [On] v
nabídce kamery.

K přiřaditelnému tlačítku můžete také přiřadit funkci [Auto Shutter].

2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení závěrky

Závěrku můžete nastavit ručně.

Stiskněte tlačítko [Shutter] v panelu základní konfigurace kamery.

Rám tlačítka [Shutter] se změní na oranžový.

Zobrazí se panel nastavení Shutter.

1

Stiskněte tlačítko [Shutter Type] a ze seznamu vyberte položku [Speed].2

Nastavte závěrku pomocí posuvníku [Speed] nebo tlačítek pro nastavení [Speed].

Chcete-li upravit čas expozice tak, aby odpovídala intervalu snímku, vyberte v kroku 2 možnost [Off]. Pevnou
hodnotu můžete také nastavit pomocí [ECS] (frekvence) nebo ji automaticky upravit pomocí [Auto].
Příklad: Nastavení pomocí [ECS] (frekvence)

Tip

Nastavení posuvníku a tlačítek nastavení jsou propojena.

Chcete-li použít možnost [Angle] místo možnosti [Speed] nebo [Off], nastavte možnost [Shooting] > [Shutter] > [Mode] na
hodnotu [Angle] v nabídce kamery.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

O filtru ND

V podmínkách, kdy je osvětlení příliš jasné, můžete upravit příslušný jas změnou filtru ND.
Při snímání jasně nasvětleného objektu může přílišné zavření clony způsobit difrakční rozmazání a způsobit, že obraz
začne být rozostřen (typický jev u kamer). Tento efekt můžete potlačit pomocí filtru ND a dosáhnout tak lepších výsledků
snímání.
Jednotka je vybavena následujícími režimy filtru ND.
Režim předvolby

Viz také „Nastavení v režimu předvolby“.

Proměnný režim (automatické nastavení)

Další informace naleznete v části „Automatické nastavení v proměnném režimu“.

Proměnný režim (ruční nastavení)

Další informace naleznete v části „ Ruční nastavení v proměnném režimu“.

Příbuzné téma

Nastavení v režimu předvolby

Automatické nastavení v proměnném režimu

Ruční nastavení v proměnném režimu

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení v režimu předvolby

Předem můžete volit tři hodnoty propustnosti filtru ND a při snímání mezi nimi rychle přepínat.

Tip

Po stisknutí přiřaditelného tlačítka s funkcí [ND Filter Position] se filtr ND změní v pořadí [Clear] → [Preset1] → [Preset2] →
[Preset3] → [Clear].
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Nastavte možnost [Shooting] > [ND Filter] > [Mode] na hodnotu [Preset] v nabídce kamery.1

Stiskněte tlačítko [ND Filter] v panelu základní konfigurace kamery.

Rám tlačítka [ND Filter] se změní na oranžový.

Zobrazí se panel nastavení ND Filter.

2

Stiskněte tlačítko [ND Filter] a ze seznamu vyberte jednu z následujících možností.

[Clear]: Bez filtru ND.
[Preset1]: Propustnost nastavená [Shooting] > [ND Filter] > [Preset1] v nabídce kamery.
[Preset2]: Propustnost nastavená [Shooting] > [ND Filter] > [Preset2] v nabídce kamery.
[Preset3]: Propustnost nastavená [Shooting] > [ND Filter] > [Preset3] v nabídce kamery.

Je-li pro filtr ND vybrána jedna z možností [Preset1] až [Preset3], zobrazí se vedle názvu filtru ND hodnota
propustnosti.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení v proměnném režimu

Můžete povolit automatické nastavení expozice pomocí filtru ND.

Poznámka

Pokud je filtr ND během snímání přepnut do režimu [Clear] nebo z něj, v obrazu se zobrazí rámeček filtru ND a je vygenerován
zvuk obsluhy.

Tip

Funkci [Auto ND Filter] můžete také přiřadit tlačítku a stisknutím tlačítka můžete přepínat mezi možnostmi [Auto] a [Manual].
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Nastavte možnost [Shooting] > [ND Filter] > [Mode] na hodnotu [Variable] v nabídce kamery.1

Stiskněte tlačítko [ND Filter] v panelu základní konfigurace kamery.

Rám tlačítka [ND Filter] se změní na oranžový.

Zobrazí se panel nastavení ND Filter.

2

Stiskněte tlačítko [ND Filter] a ze seznamu vyberte položku [Auto].

Automaticky nastavená hodnota propustnosti filtru ND se zobrazí vedle tlačítka [ND Filter].

3

209



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení v proměnném režimu

Můžete provést ruční nastavení expozice pomocí filtru ND.

Dočasné automatické nastavení
Funkci [Push Auto ND] můžete také přiřadit přiřaditelnému tlačítku a dočasně nastavit funkci automatický filtr ND na
volbu On při stisknutí tlačítka. Po uvolnění tlačítka se funkce automatický filtr ND vrátí na volbu Off.
Nastavte funkci ND Filter na hodnotu [Manual].

Poznámka

Pokud je filtr ND během snímání přepnut do režimu [Clear] nebo z něj, v obrazu se zobrazí rámeček filtru ND a je vygenerován
zvuk obsluhy.

Nastavte možnost [Shooting] > [ND Filter] > [Mode] na hodnotu [Variable] v nabídce kamery.1

Stiskněte tlačítko [ND Filter] v panelu základní konfigurace kamery.

Rám tlačítka [ND Filter] se změní na oranžový.

Zobrazí se panel nastavení ND Filter.

2

Stiskněte tlačítko [ND Filter] a ze seznamu vyberte položku [Manual].3

Nastavte propustnost ND filtru pomocí posuvníku [ND Filter] nebo tlačítek pro nastavení [ND Filter].

Tip

Nastavení posuvníku a tlačítek nastavení jsou propojena.

Filtr ND můžete také nastavit na kartě  (Main) v ovládacím bloku kamery.

4
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Tip

Funkci [ND Filter Position] můžete také přiřadit tlačítku a stisknutím tlačítka můžete přepínat mezi možnostmi [Manual] a [Clear].

Můžete také stisknout tlačítko [Push Auto] na panelu nastavení ND Filter a zapnout automatický filtr ND při stisknutí tlačítka.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavení vyvážení bílé barvy

Vyvážení bílé můžete upravit pomocí obrazovky živého provozu webové aplikace, abyste získali vyvážení bílé barvy, díky
němuž bude obraz vypadat přirozeněji.
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Panel základní konfigurace kamery1.

Panel nastavení základní konfigurace kamery
Zobrazí panel nastavení pro položku nastavení vybranou na panelu základní konfigurace kamery.

2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatické nastavení vyvážení bílé

Pomocí funkce ATW (automatické sledování vyvážení bílé barvy) můžete kdykoli získat vhodně nastavené vyvážení bílé
barvy.
Když je funkce ATW povolena, vyvážení bílé barvy je automaticky nastaveno, když se změní teplota barev zdroje světla.

Poznámka

Funkci ATW nelze použít, pokud je možnost [Shooting Mode] nastavena na hodnotu [Cine EI] nebo [Cine EI Quick].

V závislosti na nasvětlení a stavu objektu nemusí být pomocí funkce ATW možné nastavit odpovídající barvu.
Příklady:

Když objektu dominuje jedna barva, například obloha, moře, zem nebo květiny.
Když je teplota barev extrémně vysoká nebo extrémně nízká.

Pokud je rychlost automatického sledování vyvážení bílé barvy nízká nebo nelze dosáhnout příslušného účinku, stiskněte tlačítko
[WB SET] a spusťte automatické vyvážení bílé.

Tip

Rychlost odezvy v režimu ATW můžete volit z pěti kroků (1, 2, 3, 4, 5) pomocí položek [Shooting] > [White Setting] > [ATW Speed]
v nabídce kamery. Čím nižší je číslo, tím je rychlost odezvy vyšší.

Aktuální nastavení vyvážení bílé barvy můžete fixovat přiřazením funkce [ATW Hold] přiřaditelnému tlačítku a stisknutím
přiřaditelného tlačítka pak dočasně pozastavit režim ATW během jeho používání.
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Stiskněte tlačítko [White Balance] v panelu základní konfigurace kamery.

Rám tlačítka [White Balance] se změní na oranžový.

Zobrazí se panel nastavení White Balance.

1

Stiskněte tlačítko [White Mode] a ze seznamu vyberte položku [ATW].2
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ruční nastavení vyvážení bílé

Vyvážení bílé barvy můžete nastavit ručně.

Stiskněte tlačítko [White Balance] v panelu základní konfigurace kamery.

Rám tlačítka [White Balance] se změní na oranžový.

Zobrazí se panel nastavení White Balance.

1

Stiskněte tlačítko [White Mode] a ze seznamu vyberte jednu z následujících možností.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Nastavte vyvážení bílé pomocí posuvníků nebo nastavovacích tlačítek.

Tip

Nastavení posuvníku a tlačítek nastavení jsou propojena.

Rozdíl mezi funkcemi [Memory A(T/T)] a [Memory A(R/B)] spočívá v tom, že osa seřízení je jiná, ale výsledky seřízení jsou
propojené.

Pro [Memory A(T/T)]
Tento režim upravuje vyvážení bílé uložené v paměti A úpravou teploty barev (Temp) a Tint.
Teplotu barev lze nastavit v krocích po 20 K v rozmezí 2000 K až 5600 K. Hodnoty nad 5600 K lze nastavit v
intervalech odpovídajících velikosti změny barvy („zakalení“) od 5580 K do 5600 K.

3
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Stiskněte tlačítko [Reset] na pravé straně [Temp] nebo [Tint] a obnovte tak odpovídající nastavení výchozí hodnoty.
Pro [Memory A(R/B)]
Tento režim upravuje vyvážení bílé uložené v paměti A úpravou parametrůR Gain a B Gain.
Stisknutím tlačítka [Reset] obnovíte nastavení zesílení na výchozí hodnotu.
Pro [Preset]
Tento režim upravuje teplotu barev na přednastavenou hodnotu.
Hodnotu můžete nastavit v přírůstcích po 100 K.
V režimu předvoleb můžete k přiřaditelnému tlačítku také přiřadit funkci [Preset White Select] a stisknutím tlačítka
pak změnit předem nakonfigurovanou hodnotu předvolby.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spuštění automatického vyvážení bílé

V režimu paměti A je vyvážení bílé, které chcete uložit, nastaveno automaticky.

Stiskněte tlačítko [White Balance] v panelu základní konfigurace kamery.

Rám tlačítka [White Balance] se změní na oranžový.

Zobrazí se panel nastavení White Balance.

1

Stiskněte tlačítko [White Mode] a ze seznamu vyberte položku [Memory A(T/T)] nebo [Memory A(R/B)].

[Memory A(T/T)]

[Memory A(R/B)]

2

Umístěte bílý papír (nebo jiný objekt) na místo se stejným zdrojem osvětlení a se stejnými podmínkami, jaké
má snímaný objekt. Pak přibližujte papír, aby se na obrazovce zobrazila bílá barva.

3

Nastavte jas.

Nastavte clonu podle postupu uvedeného v části „Ruční nastavení clony“.

4

Stiskněte tlačítko [WB SET] na panelu nastavení vyvážení bílé.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Poznámka

Pokud nastavení nebylo úspěšné, zobrazí se na obrazovce po dobu přibližně tří sekund chybová zpráva. Pokud chybová zpráva
přetrvává i po opakovaných pokusech o nastavení funkce vyvážení bílé, obraťte se na servisního zástupce společnosti Sony.

Tip

Toto můžete také spustit v režimu ATW. Tuto možnost můžete použít, pokud chcete během činnosti funkce ATW rychle nastavit
vyvážení bílé barvy. Po seřízení se režim vrátí do normální činnosti funkce ATW.

Příbuzné téma

Ruční nastavení clony

5-041-958-43(1) Copyright 2022 Sony Corporation

Pokud funkce automatického vyvážení bílé pracuje v režimu paměti, výsledek automatického seřízení se uloží do
paměti A.
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Obrazovka konfigurace zvuku

Úroveň zvuku, kterou má jednotka zaznamenat, můžete upravit na obrazovce živého provozu webové aplikace.
Nakonfigurujte spínače na bloku konektorů jednotky a nakonfigurujte zvuk pomocí nabídky kamery nebo webové
nabídky.

5-041-958-43(1) Copyright 2022 Sony Corporation

Ovládací panel kamery – karta  (Audio)1.

218



Průvodce nápovědou
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Výběr vstupního zvukového zařízení

Nastavte následující spínače podle zařízení připojeného ke konektoru AUDIO IN.

Poznámka

Zvuk se v režimech Interval Rec a Slow & Quick Motion nezaznamenává.

5-041-958-43(1) Copyright 2022 Sony Corporation

Je-li připojen mikrofon, nastavte spínač SETUP 2 na bloku konektorů na zadní straně jednotky.

CH-1 a CH-2 mají společné nastavení.

1

Nastavení Popis

OFF
(výchozí)

Vyberte v případě použití dynamického mikrofonu nebo mikrofonu napájeného baterií. Tím se
vypne zdánlivé napájení +48 V a nastaví se vstup LINE nebo MIC jako zdroj zvuku CH-1 a CH-2.

ON
Tuto možnost vyberte při použití mikrofonu kompatibilního se zdánlivým napájením +48 V . Tím se
zapne zdánlivé napájení +48 V a nastaví se mikrofon kompatibilní se zdánlivým napájením jako
zdroj zvuku pro CH-1 a CH-2.

Nastavte typ připojeného zařízení, a to pomocí položky [Audio] > [Audio Input] > [AUDIO IN Select] v
nabídce kamery.

2

Nastavte vstup zvuku pomocí možnosti [Audio] > [Audio Input] > [CH1 Input Select] na hodnotu [CH4 Input
Select] ve webové nabídce nebo v nabídce kamery.

3
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Automatická úprava úrovně hlasitosti záznamu zvuku

Nastavte kanál, pro který chcete nastavit úroveň záznamu zvuku automaticky na hodnotu [Auto] na stránce [Audio] ve
webové nabídce, nebo pomocí položky [Audio] > [Audio Input] > [CH1 Level Control] na hodnotu [CH4 Level Control] v
nabídce kamery.
Kanály určené pro automatické nastavení jsou označeny ikonou  (Auto) vedle odpovídajících kanálů na kartě 
(Audio) obrazovky živého provozu.

5-041-958-43(1) Copyright 2022 Sony Corporation

220



Průvodce nápovědou
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Ruční úprava úrovně hlasitosti záznamu zvuku

Úroveň hlasitosti záznamu zvuku můžete nastavit ručně.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte kanál, pro který chcete nastavit úroveň záznamu zvuku ručně na hodnotu [Manual] na stránce
[Audio] ve webové nabídce, nebo pomocí položky [Audio] > [Audio Input] > [CH1 Level Control] na hodnotu
[CH4 Level Control] v nabídce kamery.

1

Stiskněte kartu  (Audio) v ovládacím panelu kamery.2

Na obrazovce [Audio] v ovládacím bloku kamery nastavte úroveň hlasitosti záznamu zvuku pomocí
posuvníku nebo tlačítek pro nastavení kanálu, jehož úroveň hlasitosti záznamu chcete nastavit ručně.

Poznámka

Kanály, pro které je zobrazena ikona  (Auto), se upraví automaticky. Změny hodnot pomocí posuvníku nebo tlačítek se
na nahraný zvuk nepoužijí.

Tip

Nastavení posuvníku a tlačítek nastavení v každé řadě jsou propojena.

Úroveň vstupu zvuku můžete zkontrolovat v reálném čase pomocí displeje měřiče úrovně hlasitosti na obrazovce snímání.

3
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Ovládání přímé nabídky

Stav a nastavení jednotky zobrazené na překryvném obrazu kamery můžete zkontrolovat a nastavení vybrat a změnit
pomocí tlačítek pro ovládání GUI na infračerveném dálkovém ovladači.
Lze konfigurovat následující položky.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Hodnota [ND Filter]
[Auto Iris]
Hodnota [Iris]
[AGC]
Hodnota [Gain]
Hodnota [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Hodnota [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] a [Frame Rate]

Tip

Stejnou funkci můžete také provést pomocí přiřaditelného tlačítka a ovládacího panelu grafického uživatelského rozhraní webové
aplikace.

Stiskněte přiřaditelné tlačítko s funkcí [Direct Menu] na infračerveném dálkovém ovladači.

Tlačítko [Direct Menu] je ve výchozím továrním nastavení přiřazeno k přiřaditelnému tlačítku 1.
Pomocí oranžového kurzoru lze vybrat pouze položky na obrazovce, které lze konfigurovat pomocí přímé nabídky.

1

Přesuňte kurzor na požadovanou položku pomocí tlačítek se šipkami v ovládacím panelu grafického
uživatelského rozhraní a stiskněte tlačítko [Set].

Zobrazí se nabídka, nebo se položka zobrazí na bílém pozadí.

2

Pomocí tlačítek se šipkami vyberte nastavení a stiskněte tlačítko [Set].

Nabídka nebo bílé pozadí zmizí a nové nastavení se zobrazí s oranžovým kurzorem.
Stiskněte znovu přiřaditelné tlačítko s funkcí [Direct Menu] nebo počkejte 3 sekundy bez provedení jakékoliv akce a
ukončete tak přímou nabídku.

3
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Přiřaditelná tlačítka

Ve webové aplikaci jednotky je deset přiřaditelných tlačítek, ke kterým lze přiřadit funkci.
Přiřaditelná tlačítka jsou zobrazena na obrazovce živého provozu a obrazovce přehrávání.

Poznámka

Seznam přiřaditelných tlačítek se nezobrazuje při konfiguraci nastavení v panelu základní obsluhy kamery obrazovky živého
provozu. Chcete-li operaci ukončit, stiskněte tlačítko [X] vpravo nahoře na panelu nastavení.

Následující funkce jsou přiřazeny tlačítkům ve výchozím továrním nastavení.
Tlačítko 1: [Direct Menu]
Tlačítko 2: [Focus Setting]
Tlačítko 3: [Rec Review]

Tlačítka 1 až 3 odpovídají tlačítkům se stejným číslem na dodaném infračerveném dálkovém ovladači.

Tlačítko 4: [Push Auto ND]
Tlačítko 5: [Crop Select]
Tlačítko 6: [Marker]
Tlačítko 7: [Video Signal Monitor]
Tlačítko 8: [Clip Flag OK]
Tlačítko 9: [Color Bars]
Tlačítko Focus Hold: [Focus Hold]

Tlačítko Focus Hold odpovídá tlačítku Focus Hold na objektivu E-Mount.

Změna funkce tlačítka
V nabídce kamery použijte možnost [Project] > [Assignable Button].
Při změně přiřazení se změní zobrazení seznamu přiřaditelných tlačítek.
Další informace o přiřaditelných funkcích naleznete v části „Assignable Button“ v položce „Nabídka kamery a podrobná
nastavení“.

Příbuzné téma

Assignable Button

5-041-958-43(1) Copyright 2022 Sony Corporation
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Pomalý a rychlý pohyb

Pokud je formát záznamu nastaven na následující hodnoty, můžete zadat odlišné hodnoty pro snímkové frekvence
snímání a přehrávání.
Následující tabulka zobrazuje konfigurovatelné snímkové frekvence.

Systémová frekvence: 59.94/50/29.97/25/23.98, Režim skenování obrazového snímače: FF

Systémová frekvence: 59.94/50/29.97/25/23.98, Režim skenování obrazového snímače: S35

Systémová frekvence: 24, Režim skenování obrazového snímače: FF

Poznámka

Funkci Slow & Quick Motion nelze nastavit během nahrávání, přehrávání nebo při zobrazení obrazovky miniatur.

Nahrávání zvuku není v režimu Slow & Quick Motion podporováno.

Funkce automatické clony a funkce automatické závěrky jsou v režimu Slow & Quick Motion vypnuty.

Automatické zaostřování má v režimu Slow & Quick Motion následující omezení.

Omezení v důsledku modelu objektivu, systémové frekvence a snímkové frekvence snímání

Kodek Formát videa Konfigurovatelné snímkové frekvence

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Formát videa Konfigurovatelné snímkové frekvence

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Formát videa Konfigurovatelné snímkové frekvence

XAVC-I 4096×2160P 1–60
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Funkce automatického zaostřování je dočasně vypnuta, pokud je clona nastavena na F18 nebo vyšší hodnotu.

Další informace o videu používajícím výstup RAW naleznete v části „Záznam videa ve formátu RAW“.

Příbuzné téma

Záznam videa ve formátu RAW

5-041-958-43(1) Copyright 2022 Sony Corporation

Objektiv Sony Systémová frekvence Dostupnost AF

Kromě SEL16F28 – Podporováno 7 snímků za sekundu nebo více

SEL16F28

59.94/29.97/23.98 Podpora 30, 60, 120, 240 snímků za sekundu

50,00/25,00 Podpora 25, 50, 100, 200 snímků za sekundu

24,00 Není podporováno
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Přerušované nahrávání videa (Interval Rec)

Funkce Interval Rec jednotky umožňuje pořizovat zaznamenané video přerušovaně a ukládat jej do interní paměti
jednotky. Tato funkce představuje účinný způsob filmování pomalu se pohybujících objektů.
Po zahájení záznamu jednotka automaticky zaznamená stanovený počet snímků (Number of Frames) v určeném
časovém intervalu (Interval Time).

A: Interval snímání (Interval Time)
B: Počet snímků na jeden záznam (Number of Frames)

Poznámka

Současně lze použít pouze jednu speciální funkci záznamu, jako je například Interval Rec.

Pokud je během používání funkce Interval Rec aktivován jiný speciální režim záznamu, režim Interval Rec se automaticky uvolní.

Režim Interval Rec se automaticky uvolní po změně nastavení systému, například formátu videa.

Nastavení režimu Interval Rec nelze změnit během záznamu nebo přehrávání nebo při zobrazení obrazovky miniatur.

Omezení během záznamu
Zvuk není zaznamenáván.
Prohlížení záznamu (Rec Review) není možné.

Je-li jednotka během záznamu vypnutá
Je-li napájení jednotky nastaveno do polohy pohotovostního stavu, média jsou přístupná po dobu několika sekund,
aby bylo možné zaznamenat obrazy uložené v paměti až do tohoto okamžiku, a poté se jednotka automaticky přepne
do pohotovostního stavu.
Pokud dojde k odpojení kabelu stejnosměrného napájení, vypnutí napájení z napájecího adaptéru nebo odpojení
napájení z PoE++, může dojít ke ztrátě snímků zhotovených až do tohoto okamžiku (maximálně 10 sekund). Je třeba
postupovat opatrně.

Nastavení počtu snímků a intervalu mezi snímáním
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Nastavte možnost [Project] > [Interval Rec] > [Setting] na hodnotu [On] ve webové nabídce, a pak nastavte [Number of
Frames] a [Interval Time].
Jednotka ukončí režim Interval Rec, když je vypnuta, ale nastavení [Number of Frames] a [Interval Time] jsou
zachována. Při dalším snímání v režimu Interval Rec je již nemusíte nastavovat.

Tip

To lze také nastavit pomocí položek [Project] > [Interval Rec] v nabídce kamery.

Zahájení snímání

Stiskněte tlačítko START/STOP a spusťte záznam. Střídavě se zobrazují nápis „Int●Rec“ a „Int●Stby“.

Ukončení snímání

Zastavte záznam.
Po ukončení záznamu se videodata uložená v paměti až do tohoto okamžiku zapíšou na médium.
Chcete-li ukončit režim Interval Rec, proveďte jeden z následujících úkonů.

Přepnutí napájení jednotky do pohotovostního stavu.
V pohotovostním režimu záznamu nastavte možnost [Project] > [Interval Rec] > [Setting] na hodnotu [Off].

Režim Interval Rec se také automaticky uvolní po restartování jednotky.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Nahrávání obrázků do mezipaměti (Picture Cache Rec)

Funkce Picture Cache Rec umožňuje zachytit video zpětně, když začnete nahrávat, a to tak, že při natáčení zachováte
interní mezipaměť se stanovenou dobou trvání.

Nastavení velikosti mezipaměti

Nastavte možnost [Project] > [Picture Cache Rec] > [Setting] na hodnotu [On] ve webové nabídce a nastavte velikost
mezipaměti pomocí možnosti [Cache Size].

Poznámka

Funkci Picture Cache Rec nelze použít v kombinaci s funkcí Interval Rec, současným nahráváním ve 2 slotech nebo nahráváním
proxy. Když je funkce Picture Cache Rec nastavena na volbu On, jsou uvedené další speciální režimy záznamu vynuceně
nastaveny na volbu Off.

Režim nahrávání do mezipaměti nelze zvolit během nahrávání nebo náhledu nahrávky.

Když je funkce Picture Cache Rec nastavena na možnost On, časový kód se zaznamená do režimu [Free Run], i když je
nastavena volba [Regen] nebo [Rec Run].

Nastavení [Output Format] nemusí být konfigurovatelné v režimu záznamu do mezipaměti. Pokud k tomu dojde, dočasně
nastavte funkci Picture Cache Rec do stavu Off a pak změňte nastavení.

Tip

Doba mezipaměti může být kratší v závislosti na formátu záznamu. Zkontrolujte čas zobrazený v položce [Project] > [Picture
Cache Rec] > [Cache Rec Time] ve webové nabídce.

To lze také nastavit pomocí položek [Project] > [Picture Cache Rec] v nabídce kamery.

Pomocí přiřaditelného tlačítka můžete také přepínat funkci [Picture Cache Rec] mezi stavyOn a Off.

Zahájení nahrávání obrázků do mezipaměti

Když je možnost [Picture Cache Rec] nastavena na hodnotu On, zobrazí se „●Cache“ (● je zelená).
Když stisknete tlačítko START/STOP záznamu, spustí se záznam a video se zapíše na paměťové karty počínaje videem
uloženým v mezipaměti.

Poznámka

Změna formátu záznamu nebo základního vzhledu vymaže video v mezipaměti uložené až do tohoto okamžiku a spustí ukládání
nového videa do mezipaměti. V důsledku toho není možné nahrávat obrázky do mezipaměti před změnou formátu, a to ani v
případě, že začnete nahrávat ihned po změně formátu.

Nastavení [Cache Size] Čas mezipaměti (přibližně)

[Short] 5 sekund

[Medium] 10 sekund

[Long] 20 sekund

[Max] Maximální hodnota nebo každý formát záznamu
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Pokud je funkce Picture Cache Rec nastavena na možnost On nebo Off ihned po vložení paměťové karty, data mezipaměti
nemusí být na kartě zaznamenána.

Video se ukládá do paměti mezipaměti při nastavení funkce Picture Cache Rec na možnost On. Video před nastavením funkce
na možnost On není v mezipaměti uloženo.

Video není uloženo v mezipaměti během přístupu k paměťové kartě, například během přehrávání, náhledu záznamu nebo
zobrazení miniatury. Nahrávání videa do mezipaměti během tohoto intervalu není možné.

Zrušení nahrávání obrázků do mezipaměti

Nastavte možnost [Project] > [Picture Cache Rec] > [Setting] na hodnotu [Off] ve webové nabídce, nebo stiskněte
přiřaditelné tlačítko přiřazené funkci [Picture Cache Rec].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Současné nahrávání na paměťové karty A a B. (2-slot Simul Rec)

Na paměťovou kartu A i B můžete zaznamenávat současně nastavením položek [Project] > [Simul Rec] > [Setting] na
hodnotu [On] ve webové nabídce nebo v nabídce kamery.

Samostatný záznam na paměťovou kartu A a paměťovou kartu B

Samostatný záznam na každou paměťovou kartu můžete spustit/zastavit nezávisle pomocí tlačítek START/STOP nebo
[2nd Rec START/STOP] na kartě  (Others).
Ve výchozím továrním nastavení jsou obě tlačítka nastavena na spuštění/zastavení současného záznamu na paměťové
karty A i B.
Jsou-li tlačítka nastavena na ovládání záznamu pro různé paměťové karty, funkce [SDI/HDMI Rec Control] zaznamenává
spuštění/zastavení a sleduje stav záznamu ve slotu A.

Změna nastavení

Nastavte následující v položkách [Project] > [Simul Rec] > [Rec Button Set] v nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavení [Rec
Button Set] Tlačítka a paměťové karty

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Spouští/zastavuje současně záznam na paměťové karty A a B pomocí kteréhokoliv z tlačítek.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

Tlačítko START/STOP záznamu spustí/zastaví záznam na paměťovou kartu A a tlačítko [2nd
Rec START/STOP] na kartě  (Others) spustí/zastaví záznam na paměťovou kartu B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

Tlačítko START/STOP záznamu spustí/zastaví záznam na paměťovou kartu B a tlačítko [2nd
Rec START/STOP] na kartě  (Others) spustí/zastaví záznam na paměťovou kartu A.
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Monitor video signálu

Typ videosignálu, který se má zobrazit na panelu obrazu kamery, můžete nastavit na křivku, vektorový osciloskop nebo
histogram, a to pomocí položky [Monitoring] > [Video Signal Monitor] > [Setting] v nabídce kamery.
Oranžová čára označuje nastavenou hodnotu [Level Marker 1] a [Level Marker 2].
K přiřaditelnému tlačítku [Video Signal Monitor] můžete také přiřadit přiřaditelné tlačítko.

Monitorování zobrazení cíle
V režimu snímání Log se v pravé horní části monitoru video signálu zobrazuje nastavení barevného gamutu, nebo
informace o nastavení monitoru LUT pro indikaci cíle monitorování.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Značky klipu

Značky klipu [OK] do něj můžete přidat stisknutím přiřaditelného tlačítka přiřazeného funkci [Clip Flag OK] a výběrem
možnosti [Add OK].
Značku klipu [OK] můžete odstranit dvojím stisknutím tlačítka a výběrem možnosti [Delete Clip Flag].

Tip

Značku klipu můžete také přidat pomocí položek [Thumbnail] > [Set Clip Flag] v nabídce kamery.

Obrazovku miniatur lze zobrazit seřazenou podle typu značky klipu (filtrovaná obrazovka miniatur klipu). Další informace
naleznete v části „Operace se zaznamenanými klipy“ v „Obrazovka miniatur“.

Příbuzné téma

Operace se zaznamenanými klipy

5-041-958-43(1) Copyright 2022 Sony Corporation
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Kompenzace dýchání

Můžete nastavit, zda se má provést kompenzace „dýchání“ objektivu pomocí položek [Technical] > [Lens] > [Breathing
Compensation] v nabídce kamery.
Tato funkce koriguje jev, při kterém dochází ke změnám úhlu pohledu s tím, jak se mění poloha ostření.
Při provádění kompenzace dýchání je část obrazu elektronicky oříznuta tak, aby byl zachován konstantní úhel pohledu,
takže se jev dýchání neobjeví.

Poznámka

Je-li povolena kompenzace dýchání, může se úhel pohledu a kvalita obrazu mírně změnit.

V závislosti na objektivu nemusí být možné opravit změnu úhlu pohledu, když je povolena kompenzace dýchání.

Kompenzace není možná, pokud je připojen objektiv, který nepodporuje kompenzaci dýchání.

Tato funkce je nastavena na Off (pevně) v následujících případech.

Když je možnost [Technical] > [Lens] > [Distortion Comp.] nastavena na hodnotu [Off] v nabídce kamery
Když je možnost [Shooting] > [S&Q Motion] > [Setting] nastavena na hodnotu [On] ve webové nabídce nebo v nabídce kamery
Když je možnost [Project] > [Rec Format] > [Codec] nastavena na hodnotu [RAW] nebo [RAW & XAVC-I] ve webové nabídce
nebo v nabídce kamery

5-041-958-43(1) Copyright 2022 Sony Corporation

234



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přehled proxy záznamu

Tato funkce umožňuje nahrávat proxy data s nízkým rozlišením současně s nahráváním původního datového videa s
vysokým rozlišením.

Podrobnosti o podporovaných paměťových kartách, jejich formátování a kontrole zbývající kapacity naleznete v části
„Podporované paměťové karty“, „Příprava paměťových karet“.

O zaznamenaném souboru
Přípona názvu souboru je „.mp4“.
Časový kód se zaznamenává současně.

Cíl uložení zaznamenaného souboru
Zaznamenaný soubor je uložen v následujícím adresáři.

O názvu souboru
Název souboru se skládá z názvu klipu zaznamenaného na paměťové kartě a přípony „S03“.
Další informace o názvech klipů naleznete v části [TC/Media] > [Clip Name Format] v nabídce kamery.

Příbuzné téma

Podporované paměťové karty
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Záznamové médium Cesta ke složce

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Záznam proxy

Záznam můžete zahájit, je-li povolen záznam proxy.

Ukončení snímání
Zastavte záznam.

Nastavení zvukového kanálu pro proxy záznam
Nastavte zvukový kanál pro proxy záznam dat pomocí položek [Project] > [Proxy Rec] > [Audio Channel] v nabídce
kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte možnost [Project] > [Proxy Rec] > [Setting] na hodnotu [On] ve webové nabídce nebo v nabídce
kamery.

1

Vložte paměťovou kartu do slotu pro karty CFexpress Type A/SD.

U karet CFexpress štítek směřuje nahoru.
U karet SD štítek směřuje dolů.

Poznámka

Možnosti Proxy Rec nelze nastavit na volbu On současně s funkcemi S&Q Motion nebo Interval Rec. Když je funkce Proxy
Rec nastavena na volbu On, jsou uvedené další režimy záznamu vynuceně nastaveny na volbu Off.

2

Stiskněte tlačítko START/STOP záznamu.

Spustí se proxy záznam.

Poznámka

Pokud je jednotka vypnutá nebo je paměťová karta vyjmuta během v době, kdy k ní systém přistupuje, může dojít k
poškození dat na kartě.
Všechna data zaznamenaná na paměťové kartě mohou být nepoužitelná. Před vypnutím jednotky nebo vyjmutím
paměťové karty se vždy ujistěte, že indikátor přístupu na paměťovou kartu svítí zeleně nebo je zhasnutý.

Ujistěte se, že paměťová karta při vkládání nebo vyjímání nevyskočí.

3
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Přehled vzhledu

Pokud je jednotka v režimu Custom, můžete přidat úpravy k parametrům černé, matrice a dalším parametrům a vytvořit
tak „vzhled“ na základě základního vzhledu.

Uložíte-li si různé kombinace nastavení v souborech scén, můžete také rychle vybrat jiný vzhled.
Jednotka má celkem sedm přednastavených vzhledů.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Výběr vzhledu

Toto téma popisuje, jak vybrat vzhled.

Zkontrolujte, zda je možnost [Project] > [Base Setting] > [Shooting Mode] nastavena na hodnotu [Custom]
ve webové nabídce nebo v nabídce kamery.

Tip

V režimu [Custom] se v panelu základní konfigurace kamery zobrazí tlačítko [ISO/Gain] a [Scene File].

1

Stiskněte tlačítko [Scene File] v panelu základní konfigurace kamery.

Rám tlačítka [Scene File] se změní na oranžový.

Zobrazí se panel nastavení Scene File.

2

Stiskněte tlačítko [Scene File] na panelu nastavení a ze seznamu vyberte soubor scény s požadovaným
vzhledem.

Ve výchozím továrním nastavení jsou konfigurovány následující předvolby.

Tip

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Soubor scény 1 [S-Cinetone] [HLG Live]

Soubor scény 2 [Standard] [HLG Natural]

Soubor scény 3 [Still] (Neregistrováno)

Soubor scény 4 [ITU709] (Neregistrováno)

Soubor scény 5 [709tone] (Neregistrováno)

Soubor scény 6 až 16 (Neregistrováno) (Neregistrováno)
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Vzhled můžete také vybrat pomocí položek [Paint/Look] > [Scene File] > [Recall] v nabídce kamery. Přednastavený vzhled
můžete také vyvolat pomocí položky [Scene File] > [Preset Recall].

Poznámka

Předvolba souboru scény 5 je nastavena na [709tone] se softwarem verze 2.0 nebo novější. Zobrazí se, když je vykonána
položka [Maintenance] > [Reset] > [Factory Default] ve webové nabídce.
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Importování požadovaného základního vzhledu

Jako základní vzhled můžete importovat soubor 3D LUT vytvořený v počítači nebo jiném zařízení. Importovat můžete až
16 souborů.
Formát souboru: soubor CUBE (*.cube) pro 17uzlový nebo 33uzlový 3D LUT vytvořený pomocí aplikace Catalyst
Browse, RAW Viewer nebo DaVinci Resolve* (od společnosti Blackmagic Design Pty. Ltd.).

Vstupní barevný gamut/gamma: [S-Gamut3.Cine/S-Log3] nebo [S-Gamut3/S-Log3]

Ověřeno s pomocí aplikace Resolve V9.0, V10.0 a V11.0.*

Uložte soubor 3D LUT na zařízení se spuštěnou webovou aplikací.1

Otevřete možnost [Paint/Look] > [Base Look] ve webové nabídce.

Zobrazí se seznam registrovaných základních vzhledů.

2

Stiskněte tlačítko [Import] v řádku, kam chcete soubor importovat.

Zobrazí se dialogové okno výběru souborů.

3

Vyberte připravený soubor 3D LUT.

Importovaný soubor 3D LUT se stáne základním vzhledem jednotky.

4

Vyberte importovaný soubor 3D LUT pomocí položek [Paint/Look] > [Base Look] > [Select] v nabídce
kamery.

5

Nakonfigurujte možnosti [Paint/Look] > [Base Look] > [Input] a [Output] v nabídce kamery tak, aby
odpovídaly atributům importovaného souboru 3D LUT.

6
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Nastavení pro podexponování
Pokud se při použití importovaného základního vzhledu vyskytuje tendence k podexponování, nastavte možnost
[Paint/Look] > [Base Look] > [AE Level Offset] ve webové nabídce.

Poznámka

Pouhý import souboru 3D LUT nemá na obraz žádný vliv. Nahrajte importovaný soubor 3D LUT pomocí položek [Paint/Look] >
[Base Look] > [Select] v nabídce kamery.

Pokud není správně nastavena položka [Input], nebude získán správný vzhled.

Nastavení položek nabídky [Input], [Output] a [AE Level Offset] se použijí na základní vzhled vybraný pomocí položky [Select].
Pokud je importováno více souborů 3D LUT, vyberte pro každý soubor 3D LUT možnost [Select], a nakonfigurujte pro každý
soubor individuálně položky [Input], [Output], a [AE Level Offset].

Pro každý soubor 3D LUT se uloží nakonfigurovaná nastavení [Input], [Output] a [AE Level Offset].

Možnosti výběru základního vzhledu / LUT pro importované soubory 3D LUT jsou společné pro režimy snímání [SDR(BT.709)],
[HDR(HLG)] a Log, ale konverze barevného gamutu a gama se v těchto režimech neprovádějí.

Soubory 3D LUT se neodstraní, když je možnost [Maintenance] > [Reset] > [All Reset (except for Network Settings)] vykonána ve
webové nabídce.

 (Chyba přílohy souboru 3D LUT) zobrazená před displejem [Base Look Name] znamená, že soubory 3D LUT nelze připojit ke
klipům zaznamenaným v režimech snímání Log. Znovu importujte soubor 3D LUT.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Přizpůsobení vzhledu

Vzhled můžete přizpůsobit podle základního vzhledu pomocí posuvníků [Master Black], [R Black] a [B Black] v panelu
nastavení Scene File v panelu základní konfigurace kamery, dále pomocí položek [Paint/Look] > [Matrix] a dalších
položek nastavení v nabídce kamery.
Připojte jednotku k televizoru nebo monitoru a sledováním obrazu na nich zobrazeného upravte jeho kvalitu.

1: Posuvník/nastavovací tlačítka [R Black]
2: Posuvník/nastavovací tlačítka [B Black]
3: Posuvník/nastavovací tlačítka [Master Black]

Poznámka

Když importujete soubor 3D LUT a aplikujete jej na obraz, požadovaný vzhled definovaný v souboru 3D LUT nebude dosažen,
pokud dojde ke změně nastavení možnosti [Paint/Look] > [Matrix] a jiného nastavení kromě základního vzhledu v nabídce
kamery.

Všechna přizpůsobená nastavení můžete změnit pomocí položek [Paint/Look] > [Reset Paint Settings] > [Reset without Base
Look] v nabídce kamery.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Uložení vzhledu

Aktuální vzhled můžete uložit jako soubor scény do interní paměti pomocí položek [Paint/Look] > [Scene File] > [Store] v
nabídce kamery.
Aktuální vzhled můžete rychle vyvolat pomocí panelu nastavení Scene File nebo pomocí operací přímé nabídky.

Poznámka

Pokud vyberete jiný vzhled bez uložení stávajícího vzhledu, tento stávající vzhled se odstraní.

Tip

Soubory přednastavené scény můžete přepsat. Chcete-li obnovit přednastavený soubor scény, načtěte vzhled, který má být
obnoven, pomocí položky [Paint/Look] > [Scene File] > [Preset Recall] v nabídce kamery a poté uložte soubor scény pomocí
položky [Scene File] > [Store].

Odstranění uloženého vzhledu
Aktuální soubor scény uložený v interní paměti můžete odstranit pomocí položek [Paint/Look] > [Scene File] > [Delete] v
nabídce kamery.

Tip

Po odstranění se již nezobrazuje v panelu nastavení Scene File ani v přímé nabídce.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Odstranění základního vzhledu

Odstraňte importovaný soubor 3D LUT individuálně pomocí položek [Paint/Look] > [Base Look] > [Delete] v nabídce
kamery.
Odstraňte všechny importované soubory 3D LUT pomocí položek [Paint/Look] > [Base Look] > [Delete All] v nabídce
kamery.

Poznámka

Před odstraněním zkontrolujte, zda se základní vzhled nepoužívá v žádných souborech scén. Pokud je odstraněn základní
vzhled, který se používá, bude vzhled odpovídajících souborů prostředí nesprávný.

Importované soubory 3D LUT se neodstraní, když je možnost [Maintenance] > [Reset] > [All Reset (except for Network Settings)]
vykonána ve webové nabídce.

Odstraněný základní vzhled již nelze použít jako LUT v režimech snímání Log.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Snímání s úpravou vzhledu v postprodukci

Použitím jednotky v režimu snímání Log*1 a rovnoměrným záznamem gradací z tmavých do světlých míst můžete při
postprodukci provést jemné úpravy, například místní obnovení gradace tmavých světlých míst.
Při prohlížení zaznamenaných obrazů na běžném monitoru se však celkový kontrast zobrazí jako nízký, což ztěžuje
zaostření a nastavení expozice.
K usnadnění různých úprav během snímání můžete použít LUT na cíl monitorování na jednotce. Při přehrávání můžete
také použít LUT použitý při automatickém snímání a rychle tak zkontrolovat konečný výsledek.
LUT používají následující systémy. Lze však použít pouze jeden LUT.

Výstup SDI
Výstup a streamování HDMI
Klip proxy zaznamenaný na záznamovém médiu
Klip s vysokým rozlišením (hlavní) zaznamenaný na záznamovém médiu

5-041-958-43(1) Copyright 2022 Sony Corporation

Obecný termín pro režim Flexible ISO / režim Cine EI / režim Cine EI Quick*1
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Použití LUT pro výstup HDMI a streamování

LUT můžete použít pro výstup HDMI a streamování.

Poznámka

Obrázek v panelu obrazu kamery webové aplikace je také zahrnut do streamovaného obrazu.

Tip

To lze také nastavit pomocí položek [Shooting] > [LUT On/Off] > [HDMI/Stream] v nabídce kamery.

Stejným způsobem lze nastavit výstup SDI.

Pro video na záznamovém médiu toto můžete nastavit pomocí položek [Shooting] > [LUT On/Off] > [Internal Rec] a [Proxy] v
nabídce kamery.

 (Chyba přílohy souboru 3D LUT) zobrazená před displejem [Base Look/LUT] znamená, že soubory 3D LUT nelze připojit ke
klipům zaznamenaným v režimech snímání Log. Znovu importujte soubor 3D LUT.
Tato ikona se také zobrazí, když se příloha nezdaří kvůli dočasnému přetížení zpracování.

Zkontrolujte, zda je možnost [Project] > [Base Setting] > [Shooting Mode] nastavena na hodnotu [Flexible
ISO], [Cine EI] nebo [Cine EI Quick] ve webové nabídce nebo v nabídce kamery.

Tip

V režimech snímání Log se v panelu základní konfigurace kamery zobrazí tlačítko [Base ISO/Exposure Index] a [Base
Look/LUT].

1

Stiskněte tlačítko [Base Look/LUT] v panelu základní konfigurace kamery.

Rám tlačítka [Base Look/LUT] se změní na oranžový.

Zobrazí se panel nastavení Base Look/LUT.

2

Vyberte možnost [HDMI/Stream] > [MLUT].3
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Změna LUT

Můžete změnit LUT pro použití.

Tip

Jednotka poskytuje možnosti [s709], [709(800%)] a [S-Log3] jako přednastavené LUT.

Můžete také importovat a aplikovat soubor 3D LUT. Podrobnosti viz také kapitola „Importování požadovaného základního
vzhledu“ a „Odstranění základního vzhledu“.

To lze také nastavit pomocí položek [Paint/Look] > [Base Look] > [Select] v nabídce kamery.

Příbuzné téma
Importování požadovaného základního vzhledu

Odstranění základního vzhledu

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskněte tlačítko [Base Look/LUT] v panelu základní konfigurace kamery.

Rám tlačítka [Base Look/LUT] se změní na oranžový.

Zobrazí se panel nastavení Base Look/LUT.

1

Stiskněte tlačítko [Base Look/LUT] a vyberte základní vzhled, který chcete použít.2
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Změna rozložení tmavých a světlých míst v zaznamenaném snímku

V režimech Cine EI a Cine EI Quick můžete rozložení tmavých a světlých míst změnit například v případě, že chcete
nastavit prioritu tónu tmavých míst před světlými místy, a to změnou možnosti Exposure Index ze základní citlivosti.

Stiskněte tlačítko [Base Look/LUT] v panelu základní konfigurace kamery.

Rám tlačítka [Base Look/LUT] se změní na oranžový.

Zobrazí se panel nastavení Base Look/LUT.

1

Vyberte možnost [HDMI/Stream] > [MLUT].

LUT se používá pro výstup HDMI a streamování.

2

Stiskněte tlačítko [Base ISO/Exposure Index] v panelu základní konfigurace kamery.

Rám tlačítka [Base ISO/Exposure Index] se změní na oranžový.

Zobrazí se panel nastavení Base ISO/Exposure Index.

3

Upravte index expozice podle požadovaného rozložení tmavých a světlých oblastí pomocí posuvníku
[Exposure Index] nebo tlačítek nastavení [Exposure Index].

Pro [Cine EI]

Pro [Cine EI Quick]
Základní citlivost se nastaví automaticky podle zadaného indexu expozice.

4
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Tip

To lze také nastavit pomocí položek [Shooting] > [ISO/Gain/EI] > [Exposure Index] v nabídce kamery.

Stejným způsobem lze použít výstup SDI.

Druhá číselná hodnota nastavení udává, kolik kroků informace o jasu je přiřazeno světlým místům (jas je vyšší než 18% šedé).
Místa, které jsou světlejší než tato, jsou přeexponovaná.
Příklad: V možnosti „400EI/5.0E“ je světlé straně přiřazeno 5,0 kroku.

Toto můžete také použít jako vodítko ke kontrole tónu tmavých a světlých míst během snímání. Po kontrole expozice se
nezapomeňte vrátit k originální hodnotě EI. Také v režimu Cine EI Quick buďte opatrní, abyste nepříznivě neovlivnili citlivost
základny.

5-041-958-43(1) Copyright 2022 Sony Corporation

Upravte osvětlení a/nebo filtr ND tak, aby výstup obrazu kamery z [HDMI/Stream] měl odpovídající expozici.5
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Záznam videa ve formátu RAW

Výstup videosignálu ve formátu RAW z konektoru SDI OUT jednotky lze zaznamenat na podporovaném externí
rekordéru.
Níže jsou uvedeny podporované výstupní formáty RAW.

Systémová frekvence [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Připojte externí rekordér s funkcí záznamu RAW ke konektoru SDI OUT jednotky.1

Nastavte možnost [Project] > [Base Setting] > [Shooting Mode] na hodnotu [Cine EI], [Cine EI Quick] nebo
[Flexible ISO] ve webové nabídce nebo v nabídce kamery.

2

Nastavte úhel pohledu (pouze FF) pomocí možnosti [Project] > [Rec Format] > [Imager Scan Mode] ve
webové nabídce nebo v nabídce kamery.

3

Nastavte možnost [Project] > [Rec Format] > [Codec] na hodnotu [RAW] ve webové nabídce nebo v nabídce
kamery.

Výběrem možnosti [RAW & XAVC-I] současně zaznamenáte video na externí rekordér RAW a jako video na
paměťovou kartu ve jednotce.

4

Nastavte rozlišení pomocí možnosti [Project] > [Rec Format] > [RAW Output Format] ve webové nabídce
nebo v nabídce kamery.

5

Zkontrolujte, zda je externí rekordér zapnutý, a poté stiskněte tlačítko START/STOP záznamu na obrazovce
živého provozu.

Stav záznamu videa RAW je signalizován ikonou v panelu obrazu kamery.

6
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Poznámka

Při zahájení záznamu na externím rekordéru bez použití tlačítka START/STOP záznamu na obrazovce živého provozu nemusí
být klipy zaznamenány správně.
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Poznámka

Řídicí signál nahrávání je odesílán na výstup z konektoru SDI OUT jednotky, není však možné získat stav externího
rekordéru. Jednotka proto může indikovat, že probíhá nahrávání videa ve formátu RAW, i když externí rekordér ve
skutečnosti nic nenahrává. Zkontrolujte indikátor na externím rekordéru, který informuje o správném provozním stavu.
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Záznam videa RAW v režimu pomalého a rychlého pohybu

Video RAW můžete zaznamenávat v režimu pomalého a rychlého pohybu.

Podrobné informace o podporovaných snímkových frekvencích pro snímání naleznete v části „Pomalý a rychlý
pohyb“.

Příbuzné téma
Pomalý a rychlý pohyb
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Zapínání/vypínání funkce řízení efektu bokeh

Stupeň efektu bokeh můžete snadno nastavit propojením filtru ND a zesílení s činností clony.

Zapínání/vypínání funkce řízení efektu bokeh

Tuto funkci lze aktivovat pouze při ručním nastavení expozice. Nastavte filtr ND do variabilního režimu a potom nastavte
clonu, zesílení, závěrku a filtr ND na ruční nastavení.
Funkci ovládání bokeh můžete zapnout/vypnout pomocí položek [Shooting] > [Iris] > [Bokeh Control] v nabídce kamery.
Je-li funkce řízení efektu bokeh nastavena na možnost On, na filtru ND se zobrazí ikona  (B) a indikátory zesílení.

Poznámka

Tato funkce je povolena pouze na objektivech E-Mount, které mohou komunikovat s jednotkou.

Maximálního efektu této funkce lze dosáhnout pomocí objektivu Sony E-mount.

Funkce řízení efektu bokeh je nastavena na volbu Off, pokud provedete některou z následujících operací.

Je-li jednotka vypnutá
Je-li některý z filtrů clony, zesílení, závěrky nebo ND nastaven na hodnotu Auto
Pokud je režim snímání přepnut
Pokud je filtr ND nastaven na režim vymazání nebo přednastavené hodnoty
Při sejmutí objektivu
Když se jednotka restartuje, například po přepnutí frekvence

Tip

Funkci [Bokeh Control] můžete také přiřadit přiřaditelnému tlačítku a pomocí tlačítka přepínat funkci řízení efektu bokeh meziOn a
Off.
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Nastavení stupeň efektu bokeh

Upravte nastavení v krocích 2 až 4 podle potřeby.

Poznámka

Vzhled se může lišit v závislosti na rychlosti provozu, objektivu, nastavení snímání a objektu a také se může změnit jas. Před
záznamem se důrazně doporučuje provést kamerový test.

Jas se může změnit, když se změní směr chodu clony, například při otevírání clony po jejím zavření nebo při zavírání clony po
jejím otevření. V tomto případě seřiďte o něco více, než je předem požadováno, a pak nastaven upravte mírně zpět, zkontrolujte
jas a pak začněte snímat. Pokud například chcete otevřít clonu na F8 a rozmazat pozadí, nejprve uzavřete clonu za hodnotou F8
a poté se vraťte na hodnotu F8, zkontrolujte jas a začněte snímat.

Provádějte operace řízení efektu bokeh pomalu. Potřebujete-li operaci urychlit, zkuste ji upravovat postupně při kontrole změn
obrazu.

Tip

Je-li funkce řízení efektu bokeh nastavena na možnost On, filtr ND a zesílení pracují společně, aby kompenzovaly změny
expozice způsobené nastavením clony, což vám umožní změnit stupeň efektu bokeh.

Řízení efektu bokeh se nejprve spojí s filtrem ND v reakci na činnosti clony. Pokud již nelze filtr ND změnit, zesílení je propojeno.

V režimu MF se doporučuje nejprve otevřít clonu a poté upravit zaostření.

Pokud použijete automatický filtr ND namísto funkce řízení efektu bokeh, filtr ND následuje po změně jasu objektu.

Zobrazení během operace propojení zesílení
Je-li funkce řízení efektu bokeh nastavena na možnost On, zesílení se může měnit při nastavení clony.
Když je spojení zesílení aktivní a toto zesílení se změní, zobrazí se v horní části obrazovky zpráva a na indikátoru
zesílení začne blikat ikona  (B).

Přepněte funkci řízení efektu bokeh do stavu On.1

Úplně otevírá clonu.2

Nastavte funkci ND Filter na hodnotu 1/128.3

Nastavte zesílení na hodnotu 0 dB a použijte osvětlení, abyste získali správnou expozici.4

Nastavte zaostření.5

Nastavuje clonu.

Stupeň efektu bokeh se změní.

6
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Přehled ukládání a načítání dat konfigurace

Nastavení jednotky můžete uložit jako konfigurační data pomocí webové aplikace. To vám umožní rychle vyvolat
příslušnou sadu nastavení nabídky pro aktuální situaci.
S touto jednotkou můžete uložit téměř všechna nastavení související s funkcemi kamery, kromě následující poznámky,
jako soubor ALL (soubor se všemi nastaveními).

Poznámka

Nastavení funkcí sítě a informace o ověření se neukládají. Podrobnosti o uložených položkách naleznete v části „Seznam
položek nabídky“.

Příbuzné téma

Seznam položek nabídky
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Ukládání souboru ALL

Toto téma popisuje, jak uložit soubor ALL.
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Otevřete možnost [Project] > [All File] ve webové nabídce.1

Stiskněte tlačítko [Save All File] > [Save].

Webový prohlížeč stáhne soubor s názvem all-file.ALL.

2

Zadejte umístění a název souboru pro stažený soubor all-file.ALL a uložte jej.

Podrobnosti o operacích se souborem naleznete v uživatelské příručce zařízení.

3
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Načítá ALL soubor

Toto téma popisuje, jak načíst soubor ALL.

Poznámka

Po načtení dat konfigurace se jednotka automaticky restartuje. Po restartu stránku znovu načtěte do webového prohlížeče.
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Otevřete možnost [Project] > [All File] ve webové nabídce.1

Stiskněte tlačítko [Load All File] > [Load].

Na zařízení se spuštěnou webovou aplikací se zobrazí dialogové okno Otevřít soubor.

2

Otevřete soubor, který chcete načíst.

Podrobnosti o operacích se souborem naleznete v uživatelské příručce zařízení.

3

Jakmile se zobrazí obrazovka potvrzení názvu souboru, stiskněte tlačítko [OK].4

Jakmile se zobrazí obrazovka vykonání výsledku, stiskněte tlačítko [OK].5

Vyčkejte na restartování jednotky, a poté znovu připojte webovou aplikaci.6
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O přenosu souborů

Můžete odeslat proxy soubor nebo původní soubor zaznamenaný ve jednotce na servery na Internetu nebo v místní síti.

Poznámka

Pokud je napájení nastaveno do pohotovostního stavu, přenosy souborů se pozastaví, i když je jednotka stále zapnutá.
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Registrace cílového umístění pro přenos souborů

Před zahájením přenosu souborů můžete zaregistrovat cílový server přenosu.

Vyberte možnost [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (nebo [Server
Settings2], [Server Settings3]) ve webové nabídce.

Tip

Název možnosti výběru se změní podle možnosti [Display Name] nakonfigurovaného v dalším kroku.

1

Nastavte následující položky pro možnost [Network] > [FTP Server 1] až [FTP Server 3] ve webové nabídce.

[Display Name]
Při výběru cílového serveru přenosu zadejte název serveru, který se má zobrazit v seznamu úloh přenosu.
[Service]
Zobrazí typ serveru.
[FTP]: server FTP
[Host Name]
Zadejte adresu nebo název hostitele serveru.
[Port]
Zadejte číslo portu serveru, ke kterému se chcete připojit.
[User Name]
Zadejte uživatelské jméno.
[Password]
Zadejte heslo.
[Passive Mode]
Zapnutí/vypnutí pasivního režimu.
[Destination Directory]
Zadejte název adresáře na cílovém serveru.

Poznámka

Pokud jsou na cílovém serveru zadány do položky [Destination Directory] znaky, které jsou neplatné, budou soubory
přeneseny do domovského adresáře uživatele. Neplatné znaky se budou lišit v závislosti na serveru.

[Using Secure Protocol]
Nastavte, zda chcete provádět zabezpečené přenos na server FTP.
[Root Certificate]
Načtení/vymazání certifikátu.
[Load]: Načtěte certifikát CA. Načte certifikáty ve formátu PEM.
[Clear]: Vymažte certifikát CA.
[None]: Nenahrávejte ani nevymazávejte certifikát.

Poznámka

Před načtením certifikátu CA nastavte hodiny jednotky na správný čas.

Při záznamu v režimu XAVC-I 4096×2160P / 3840×2160P 59.94/50P nelze zvolit položku [Load].

[Root Certificate Status]: Zobrazuje stav načtení certifikátu.

2
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[Reset]:Resetuje nastavení Server Settings na výchozí hodnoty.
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Nahrávání proxy souboru na paměťovou kartu z obrazovky miniatur

Můžete nahrát proxy soubor na paměťovou kartu z obrazovky miniatur.

Poznámka

Zaregistrovat můžete až 200 úloh přenosu.
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Stiskněte tlačítko [Thumbnail] na obrazovce živého provozu webové aplikace.

Zobrazení se přepne z obrazu kamery na obrazovku miniatur.

1

Vyberte možnost [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] v nabídce kamery.

Chcete-li současně přenášet všechny proxy soubory, vyberte možnost [Transfer Clip (Proxy)] > [All Clips].
Klipy lze přenést z obrazovky miniatur nebo z obrazovky miniatur filtrovaných klipů.

2

Pomocí tlačítka [Set] vyberte klip, který chcete přenést, a stiskněte tlačítko [Menu].

Zobrazí se obrazovka potvrzení přenosu.

3

Vyberte možnost [Execute].

Proxy soubor odpovídající vybranému klipu je zaregistrován jako úloha přenosu a nahrávání je zahájeno.
Po úspěšné registraci úlohy přenosu se zobrazí obrazovka s jeho výsledky.

4

Stiskněte tlačítko [OK].5
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Nahrávání původního souboru na paměťovou kartu z obrazovky miniatur

Můžete nahrát původní soubor na paměťovou kartu z obrazovky miniatur.

Poznámka

Zaregistrovat můžete až 200 úloh přenosu.
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Stiskněte tlačítko [Thumbnail] na obrazovce živého provozu webové aplikace.

Zobrazení se přepne z obrazu kamery na obrazovku miniatur.

1

Vyberte možnost [Thumbnail] > [Transfer Clip] > [Select Clip] v nabídce kamery.

Chcete-li současně přenášet všechny originální soubory, vyberte možnost [Transfer Clip] > [All Clips].
Klipy lze přenést z obrazovky miniatur nebo z obrazovky miniatur filtrovaných klipů.

2

Pomocí tlačítka [Set] vyberte klip, který chcete přenést, a stiskněte tlačítko [Menu].

Zobrazí se obrazovka potvrzení přenosu.

3

Vyberte možnost [Execute].

Původní soubor odpovídající vybranému klipu je zaregistrován jako úloha přenosu a nahrávání je zahájeno.
Po úspěšné registraci úlohy přenosu se zobrazí obrazovka s jeho výsledky.

4

Stiskněte tlačítko [OK].5
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Kontrola stavu přenosu souborů

Stav přenosu souborů můžete zkontrolovat výběrem položek [Network] > [File Transfer] > [View Job List] v nabídce
kamery.

Poznámka

Zaregistrovat můžete až 200 úloh přenosu.

Úlohy přenosu zůstanou zachovány po přepnutí jednotky do pohotovostního stavu, ale až 10 minut posledních informací o
průběhu může být ztraceno, pokud je napájení odpojeno jiným způsobem.

Pokud dojde k chybě během přenosu souboru, přenos klipu se stejným názvem jaký má přenesený klip nemusí být obnoven, a to
v závislosti na nastavení a stavu cílového serveru přenosu. V takovém případě zkontrolujte nastavení a stav cílového serveru
přenosu.

Tip

Pokud je možnost [Network] > [File Transfer] > [Auto Upload (Proxy)] nastavena na hodnotu [On] v nabídce kamery a je k
dispozici síťové připojení, jsou po ukončení nahrávání proxy soubory automaticky odeslány na server určený pomocí funkce
[Default Upload Server].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Odesílání pomocí protokolu Secure FTP

Šifrované soubory můžete nahrát pomocí protokolu FTPS v explicitním režimu (FTPES) pro připojení k cílovému
souborovému serveru.
Chcete-li provést přenos protokolem Secure FTP, nastavte možnost [Using Secure Protocol] na hodnotu [On] na cílovém
souborovém serveru a nahrajte certifikát.

Podrobnosti o konfiguraci viz „Registrace cílového umístění pro přenos souborů“.

Příbuzné téma

Registrace cílového umístění pro přenos souborů
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O streamování

Jednotka může současně vysílat video a zvuk, který je odesílán na výstup z konektoru HDMI.

Poznámka

Chcete-li streamování použít jako hlavní video, nastavte položku [Monitoring] > [Output Display] > [SDI] na hodnotu [On] a
položku [HDMI/Stream] na hodnotu [Off] ve webové nabídce a sledujte stav kamery na monitoru SDI.

Je-li monitor připojen ke konektoru HDMI, který nepodporuje výstupní formát HDMI nakonfigurovaný pomocí nabídky [Monitoring]
ve webové nabídce nebo v nabídce kamery, obraz kamery se do webové aplikace neodešle. Streamované video také nelze
odeslat na výstup.

Rozlišení streamování nelze nastavit na vyšší hodnotu než je rozlišení výstupního signálu HDMI.

Při prohlížení více uživateli může dojít ke zkreslení obrazu v závislosti na nastavení kodeku.

Tato jednotka podporuje následující metody streamování. Video kodeky, které jsou k dispozici pro výběr, jsou uvedeny v
závorce.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Nakonfigurujte nastavení formátu streamování, nastavení video a audio kodeku v uvedeném pořadí.

●: Zapnuto, –: Vypnuto

Tip

Obrázek v panelu obrazu kamery webové aplikace je také zahrnut do streamujícího systému.

Formát streamování
Nastavení kodeku

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Webová aplikace – – ● –

RTMP lze vybrat, když je možnost [Stream] > [Audio Stream] nastavena na hodnotu [On] ve webové nabídce.*1

Pokud je systémová frekvence 59.94 nebo 50 a výstupní formát HDMI je 3840×2160 nebo vyšší, výstup video 2 není k dispozici.*2
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Nastavení formátu streamování

Nastavte formát streamování pomocí položek [Stream] > [Stream] > [Stream Setting] > [Setting] ve webové nabídce.

Když je možnost [Setting] nastavena na volbu [RTSP]

Při RTSP streamování může obraz z jedné kamery sledovat až pět uživatelů současně.
Můžete nastavit až dva režimy video kodeku.
[Port Number]
Nastavuje číslo portu, který má být použit pro RTSP streamování. Výchozí nastavení je 554.
Změna nastavení restartuje RTSP server.
[Time Out]
Určuje časový limit příkazu Keep-Alive pro RTSP streamování. Časový limit lze nastavit v rozsahu 0 sekund až 600
sekund. Výchozí hodnota je 60 sekund.
Při nastavení na 0 sekund nedojde k uplynutí časového limitu v důsledku příkazu Keep-Alive.
[Authentication]
Nastavuje, zda je vyžadováno ověření.
[Video Port Number 1], [Video Port Number 2]
Určuje číslo portu pro přenos obrazových dat, který má být použit pro RTSP unicast streamování. Výchozí tovární
nastavení pro Video Port Number 1 je 51000. Výchozí tovární nastavení pro Video Port Number 2 je 53000. Zadejte sudé
číslo v rozsahu 1024 až 65534. Číslo nastavené zde a následné liché číslo získané přidáním 1 se stávají dvěma čísly
portů používanými pro přenos a řízení obrazových dat.
Možnosti [Video Port Number 1] a [Video Port Number 2] odpovídají možnostem [Stream] > [Video Stream] > [Video
Stream 1] a [Video Stream 2].
[Audio Port Number]
Určuje číslo portu pro přenos zvukových dat, který má být použit pro RTSP unicast streamování. Výchozí nastavení je
57000. Zadejte sudé číslo v rozsahu 1024 až 65534. Číslo nastavené zde a následné liché číslo získané přidáním 1 se
stávají dvěma čísly portů používanými pro přenos a řízení zvukových dat.

Když je možnost [Setting] nastavena na volbu [RTMP]

Režim video kodeku, který lze použít pro RTMP, je pouze H.264. Chcete-li použít RTMP, musí být možnost [Stream] >
[Audio Stream] nastavena na volbu [On] ve webové nabídce.
[Server URL]
Nastavuje cílovou adresu URL nahrávání. Zadejte řetězec znaků začínající „rtmp://“ nebo „rtmps://“.
[Stream Key]
Zadejte klíč streamu získaný ze webu, který používáte. Stisknutím tlačítka [Clear] se položka vymaže.

Poznámka

Při manipulaci s klíčem streamu buďte opatrní. Pokud je klíč streamu znám třetí straně, hrozí riziko zfalšování streamu.

[Root Certificate]
Importuje kořenový certifikát požadovaný pro streamování pomocí protokolu RTMPS. Chcete-li importovat kořenový
certifikát, stiskněte tlačítko [Load] a vyberte kořenový certifikát. Stiskněte tlačítko [OK] v dialogovém okně výběru
souboru pro import vybraného souboru do jednotky. Pokud je v jednotce importován kořenový certifikát, bude kořenový
certifikát aktualizován. Pro odstranění importovaného kořenového certifikátu stiskněte tlačítko [Delete] na obrazovce
nastavení. Stav kořenového certifikátu se zobrazuje v části [Root Certificate Status].

Poznámka
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Importujte kořenový certifikát požadovaný streamovací službou.

Když je možnost [Setting] nastavena na volbu [SRT-Caller] nebo [SRT-Listener]

Režim video kodeku je pouze H.264.
[Destination]
Zobrazuje se, když je režim streamování nastaven na volbu [SRT-Caller]. Nastavuje cílovou adresu URL připojení.
[Port Number]
Zobrazuje se, když je režim streamování nastaven na volbu [SRT-Listener]. Nastavuje číslo portu, na kterém má být
nasloucháno. Výchozí nastavení je 4201.
[Latency]
Nastaví latenci v rozsahu 20 ms až 8000 ms. Výchozí nastavení je 120.
[TTL]
Nastavuje hodnotu TTL v rozsahu 1 až 255. Výchozí nastavení je 64.
[Encryption]
Volí metodu šifrování. Vyberte možnost Off, AES128 nebo AES256. Výchozí hodnota je Off.
[Passphrase]
Nastavuje přístupové heslo použité pro šifrování. Stisknutím tlačítka [Clear] resetujete nakonfigurované přístupové heslo.
[ARC]
Chcete-li aktivovat funkci Adaptive Rate Control, nastavte ji na hodnotu On.
Když je povolena funkce Adaptive Rate Control, mohou být přerušení obrazu způsobená přetížením komunikačních linek
snížena.

Když je možnost [Setting] nastavena na volbu [NDI|HX]

Jednotka splňuje požadavky funkce NDI|HX verze 2 od společnosti NewTek.
Chcete-li použít funkci NDI|HX, musíte zakoupit licenční klíč.
Zakoupení licenčního klíče
Nákup můžete uskutečnit na následující adrese URL NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Poznámka

Stáhněte si nejnovější ovladač NDI|HX a nainstalujte si jej do produktu NewTek.

Podrobnosti o registraci a obsluze funkce NDI|HX naleznete v uživatelské příručce výrobku NewTek.

[License]
Zobrazí informace o licenci pro povolenou licenci.
[Source Name]
Zobrazuje název zdroje.
[Group]
Chcete-li aktivovat funkci seskupování NDI, nastavte ji na hodnotu On.
[Group Name]: Nastavuje název skupiny NDI. Více nastavení je možné nakonfigurovat s oddělením čárkou.
[Discovery Server 1], [Discovery Server 2]
Nastavuje NDI server zjišťování 1 a NDI server zjišťování 2.
[Reliable UDP Mode]
Chcete-li aktivovat režim Reliable UDP, nastavte možnost na hodnotu On.
[Multicast Mode]
Chcete-li aktivovat vícesměrové streamování, nastavte možnost na hodnotu On.
[Multicast Prefix]: Nastavuje předponu pro použití ke vícesměrovému streamování.
[Multicast Netmask]: Nastavuje masku sítě, která určuje rozsah adres vícesměrového streamování.
[Multicast TTL]: Nastavuje hodnotu TTL pro vícesměrové streamování v rozsahu 1 až 256. Výchozí nastavení je 3.
[Multi-TCP Mode]
Chcete-li aktivovat režim Multi-TCP, nastavte možnost na hodnotu On.
[Unicast UDP Mode]
Chcete-li aktivovat režim Unicast UDP, nastavte možnost na hodnotu On.
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O službách a softwaru třetích stran
Mohou platit odlišné podmínky použití.

Poskytování služeb a aktualizací softwaru může být přerušeno nebo ukončeno bez předchozího upozornění.
Popis služeb a softwaru se může změnit bez upozornění.
Může být nutná samostatná registrace a předplatné.

Společnost Sony nenese odpovědnost za žádné nároky vznesené uživateli nebo třetí stranou v důsledku používání
služeb a softwaru jiných společností.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení video kodeku pro streamování

Nastavte videokodek pomocí položek [Stream] > [Video Stream] ve webové nabídce.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Můžete nastavit až tři režimy obrazového kodeku. Nakonfigurujte následující nastavení zvlášť pro každý režim obrazu.
[Video Stream 3] se používá pro zobrazení panelu obrazu kamery webové aplikace.

Poznámka

Když je možnost [Stream] > [Stream Setting] > [Setting] nastavena na volbu [RTMP], [SRT-Caller] nebo [SRT-Listener], některá z
nastavení [Video Stream 1], [Video Stream 2] a [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])
mají výchozí hodnoty.

[Codec 1], [Codec 2], [Codec 3]
Vyberte možnost [H.264], [H.265] nebo [Off]. Upozorňujeme, že možnost [Codec 1] nelze nastavit na hodnotu [Off]. Také
možnost [Codec 3] je nastavena na hodnotu [JPEG] (pevné).

Poznámka

Následující příznaky se mohou objevit v závislosti na kombinaci různých nastavení, jako je velikost obrazu, počet snímků za
sekundu a přenosová rychlost [Codec 1], [Codec 2] a [Codec 3].

Zvýšená latence videa.
Přeskakování snímků během přehrávání.
Přerušovaný zvuk.
Pomalá odezva kamery na různé příkazy.
Pomalá odezva kamery na obsluhu dálkovým ovladačem.
Zobrazení a konfigurace obrazovky monitorování pomalé odezvy.

Pokud zaznamenáte tyto příznaky, snižte hodnoty velikosti obrazu, počet snímků za sekundu a parametrů přenosové rychlosti
nebo změňte hodnoty jiných parametrů nastavení, abyste problém vyřešili.

Když je možnost [Stream] > [Stream Setting] > [Setting] nastavena na hodnotu [RTMP], [SRT-Caller] nebo [SRT-Listener],
možnost [Codec 1] je nastavena na hodnotu [H.264] (pevné). Možnost [Codec 2] je nastavena na hodnotu [Off] (pevné).

Když se změní velikost obrazu nebo systémová frekvence výstupu HDMI, možnost [Codec 2] je nastavena na hodnotu [Off].

[Size 1], [Size 2], [Size 3]
Zvolí velikost obrazu pro streamování z kamery.
Dostupné možnosti velikosti obrazu se budou lišit v závislosti na velikosti obrazu výstupu HDMI.

Poznámka

Když se změní velikost obrazu nebo systémová frekvence výstupu HDMI, je vybrána maximální velikost obrazu.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Nastavuje snímkovou frekvenci obrazu.
Jednotky „fps“ udávají počet snímků streamovaných za sekundu.
Dostupné možnosti snímkové frekvence se budou lišit v závislosti na velikosti obrazu výstupu HDMI.

Poznámka
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Když se změní velikost obrazu nebo systémová frekvence výstupu HDMI, je vybrána maximální snímková frekvence.

[I-Picture Mode 1], [I-Picture Mode 2]
Vybírá metodu pro zadání intervalu vložení obrazu I pro H.264 a H.265 z položek [Time] nebo [Frame].
Nelze nastavit pro [Codec 3].
[Time]: Nastavuje interval vložení obrazu I jako čas.
[Frame]: Nastavuje interval vložení obrazu I jako počet snímků.
[I-Picture Interval 1], [I-Picture Interval 2]
Nastavuje interval vložení obrazu I v jednotkách sekund. Nastavuje hodnotu v rozsahu 1 až 5 sekund. Výchozí hodnota
je 1 sekunda.
Nelze nastavit pro [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Nastavuje interval vložení obrazu I pro H.264 a H.265 jako počet snímků v rozsahu 15 až 300. Výchozí hodnota je 300
snímků.
Nelze nastavit pro [Codec 3].
[Profile 1], [Profile 2]
Nastavuje profil obrazového kodeku H.264 nebo H.265.
[H.264]: Vyberte profil [high], [main] nebo [baseline].
[H.265]: Vyberte profil [main] nebo [main10]. Jsou-li povoleny dva video kodeky, je k dispozici pouze možnost výběru
profilu [main].
Účinnost komprese obrazu se zvyšuje v pořadí [high], [main] a [baseline]. Vyberte profil podporovaný vaším systémem.
Když je možnost [H.265] nastavena na hodnotu [main10], operace je v [main10], když je výstup HDMI YCrCb, nebo
[main], když je výstup HDMI RGB.
Nelze nastavit pro [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Vyberte možnost [CBR] nebo [VBR].
Chcete-li zachovat konstantní přenosovou rychlost, vyberte možnost [CBR]. Chcete-li zachovat kvalitu obrazu, vyberte
položku [VBR].
Nelze nastavit pro [Codec 3].

Poznámka

Skutečně streamovaná snímková frekvence a přenosová rychlost se mohou lišit od nastavených hodnot v závislosti na velikosti
obrazu, scéně snímání, síťovém prostředí a dalších faktorech.

Když je možnost [Stream] > [Stream Setting] > [Setting] nastavena na hodnotu [RTMP], [SRT-Caller] nebo [SRT-Listener],
možnost [Bit Rate Compression Mode 1] je nastavena na hodnotu [CBR] (pevné).

[Bit Rate 1], [Bit Rate 2]
Pokud je možnost [Bit Rate Compression Mode] nastavena na hodnotu [CBR], můžete nastavit bitovou rychlost pro video
streamování. Nastavení vysoké přenosové rychlosti umožňuje streamovat video ve vysoké kvalitě obrazu.
Nelze nastavit pro [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Nastavuje kvalitu obrazu v rozsahu 1 až 10. Hodnota 10 nastavuje nejvyšší kvalitu obrazu. Výchozí nastavení je 6.
Pro možnosti [Quality 1] a [Quality 2] můžete nastavit kvalitu obrazu H.264 nastavením parametru [Bit Rate Compression
Mode] na hodnotu [VBR] a parametru [Codec] na hodnotu [H.264]. Kvalitu obrazu H.265 můžete nastavit nastavením
parametru [Bit Rate Compression Mode] na hodnotu [VBR] a parametru [Codec] na hodnotu [H.265].

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení zvukového kodeku pro streamování

Nastavte zvukový kodek pomocí položek [Stream] > [Audio Stream] ve webové nabídce.
[Setting]
Chcete-li aktivovat streamování zvuku, nastavte možnost na hodnotu On.

Poznámka

Pro výběr RTMP vždy nastavte On předem.

[Codec]
Volí typ kodeku, který se použije pro streamování zvuku.
[AAC (256kbps)]: Vyberte pro upřednostnění kvality zvuku.
[AAC (128kbps)]: Vyberte pro upřednostnění datové kapacity.
Toto nastavení nemá žádný vliv na klip zaznamenaný jednotkou nebo na zvukový signál vložený do signálu HDMI/SDI.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spuštění/zastavení streamování

For [RTSP], [SRT-Listener] a [NDI|HX]

Jednotka čeká na požadavek na doručení streamu.
Spusťte klientskou aplikaci pro prohlížení streamování a přistupte k adrese URL zobrazené v následující tabulce.
Zadejte hodnoty pro uživatelské jméno a heslo, které jsou nakonfigurovány na jednotce.

<camera_address>: IP adresa jednotky
<Port>: Konfigurace portu posluchače pomocí [Port Number]

Poznámka

Přehrávání ve všech aplikacích nebo zařízeních není zaručeno.

Pro [RTMP] a [SRT-Caller]

Stisknutím tlačítka [Stream now] na kartě  (Stream) obrazovky živého provozu zahájíte streamování. Popisek tlačítka
se změní na [Stop stream] a v horní části panelu obrazu kamery se zobrazí ikona [Stream].
Stisknutím tlačítka [Stop stream] během streamování jej zastavíte. Popisek tlačítka se změní zpět na [Stream now] a v
horní části panelu obrazu kamery zmizí ikona [Stream].

Poznámka

Přehrávání ve všech aplikacích nebo zařízeních není zaručeno.

5-041-958-43(1) Copyright 2022 Sony Corporation

Formát streamování URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Viz uživatelská příručka klientského zařízení kompatibilního s NDI|HX.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka miniatur

Po stisknutí tlačítka [Thumbnail] na obrazovce operace přehrávání nebo tlačítka THUMBNAIL na infračerveném
dálkovém ovladači se klipy zaznamenané na paměťové kartě zobrazí na panelu obrazu kamery. Tento displej na panelu
obrazu kamery se nazývá obrazovka miniatur.
Na obrazovce miniatur můžete vybrat klip a spustit přehrávání tohoto klipu.
Stisknutím tlačítka [Thumbnail] během zobrazení obrazovky miniatur zavřete tuto obrazovku miniatur a vrátíte se k
zobrazení snímaného obrazu.

Poznámka

Na obrazovce miniatur se zobrazí pouze klipy zaznamenané v aktuálně vybraném formátu záznamu. Pokud se očekávaný
zaznamenaný klip nezobrazí, zkontrolujte formát záznamu. Před formátováním (inicializací) média si tuto informaci
poznamenejte.

Rozvržení obrazovky

Miniatura vybraného klipu se zobrazí s oranžovým pozadím.
Informace o vybraném klipu se zobrazuje v dolní části obrazovky.
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Vybraná paměťová karta
Pokud je paměťová karta chráněna proti zápisu, zobrazí se ikona uzamčení.

1.

Číslo klipu / celkový počet klipů2.

Miniatura (indexový obrázek)
Zobrazuje indexový obrázek klipu. Po záznamu klipu se první snímek automaticky nastaví jako indexový obrázek.
Pod miniaturou se zobrazí informace o klipu/snímku. Zobrazené informace můžete změnit pomocí položek
[Thumbnail] > [Customize View] > [Thumbnail Caption] v nabídce kamery.

3.

Název klipu
Zobrazuje název vybraného klipu.

4.

Formát záznamu
Zobrazuje formát souboru vybraného klipu.

5.

Zvláštní informace o záznamu
Zobrazuje režim záznamu pouze v případě, že byl klip zaznamenán pomocí zvláštního režimu záznamu.
U klipů zaznamenaných v režimu pomalého a rychlého pohybu se snímková frekvence zobrazuje vpravo.

6.

Délka klipu7.

Datum vytvoření8.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přehrávání zaznamenaných klipů

Zaznamenané klipy můžete přehrávat, pokud je jednotka v pohotovostním režimu záznamu (Stby).
Toto téma popisuje, jak přehrávat zaznamenané klipy pomocí ovládacího panelu grafického uživatelského rozhraní.

Vložte paměťovou kartu, jejíž obsah chcete přehrát.1

Stiskněte tlačítko [Thumbnail].

Zobrazí se miniatury klipu.

2

Pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní přesuňte kurzor na
miniaturu klipu, který chcete přehrát.

3
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Poznámka

Na rozhraní mezi klipy může dojít k chvilkovému přerušení obrazu nebo zobrazení statického obrazu. Během této doby nelze
jednotku ovládat.

Poznámka

Klipy nelze vybrat dotykovým ovládáním.

Stiskněte tlačítko [Set] v ovládacím panelu grafického uživatelského rozhraní.

Přehrávání začne od začátku vybraného klipu.

4

Ovládací panel přehrávání ovládejte podle potřeby.

Tip

Provoz můžete také ovládat pomocí ovládacího panelu grafického uživatelského rozhraní.

Přehrát: Stiskněte tlačítko [Set].
Pozastavení přehrávání: Stiskněte tlačítko [Set] během přehrávání. Opětovným stisknutím tlačítka se vrátíte k
normálnímu přehrávání.
Přejděte na začátek klipu/začátek následujícího klipu: Stiskněte tlačítko vlevo/vpravo.
Rychle vpřed/vzad: Stiskněte a podržte tlačítko vlevo/vpravo. Když tlačítko uvolníte, přehrávání se vrátí k normální
rychlosti.
Zastavení přehrávání: Stiskněte tlačítko [Cancel/Back].

5

Tlačítko Funkce

Tlačítko  (Přehrát/Pozastavit) Přehrává klip. Během přehrávání pozastaví klip.

Tlačítko  (Rychle vpřed), tlačítko
 (Rychle vzad)

Přehraje klip vysokou rychlostí. Když stisknete toto tlačítko, změní se
rychlost přehrávání ve třech krocích.

Tlačítko  (Předchozí), tlačítko 
(Další)

Přejde na začátek klipu nebo předchozí/následující klip.

Tlačítko  (Stop) Zastavuje přehrávání a přepíná na obrazovku snímání.
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Pokud vyberete klip na obrazovce miniatur a spustíte přehrávání, může se na začátku klipu krátkodobě obraz deformovat.
Chcete-li zobrazit začátek klipu bez deformace,, pozastavte přehrávání, stiskněte tlačítko  (Předchozí), vraťte se na začátek
klipu a znovu přehrávání spusťte.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Operace se zaznamenanými klipy

Na obrazovce miniatur můžete klipy ovládat nebo zkontrolovat vlastnosti klipu pomocí nabídky [Thumbnail] nabídky
kamery.
Stisknutím tlačítka [Menu] na obrazovce operace přehrávání zobrazíte nabídku kamery v panelu obrazu kamery.
Následující operace můžete provést pomocí nabídky [Thumbnail] v nabídce kamery.
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Tip

Můžete také stisknout tlačítko [Menu] na obrazovce živého provozu a zobrazit nabídku kamery.

Obsluha pomocí položky [Thumbnail] v nabídce kamery
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Pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní vyberte obsluhovanou funkci a
stiskněte tlačítko [Set].
Stiskněte tlačítko [Cancel/Back] a vraťte se na předchozí obrazovku.

Poznámka

Některé položky nelze vybrat v závislosti na stavu, kdy byla nabídka zobrazena.

Položky nabídky pro operace s klipem

Nabídka [Thumbnail] v nabídce kamery obsahuje následující položky nabídky související s operacemi s klipem.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Podrobné informace o položkách nabídky naleznete v nabídce [Thumbnail].

Zobrazení obrazovky vlastností klipu
Výběrem možnosti [Thumbnail] > [Display Clip Properties] v nabídce kamery zobrazte obrazovku vlastností klipu.
Stisknutím tlačítka  (Předchozí) nebo  (Další) přejdete na předchozí/další klip.

Přidání značek klipu
Do klipů můžete přidat značky klipů (OK, NG nebo KP) a filtrovat tak zobrazení klipů na základě jejich značek.
Vyberte miniaturu klipu, ke které chcete přidat značku, a poté vyberte značku klipu pomocí položky [Thumbnail] > [Set
Clip Flag] v nabídce kamery.

Tip

K přidání značky klipu můžete také použít přiřaditelné tlačítko s funkcí značky klipu.

Zobrazení obrazovky miniatur filtrovaného klipu
Vyberte možnost [Thumbnail] > [Filter Clips] v nabídce kamery a pak vyberte typ značky klipu, čímž zobrazíte pouze klipy
se zadanou značkou.
Chcete-li zobrazit všechny klipy, vyberte možnost [All].
Pro řazení zobrazení miniatur podle značek můžete také stisknout tlačítko [Display].

Odstranění klipů
Klipy můžete z paměťových karet také odstranit.
Vyberte možnost [Thumbnail] > [Delete Clip] > [Select Clip] nebo [All Clips] v nabídce kamery.
[Select Clip]:Odstraní vybraný klip. Je podporován výběr více klipů.
[All Clips]: Odstraní všechny zobrazené klipy.

Změna informací zobrazených na obrazovce miniatur

Nastavení Přidaná značka klipu

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Informace o klipu/snímku zobrazené pod miniaturou můžete změnit.
V nabídce kamery vyberte možnost [Thumbnail] > [Customize View] > [Thumbnail Caption] a zvolte informace, které
chcete zobrazit.
[Date Time]: Zobrazuje datum a čas vytvoření a poslední úpravy klipu.
[Time Code]: Zobrazuje časový kód.
[Duration]: Zobrazuje dobu trvání klipu.
[Sequential Number]: Na každé miniatuře zobrazuje pořadové číslo.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfigurace nabídky kamery

Po stisknutí tlačítka [Menu] v ovládacím panelu grafického uživatelského rozhraní nebo tlačítka MENU na infračerveném
dálkovém ovladači se v panelu obrazu kamery zobrazí nabídka kamery pro konfigurování různých požadovaných
nastavení pro snímání a přehrávání.

Nabídka obsahuje následující položky/podnabídky.

Konfigurace nabídky

Nabídka [User]
Obsahuje položky nabídky konfigurované uživatelem.
Lze upravit pomocí položky [Edit User Menu].
Nabídka [Edit User]
Obsahuje položky nabídky pro úpravu nabídky [User].
Nabídka [Shooting]
Obsahuje nastavení související se snímáním/filmováním.
Nabídka [Project]
Obsahuje základní nastavení projektu.
Nabídka [Paint/Look]
Obsahuje nastavení související s kvalitou obrazu.
Nabídka [Pan-Tilt]
Obsahuje nastavení související s posunem/naklápěním.
Nabídka [TC/Media]
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Obsahuje nastavení související s časovými kódy a záznamovým médiem.
Nabídka [Monitoring]
Obsahuje nastavení související s výstupem videa a zobrazením na obrazovce displeje.
Nabídka [Audio]
Obsahuje nastavení související se zvukem.
Nabídka [Thumbnail]
Obsahuje nastavení související se zobrazením miniatur.
Nabídka [Technical]
Obsahuje nastavení technických položek.
Nabídka [Network]
Obsahuje nastavení související se sítěmi.
Nabídka [Maintenance]
Obsahuje nastavení parametrů zařízení, jako jsou hodiny a jazyk.

Konfigurace a hierarchie nabídky kamery

Úroveň 1 Úroveň 2

User
(Výrobní nastavení)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Úroveň 1 Úroveň 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Úroveň 1 Úroveň 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Úroveň 1 Úroveň 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter

289



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládání nabídky kamery

Po stisknutí tlačítka [Menu] v ovládacím panelu grafického uživatelského rozhraní nebo tlačítka MENU na infračerveném
dálkovém ovladači se v panelu obrazu kamery zobrazí nabídka kamery pro konfigurování různých požadovaných
nastavení pro snímání a přehrávání.
Nabídka se ovládá pomocí ovládacího panelu grafického uživatelského rozhraní.

Tlačítko [Menu]: Stisknutím zobrazíte nabídku kamery. Opětovným stisknutím tlačítka při zobrazení nabídky kamery ji
skryjete.
Tlačítka se šipkami: Stisknutím tlačítek se šipkami přesuňte kurzor nahoru / dolů / doleva / doprava v nabídce kamery a
vyberte položky nabídky nebo nastavení.
Tlačítko [Set]: Stisknutím tlačítka vybranou položku použijete.
Tlačítko [Cancel/Back]: Stisknutím tlačítka se vrátíte do předchozí nabídky. Nedokončená změna je zrušena.

Poznámka

Některé položky nelze vybrat v závislosti na stavu, kdy byla nabídka zobrazena.

Položky nabídky nastavení

Přesuňte kurzor na požadovanou položku pomocí tlačítek se šipkami v ovládacím bloku grafického uživatelského
rozhraní a stisknutím tlačítka [Set] nastavení použijete.

Oblast výběru položky nabídky zobrazuje až osm řádků. Pokud nelze možnosti dostupné pro položku zobrazit
současně, posuňte zobrazení pohybem kurzoru nahoru/dolů.
U podřízených položek s velkým rozsahem nastavení (například −99 až +99) se oblast nastavení nezobrazí. Aktuální
nastavení je zvýrazněno, což znamená, že hodnotu lze změnit.
Výběrem možnosti [Execute] funkce tuto možnost pro funkci vykonáte.
Výběrem položky, která před provedením vyžaduje potvrzení, se dočasně skryje nabídka a zobrazí se potvrzovací
zpráva. Zkontrolujte zprávu a poté zvolte, zda chcete funkci provést nebo ji zrušit.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zadání řetězce znaků

Když vyberete položku, například název souboru, která vyžaduje zadání znaků, zobrazí se obrazovka pro zadání znaků.

5-041-958-43(1) Copyright 2022 Sony Corporation

Stiskem tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní vyberte typ znaku a
použijte nastavení.

[ABC]: Velká písmena abecedy
[abc]: Malá písmena abecedy
[123]: íselné znaky
[!#$]: Speciální znaky

1

Vyberte znak a stisknutím tlačítka [Set] nastavení použijte.

Kurzor se přesune k následujícímu poli.
[Space]: Zadá znak mezery na pozici kurzoru.
[←] [→]: Posune polohu kurzoru.
[BS]: Odstraní znak nalevo od kurzoru (backspace).

2

Po dokončení stisknutím tlačítka [Done] nastavení použijte.

Řetězec znaků je potvrzen a obrazovka pro zadávání znaků zmizí.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Toto téma popisuje funkci a nastavení každé položky nabídky.

Poznámka

Položky v nabídce [User] můžete přidávat a odebírat pomocí nabídky [Edit User]. Nakonfigurovat můžete až 20 položek.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Popis

Base Setting Položka Project > Base Setting

Focus Položka Shooting > Focus

S&Q Motion Položka Shooting > S&Q Motion

LUT On/Off Položka Shooting > LUT On/Off

Simul Rec Položka Project > Simul Rec

Proxy Rec Položka Project > Proxy Rec

Interval Rec Položka Project > Interval Rec

Picture Cache Rec Položka Project > Picture Cache Rec

Assignable Button Položka Project > Assignable Button

Scene File Položka Project > Scene File

Base Look Položka Paint/Look > Base Look

P/T Acceleration Položka Pan-Tilt > P/T Acceleration

Clip Name Format Položka TC/Media > Clip Name Format

Format Media Položka TC/Media > Format Media

Video Signal Monitor Položka Monitoring > Video Signal Monitor

Marker Položka Monitoring > Marker

Zoom Položka Technical > Zoom

Lens Položka Technical > Lens

Edit User Menu Zobrazuje nabídku Edit User.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Edit User

Nabídka [Edit User] se zobrazí na nejvyšší úrovni, pokud je v nabídce [User] vybrána možnost [Edit User Menu].
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Add Item
Přidání položky do
nabídky [User]

– – Přidá položku nabídky úrovně 2 do nabídky [User]

Customize Reset
Resetování položky v
nabídce [User]

– –
Obnoví položky nabídky zaregistrované v nabídce
[User] na výchozí tovární nastavení.

Položka nabídky úrovně 2
vybraná během úprav

Delete –
Odstraní zaregistrovanou položku nabídky úrovně 2
z nabídky [User].

Move –
Přeuspořádá registrované položky nabídky v
nabídce [User].

Edit Sub Item –
Upraví (zaregistruje/odstraní) registrovanou
podřízenou položku nabídky úrovně 3 v nabídce
[User].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ISO/Gain/EI

Nastavuje úroveň zesílení.

Položka Nastavení podřízené položky Tovární nastavení Popis

Mode ISO/dB dB
Vybírá režim nastavení
zesílení.

ISO/Gain<L>

Další informace o nastavení
naleznete v části „Nastavení
možnosti ISO/Gain a výchozí
hodnoty“.

–
Nastavuje přednastavenou
hodnotu zesílení <L>.

Exposure
Index<L>

Když je možnost Base ISO
nastavena na hodnotu ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Když je možnostBase
ISOnastavena na hodnotu ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Když je možnost Base
ISOnastavena na hodnotu
ISO 800: 800EI / 6.0E
Když je možnost Base
ISOnastavena na hodnotu
ISO 12800: 12800EI / 6.0E

Nastavuje hodnotu
Exposure Index<L>.

Shockless
Gain

On / Off Off
Zapíná/vypíná funkci
zesílení bez otřesů.

Base
Sensitivity

High / Low Low Nastavuje základní citlivost
pro režim Custom.
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Příbuzné téma
Nastavení možnosti ISO/Gain a výchozí hodnoty
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Položka Nastavení podřízené položky Tovární nastavení Popis

Base ISO ISO 12800 / ISO 800 ISO 800
Nastavuje základní citlivost
ISO pro režim Cine
EI/Flexible ISO.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ND Filter

Nastavuje přednastavené hodnoty pro filtr ND.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Mode Preset / Variable Variable Volí režim filtru ND.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Nastavuje hodnotu předvolby 1 pro filtr ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Nastavuje hodnotu předvolby 2 pro filtr ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Nastavuje hodnotu předvolby 3 pro filtr ND.

296



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Shutter

Nastavuje podmínky provozu elektronické závěrky.
Používá se pro zřetelné snímání rychle se pohybujících objektů.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Mode Speed / Angle Speed
Vybírá režim pro nastavení rychlosti
závěrky v sekundách (Speed) nebo
jako úhlu závěrky (Angle).

Shutter
Speed
On/Off

On / Off Off

Nastavuje, zda se čas expozice při
výběru režimu Speed řídí hodnotou
[Shutter Speed] nebo zda je
nastavena na plnou expozici.

Shutter
Speed

64F až 1/8000
Dostupná nastavení se liší v závislosti na
frekvenci snímků vybraného formátu videa.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120
/ 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000
/ 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 /
1/96 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Nastavuje čas závěrky, když je
zvolen režim Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F
/ 360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Nastavuje úhel závěrky, když je
zvolen režim Angle.

ECS On/Off On / Off Off
Zapíná/vypíná funkci Extended
Clear Scan.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

ECS
Frequency

23.99 až 8000
Dostupná nastavení se liší v závislosti na
frekvenci snímků formátu záznamu videa.

59.94P:
60.00
50P: 50.00
29.97P:
30.00
23.98P:
23.99
25P: 25.02
24P: 24.02

Nastavuje frekvenci ECS, když je
možnost Mode nastavena na volbu
ECS.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Iris

Nastavuje nastavení clony.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Bokeh Control On / Off Off Zapíná/vypíná funkci řízení efektu bokeh.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Auto Exposure

Nastavuje parametry automatické úpravy expozice.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / +1.5
/ +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0 / −0.25
/ −0.5 / −0.75 / −1.0 / −1.25 / −1.5 / −1.75 /
−2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Nastavuje úroveň jasu pro automaticky
detekovanou expozici.

Mode Backlight / Standard / Spotlight Standard

Nastavuje provozní režim automatické
úpravy expozice.
Backlight: Režim podsvícení (režim
pro snížení ztmavení objektu při
nasvětlení protisvětlem)
Standard: Standardní režim
Spotlight: Režim bodového světla
(režim pro snížení ostřižených bílých
míst při nasvětlení objektu bodovým
osvětlením)

Speed −99 až +99 ±0
Nastavuje rychlost automatické úpravy
expozice.

AGC On / Off Off
Zapíná/vypíná funkci AGC
(automatické řízení zesílení).

AGC Limit

Další informace o nastavení naleznete v
části „Nastavení možnosti AGC Limit a
výchozí hodnoty“.

–
Nastavuje maximální hodnotu zesílení
pro funkci AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Nastavuje hodnotu F-stop clony, kde
se funkce AGC spouští, je-li funkce
AGC nastavena na volbu On.

Auto Shutter On / Off Off
Zapíná/vypíná funkci automatického
řízení závěrky.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Nastavuje nejkratší čas funkce
automatické závěrky.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Nastavuje hodnotu F-stop clony, kde
se spustí funkce automatické závěrky.

Clip High
light

On / Off Off

Zapne nebo vypne funkci, která
ignoruje nejjasnější oblasti, aby
poskytovala plošší odezvu při vysoké
svítivosti.
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Příbuzné téma

Nastavení možnosti AGC Limit a výchozí hodnoty
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Nastavuje rozsah měření světla pro
automatické nastavení expozice podle
jasu objektu. (Není k dispozici při ruční
úpravě expozice)

Detect
Window
Indication

On / Off Off
Zapíná/vypíná indikátor rozsahu
měření světla.

Custom
Width

40 až 999 500 Nastavuje šířku rozsahu měření světla.

Custom
Height

70 až 999 500
Nastavuje výšku rozsahu měření
světla.

Custom H
Position

−479 až +479 ±0
Nastavuje vodorovnou polohu rozsahu
měření světla.

Custom V
Position

−464 až +464 ±0
Nastavuje svislou polohu rozsahu
měření světla.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White

Nastavuje funkci vyvážení bílé barvy.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Preset
White

2000K až
15000K

3200K Nastavuje přednastavenou hodnotu vyvážení bílé.

Color
Temp <A>

2000K až
15000K

3200K

Nastavuje teplotu barvy pro vyvážení bílé uloženou v paměti A.

Poznámka

Vzhledem k tomu, že parametr Color Temp je během operace R
Gain/B Gain oříznut na 2000K a 15000K, nemusí být možné zobrazit
správnou hodnotu Color Temp pro hodnotu R Gain/B Gain.

Tint<A> −99 až +99 ±0

Nastavuje hodnotu odstínu pro vyvážení bílé uloženou v paměti A
bílé barvy.

Poznámka

Vzhledem k tomu, že parametr Tint je během operace R Gain/B Gain
oříznut na ±99, nemusí být možné zobrazit správnou hodnotu Tint pro
hodnotu R Gain/B Gain.

R Gain
<A>

−99.0 až +99.0 ±0.0 Nastavuje hodnotu zesílení R pro vyvážení bílé uloženou v paměti A.

B Gain
<A>

−99.0 až +99.0 ±0.0 Nastavuje hodnotu zesílení B pro vyvážení bílé uloženou v paměti A.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White Setting

Upravuje nastavení vyvážení bílé barvy.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Shockless
White

Off / 1 / 2 / 3 2

Nastavuje rychlost odezvy vyvážení bílé při přepínání
režimu vyvážení bílé.
Off: Okamžitě se přepne.
1 až 3: Spíná tím pomaleji, čím vyšší je číslo.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Nastavuje rychlost odezvy v režimu ATW.
Nejvyšší rychlost odezvy je 1 a nejnižší rychlost
odezvy je 5.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Offset White

Nastavuje funkci odchylky vyvážení bílé barvy.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Offset White <A> On / Off Off
Vybírá, zda chcete přidat (On) nebo nepřidat (Off) hodnotu
odchylky k vyvážení bílé barvy v paměti A.

Offset Color
Temp<A>

−99 až +99 ±0
Nastavuje odchylku teploty barev, která se má přidat k
vyvážení bílé v paměti A při nastavení možnosti [Offset White
<A>] na volbu On.

Offset Tint<A> −99 až +99 ±0
Nastavuje hodnotu odchylky možnosti Tint, která se má přidat
k vyvážení bílé v paměti A při nastavení možnosti [Offset
White <A>] na volbu On.

Offset
White<ATW>

On / Off On
Vybírá, zda chcete přidat (On) nebo nepřidat (Off) hodnotu
odchylky k vyvážení bílé barvy ATW.

Offset Color
Temp<ATW>

−99 až +99 ±0
Nastavuje odchylku teploty barev, která se má přidat k
vyvážení bílé ATW při nastavení možnosti [Offset
White<ATW>] na volbu On.

Offset Tint<ATW> −99 až +99 ±0
Nastavuje hodnotu odchylky možnosti Tint, která se má přidat
k vyvážení bílé ATW při nastavení možnosti [Offset
White<ATW>] na volbu On.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Focus

Nastavuje parametry ostření.

Příbuzné téma

Nastavení oblasti/polohy automatického zaostřování (Focus Area)

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Nastavuje rychlost pohonu zaostřování pro případ, kdy se
objekt během automatického zaostřování změní.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Nastavuje citlivost pro změnu zaostření objektu během
automatického zaostřování.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Nastavuje cílovou oblast pro automatické zaostřování a
vynucené automatické zaostřování (AF).

Viz „Automatické nastavení zaostření (Auto Focus)“ a
„Nastavení oblasti/polohy automatického zaostřování
(Focus Area)“.

Wide: Při zaostřování vyhledává objekt v širokém úhlu
záběru.
Zone: Automaticky vyhledá bod zaostření v zadané zóně.
Flexible Spot: Zaostří na stanovenou pozici v obraze.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Nastavuje cílovou oblast pro vynucené automatické
zaostřování (AF-S) .

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye
Priority AF

Aktivuje/deaktivuje automatické zaostřování s detekcí obličeje.

Viz také „Sledování pomocí detekce obličeje a očí
(Face/Eye Detection AF)“.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Nastavuje režim vynuceného automatického zaostřování.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Nastavuje operaci, když se dotknete obrazu kamery na
obrazovce živého provozu webové aplikace v režimu MF.

AF Assist On / Off On

Je-li tato možnost nastavena na volbu On, můžete dočasně
potlačit automatické zaostřování a nastavit zaostření ručně.

Viz „Ruční nastavení automatického zaostřování cíle (AF
Assist) pomocí webové aplikace Web App“ a „Ruční
zaostřování během automatického zaostřování pomocí
dodaného infračerveného dálkového ovladače“.
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Sledování pomocí detekce obličeje a očí (Face/Eye Detection AF)

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App

Ruční zaostřování během automatického zaostřování pomocí dodaného infračerveného dálkového ovladače

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

S&Q Motion

Nastavuje režim pomalého a rychlého pohybu (viz „Pomalý a rychlý pohyb“).

Příbuzné téma
Pomalý a rychlý pohyb
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Setting On / Off Off
Zapíná/vypíná režim pomalého a rychlého
pohybu.

Frame
Rate

1fps až 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Nastavuje snímkovou frekvenci pro snímání
pomalého a rychlého pohybu.

Poznámka

Dostupná nastavení se liší v závislosti na
zvolené frekvenci systému, kodeku a formátu
videa.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

LUT On/Off

Nastavuje parametry nastavení LUT.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

SDI MLUT On / MLUT Off MLUT Off
Vybírá, zda se má použít LUT monitoru pro
video výstup SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Vybírá, zda se má použít LUT monitoru pro
video výstup HDMI a Stream.

Proxy MLUT On / MLUT Off MLUT Off
Vybírá, zda se má použít LUT monitoru pro
proxy záznam videa.

Internal Rec MLUT On / MLUT Off MLUT Off
Vybírá, zda se má použít LUT monitoru pro
hlavní záznam videa.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI &
HDMI/Stream

HDMI/Stream
Nastavuje cílový výstup řízený přiřaditelným
tlačítkem LUT On/Off.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Noise Suppression

Nastavuje parametry nastavení potlačení šumu.

Tip

Nastavení [Setting(Custom)] a [Level(Custom)] se projeví v nastavení [Target Display].

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting(Custom) On / Off On
Zapíná/vypíná funkci potlačení šumu v režimu
Custom.

Level(Custom) Low / Mid / High Mid
Nastavuje úroveň potlačení šumu v režimu
Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Zapíná/vypíná funkci potlačení šumu v režimu
snímání Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Nastavuje úroveň potlačení šumu v režimu
snímání Log.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Flicker Reduce

Nastavuje korekci blikání.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Mode Auto / On / Off Off Nastavuje režim korekce blikání.

Frequency 50Hz / 60Hz 60Hz
Nastavuje frekvenci zdroje napájení světla, které blikání
způsobuje.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SteadyShot

Nastavuje parametry nastavení stabilizace obrazu.
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Setting
Active / Standard /
Off

Off

Nastavuje funkci stabilizace obrazu.

Poznámka

Tato možnost je aktivní, pokud je připojen kompatibilní objektiv.

Pokud je nastavena možnost Active nebo Standard, může během
operace posunu/naklápění dojít k neočekávanému chování.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

Nastavuje základní parametry nastavení.

Příbuzné téma

Konfigurace základní obsluhy
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Nastavuje režim snímání.

Další informace naleznete v části „Nastavení režimu
snímání“ v položce „Konfigurace základní obsluhy“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Nastavuje barevný gamut záznamu/výstupu v režimu
Custom.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

Nastavuje parametry formátu záznamu.

Nastavení [RAW Output Format]

Výchozí hodnoty jsou zvýrazněny tučným písmem.
Podmínky, za kterých nelze nastavit [RAW Output Format], byly vynechány.

Nastavení [Video Format]

Položka Nastavení podřízené položky Tovární
nastavení Popis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Vybírá systémovou frekvenci.

Imager Scan
Mode

FF / S35 FF Vybírá velikost snímku.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Nastavuje kodek záznamu/přehrávání klipu.

Poznámka

Když je možnost [Imager Scan Mode]
nastavena na [S35], nelze vybrat možnost
[RAW] a [RAW & XAVC-I].

RAW Output
Format

Dostupná nastavení se liší v
závislosti na nastavení parametrů
[Frequency].

Viz „Nastavení [RAW Output
Format]“ níže.

–

Nastavuje velikost obrazu RAW na výstup do
externího rekordéru RAW.

Poznámka

Pokud je možnost [Codec] nastavena na
formát [RAW & XAVC-I], nastavení [Video
Format] se přepne v součinnosti s nastavením
[RAW Output Format].

Video
Format

Dostupná nastavení se liší v
závislosti na nastavení parametrů
[Frequency], [Imager Scan Mode] a
[Codec].

Viz „Nastavení [Video Format]“
níže.

–
Nastavuje velikost snímku a přenosovou
rychlost.

Frequency Imager Scan Mode Codec Nastavení

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Výchozí hodnoty jsou zvýrazněny tučným písmem.

5-041-958-43(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Nastavení

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cine EI/Flex.ISO Set

Nastavení režimu snímání Log (viz „Nastavení režimu snímání“ v části „Konfigurace základní obsluhy“).

Příbuzné téma

Konfigurace základní obsluhy
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Položka Nastavení podřízené
položky Tovární nastavení Popis

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Nastavuje barevný gamut režimů snímání Log
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed
LUT File

On / Off On
Zapíná/vypíná záznam metadat souboru 3D
LUT (soubor CUBE).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Simul Rec

Nastavuje 2-slotový režim simultánního nahrávání (viz „Současné nahrávání na paměťové karty A a B. (2-slot Simul
Rec)“).
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off
Zapíná/vypíná režim
současného záznamu se
dvěma sloty.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:
<Slot A> <Slot B> / Rec Button:<Slot A> 2nd
Rec Button:<Slot B> / Rec Button:<Slot B>
2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot
B>

Přiřadí tlačítka záznamu
používaná pro ovládání
každého záznamového
média.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Proxy Rec

Nastavuje parametry režimu záznamu proxy serveru (viz „Proxy záznam“).
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off Zapne nebo vypne režim proxy záznamu.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 Vybírá zvukový kanál pro záznam dat proxy.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Interval Rec

Nastavuje parametry intervalového režimu záznamu (viz „Přerušované nahrávání videa (Interval Rec)“).
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off

Zapíná/vypíná režim intervalového
záznamu. (Nastavením tohoto režimu
na volbu On se všechny ostatní
speciální režimy nastaví na volbu Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1
Nastavuje interval mezi záznamy v
režimu Interval Rec (je-li možnost
Interval Rec nastavena na volbu On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostupná nastavení se liší v
závislosti na frekvenci snímků
vybraného formátu videa.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavuje počet snímků pro záznam
na jeden snímek v režimu Interval
Rec (je-li možnost Interval Rec
nastavena na volbu On).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

Nastavuje parametry nastavení režimu záznamu do mezipaměti (viz „Nahrávání obrázků do mezipaměti (Picture Cache
Rec)“).

Příbuzné téma

Nahrávání obrázků do mezipaměti (Picture Cache Rec)
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off Zapíná/vypíná funkci ukládání obrazu do mezipaměti.

Cache Size
Short / Medium / Long
/ Max

Max
Nastavuje čas akumulace obrázků v mezipaměti (doba
záznamu mezipaměti obrázků).

Cache Rec
Time

– –
Zobrazuje čas akumulace obrázků v mezipaměti (doba
záznamu mezipaměti obrázků).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SDI/HDMI Rec Control

Nastavuje parametry ovládání záznamu SDI/HDMI.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Nastavuje ovládání spuštění/zastavení záznamu na externím zařízení
prostřednictvím připojení výstupního signálu SDI/HDMI.
Off: Nepoužije se dálkové ovládání.
SDI/HDMI Remote I/F: Ovládání zastavení/spuštění záznamu na
externím připojeném zařízení, pokud není v jednotce vloženo žádné
médium. Není synchronizováno s přesností snímků na médiu v
jednotce.
Parallel Rec: Ovládání zastavení/spuštění záznamu na externím
připojeném zařízení, pokud je v jednotce vloženo médium. Je
synchronizováno s přesností snímků na médiu v jednotce.

Poznámka

Pro ovládání pomocí výstupního signálu HDMI nastavte v nabídce
kamery možnost [TC/Media] > [HDMI TC Out] > [Setting] na hodnotu
[On].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Assignable Button

Nastavuje přiřazení funkcí přiřaditelným tlačítkům (<1> až <9>) a tlačítku [Focus Hold Button].
Lze přiřadit následující funkce.
[Off]: Žádná přiřazená funkce.
[Base ISO/Sensitivity]: Přepíná základní citlivost obrazového snímače.
[AGC]: Zapíná/vypíná funkci AGC.
[Push AGC]: Aktivuje funkci AGC při stisknutí tlačítka.
[ND Filter]

V proměnném režimu: Nastavuje propustnost filtru ND. Stiskněte a podržte tlačítko a přepněte mezi možnostmi
Clear/Manual/Auto.
V přednastaveném režimu: Stiskněte a podržte tlačítko a přepněte přednastavení.

[ND Filter Position]: Přepíná filtr ND.
[Auto ND Filter]: Zapíná/vypíná funkci automatického nastavení filtru ND.
[Push Auto ND]: Aktivuje funkci automatického filtru ND při stisknutí tlačítka.
[Auto Iris]: Zapíná/vypíná funkci clony.
[Push Auto Iris]: Aktivuje funkci clonu při stisknutí tlačítka.
[Bokeh Control]: Zapíná/vypíná režim řízení efektu bokeh.
[Auto Shutter]: Zapíná/vypíná funkci automatické závěrky.
[AE Level/Mode]: Nastavení úrovně AE. Stiskněte a podržte tlačítko a přepněte režim AE.
[Backlight]: Přepíná mezi Backlight a Standard.
[Spotlight]: Přepíná mezi Spotlight a Standard.
[Preset White Select]: Přepíná hodnoty režimu předvolby vyvážení bílé.
[ATW]: Zapíná/vypíná funkci ATW.
[ATW Hold]: Pozastaví činnost funkce ATW.
[AF Speed/Sens.]: Přepíná nastavení rychlosti přechodu AF a citlivosti posunu objektu AF.
[Focus Setting]: Nastavuje oblast zaostření.
[Face/Eye Detection AF]: Přepíná nastavení funkce automatického zaostřování s detekcí obličeje.
[Push AF Mode]: Přepíná nastavení režimu vynuceného automatického zaostřování.
[Push AF/MF]: V režimu zaostřování MF se aktivuje automatické zaostřování při stisknutí tlačítka. V režimu zaostřování
AF se aktivuje MF při stisknutí tlačítka.
[Focus Hold]: V režimu zaostřování AF je zaostření při stisknutí tlačítka nastaveno pevně.
[S&Q Motion]: Zapíná/vypíná režim pomalého a rychlého pohybu. Při stisknutí a podržení nastavuje snímkové
frekvence snímání.
[LUT On/Off]: Zapíná/vypíná funkci LUT. Cíl spínání se nastaví pomocí možností [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: Přepíná mezi možnostmi Active, Standard a Off.
[Crop Select]: Přepíná Imager Scan Mode. Přepínání je povoleno v rozsahu bez změny formátu záznamu.
[Rec]: Spuštění/zastavení záznamu.
[Picture Cache Rec]: Zapíná/vypíná režim záznamu do mezipaměti.
[Rec Review]: Zapíná/vypíná funkci prohlížení záznamu.
[Clip Flag OK]: Spustí Add OK. Dvojím stisknutím vykonáte Delete Clip Flag.
[Clip Flag NG]: Spustí Add NG. Dvojím stisknutím vykonáte Delete Clip Flag.
[Clip Flag Keep]: Spustí Add KEEP. Dvojím stisknutím vykonáte Delete Clip Flag.
[Slot Select]: Přepíná mezi paměťovým slotem (A) a (B).
[Color Bars]: Zapíná/vypíná pruhy barev.
[DURATION/TC/U-BIT]: Přepíná mezi možnostmi Time Code, Users Bit a Duration.
[Display]: Zapíná/vypíná indikátory na obrazovce.
[Lens Info]: Přepíná indikátor hloubky ostrosti.
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[Video Signal Monitor]: Přepíná monitor videosignálu (například monitor křivky).
[Marker]: Zapíná/vypíná funkci značky.
[Thumbnail]: Zobrazí/ukončí obrazovku miniatur.
[Auto Upload (Proxy)]: Zapne nebo vypne automatický přenos proxy souboru.
[Direct Menu]: Zobrazí/ukončí přímou nabídku.
[User Menu]: Zobrazí/ukončí nabídku User.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Scene File

Nastavuje parametry související se soubory scén (viz „Snímání s požadovaným vzhledem“).
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Recall – –
Načte soubor scény uložený v interní
paměti a použije nastavení jako
aktuální nastavení kvality snímku.

Store – –
Uloží aktuální stav kvality obrazu jako
soubor scény do vnitřní paměti.

Delete – – Odstraní soubor scény uložený v
interní paměti.

Preset
Recall

Pokud je možnost Shooting Mode nastavena
na hodnotu Custom a možnost Target Display
je nastavena na SDR(BT.709): S-Cinetone
/Standard/ Still / ITU709/ 709tone
Pokud je možnost Shooting Mode nastavena
na hodnotu Custom a možnost Target Display
je nastavena na HDR(HLG): HLG Live / HLG
Natural

–
Použije přednastavená nastavení
kvality obrazu (nepřepisovatelná) jako
aktuální nastavení kvality obrazu.

323



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Look

Nastavuje parametry související se základním vzhledem.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Select

Pokud je možnost Shooting Mode je
nastavena na Custom a možnost Target
Display je nastavena na SDR(BT.709): S-
Cinetone / Standard / Still / ITU709 /
709tone / User1 až User16
Pokud je možnost Shooting Mode
nastavena na Custom a možnost Target
Display je nastavena na HDR(HLG): HLG
Live / HLG Natural / User1 až User16
Pokud je možnost Shooting Mode
nastavena na režimy snímání Log: s709 /
709(800) / S-Log3 / User1 až User16

Pokud je možnost Shooting
Mode nastavena na Custom a
možnost Target Display je
nastavena na SDR(BT.709): S-
Cinetone
Pokud je možnost Shooting
Mode nastavena na Custom a
možnost Target Display je
nastavena na HDR(HLG): HLG
Live
Pokud je možnost Shooting
Mode nastavena na režimy
snímání Log: s709

Volí základní vzhled.

Delete – –
Odstraní vybraný
základní vzhled.

Delete
All

– –
Odstraní všechny
základní vzhledy.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Nastavuje vstupní
barevný gamut pro
základní vzhled
vybraný pomocí
položky [Select].

Output BT.709 / HLG BT.709

Nastavuje výstupní
barevný gamut pro
základní vzhled
vybraný pomocí
položky [Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV /
2EV

0EV

Nastavuje referenční
hodnotu expozice pro
základní vzhled
vybraný pomocí
možnosti [Select].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset Paint Settings

Resetuje nastavení nabídky [Paint/Look], kromě možnosti základního vzhledu.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Reset without
Base Look

Execute / Cancel –
Resetuje nastavení nabídky [Paint/Look], kromě
možnosti základního vzhledu.
Execute: Vykonává funkci.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Black

Nastavuje černou barvu.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Master Black −99.0 až +99.0 ±0.0 Nastavení hlavní úroveň černé barvy.

R Black −99.0 až +99.0 ±0.0 Nastavuje úroveň černé barvy pro R.

B Black −99.0 až +99.0 ±0.0 Nastavuje úroveň černé barvy pro B.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Knee

Nastavuje korekci senzitometrické křivky.
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Položka Nastavení podřízené
položky Tovární nastavení Popis

Setting

Pokud je možnost Target
Display nastavena na
SDR(BT.709): On / Off / ---
Pokud je možnost Target
Display nastavena na
HDR(HLG): On / Off / ---

Pokud je možnost Target
Display nastavena na
SDR(BT.709): Off
Pokud je možnost Target
Display nastavena na
HDR(HLG):Off

Zapíná/vypíná funkci korekce
senzitometrické křivky.

Poznámka

Povoleno pouze v případě, že je možnost
[Base Look] > [Select] nastavena na
hodnotu [Standard], [ITU709], [709tone],
[HLG Live] nebo [HLG Natural].

Auto
Knee

Pokud je možnost Target
Display nastavena na
SDR(BT.709): On / Off / ---
Pokud je možnost Target
Display nastavena na
HDR(HLG): On / Off / ---

Pokud je možnost Target
Display nastavena na
SDR(BT.709): On
Pokud je možnost Target
Display nastavena na
HDR(HLG):Off

Zapíná/vypíná funkci automatického
nastavení senzitometrické křivky.

Poznámka

Povoleno pouze v případě, že je možnost
[Base Look] > [Select] nastavena na
hodnotu [Standard], [ITU709] nebo
[709tone].

Point 75% až 109% 90% Nastavuje bod ohybu.

Slope −99 až +99 ±0 Nastavuje sklon senzitometrické křivky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Detail

Nastavuje úprav podrobností.
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Setting On / Off On Zapíná/vypíná funkci detailů.

Level −7 až +7 ±0 Nastavuje úroveň detailů.

Manual
Setting

On / Off / --- Off Zapíná/vypíná funkci ručního nastavení detailů.

H/V Ratio −2 až +2 ±0

Nastavuje vyvážení mezi vodorovným (H) a svislým (V) detailem
pro ruční nastavení detailů.

Poznámka

Tato položka se liší v závislosti na verzi softwaru.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Nastavuje vyvážení mezi černým (B) detailem pro oblasti s
nízkou svítivostí a bílým (W) detailem pro oblasti s vysokou
svítivostí pro ruční nastavení detailů.

Limit 0 až 7 7 Nastavuje mezní úroveň detailu pro ruční nastavení detailů.

Crispening 0 až 7 0 Nastavuje úroveň zostřování pro ruční nastavení detailů.

High Light
Detail 0 až 4 0

Nastavuje úroveň detailů oblastí s vysokou svítivostí pro ruční
detailní nastavení.

Ve verzi softwaru 1.00 je položka nabídky [V/H Balance]. Ve verzi softwaru 1.10 nebo novější je položka nabídky [H/V Ratio]. Rozsah nastavení
se nemění z −2 na 0 až +2, nicméně vliv na kvalitu obrazu je odlišný.
Verze softwaru 1.00: Čím vyšší je nastavená hodnota, tím vyšší je vodorovný (H) detail.
Verze softwaru 1.10 nebo novější: Čím vyšší nastavená hodnota, tím vyšší svislý (V) detail.
Po aktualizaci z verze 1.00 na verzi 1.10 nebo novější jsou nastavení [All File], [Scene File] a další zděděna, ale s obrácenou polaritou (kvalita
obrazu je zachována).
Pokud jste zaregistrovali položku nabídky [V/H Balance] v nabídce [User], bude po aktualizaci softwaru automaticky položkou [H/V Ratio] v
nabídce [User].

*1
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Matrix

Nastavuje parametry korekce matrice.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

User Matrix On / Off Off Zapíná/vypíná funkci korekce uživatelské matrice.

User Matrix
Level

−99 až +99 ±0 Upravuje sytost barev celého obrazu.

User Matrix
Phase

−99 až +99 ±0 Upravuje barevný tón (fázi) celého obrazu.

User Matrix R-G −99 až +99 ±0 Nastavuje uživatelskou matrici R-G definovanou
uživatelem.

User Matrix R-B −99 až +99 ±0
Nastavuje uživatelskou matrici R-B definovanou
uživatelem.

User Matrix G-R −99 až +99 ±0
Nastavuje uživatelskou matrici G-R definovanou
uživatelem.

User Matrix G-B −99 až +99 ±0
Nastavuje uživatelskou matrici G-B definovanou
uživatelem.

User Matrix B-R −99 až +99 ±0 Nastavuje uživatelskou matrici B-R definovanou
uživatelem.

User Matrix B-G −99 až +99 ±0
Nastavuje uživatelskou matrici B-G definovanou
uživatelem.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Multi Matrix

Nastavuje parametry korekce vícenásobné matrice.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Setting On / Off Off
Zapíná/vypíná funkci korekce
vícenásobné matrice.

Reset Execute / Cancel –
Obnovuje odstín a sytost každé osy
barvy na výchozí hodnoty.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− / YL /
YL+ / G− / G / G+ / CY / CY+ / B−

B Vybírá osu.

Hue −99 až +99 ±0
Nastavuje odstín barvy použité pro
korekci vícenásobné matrice.

Saturation −99 až +99 ±0
Nastavuje sytost barvy použité pro
korekci vícenásobné matrice.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Acceleration

Nastavuje parametry související se zrychlením pro operace posunu/naklápění.
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Ramp
Curve

1 až 9 8
Vybírá zrychlení/zpomalení pro operace posunu/naklápění.
Čím vyšší je číslo, tím vyšší je zrychlení.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Timecode

Nastavuje časový kód.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Mode Preset / Regen / Clock Preset

Nastavuje režim chodu časového kódu.
Preset: Spustí se z přednastavené hodnoty.
Regen: Spouští se od časového kódu konce
předchozího klipu.
Clock: Používá vnitřní hodiny jako časový kód.

Run Rec Run / Free Run Rec Run
Rec Run: Spouští se pouze při záznamu.
Free Run: Spouští se vždy, bez ohledu na provoz
záznamu.

Setting – –
Nastavuje časový kód na libovolnou hodnotu.
Set: Nastavuje hodnotu.

Reset Execute / Cancel –
Resetuje časový kód na 00:00:00:00.
Execute: Vykonává funkci.

TC
Format DF / NDF DF

Nastavuje formát časového kódu.
DF: Vynechaný snímek
NDF: Bez vynechaného snímku
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

TC Display

Nastavuje zobrazení dat o čase.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Display Select Timecode / Users Bit / Duration Timecode Přepíná zobrazení dat o čase.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Users Bit

Nastavuje parametry související s uživatelskými bity.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Mode Fix / Time Fix

Nastavuje režim uživatelského bitu.
Fix: Používá v uživatelských bitech libovolnou pevnou
hodnotu.
Time: Používá v uživatelských bitech aktuální hodinu,
minutu a sekundu.

Setting – – Nastavuje uživatelské bity na libovolnou hodnotu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HDMI TC Out

Nastavuje parametry související s výstupem časového kódu při použití HDMI.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off
Nastavuje, zda bude časový kód odeslán do zařízení pro jiné
účely pomocí rozhraní HDMI.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clip Name Format

Nastavuje parametry související s pojmenováním a odstraněním klipu.
Pokud je položka [Auto Naming] nastavena na volbu [Cam ID + Reel#], budou pro každé záznamové médium určeny
první čtyři znaky názvů klipů. Po vložení nového záznamového média nebo pokud poslední klip na záznamovém médiu
neodpovídá nastavení [Camera ID] nebo [Reel Number], název klipu bliká a upozorňuje vás.
Pokud je položka [Auto Naming] nastavena na volbu [Title], můžete jako první část názvů klipů použít libovolný řetězec
znaků.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Auto
Naming

Cam ID + Reel# / Title

Vybírá formát pojmenování klipu.
Cam ID + Reel#: ID kamery + číslo cívky + číslo snímku +
datum + náhodný řetězec
Title: libovolný řetězec určený [Title Prefix] + číslo klipu

Camera ID A až Z A

Nastavuje ID kamery použité při generování názvů klipů.

Poznámka

Konfigurovatelné, pouze pokud je možnost [Auto Naming]
nastavena na hodnotu [Cam ID + Reel#].

Reel
Number

001 až 999 001

Nastavuje část s číslem válce použitou při generování
názvů klipů.

Poznámka

Konfigurovatelné, pouze pokud je možnost [Auto Naming]
nastavena na hodnotu [Cam ID + Reel#].

Camera
Position

C / L / R C

Nastavuje první znakovou část parametru Shot Number
použitou při generování názvů klipů.

Poznámka

Konfigurovatelné, pouze pokud je možnost [Auto Naming]
nastavena na hodnotu [Cam ID + Reel#].

Title Prefix

nnn_(nnn jsou posledních
3 číslice sériového čísla)
(maximálně 7místné
zobrazení)

nnn

Nastavuje titulní část (4 až 46 znaků) názvu klipu.
Otevře obrazovku pro zadání řetězce znaků.

Podrobné informace o nastavení titulů a obrazovce
zadávání znaků viz níže „Nastavení titulu“ a „Zadání
řetězce znaků“.

Poznámka

Konfigurovatelné, pouze pokud je možnost [Auto Naming]
nastavena na hodnotu [Title].
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Nastavení [Title Prefix]

Příbuzné téma

Zadání řetězce znaků
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Number
Set

0001 až 9999 0001

Nastavuje příponu názvu klipu o 4 číslicích.

Poznámka

Konfigurovatelné, pouze pokud je možnost [Auto Naming]
nastavena na hodnotu [Title].

Pomocí tlačítek se šipkami v ovládacím panelu grafického uživatelského rozhraní (znak je zvýrazněn)
vyberte znak, který chcete zadat na pozici kurzoru v oblasti [Title Prefix] z oblasti výběru znaků, a pak
stiskněte tlačítko [Set] v ovládacím panelu grafického uživatelského rozhraní.

Vloží se vybraný znak a kurzor se přesune doprava.

1

Opakováním kroku 1 nastavte název.

Podle potřeby použijte volbu [BS].

2

Po zadání titulu zavřete obrazovku zadávání znaků výběrem možnosti [Done].

Další informace o provozu na obrazovce zadávání znaků naleznete v části „Zadání řetězce znaků“.

Lze vybrat následující znaky.
!#$%()+,-.;=@[ ]^_~ mezera
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3

337



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Update Media

Aktualizuje soubor správy na paměťových kartách (viz také „Obnovení paměťových karet“).

Příbuzné téma

Obnovení paměťových karet
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Media(A) Execute / Cancel –
Aktualizuje soubor správy na paměťové kartě ve slotu
A.
Execute: Vykonává funkci.

Media(B) Execute / Cancel –
Aktualizuje soubor správy na paměťové kartě ve slotu
B.
Execute: Vykonává funkci.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Format Media

Formátuje (inicializuje) paměťové karty (viz také „Formátování (inicializace) paměťových karet“).

Příbuzné téma
Formátování (inicializace) paměťových karet
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Položka Nastavení podřízené položky Tovární nastavení Popis

Media(A) Full Format / Quick Format / Cancel – Naformátuje paměťovou kartu ve slotu A.

Media(B) Full Format / Quick Format / Cancel – Naformátuje paměťovou kartu ve slotu B.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Media Life

Zobrazuje zbývající životnost paměťových karet.

Poznámka

Vyžaduje paměťové karty, které podporují zobrazení zbývající životnosti média.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Media(A) – –
Zobrazuje zbývající životnost paměťové karty ve slotu
A.

Media(B) – –
Zobrazuje zbývající životnost paměťové karty ve slotu
B.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Nastavuje parametry formát výstupu.

Příbuzné téma

Výstupní formáty a omezení
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Položka Nastavení podřízené položky Tovární
nastavení Popis

SDI Další informace o nastavení naleznete v části
„Výstupní formáty a omezení“.

– Nastavuje rozlišení výstupů
SDI a HDMI.HDMI –
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Nastavuje parametry položky zobrazení.
Chcete-li zobrazit položku zobrazení, vyberte možnost On. Chcete-li skrýt položku zobrazení, vyberte možnost Off.

Položka Nastavení podřízené položky Tovární nastavení

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Položka Nastavení podřízené položky Tovární nastavení

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Signal Monitor

Nastavuje nastavení monitoru videosignálu.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting Off / Waveform / Vector / Histogram Off Nastavuje typ monitoru videosignálu.

Level Marker 1 0% až 109% 70% Nastavuje značku úrovně jasu 1.

Level Marker 2 0% až 109% 100% Nastavuje značku úrovně jasu 2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Marker

Nastavuje parametry zobrazení značky.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Setting On / Off On Zapíná/vypíná zobrazení všech značek.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Vybírá barvu signálu značky.

Center
Marker

1 / 2 / 3 / 4 / Off Off Vybírá středovou značku.

Safety Zone On / Off Off Zapíná/vypíná značku bezpečnostní zóny.

Safety Area 80% / 90% / 92.5% / 95% 90%
Vybírá velikost značky bezpečnostní zóny (v
procentech celkové velikosti obrazovky).

Aspect
Marker

Line / Mask / Off Off Vybírá typ značky poměru stran.

Aspect Mask 0 až 15 12 Nastavuje úroveň videosignálu vně značky.

Aspect
Safety Zone

On / Off Off
Zapíná/vypíná značku bezpečnostní zóny
poměru stran.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Vybírá velikost značky bezpečnostní zóny
poměru stran (v procentech celkové velikosti
obrazovky).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1
Nastavuje režim při zobrazení značky poměru
stran.

Custom
Aspect Ratio

Zadejte libovolnou hodnotu. 01.00:01.00

Nastavuje poměr stran na libovolnou hodnotu.

Poznámka

Povoleno, pokud je možnost [Aspect Select]
nastavena na hodnotu [Custom].

Guide
Frame

On / Off Off
Zapíná/vypíná zobrazení naváděcího
rámečku.

100%
Marker

On / Off Off Zapíná/vypíná značku 100%.

User Box On / Off Off
Zapíná/vypíná zobrazení značky uživatelského
rámečku.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

User Box
Width

3 až 479 240
Nastavuje šířku značky uživatelského rámečku
(vzdálenost od středu k levému a pravému
okraji).

User Box
Height

3 až 269 135
Nastavuje výšku značky uživatelského
rámečku (vzdálenost od středu k hornímu a
dolnímu okraji).

User Box H
Position

−476 až +476 0 Nastavuje vodorovnou polohu středu značky
uživatelského rámečku.

User Box V
Position

−266 až +266 0
Nastavuje svislou polohu středu značky
uživatelského rámečku.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Input

Nastavuje parametry vstupu zvuku.

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

AUDIO IN
Select

MIC / LINE MIC Volí typ zařízení připojeného ke konektoru AUDIO IN.

Phantom
Power +48V

On / Off Off Zobrazuje stav zdánlivého napájení +48 V.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Zobrazuje vstupní zdroj pro nahrávání na kanálu 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Přepíná vstupní zdroj pro nahrávání na kanál 2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Přepíná vstupní zdroj pro nahrávání na kanál 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Přepíná vstupní zdroj pro nahrávání na kanál 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Nastavuje referenční úroveň hlasitosti nahrávání pro vstup
mikrofonu XLR z rozhraní AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Nastavuje referenční úroveň hlasitosti nahrávání pro vstup
mikrofonu XLR z rozhraní AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Nastavuje referenční vstupní úroveň hlasitosti, když je
přepínač [AUDIO IN Select] nastaven na hodnotu LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Nastavuje úroveň hlasitosti záznamu signálu referenčního
tónu 1 kHz.

CH1 Wind
Filter

On / Off Off
Aktivuje/deaktivuje filtr snížení vlivu větru pro nahrávání
kanálu 1.

CH2 Wind
Filter

On / Off Off
Aktivuje/deaktivuje filtr snížení vlivu větru pro nahrávání
kanálu 2.

CH3 Wind
Filter

On / Off Off
Aktivuje/deaktivuje filtr snížení vlivu větru pro nahrávání
kanálu 3.

CH4 Wind
Filter

On / Off Off Aktivuje/deaktivuje filtr snížení vlivu větru pro nahrávání
kanálu 4.

CH1 Level
Control

Auto / Manual Auto
Vybírá automatické nastavení vstupní úroveň hlasitosti zvuku
nebo ruční nastavení pro kanál záznamu 1.
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

CH2 Level
Control

Auto / Manual Auto
Vybírá automatické nastavení vstupní úroveň hlasitosti zvuku
nebo ruční nastavení pro kanál záznamu 2.

CH3 Level
Control

Auto / Manual Auto
Vybírá automatické nastavení vstupní úroveň hlasitosti zvuku
nebo ruční nastavení pro kanál záznamu 3.

CH4 Level
Control

Auto / Manual Auto
Vybírá automatické nastavení vstupní úroveň hlasitosti zvuku
nebo ruční nastavení pro kanál záznamu 4.

CH1 Input
Level

0 až 99 49 Nastavuje vstupní úroveň hlasitosti pro kanál nahrávání 1.

CH2 Input
Level

0 až 99 49 Nastavuje vstupní úroveň hlasitosti pro kanál nahrávání 2.

CH3 Input
Level

0 až 99 49 Nastavuje vstupní úroveň hlasitosti pro kanál nahrávání 3.

CH4 Input
Level

0 až 99 49 Nastavuje vstupní úroveň hlasitosti pro kanál nahrávání 4.

Master Input
Level

0 až 99 99 Nastavuje hlavní vstupní úroveň hlasitosti zvuku.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Vybere charakteristiku omezovače pro silné vstupní signály při
ručním nastavení vstupní úrovně hlasitosti zvuku.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Nastavuje režim automatického nastavení úrovně hlasitosti
pro kanál záznamu 1 a 2. Při nastavení na volbu Stereo je
funkce AGC propojena mezi kanály.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Nastavuje režim automatického nastavení úrovně hlasitosti
pro kanál záznamu 3 a 4. Při nastavení na volbu Stereo je
funkce AGC propojena mezi kanály.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Vybírá vlastnost funkce AGC.

1kHz Tone on
Color Bars

On / Off Off

Zapíná/vypíná signál referenčního tónu 1 kHz při zobrazení
pruhů barev.

Poznámka

Je-li nastavena volba [On], signál referenčního tónu 1 kHz je
nastaven pro nahrávání na kanálech 3 a 4, i když jsou
možnosti [CH3 Input Select] a [CH4 Input Select] nastaveny
na volbu [Off].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Nastavuje parametry výstupu zvuku.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Nastavuje kombinaci zvukových kanálů na výstupu
HDMI/streamování.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display Clip Properties

Zobrazí obrazovku vlastností klipu.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Display Clip Properties – – Zobrazí obrazovku vlastností klipu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Set Clip Flag

Nastavení značky klipu.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Add OK – – Přidá značku OK.

Add NG – – Přidá značku NG.

Add KEEP – – Přidá značku KEEP.

Delete Clip Flag – – Odstraní všechny značky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lock/Unlock Clip

Nastavuje parametry ochrany klipu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené položky Tovární nastavení Popis

Select Clip – – Vybere a zamkne/odemkne klip.

Lock All Clips – – Uzamkne všechny klipy.

Unlock All Clips – – Odemkne všechny klipy.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Odstraní klipy.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Select Clip – – Odstraní vybraný klip.

All Clips – – Odstraní všechny klipy.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip

Přenese klipy.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Select Clip – – Přenese vybrané klipy.

All Clips – –

Přenese všechny klipy.

Poznámka

Zaregistrovat můžete až 200 úloh přenosu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip (Proxy)

Přenese proxy klipy.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Select
Clip

– –
Přenese proxy klipy odpovídající vybraným
klipům.

All Clips – –

Přenese proxy klipy odpovídající všem klipům.

Poznámka

Zaregistrovat můžete až 200 úloh přenosu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Filter Clips

Nastavuje parametry zobrazení klipů.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

OK – – Zobrazí pouze klipy se značkou OK.

NG – – Zobrazí pouze klipy se značkou NG.

KEEP – – Zobrazí pouze klipy se značkou KEEP.

None – – Zobrazí pouze klipy bez značky.

All – –
Zobrazí všechny klipy bez ohledu na to, zda mají
jakékoliv značky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Customize View

Přepíná zobrazení obrazovky miniatur.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Přepíná informace zobrazené pod
miniaturami.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Color Bars

Nastavuje parametry pruhu barev.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off Zapíná/vypíná pruhy barev.

Type ARIB / 100% / 75% / SMPTE ARIB Vybírá typ pruhu barev.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Genlock

Konfiguruje zobrazení stavu kombinace obrazových signálů (viz „Synchronizace fáze videosignálu (kombinace
obrazových signálů)“).

Příbuzné téma

Synchronizace fáze videosignálu (kombinace obrazových signálů)
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Reference
Internal / External(HD) /
External(SD)

–
Zobrazuje typ referenčního signálu pro kombinaci
obrazových signálů.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Nastavuje parametry kontrolky záznamu/indikace (viz „Připojení indikačního signálu“).

Příbuzné téma
Připojení indikačního signálu
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Tally Lamp
Brightness

High / Low / Off High Nastavuje jas kontrolky záznamu/indikace.

G Tally Lamp Enable / Disable Enable Aktivuje/deaktivuje indikační kontrolku G.

Tally Control External / Internal Internal

Vybírá cíl pro přijetí informací o ovládání kontrolky
záznamu/indikace jednotky.
External: Ovládání indikace z vnějšku kamery.
Internal: Ovládání prostřednictvím kamerového
záznamu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

Nastavuje parametry kontroly záznamu (viz „Prohlížení záznamu (Rec Review)“).

Příbuzné téma

Prohlížení záznamu (Rec Review)
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting 3s / 10s / Clip 3s
Nastavuje čas přehrávání klipů právě zaznamenaných k
prohlížení záznamu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

Nastavuje parametry zoomu („Nastavení zoomu“).
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Položka Nastavení podřízené položky Tovární nastavení Popis

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Nastavuje typ zoomu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens

Nastavuje parametry související s objektivy.

Příbuzné téma

Kompenzace dýchání
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Lens Calibration Execute / Cancel –

Vykonává funkci, která koriguje rozdíly v poloze zoomu
v důsledku rozdílů v jednotlivých objektivech při použití
elektrického objektivu s proměnlivou ohniskovou
vzdáleností.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Nastavuje směr ovládání kroužku zoomu.

Poznámka

Tato funkce je povolena pouze při použití objektivu E-
mount, který podporuje přepínání směru ovládání
kroužku zoomu.

Shading
Compensation

Auto / Off Auto Nastavuje automatickou kompenzaci stínování.

Chroma
Aberration
Comp.

Auto / Off Auto Nastavuje automatickou kompenzaci chromatické
aberace.

Distortion Comp. Auto / Off Auto Nastavuje automatickou kompenzaci zkreslení.

Breathing
Compensation Auto / Off Off

Nastavuje kompenzaci dýchání objektivu.

Další informace naleznete v části „Kompenzace
dýchání“.

Distance Display Meter / Feet Meter
Nastavuje jednotky zobrazení informací o objektivu a
poloze zaostření.

Zoom Position
Display

Focal Length /
Number / Bar Focal Length Nastavuje formát zobrazení pro poloze zoomu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

APR

Vykonává APR.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

APR Execute / Cancel –

Spustí funkci APR (automatická obnova pixelů) pro automatické
nastavení obrazového snímače.
Execute: Vykonává funkci.

Poznámka

Před spuštěním funkce APR vždy nasaďte krytku objektivu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Nastavuje parametry související s připojením k kabelové síti LAN.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

HTTP Port – 80 Zobrazí přístupový port HTTP.

Detail
Settings

– – Zobrazuje vlastnosti připojení kabelové sítě LAN.

DHCP
On / Off

On
Zobrazuje, zda je protokol DHCP povolen (On) nebo
zakázán (Off).

IP Address –
Zobrazuje IP adresu jednotky, když je možnost [DHCP]
nastavena na volbu [Off].

Subnet Mask –
Zobrazuje masku podsítě jednotky, když je možnost [DHCP]
nastavena na volbu [Off].

Gateway –
Zobrazuje výchozí bránu videokamery, když je možnost
[DHCP] nastavena na volbu [Off].

DNS Auto
On / Off

On Zobrazí nastavení automatického pořízení DNS.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Nastavuje parametry související s přenosy souborů (viz „O přenosu souborů“).

Příbuzné téma

O přenosu souborů
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Auto Upload
(Proxy)

On / Off Off Zapne nebo vypne automatické nahrání proxy souboru.

Default
Upload
Server

Server Settings1
až 3 > Display
Name

–

Vybere server pro odesílání souborů. Zde vybraný server se
stane cílovým místem pro automatické odesílání proxy souborů a
cílovým místem pro odesílání souborů z obrazovky miniatur.
Zobrazuje nastavení [Display Name] nakonfigurované v možnosti
[Server Settings1 až 3].

Clear
Completed
Jobs

Execute / Cancel –
Vymaže dokončené úlohy přenosu ze seznamu.
Execute: Vykonává funkci.

Clear All Jobs Execute / Cancel –
Vymaže všechny úlohy přenosu ze seznamu.
Execute: Vykonává funkci.

View Job List – – Zobrazí seznam úloh přenosu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

Nastavuje jazyk zobrazení.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Select – –
Nastavuje jazyk zobrazení.
Set: Nastavuje hodnotu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Nastavuje interní nastavení hodin.

Poznámka

Při změně tohoto nastavení z nabídky kamery vypněte napájení jednotky a restartujte jednotku. Při spuštění pohotovostního
režimu napájení pomocí infračerveného dálkového ovladače nebo webové aplikace může dojít k neočekávanému chování.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Time Zone UTC − 12:00 do UTC + 14:00 –
Nastavuje časový rozdíl od UTC v jednotkách 30
minut.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Vybírá formát zobrazení pro data.
YYMMDD: Rok, měsíc, den
MMDDYY: Měsíc, den, rok
DDMMYY: Den, měsíc, rok

12H/24H 12H / 24H 24H
Vybírá formát zobrazení hodin.
12H: Režim 12 hodin
24H: Režim 24 hodin

Date – –
Nastavuje aktuální datum.
Set: Nastavuje hodnotu.

Time – –
Nastavuje aktuální čas.
Set: Nastavuje hodnotu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hours Meter

Zobrazuje akumulovaný čas chodu.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Hours(System) – –
Zobrazuje akumulovaný počet hodin používání
(nelze resetovat).

Hours(Reset) – –
Zobrazuje akumulovaný počet hodin používání (lze
resetovat).

Reset Execute / Cancel –
Resetuje akumulovaný čas chodu na 0.
Execute: Vykonává funkci.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení možnosti ISO/Gain a výchozí hodnoty

Rozsah nastavení parametrů [ISO/Gain<L>] a výchozí hodnoty se liší v závislosti na nastavení parametrů [Mode], [Base
Look] > [Select] a [Base Sensitivity].
Výchozí hodnoty v tabulkách jsou zvýrazněny tučným písmem.

Když je možnost [Mode] nastavena na volbu [ISO]

Když je možnost [Base Look] > [Select] nastavena na volbu [S-Cinetone], [Standard], [ITU709],
[709tone] nebo [Still]

Když je možnost [Base Look] > [Select] nastavena na volbu [HLG Live] nebo [HLG Natural]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Když je možnost [Base Look] > [Select] nastavena na hodnotu [User1] až [User16]

Když je možnost [Mode] nastavena na volbu [dB]

Lze nakonfigurovat hodnotu v rozsahu −3dB až +30dB v krocích po 1dB.
Výchozí hodnota je 0dB.
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Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení možnosti AGC Limit a výchozí hodnoty

Rozsah nastavení nabídky [AGC Limit] a výchozí hodnoty se liší v závislosti na nastavení parametrů [Mode], [Base Look]
> [Select] a [Base Sensitivity].
Výchozí hodnoty v tabulkách jsou zvýrazněny tučným písmem.

Když je možnost [Mode] nastavena na volbu [ISO]

Když je možnost [Base Look] > [Select] nastavena na volbu [S-Cinetone], [Standard], [ITU709],
[709tone] nebo [Still]

Když je možnost [Base Look] > [Select] nastavena na volbu [HLG Live] nebo [HLG Natural]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Když je možnost [Base Look] > [Select] nastavena na hodnotu [User1] až [User16]

Když je možnost [Mode] nastavena na volbu [dB]

Vyberte z možností 3dB / 6dB / 9dB/ 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Výchozí hodnota je 15dB.
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Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [Low]

Když je možnost [ISO/Gain/EI] > [Base Sensitivity]
nastavena na volbu [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavení kvality obrazu uložená pro každý režim snímání

Aktuální stav položek konfigurace souvisejících s kvalitou obrazu se uloží pro každý z následujících režimů snímání. Při
změně režimu snímání se pro cílový režim snímání použijí odpovídající uložená nastavení.

Zobrazení cíle režimu Custom SDR(BT.709)
Zobrazení cíle režimu Custom HDR(HLG)
Snímání Log (Cine EI, Cine EI Quick, Flexible ISO)

V následujících tabulkách jsou uvedeny položky konfigurace týkající se kvality obrazu, které jsou uloženy pro každý
režim snímání.
„Ano“ znamená, že nastavení je uloženo, zatímco „Ne“ znamená, že nastavení není uloženo. „Ano“, zahrnující více
sloupců, znamená společné nastavení.

Položka

Režim snímání

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Nabídka
Shooting

ISO/Gain/EI

ISO/Gain Ano1) Ano Ne

Exposure Index Ne Ne Ano Ano

Base Sensitivity Ano Ne

Base ISO Ne Ano4) Ne3) Ano4)

White

Preset White Ano Ano

Jiné než výše
uvedené

Ano

White Setting Ano

Offset White Ano Ne

LUT On/Off Ne Ano

Noise
Suppression

Setting(Custom) Ano Ano Ne

Level(Custom) Ano Ano Ne

Setting (Cine
EI/Flex. ISO)

Ne Ano

Level (Cine EI/Flex.
ISO)

Ne Ano
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Položka

Režim snímání

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Nabídka
Paint/Look

Base Look

Select Ano Ano Ano

Input2) Ano

Output2) Ano

AE Level Offset2) Ano

Black Ano Ano Ne

Knee

Auto Knee Ano Ne Ne

Jiné než výše
uvedené

Ano Ano Ne

Detail Ano Ano Ne

Matrix Ano Ano Ne

Multi Matrix Ano Ano Ne

Pro režim CustomSDR(BT.709) a HDR(HLG) se ukládají samostatná nastavení citlivosti ISO.1)

Nastavení se uloží pro každý základní vzhled a nezávisí na režimu snímání.2)

Citlivost Base ISO se mění ve spojení s parametrem indexu expozice.3)

Společná hodnota nastavení v režimech snímání Flexible ISO a Cine EI.4)
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfigurace webové nabídky

Stisknutím karty přepínání ovládací obrazovky [Settings] zobrazte obrazovku nastavení.
Pomocí obrazovky nastavení nakonfigurujte různé položky nastavení jednotky, včetně počátečních nastavení, nastavení
sítě, nastavení snímání/přehrávání pomocí webové nabídky.

Nabídka obsahuje následující položky/podnabídky.

Konfigurace a hierarchie nabídky

Úroveň 1 Popis úrovně 1 Úroveň 2

Shooting Obsahuje nastavení související se snímáním/filmováním. Focus
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Úroveň 1 Popis úrovně 1 Úroveň 2

Project Obsahuje základní nastavení projektu.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Obsahuje nastavení související s kvalitou obrazu. Base Look

Pan-Tilt Obsahuje nastavení související s posunem/naklápěním.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Obsahuje nastavení související s výstupem videa a zobrazením na
obrazovce displeje.

Output Format

Output Display

Audio Obsahuje nastavení související se zvukem. Audio

Technical Obsahuje nastavení technických položek.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Obsahuje nastavení související se sítěmi.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Poznámka

Možnost [Accessibility] je dostupná pouze na modelech pro Severní Ameriku.
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Úroveň 1 Popis úrovně 1 Úroveň 2

Stream Obsahuje nastavení související se streamováním.

Stream

Video Stream

Audio Stream

Maintenance Obsahuje nastavení parametrů zařízení, jako jsou hodiny a jazyk.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Operace ve webové nabídce

Stisknutím karty přepínání ovládací obrazovky [Settings] a zobrazte obrazovku nastavení, jejíž pomocí nakonfigurujte
různé položky nastavení jednotky, včetně počátečních nastavení, nastavení sítě, nastavení snímání/přehrávání pomocí
webové nabídky.
Konfigurace nastavení ve webové nabídce na tabletu pomocí dotykového ovládání nebo na počítači pomocí ovládání
myší.
Stiskněte nabídku a zobrazte položky, které chcete nakonfigurovat, abyste zobrazili položky nastavení a jejich nastavení
v této nabídce.

Způsob konfigurace

Výběr hodnoty

Nabídka (úroveň 1)1.

Nabídka (úroveň 2)2.

Nastavení3.
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Stiskněte přepínač pro vybranou položku. Přepínač pro vybranou položku je zvýrazněn oranžově.

Zapnutí/vypnutí položky

Stisknutím spínače zapnete/vypnete položku. Když je položka zapnutá, spínač je oranžový a po vypnutí bílý.

Výběr hodnoty ze seznamu

Stiskněte rozevírací tlačítko a vyberte položku ze zobrazeného seznamu.

Výběr číselné hodnoty

Stisknutím tlačítka < nebo > změňte číselnou hodnotu. Pokud je číselná hodnota podtržená, můžete ji zadat také přímo.

Zadání znaku/čísla

Konfigurace na samostatné obrazovce
Stisknutím tlačítka provedete operace nastavení na samostatné obrazovce.

Informační zpráva

Zobrazí se informace, které vám pomohou nakonfigurovat některá nastavení a zprávy upozorňující uživatele.

Uložení nastavení

Po dokončení konfigurace nastavení jej uložte stisknutím tlačítka [OK].
Stiskněte tlačítko [Cancel], zahoďte změny nastavení a vrátili se k předchozímu nastavení.
Stiskněte tlačítko [Reload] a aktualizujte zobrazení na obrazovce.

Poznámka

Pokud před uložením nastavení stisknete tlačítko [Reload], změny nastavení budou zahozeny.

380



Pokud před uložením nastavení přejdete na jinou stránku, změny nastavení budou zahozeny.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Focus

Nastavuje parametry ostření.

Příbuzné téma

Ruční nastavení automatického zaostřování cíle (AF Assist) pomocí webové aplikace Web App
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Nastavuje režim vynuceného automatického zaostřování.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Nastavuje operaci, když stisknete panel obrazu kamery v režimu
MF.

AF Assist
Control

On / Off On

Když je nastavena možnost [On], můžete během automatického
zaostřování upravit polohu zaostření pomocí posuvníku zaostření
ve webové aplikaci.

Další informace naleznete v části „Ruční nastavení
automatického zaostřování cíle (AF Assist) pomocí webové
aplikace Web App“.

Poznámka

Tato položka je povolena pouze tehdy, když je možnost [AF Assist]
nastavena na hodnotu [On] v nabídce kamery.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

Nastavuje základní parametry nastavení.

Příbuzné téma

Konfigurace základní obsluhy
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Nastavuje režim snímání.

Další informace naleznete v části „Režim snímání“
v položce „Konfigurace základní obsluhy“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Nastavuje barevný gamut záznamu/výstupu v režimu
Custom.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

Nastavuje parametry formátu záznamu.

Nastavení [RAW Output Format]

Položka Nastavení podřízené položky Tovární
nastavení Popis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Vybírá systémovou frekvenci.

Poznámka

Pokud se frekvence změní, kamera se
restartuje. Po restartu stránku znovu načtěte
do webového prohlížeče.

Imager Scan
Mode

FF / S35 FF Vybírá velikost snímku.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Nastavuje kodek záznamu/přehrávání klipu.

Poznámka

Když je možnost [Imager Scan Mode]
nastavena na [S35], nelze vybrat možnost
[RAW] a [RAW & XAVC-I].

RAW Output
Format

Dostupná nastavení se liší v
závislosti na nastavení parametrů
[Frequency].

Viz „Nastavení [RAW Output
Format]“ níže.

–

Nastavuje velikost obrazu RAW na výstup do
externího rekordéru RAW.

Poznámka

Pokud je možnost [Codec] nastavena na
formát [RAW & XAVC-I], nastavení [Video
Format] se přepne v součinnosti s nastavením
[RAW Output Format].

Video
Format

Dostupná nastavení se liší v
závislosti na nastavení parametrů
[Frequency], [Imager Scan Mode] a
[Codec].

Viz „Nastavení [Video Format]“
níže.

– Nastavuje velikost snímku.

Frequency Imager Scan Mode Codec Nastavení

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160
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Výchozí hodnoty jsou zvýrazněny tučným písmem.
Podmínky, za kterých nelze nastavit [RAW Output Format], byly vynechány.

Nastavení [Video Format]

Výchozí hodnoty jsou zvýrazněny tučným písmem.
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Frequency Imager Scan Mode Codec Nastavení

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Nastavení

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Simul Rec

Nastavuje 2-slotový režim simultánního nahrávání (viz „Současné nahrávání na paměťové karty A a B. (2-slot Simul
Rec)“).

Příbuzné téma

Současné nahrávání na paměťové karty A a B. (2-slot Simul Rec)
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off
Zapíná/vypíná funkci současného nahrávání a také
nastavuje cílové médium pro nahrávání.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Zobrazí přiřazení tlačítka záznamu pro každé záznamové
médium.
Nastavte možnost [Project] > [Simul Rec] > [Rec Button Set]
v nabídce kamery.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Proxy Rec

Nastavuje parametry režimu záznamu proxy serveru (viz „Proxy záznam“).
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off Zapne nebo vypne režim proxy záznamu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Interval Rec

Nastavuje parametry intervalového režimu záznamu (viz „Přerušované nahrávání videa (Interval Rec)“).

Příbuzné téma
Přerušované nahrávání videa (Interval Rec)
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Položka Nastavení podřízené položky Tovární nastavení Popis

Setting On / Off Off

Zapíná/vypíná režim intervalového
záznamu. (Nastavením tohoto režimu
na volbu On se všechny ostatní
speciální režimy nastaví na volbu Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1
Nastavuje interval mezi záznamy v
režimu Interval Rec (je-li možnost
Interval Rec nastavena na volbu On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostupná nastavení se liší v
závislosti na frekvenci snímků
vybraného formátu videa.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavuje počet snímků pro záznam
na jeden snímek v režimu Interval
Rec (je-li možnost Interval Rec
nastavena na volbu On).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

Nastavuje parametry nastavení režimu záznamu do mezipaměti (viz „Nahrávání obrázků do mezipaměti (Picture Cache
Rec)“).

Příbuzné téma

Nahrávání obrázků do mezipaměti (Picture Cache Rec)
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off Zapíná/vypíná funkci ukládání obrazu do mezipaměti.

Cache Size
Short / Medium / Long
/ Max

Max
Nastavuje čas akumulace obrázků v mezipaměti (doba
záznamu mezipaměti obrázků).

Cache Rec
Time

– –
Zobrazuje čas akumulace obrázků v mezipaměti (doba
záznamu mezipaměti obrázků).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

All File

Provádí operace souboru ALL (viz „Ukládání a načítání dat konfigurace“).
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Load All
File

– –

Načtěte soubor ALL do jednotky ze zařízení se spuštěnou
webovou aplikací.

Poznámka

Po načtení souboru ALL do jednotky se jednotka restartuje. Po
restartu stránku znovu načtěte do webového prohlížeče.

Save All
File – –

Uložte nastavení jednotky do zařízení se spuštěnou webovou
aplikací jako soubor ALL.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Look

Do jednotky můžete nahrát základní pohled.
Na obrazovce se zobrazí seznam dostupných základních vzhledů. Aktuálně použitý základní vzhled je označen značkou
● vlevo od čísla základního vzhledu.

[No.]: Číslo základního vzhledu
[Base Look Name]: Název základního vzhledu
[Input]: Vstupní signál základního vzhledu
[Output]: Výstupní signál základního vzhledu
[AE Level Offset]: Referenční hodnota odchylky expozice základního vzhledu

Postup přidání základního vzhledu
Stiskněte tlačítko [Import] pro import nového základního vzhledu. Postupujte podle pokynů na obrazovce.
Po importu nastavte příslušné hodnoty pro položky [Input], [Output] a [AE Level Offset]. Další informace naleznete v části
„Importování požadovaného základního vzhledu“.

Příbuzné téma
Importování požadovaného základního vzhledu
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Speed

Nastavuje parametry související s rychlostí posunu/naklápění.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Speed
Step

Normal /
Extended

Extended

Nastavuje počet kroků rychlosti posunu/naklápění.
Normal: Rychlost může být zadána pomocí rozsahu 24 kroků. Toto
nastavení použijte pro kompatibilitu se stávajícími vzdálenými
kamerami Sony.
Extended: Rychlost může být zadána pomocí rozsahu 50 kroků.

Speed
Mode

Normal / Slow Normal

Nastavuje režim rychlosti posunu/naklápění.
Povoleno, pouze pokud je možnost [Speed Step] nastavena na
hodnotu [Normal].
Normal: Pracuje v normálním rozsahu rychlosti (od minima do
maxima (60 stupňů za sekundu)).
Slow: Pracuje v nízkém rozsahu rychlosti (od minima do maxima
(40 stupňů za sekundu)).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Acceleration

Nastavuje parametry související s rychlostí posunu/naklápění.
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Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Acceleration 1 až 9 8
Vybírá zrychlení/zpomalení pro operace posunu/naklápění.
Čím vyšší je číslo, tím vyšší je zrychlení.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Range Limit

Nastavuje parametry související s omezením provozního rozsahu posunu/naklápění.
Nastavte meze pracovního rozsahu posunu/naklápění pomocí následující obrazovky.

Poznámka

Je-li jednotka zapnuta nebo je proveden reset posunu/naklápění, je toto nastavení limitu rozsahu ignorováno. Tato funkce
nemůže být použita k vyhnutí se překážkám v blízkosti jednotky.

Nastavte spínač [Setting] do polohy On.

Aktivuje se funkce limitu pracovního rozsahu posunu/naklápění.

1

Zkontrolujte obraz pomocí ovladačů posunu/naklápění kamery.2

Chcete-li nastavit polohy, ve kterých chcete omezit provoz, stiskněte v těchto pozicích tlačítko [Left],
[Right], [Up], [Down] > [Set Current Value].

[Left]: Levá strana kamery
[Right]: Pravá strana kamery
[Up]: Horní strana kamery

3
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Poznámka

Pozice kamery mimo mezní polohy nelze uložit jako předvolbu.

Pokud změníte nastavení [Pan-Tilt] > [P/T Direction] > [Ceiling], vrátí se nakonfigurovaná mezní poloha do továrních nastavení.

Nastavení nelze změnit během přehrávání, během zobrazení miniatur, když nastane chyba posunu/naklápění, když není
inicializován posun/naklápění a když je posun/naklápění zamknutý.
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[Down]: Dolní strana kamery

Mezní polohy jsou nastaveny a jsou zobrazeny jako číselné hodnoty (úhel).
Chcete-li zrušit omezení, stiskněte tlačítko [Reset] pro jednotlivé polohy.

Stiskněte tlačítko [OK].

Funkce posunu/naklápění je omezena tak, aby zůstala v nakonfigurovaných mezních polohách.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Direction

Nastavuje parametry související se směrem posunu/naklápění.

Poznámka

Pokud je použito změněné nastavení [Ceiling], jsou všechny přednastavené polohy odstraněny, protože souřadnice
posunu/naklápění budou obráceny.

Rozsah posunu/naklápění pohonu se mění, jak je znázorněno na následujícím obrázku v závislosti na nastavení
[Ceiling].

A: Když je možnost [Ceiling] nastavena na volbu [Off]
B: Když je možnost [Ceiling] nastavena na volbu [On]

Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Ceiling On / Off Off

Při montáži jednotky na pracovní plochu nastavte možnost [Off]. Při
montáži jednotky na strop nastavte na hodnotu [On]. Když je možnost
[Ceiling] nastavena na hodnotu [On], je možnost [Pan Direction]
automaticky nastavena na hodnotu [Opposite].

Pan
Direction

Normal /
Opposite

Normal Nastavuje směr pohonu posunu. Když nastavení změníte, směr pohonu
se obrátí.

Tilt
Direction

Normal /
Opposite

Normal
Nastavuje směr pohonu naklápění. Když nastavení změníte, směr
pohonu se obrátí.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Preset

Nastavuje parametry související s předvolbami kamery.

Pan-Tilt
Nastavuje rychlost předvoleb.

Default
Nastaví výchozí hodnoty, které se nakonfigurují při uložení přednastavené polohy.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Nastavuje, zda jsou přednastavené rychlosti konfigurovány
samostatně nebo zda používají společné nastavení.

Pan-Tilt Speed
for Common

1 až 50 50

Nastavuje společnou rychlost předvoleb.

Poznámka

Maximální rychlost pohonu 24 se použije, pokud je nastavena
hodnota 25 nebo vyšší, když je možnost [Pan-Tilt] > [P/T Speed]
> [Speed Step] nastavena na hodnotu [Normal].

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Pan-Tilt Speed
for Separate

1 až 50 50
Nastavuje rychlost pro předvolby, když je metoda volby
předvolby rychlosti nastavena na volbu [Separate].

Zoom Sync On / Off On
Nastavuje, zda jsou operace posunu/naklápění a zoom
synchronizovány při obnovení přednastavené polohy.

Zoom Speed 0 až 32767 32767 Nastavuje rychlost zoomu.

Focus Recall On / Off On Určuje, zda jsou obnovena nastavení ostření.

MF Speed 0 až 32767 32767 Nastavuje rychlost ostření pro ruční ostření.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Nastavuje parametry formát výstupu.

Příbuzné téma

Výstupní formáty a omezení
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Položka Nastavení podřízené položky Tovární
nastavení Popis

SDI Další informace o nastavení naleznete v části
„Výstupní formáty a omezení“.

– Nastavuje rozlišení výstupů
SDI a HDMI.HDMI –
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

Nastavuje parametry související s výstupními signály.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

SDI On / Off Off
Nastavuje, zda jsou informace o nabídce a stavu integrovány do
výstupního signálu SDI.

HDMI/Stream On / Off On

Nastavuje, zda jsou informace o nabídce a stavu integrovány do
výstupního signálu HDMI.

Poznámka

Toto nastavení se také použije na výstupní obraz HDMI signálu,
výstupní obraz streamování a obraz v panelu obrazu kamery
webové aplikace.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Input

Nastavuje parametry související se zvukovým vstupem CH1 až CH4.

Nastavuje hlavní vstupní úroveň hlasitosti zvuku. Hlavní vstupní úroveň hlasitosti zvuku se používá pro všechny kanály 1
až 4.
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Položka Nastavení podřízené
položky Tovární nastavení Popis

Level
Control

Auto / Manual Auto
Vybírá automatické nastavení vstupní úroveň
hlasitosti zvuku nebo ruční nastavení.

Level 0 až 99 49 Nastavuje vstupní úroveň.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 a CH3: AUDIO
IN CH1
CH2 a CH4: AUDIO
IN CH2

Nastavuje vstupní zdroj zvuku.

Poznámka

Kanál CH1 je nastaven na hodnotu [AUDIO IN CH1]
(pevné).

Wind Filter On / Off Off Zapíná/vypíná filtr redukce hluku větru.

Položka Nastavení podřízené položky Tovární nastavení Popis

Master 0 až 99 99 Nastavuje hlavní vstupní úroveň.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Nastavuje parametry související se zvukovým výstupem.

Poznámka

Toto nastavení se také použije pro zvukový výstup streamování.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Nastavuje kombinaci zvukových kanálů na výstupu
HDMI/streamování.

402



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data Output

Nastavuje parametry související s výstupem informací o sledování (kompatibilní s protokolem free-d).
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Transfer Mode
Off / Always / On
Demand

Off Vybírá metodu výstupu informací o sledování.

Camera ID 0 až 255 255 Umožňuje nastavení ID jednotky.

Destination
Address

Adresa IPv4 –
Když je položka [Transfer Mode] nastavena na volbu [Always],
nastaví cílovou adresu IP informací o sledování.

Destination
Port

1024 až 65534 40000
Když je položka [Transfer Mode] nastavena na volbu [Always],
nastaví číslo cílového portu informací o sledování.

Listen Port 1024 až 65534 40000
Když je položka [Transfer Mode] nastavena na volbu [On
Demand], nastaví číslo portu na jednotce pro naslouchání
požadavkům klientů.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Nastavuje parametry kontrolky záznamu/indikace (viz „Připojení indikačního signálu“).

Příbuzné téma

Připojení indikačního signálu
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Tally Lamp
Brightness

High / Low / Off High Nastavuje jas kontrolky záznamu/indikace.

G Tally Lamp Enable / Disable Enable Aktivuje/deaktivuje indikační kontrolku G.

Tally Control External / Internal Internal
Vybírá cíl pro přijetí informací o ovládání kontrolky
záznamu/indikace jednotky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

Nastavuje parametry související s infračerveným dálkovým ovladačem.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off On
Aktivuje/deaktivuje obsluhu jednotky pomcí infračerveného
dálkového ovladače.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

RCP/MSU

Konfiguruje nastavení, když je připojeno RCP/MSU (volba).
Podrobnosti viz také kapitola „Připojení RCP/MSU (volitelné)“.

Poznámka

Nakonfigurujte nastavení na RCP/MSU podle potřeby.

Pro vícekamerový systém je vyžadována jednotka MSU.

Pokud používáte více jednotek MSU, nastavte jednu jednotku MSU jako hlavní a všechny ostatní jednotky MSU nastavte jako
klienty.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

CNS Mode
Off / Bridge / MCS /
PC Control

Off Slouží k nastavení režimu připojení pro RCP/MSU.

Master IP
Address

Adresa IPv4 0.0.0.0
Nastavuje IP adresu hlavního zařízení při vytváření
vícekamerového systému založeného na síti LAN.

Camera No. Camera No. (1 až
96)

1 Při vytváření vícekamerového systému založeného na síti
LAN nastaví v systému jedinečné číslo kamery.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens Controller

Nastaví nastavení pro připojený ovladač objektivu (volitelně).
Podrobnosti viz také část „Připojení ovladače objektivu“.

Poznámka

Když dojde ke změně [Setting], jednotka se restartuje. Stránku znovu načtěte do webového prohlížeče.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off Nastavuje, zda se má použít ovladač objektivu (volitelně).

Mode 0 až 15 0

Nastavuje provozní režim ovladače objektivu (volitelně).
Hodnoty v rozsahu 0 až 15 jsou k dispozici, ale skutečné hodnoty, které
lze vybrat, se budou lišit v závislosti na ovladači objektivu (volitelně).
Podrobnosti naleznete v uživatelské příručce ovladače objektivu.

Reverse On / Off Off Obrátí směr otáčení ovladače objektivu (volitelně).

Initialize – – Inicializuje ovladač objektivu (volitelně).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Camera Name

Nastavuje parametry související s názvem kamery (název jednotky).

Jako Camera Name je možné zadat až osm (0 až 8) z následujících znaků.
Alfanumerické znaky
Symboly (mezera !#$`*+-./;<=>?@[\]^_`{|})
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Položka Nastavení podřízené položky Tovární nastavení Popis

Camera Name – FR7 Nastavuje název kamery.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Nastavuje parametry související s přístupem uživatele k jednotce.

Nastavení související s uživateli s oprávněném správce (Administrator) (povinné)

Nastavení týkající se běžných uživatelů (User 1 až User 9) (nepovinné)
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Položka Nastavení podřízené položky Tovární nastavení Popis

User Name – admin Nastavuje uživatelské jméno.

Current Password – – Při změně hesla zadejte aktuální heslo.

New Password – – Zadejte nové heslo.

Re-Type Password – – Pro potvrzení zadejte znovu stejné heslo.

Položka Nastavení podřízené položky Tovární nastavení Popis

User Name – – Nastavuje uživatelské jméno.

Current Password – – Při změně hesla zadejte aktuální heslo.

New Password – – Zadejte nové heslo.

Re-Type Password – – Pro potvrzení zadejte znovu stejné heslo.

409



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Status
Zobrazuje stav sítě.

IPv4
Nastavuje parametry související se sítí IPv4.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Host Name – – Zobrazuje název hostitele.

MAC Address – – Zobrazuje adresu MAC jednotky.

Ethernet Status – – Zobrazuje aktuální rychlost komunikace.

IP Address – – Zobrazuje adresu IP jednotky.

Subnet Mask – – Zobrazí masku podsítě jednotky.

Gateway – – Zobrazuje výchozí bránu IPv4 jednotky.

Primary DNS Server – –
Zobrazuje adresu primárního serveru DNS
jednotky.

Secondary DNS
Server

– –
Zobrazuje adresu sekundárního serveru DNS
jednotky.

IPv6 Address 1 – – Zobrazuje IPv6 adresu 1 jednotky.

IPv6 Address 2 – – Zobrazuje IPv6 adresu 2 jednotky.

IPv6 Gateway – – Zobrazuje výchozí bránu IPv6 jednotky.

Link-local IPv6
Address

– –
Zobrazuje adresu IPv6 místního propojení
jednotky.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

DHCP On / Off On Zapíná/vypíná funkci [DHCP].

IP Address – –
Nastavuje adresu IPv4, když je možnost [DHCP]
nastavena na hodnotu Off.

Subnet
Mask

– –
Nastavuje masku podsítě, když je možnost [DHCP]
nastavena na hodnotu Off.

Gateway – –
Nastavuje výchozí bránu IPv4, když je možnost [DHCP]
nastavena na hodnotu Off.
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IPv6
Nastavuje parametry související se sítí IPv6.

Common
Nastavuje parametry společné pro sítě IPv4/IPv6.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Obtain an IP Address
Automatically

On / Off On Zapíná automatické získávání adresy IPv6.

IP Address – –
Nastavuje adresu IPv6, když je možnost [Obtain an IP
Address Automatically] nastavena na hodnotu Off.

Prefix Length – – Nastavuje předponu, když je možnost [Obtain an IP
Address Automatically] nastavena na hodnotu Off.

Gateway – –
Nastavuje výchozí bránu IPv6, když je možnost [Obtain
an IP Address Automatically] nastavena na hodnotu
Off.

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

HTTP Port 80, 1024 až 65534 80 Nastavuje číslo portu HTTP.

DNS Auto On / Off On
Nastavuje, zda chcete získat adresy DNS ze serveru
DHCP.

Primary DNS
Server Adresa IPv4/IPv6 –

Zadejte primární server DNS v případě, že možnost
[DNS Auto] je nastavena na volbu Off.

Secondary DNS
Server

Adresa IPv4/IPv6 –
Zadejte sekundární server DNS v případě, že možnost
[DNS Auto] je nastavena na volbu Off.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Nastavuje parametry související s přenosy souborů.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Auto Upload
(Proxy)

On / Off Off Zapne nebo vypne automatické nahrání proxy souboru.

Default
Upload
Server

Server Settings1
až 3 > Display
Name

Server
Settings1

Vybere server pro odesílání souborů. Zde vybraný server se stane
cílovým místem pro automatické odesílání proxy souborů a
cílovým místem pro odesílání souborů z obrazovky miniatur.
Zobrazuje nastavení [Display Name] nakonfigurované v možnosti
[Server Settings1 až 3].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

FTP Server 1 až 3

Nastavuje parametry související s přenosy souborů FTP.
Nastavení jsou společná pro FTP Server 1 až 3.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Display Name – –
Nastavuje zobrazovaný název v nabídce nastavení
cílového umístění přenosu.

Service – – Zobrazí typ serveru.

Host Name – – Nastavuje název hostitele cílového serveru přenosu.

Port 21, 990, 1024 až
65534

21 Nastavuje číslo portu cílového serveru přenosu.

User Name – –
Nastavuje uživatelské jméno pro ověření připojení
cílového serveru přenosu.

Password – –
Nastavuje ověřovací heslo pro připojení cílového
serveru přenosu.

Passive Mode On / Off Off Zapnutí/vypnutí pasivního režimu.

Destination
Directory

– – Nastavuje název cílového adresáře přenosu.

Using Secure
Protocol

On / Off Off
Nastavuje, zda použít (On) nebo nepoužít (Off)
zabezpečený přenos FTP.

Root Certificate – –

Načte kořenový certifikát pro zabezpečený přenos
FTP.
Stiskněte tlačítko [Load] a na zobrazené obrazovce
vyberte kořenový certifikát.
Pro odstranění načteného kořenového certifikátu
stiskněte tlačítko [Delete].

Root Certificate
Status

– – Zobrazuje stav načtení kořenového certifikátu.

Reset – –
Resetuje nastavení [Server Settings] na výchozí
hodnoty.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SSL

Nastavuje parametry související s protokolem SSL.

SSL
Aktivuje/deaktivuje funkci SSL.

SSL Server Authentication
Nastavuje parametry související se serverem SSL ověřování.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
Aktivuje/deaktivuje funkci
SSL.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external
certificate

– Nastavuje způsob instalace certifikátu SSL serveru.

Status – –
Zobrazuje platnost certifikátu SSL serveru, když je
možnost [Certificate Options] nastavena na hodnotu
[Use a self-signed certificate (For test use)].

Issuer DN – –

Zobrazuje jednoznačné jméno vydavatele certifikátu
SSL serveru, když je možnost [Certificate Options]
nastavena na hodnotu [Use a self-signed certificate (For
test use)].

Subject DN – –

Zobrazuje jednoznačné jméno subjektu certifikátu SSL
serveru, když je možnost [Certificate Options]
nastavena na hodnotu [Use a self-signed certificate (For
test use)].

Available Period – –
Zobrazuje dobu platnosti certifikátu SSL serveru, když je
možnost [Certificate Options] nastavena na hodnotu
[Use a self-signed certificate (For test use)].

Extended Key
Usage

– –
Zobrazuje rozšířenou metodu použití klíče, když je
možnost [Certificate Options] nastavena na hodnotu
[Use a self-signed certificate (For test use)].

Delete – –

Toto tlačítko se zobrazí v případě, že možnost
[Certificate Options] je nastavena na hodnotu [Use a
self-signed certificate (For test use)].
Odstraní nainstalovaný certifikát SSL serveru.
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Import – –
Nainstaluje externí certifikát SSL serveru ze seznamu v
případě, že možnost [Certificate Options] je nastavena
na hodnotu [Use an external certificate].

Private Key
Password

– –

Nastavuje heslo pro informace o soukromém klíči
certifikátu SSL serveru v případě, že možnost
[Certificate Options] je nastavena na hodnotu [Use an
external certificate].

Reset – –
Toto tlačítko vymaže zobrazení hesla soukromého klíče
pro zadání nového hesla.

Self-Signed
Certificate
Generation

– –

Stisknutím tlačítka [Generate] vygenerujete certifikát s
vlastním podpisem v případě, že možnost [Certificate
Options] je nastavena na hodnotu [Use a self-signed
certificate (For test use)].
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Referer Check

Nastavuje parametry související s kontrolami odkazujícího serveru.

Exception List
Nastavuje parametry související se seznamem výjimek kontrolní referenčního serveru.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off On
Aktivuje/deaktivuje funkci kontroly odkazujícího
serveru.

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

No. 1 až 10 – Nastaví číslo výjimky ze seznamu.

Host
Name

– – Nastavuje název hostitele výjimky.

Port
Number – – Nastavuje číslo portu výjimky.

Set – –
Stisknutím tlačítka zaregistrujete nakonfigurovanou výjimku v
seznamu výjimek.

Delete – –
Vyberte výjimku, kterou chcete odstranit, a stiskněte tlačítko pro
odstranění registrované výjimky ze seznamu výjimek.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Brute Force Attack Protection

Nastavuje parametry související s ochranou před útoky hrubou silou.

Když je útočník detekován, zobrazí se informace o seznamu útočníků.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Setting On / Off On Zapíná/vypíná funkci [Brute Force Attack Protection].

Count 3 až 100 8
Nastavuje počet pokusů, které budou považovány za útok.
Povoleno, pokud je možnost [Setting] nastavena na hodnotu On.

Release
Mode

Always / Timer Timer

Nastavuje podmínky uvolnění.
Povoleno, pokud je možnost [Setting] nastavena na hodnotu On.
Always: Neodstraňovat ze seznamu útočníků.
Timer: Odstranit ze seznamu útočníků po uplynutí doby uvolnění
nastavené pomocí [Release Time].

Release
Time

30 až 86400 s 60

Nastavuje čas uvolnění.
Povoleno, pokud je možnost [Setting] nastavena na hodnotu On.
Když je možnost Release Mode nastavena na hodnotu [Timer],
položky jsou odstraněny ze seznamu útočníků po uplynutí doby
vydání.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Nastavuje parametry streamování (viz „O streamování“).

Stream Setting
Nastavuje parametry související s protokolem streamování.

Poznámka

Chcete-li použít RTMP, nastavte položku [Stream] > [Audio Stream] > [Setting] předem na hodnotu [On].

RTSP
Následující položky se zobrazí v případě, že možnost [Stream Setting] je nastavena na hodnotu [RTSP].
Nastavuje parametry související s RTSP streamováním.

RTMP
Následující položky se zobrazí v případě, že možnost [Stream Setting] je nastavena na hodnotu [RTMP].
Nastavuje parametry související s RTMP streamováním.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX /
Off

RTSP
Vybírá protokol
streamování.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Port Number 554, 1024 až 65534 554 Nastavuje číslo RTSP portu.

Time Out 0 až 600 60
Nastavuje časový limit příkazu Keep Alive pro RTSP
streamování.

Authentication On / Off On Zapíná/vypíná funkci ověřování RTSP.

Video Port
Number 1

1024 až 65534 51000
Nastavuje číslo portu pro odesílání videa 1 pro
RTSP unicast streamování.

Video Port
Number 2

1024 až 65534 53000
Nastavuje číslo portu pro odesílání videa 2 pro
RTSP unicast streamování.

Audio Port
Number

1024 až 65534 57000
Nastavuje číslo portu pro odesílání zvuku pro RTSP
unicast streamování.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Server URL – –
Nastavuje cílovou adresu URL připojení RTMP nebo
RTMPS.
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SRT
Následující položky se zobrazí v případě, že možnost [Stream Setting] je nastavena na hodnotu [SRT-Caller] nebo [SRT-
Listener].
Nastavuje parametry související s SRT streamování.

NDI|HX
Následující položky se zobrazí v případě, že možnost [Stream Setting] je nastavena na hodnotu [NDI|HX].
Nastavuje parametry související s NDI|HX.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Stream Key – – Nastavuje klíč proudu získaný ze strany serveru RTMP.

Root
Certificate

– –

Načte kořenový certifikát požadovaný pro připojení k
serveru RTMP.
Stiskněte tlačítko [Load] a na zobrazené obrazovce
vyberte kořenový certifikát.
Pro odstranění načteného kořenového certifikátu
stiskněte tlačítko [Delete].
Stav se zobrazuje v části [Root Certificate Status].

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Destination – –
Nastavuje cílovou adresu URL připojení, když jednotka
pracuje jako volající.

Port
Number

1024 až 65534 4201
Nastavuje číslo portu pro poslech, když jednotka pracuje
jako posluchač.

Latency 20 až 8000 ms 120 Nastavuje latenci.

TTL 1 až 255 64 Nastavuje hodnotu TTL.

Encryption Off / AES128 / AES256 Off Povoluje/zakazuje šifrování a nastavuje metodu šifrování.

Passphrase
0 nebo řetězec 10 až 79
znaků

0
Nastavuje přístupové heslo použité pro šifrování.
Pro vymazání zadané přístupového hesla stiskněte
tlačítko Reset.

ARC On / Off On Zapíná/vypíná funkci Adaptive Rate Control.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

License – – Zobrazí stav instalace licenčního klíče NDI.

Source Name – – Zobrazuje název zdroje NDI.

Group On / Off Off Zapíná/vypíná funkci seskupování NDI.

Group Name – –
Zobrazuje se, kdy je funkce seskupování NDI
nastavena na hodnotu On.
Nastavuje název skupiny.
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Příbuzné téma

O streamování
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Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Discovery
Server 1

– – Nastavuje NDI server zjišťování 1.

Discovery
Server 2

– – Nastavuje NDI server zjišťování 2.

Multicast Mode On / Off Off Zapíná/vypíná vícesměrové streamování.

Multicast Prefix 239.255.0.0 239.255.0.0

Zobrazí se, pokud je možnost [Multicast Mode]
nastavena na hodnotu On.
Nastavuje předponu pro použití ke vícesměrovému
streamování.

Multicast
Netmask

255.255.0.0 255.255.0.0

Zobrazí se, pokud je možnost [Multicast Mode]
nastavena na hodnotu On.
Nastavuje masku sítě, která určuje rozsah adres
vícesměrového streamování.

Multicast TTL 1 až 256 3
Zobrazí se, pokud je možnost [Multicast Mode]
nastavena na hodnotu On.
Nastavuje hodnotu TTL pro vícesměrové streamování.

Multi-TCP
Mode

On / Off Off Zapíná/vypíná režim Multi-TCP.

Unicast UDP
Mode

On / Off On Zapíná/vypíná režim Unicast UDP.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

Nastavuje parametry související s video kodeky streamování.

Video Stream 1
Nastavuje parametry související s video kodekem 1.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Codec 1 H.264 / H.265 H.264 Nastavuje kodek obrazu 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Nastavuje velikost obrazu 1.

Frame Rate 1

Další informace o podporovaných
snímkových frekvencích naleznete v
části „Nastavení video kodeku pro
streamování“.

–
Nastavuje snímkovou frekvenci
obrazu 1.

I-Picture Mode 1 Time / Frame Time
Nastavuje interval vložení IDR-
Frame obrazu 1 jako čas nebo
počet snímků.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Zobrazí se, pokud je možnost [I-
Picture Mode 1] nastavena na
hodnotu Time.
Nastavuje interval vložení IDR-
Frame pro H.264 a H.265 jako čas.

I-Picture Ratio 1 15 až 300 snímků 30

Zobrazí se, pokud je možnost [I-
Picture Mode 1] nastavena na
hodnotu Frame.
Nastavuje interval vložení IDR-
Frame pro H.264 a H.265 jako počet
snímků.

Profile 1
H.264: high / main / baseline
H.265: main / main10 H.264: high

Nastavuje profil obrazového kodeku
H.264 nebo H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Nastavuje režim komprese
přenosové rychlosti obrázku 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000
/ 6000 / 7000 / 8000 / 16000 / 24000 /
32000 / 50000 / 64000 / 80000 kbps

16000

Zobrazí se, pokud je možnost [Bit
Rate Compression Mode 1]
nastavena na hodnotu On.
Nastavuje cílovou hodnotu
přenosové rychlosti, když je režim
komprese přenosové rychlosti
nastaven na CBR.
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Video Stream 2
Nastavuje parametry související s video kodekem 2.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Nastavuje kvalitu obrazového
kodeku H.264 nebo H.265.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Codec 2 H.264 / H.265 / Off Off Nastavuje kodek obrazu 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Nastavuje velikost obrazu 2.

Frame Rate 2

Další informace o podporovaných
snímkových frekvencích naleznete v
části „Nastavení video kodeku pro
streamování“.

–
Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na volbu Off.
Nastavuje snímkovou frekvenci obrazu 2.

I-Picture Mode 2 Time / Frame Time

Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na volbu Off.
Nastavuje interval vložení IDR-Frame
obrazu 2 jako čas nebo počet snímků.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na hodnotu Off
a možnost [I-Picture Mode 2] je
nastavena na hodnotu [Time].
Nastavuje interval vložení IDR-Frame
pro H.264 a H.265 jako čas.

I-Picture Ratio 2 15 až 300 snímků 30

Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na hodnotu Off
a možnost [I-Picture Mode 2] je
nastavena na hodnotu [Frame].
Nastavuje interval vložení IDR-Frame
pro H.264 a H.265 jako počet snímků.

Profile 2
H.264: high / main / baseline
H.265: main

–
Nastavuje profil obrazového kodeku
H.264 nebo H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na volbu Off.
Nastavuje režim komprese přenosové
rychlosti obrázku 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Zobrazuje se v případě, že možnost
[Codec 2] není nastavena na hodnotu Off
a možnost [Bit Rate Compression Mode
2] je nastavena na hodnotu [On].
Nastavuje cílovou hodnotu přenosové
rychlosti, když je režim komprese
přenosové rychlosti nastaven na CBR.
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Video Stream 3
Nastavuje parametry související s video kodekem 3.

Příbuzné téma

Nastavení video kodeku pro streamování

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené položky Tovární
nastavení Popis

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Zobrazí se, pokud je možnost [Codec 2]
nastavena na hodnotu H.264 a možnost
[Bit Rate Compression Mode 2] je
nastavena na hodnotu Off.
Nastavuje kvalitu obrazového kodeku
H.264 nebo H.265.

Položka Nastavení podřízené položky Tovární
nastavení Popis

Codec 3 JPEG JPEG Nastavuje kodek
obrazu 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Nastavuje velikost
obrazu 3.

Frame
Rate 3

Další informace o podporovaných snímkových frekvencích
naleznete v části „Nastavení video kodeku pro
streamování“.

– Nastavuje snímkovou
frekvenci obrazu 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Nastavuje kvalitu.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

Nastavuje parametry související s audio kodeky streamování.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Setting On / Off Off Zapíná/vypíná výstup streamování zvuku.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Zobrazí se, pokud je možnost [Setting] nastavena na
hodnotu On.
Nastavuje zvukový kodek pro streamování.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

Nastavuje jazyk zobrazení.

Poznámka

Dostupné jazyky se mohou lišit v závislosti na zemi nebo oblasti.
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Položka Nastavení podřízené položky Tovární nastavení Popis

Language – – Nastavuje jazyk zobrazení.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

Nastavuje parametry související se zvukovým čtením (z textu do řeči).

Poznámka

Tato funkce je k dispozici pouze u modelů prodávaných v Severní Americe. Funkci čtečky obrazovky lze použít pouze tehdy, je-li
jazyk nastaven na angličtinu (k datu vydání).

Povolte funkci čtečky obrazovky webového prohlížeče na zařízení se spuštěnou webovou aplikací.
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Položka Nastavení podřízené položky Tovární
nastavení Popis

Screen
Reader

On / Off Off 
Zapíná/vypíná funkci čtečky obrazovky v panelu
obrazu kamery webové aplikace.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal
Nastavuje rychlost funkce čtečky obrazovky.
Při nastavené rychlosti se hlasitě přečte vzorek.

Speech
Volume

1 až 15 7

Nastavuje hlasitost funkce čtečky obrazovky
webové aplikace.
Při nakonfigurované hlasitosti se nahlas přečte
vzorek.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Nastavuje interní nastavení hodin.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené položky Tovární
nastavení Popis

Current
Date & Time

– – Zobrazuje aktuální čas nakonfigurovaný na jednotce.

PC Clock – –
Zobrazuje aktuální čas tabletu nebo počítače
použitého pro konfiguraci.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-
dd-yyyy hh:mm:ss / dd-mm-
yyyy hh:mm:ss

yyyy-mm-dd Nastavuje formát zobrazení pro datum a čas.

12 h / 24 h 12 h / 24 h 24 h
Nastavuje čas na 12hodinový / 24hodinový formát
zobrazení.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

– Nastavuje způsob konfigurace pro datum a čas.

yy-mm-dd
hh:mm:ss

yy: 19 až 37
mm: 01 až 12
dd: 01 až 31
hh: 00 až 23
mm: 00 až 59
ss: 00 až 59 (sekundy)

–
Zobrazí se, pokud je možnost [Time Setting]
nastavena na hodnotu Manual setting.
Ručně nastavuje datum a čas.

NTP Auto On / Off Off

Zobrazí se, pokud je možnost [Time Setting]
nastavena na hodnotu Synchronize with NTP.
Nastavuje, zda chcete získat adresy IP serveru NTP
ze serveru DHCP.

NTP Server
IPv4/IPv6 adresa nebo název
hostitele

–

Zobrazuje se v případě, že možnost [Time Setting] je
nastavena na hodnotu [Synchronize with NTP] a
možnost [NTP Auto] je nastavena na hodnotu Off.
Určuje server NTP používaný pro synchronizaci času.

Time Zone UTC − 12:00 do UTC + 14:00 – Volí časové pásmo.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

Inicializuje jednotku.

Reboot
Restartuje jednotku.

Reset
Resetuje nastavení jednotky.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Reboot Execute –

Restartuje jednotku.
Execute: Vykonává funkci.

Poznámka

Po restartu stránku znovu načtěte do webového
prohlížeče.

Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

All Reset (except for
Network Settings)

Execute –

Resetuje nastavení jednotky (kromě síťových
nastavení).
Execute: Vykonává funkci.

Poznámka

Importované základní vzhledy a soubory LUT jsou
odstraněny.

Network Reset Execute –

Resetuje síťová nastavení jednotky.
Execute: Vykonává funkci.

Poznámka

Po vykonání Network Reset se jednotka restartuje. Po
restartu stránku znovu načtěte do webového
prohlížeče.
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Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

Factory Default Execute –

Vrací nastavení jednotky do výchozího továrního
nastavení.
Execute: Vykonává funkci.

Poznámka

Po vykonání Factory Default se jednotka restartuje. Po
restartu stránku znovu načtěte do webového
prohlížeče.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Information

Zobrazuje informace o kameře a objektivu. Používá se také k aktualizaci softwaru.

Camera
Zobrazuje informace o kameře a aktualizuje software.

Lens
Zobrazuje informace o objektivu a aktualizuje software.

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Model Name – – Zobrazí název modelu kamery.

Serial
Number

– – Zobrazí sériové číslo kamery.

Version
Number

– – Zobrazuje informace o verzi softwaru jednotky.

Version Up – –

Stiskněte tlačítko [Choose File] a aktualizujte software
kamery podle pokynů na obrazovce.

Poznámka

Po aktualizaci se jednotka restartuje. Po restartu stránku
znovu načtěte do webového prohlížeče.

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Model
Name

– – Zobrazí název modelu objektivu.

Serial
Number

– – Zobrazí sériové číslo objektivu.

Version
Number

– – Zobrazuje informace o verzi softwaru objektivu.
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Příbuzné téma

Aktualizace softwaru objektivu E-Mount

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení
podřízené položky

Tovární
nastavení Popis

Version Up – –

Stiskněte tlačítko [Choose File] a aktualizujte software
objektivu podle pokynů na obrazovce.

Podrobnosti viz také kapitola „Aktualizace softwaru
objektivu E-Mount“.

Poznámka

Po aktualizaci objektivu se jednotka restartuje. Po restartu
stránku znovu načtěte do webového prohlížeče.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

System Log

Nastavuje parametry související s systémovým protokolem.

Získaný protokol se zobrazí, jak je znázorněno níže.

Příbuzné téma

Aktualizace softwaru objektivu E-Mount

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical,
Warning & Info

Nastavuje úroveň pro přidání záznamu do
systémového protokolu.

Log Size 200 až 1024 1024
Nastavuje velikost záznamu, který se má uložit do
systémového protokolu.

Download as
File – –

Stiskněte tlačítko [Download] a uložte systémový
protokol do tabletu nebo počítače ze zobrazené
obrazovky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HTTP Access Log

Nastavuje parametry související s protokolem HTTP přístupu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka Nastavení podřízené
položky

Tovární
nastavení Popis

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical,
Warning & Info

Nastavuje úroveň pro přidání záznamu do
přístupového protokolu HTTP.

Log Size 200 až 1024 1024
Nastavuje velikost záznamu, který se má uložit do
přístupového protokolu HTTP.

Download
as File – –

Stiskněte tlačítko [Download] a uložte přístupový
protokol HTTP do tabletu nebo počítače ze zobrazené
obrazovky.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Service

Získá informace o jednotce. Použijte při kontaktování servisního zástupce společnosti Sony.

5-041-958-43(1) Copyright 2022 Sony Corporation

Položka
Nastavení
podřízené
položky

Tovární
nastavení Popis

I agree to download
device information.

– –

Zaškrtněte toto pole a vyjádřete tak souhlas se získáváním
informací o zařízení, pak stiskněte tlačítko [OK].
Stiskněte zobrazené tlačítko [Download]. Webový prohlížeč
stáhne soubor s názvem deviceinformation.dat.

Poznámka

Po stažení se jednotka restartuje. Pokud se jednotka
nerestartuje automaticky, restartujte ji ručně. Po restartu
stránku znovu načtěte do webového prohlížeče.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

EULA

Zobrazuje licenční smlouvu s koncovým uživatelem (EULA).

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Software

Zobrazuje softwarovou licenci.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Připojení externích monitorů a záznamových zařízení

Chcete-li zobrazit zaznamenané/přehrávané obrazy na externím monitoru, nastavte typ výstupu externího monitoru a
použijte vhodný kabel pro připojení monitoru.
Můžete také připojit externí záznamník a zaznamenat výstupní signál z jednotky.
Na externím monitoru můžete zobrazit stejné informace, které jsou viditelné v panelu obrazu kamery, například
informace o stavu a nabídky. Nastavte požadovaný typ systému pro zobrazení obrazovky na hodnotu On pomocí
položek [Monitoring] > [Output Display] ve webové nabídce.

Poznámka

Je-li monitor připojen ke konektoru HDMI, který nepodporuje výstupní formát HDMI nakonfigurovaný pomocí nabídky [Monitoring]
ve webové nabídce nebo v nabídce kamery, obraz kamery se do webové aplikace neodešle. Streamované video také nelze
odeslat na výstup.

Můžete nastavit možnost [Output Display] > [SDI] a [HDMI/Stream] na hodnotu [Off], tím však zabráníte použití nabídky kamery a
funkcí, které závisí na zobrazení obrazovky. Kromě toho budou oznámení o chybách jednotky omezena na kontrolky (rozsvícené
nebo blikající) jednotky a zobrazení oznamovací značky v pravém horním rohu webové aplikace. Chcete-li zobrazit podrobnosti,
nastavte možnost [Output Display] na hodnotu [On].

Tip

Ve výchozím nastavení výrobce je možnost [Output Display] > [SDI] nastavena na hodnotu [Off] a možnost [HDMI/Stream] na
hodnotu [On]. Chcete-li streamování použít jako hlavní video, nastavte položku [SDI] na hodnotu [On] a [HDMI/Stream] na
hodnotu [Off], a pak sledujte stav kamery na monitoru SDI.

Konektor SDI OUT (typ BNC)

Formát výstupu nastavte pomocí nabídky [Monitoring] ve webové nabídce nebo v nabídce kamery.
Pro připojení použijte volně prodejný koaxiální kabel 75 Ω.

Poznámka

Před zapnutím zařízení zkontrolujte, zda je spojení mezi jednotkou a externím zařízením řádně uzemněno.

Doporučujeme jednotku a externí zařízení zapnout až po připojení koaxiálního kabelu 75 Ω.
Pokud musí být externí zařízení připojeno k jednotce, když je tato zapnutá, připojte nejprve koaxiální kabel 75 Ω k
externímu zařízení a poté jej připojte k jednotce.

Zahájení záznamu na jednotku a externí zařízení současně
S povoleným výstupem signálu SDI nastavte v nabídce kamery možnost [Project] > [SDI/HDMI Rec Control] > [Setting]
na hodnotu [SDI/HDMI Remote I/F] nebo [Parallel Rec], aby byl výstup spouštěcího signálu záznamu REC povolen do
externího zařízení připojeného ke konektoru SDI OUT. Tím dojde k synchronizaci záznamu na externím zařízení s
jednotkou.

Poznámka

Pokud připojené externí zařízení nepodporuje spouštěcí signál REC, nelze jej ovládat.

Když je možnost [Project] > [SDI/HDMI Rec Control] > [Setting] nastavena na hodnotu [SDI/HDMI Remote I/F] v nabídce kamery,
výstup spouštěcího signálu REC je možný pouze v případě, že není vloženo žádné záznamové médium a je spuštěno tlačítko
START/STOP záznamu.
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Konektor HDMI OUT (konektor typu A)

Nastavení stavu výstupu na On/Off a výstupního formátu proveďte v nabídce [Monitoring] nabídky kamery.

Zahájení záznamu na jednotku a externí zařízení současně
S povoleným výstupem signálu HDMI nastavte možnost [TC/Media] > [HDMI TC Out] > [Setting] na hodnotu [On] a
[Project] > [SDI/HDMI Rec Control] > [Setting] na hodnotu [SDI/HDMI Remote I/F] nebo [Parallel Rec] v nabídce kamery
a povolte tak výstup signálu spouště REC do externího zařízení připojeného ke konektoru HDMI OUT. Tím dojde k
synchronizaci záznamu na externím zařízení s jednotkou.

Poznámka

Pokud připojené externí zařízení nepodporuje spouštěcí signál REC, nelze jej ovládat.

Když je možnost [Project] > [SDI/HDMI Rec Control] > [Setting] nastavena na hodnotu [SDI/HDMI Remote I/F] v nabídce kamery,
výstup spouštěcího signálu REC je možný pouze v případě, že není vloženo žádné záznamové médium a je spuštěno tlačítko
START/STOP záznamu.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Připojení k RCP/MSU

Některé funkce jednotky lze ovládat na dálku připojením dálkového ovládacího panelu (RCP), například RCP-3500/3501,
nebo hlavní nastavovací jednotky (MSU), například MSU-3500, k jednotce pomocí kabelu LAN.
Způsob připojení se bude lišit v závislosti na konfiguraci souvisejících zařízení a aplikaci.

Podrobnosti o spojení mezi jednotkou a RCP naleznete v části „Propojení jeden-na-jednoho mezi jednotkou a RCP“.
Podrobnosti o připojení více kamer pomocí MSU nebo softwaru pro ovládání kamery naleznete v kapitole „Použití
jednotky v prostředí více kamer se softwarem pro dálkové ovládání MSU/kamery“.

Příbuzné téma

Propojení jeden-na-jednoho mezi jednotkou a RCP

Použití jednotky v prostředí více kamer se softwarem pro dálkové ovládání MSU/kamery

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Propojení jeden-na-jednoho mezi jednotkou a RCP

Poznámka

Viz „Seznam podporovaných funkcí“ a nakonfigurujte jednotku tak, aby splňovala provozní podmínky pro funkce, které chcete
použít, a poté povolte spojení s RCP pomocí následujícího postupu.

Příbuzné téma
Seznam podporovaných funkcí

5-041-958-43(1) Copyright 2022 Sony Corporation

Zapněte všechna zařízení.1

Nastavte možnost [Technical] > [RCP/MSU] > [CNS Mode] na hodnotu [Bridge] ve webové nabídce kamery.2

Nakonfigurujte následující nastavení na RCP.

Podrobnosti o konfiguraci naleznete v uživatelské příručce RCP.

3

Nastavte režim připojení do režimu Bridge.1.
Registruje IP adresu kamery.2.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Použití jednotky v prostředí více kamer se softwarem pro dálkové ovládání
MSU/kamery

Můžete připojit několik kamer pomocí MSU nebo softwaru dálkového ovládání kamery.

Poznámka

Viz „Seznam podporovaných funkcí“ a nakonfigurujte jednotku tak, aby splňovala provozní podmínky pro funkce, které chcete
použít, a poté povolte spojení s MSU nebo softwaru dálkového ovládání kamery pomocí následujícího postupu.

Příbuzné téma
Seznam podporovaných funkcí
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Zapněte všechna zařízení.1

Nakonfigurujte síťová nastavení systému pomocí softwaru dálkového ovládání MSU nebo kamery.

Podrobnosti o konfiguraci naleznete v uživatelské příručce MSU nebo softwaru dálkového ovládání kamery.

2

Následující nastavení nakonfigurujte pomocí položek [Technical] > [RCP/MSU] ve webové nabídce kamery.3

Pokud používáte jednotku MSU, nastavte položku [CNS Mode] na hodnotu [MCS]. Pokud používáte software
dálkového ovládání kamery, nastavte položku [CNS Mode] na hodnotu [PC Control].

1.

Nastavte IP adresu hlavní jednotky MSU nebo softwaru dálkového ovládání kamery v položce [Master IP
Address].

2.

Nastavte číslo kamery, pro kterou bude kamera zaregistrována v [Camera No.].3.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Seznam podporovaných funkcí

Následující tabulka zobrazuje podporované funkce a jejich odpovídající provozní podmínky.

Ovládací
panel Funkce jednotky Provozní podmínky

IRIS Ruční nastavení clony –

AUTO IRIS Zapínání/vypínání Auto Iris –

ND
Přepínání přednastavené polohy filtru ND
(Clear/Preset1 až Preset3)

Tato funkce je povolena, když je možnost
[Shooting] > [ND Filter] > [Mode] nastavena na
[Preset] v nabídce kamery.

MASTER
GAIN

Ruční nastavení zesílení (3 dB jednotky)

Aktivováno, když je režim snímání nastaven na
režim Custom a možnost [Shooting] >
[ISO/Gain/EI] > [Mode] je nastavena na [dB] v
nabídce kamery.

WHITE
(R/B)

Ruční nastavení vyvážení bílé (R Gain/B Gain)

Povoleno, pokud je možnost [White Mode]
nastavena na hodnotu [Memory A(R/B)] nebo
[Memory A(T/T)].

WHITE
(Color
Temp)

Ruční nastavení vyvážení bílé (barevná
teplota/odstín)

RCP – [Color Temp]: Teplota barvy vyvážení
bílé
RCP – [Balance]: Hodnota odstínu vyvážení
bílé

ATW
Zapnutí/vypnutí funkce ATW (automatické
sledování vyvážení bílé barvy)

Pokud je režim snímání nastaven na režim
Custom.

BLACK R/B Nastavení vyvážení černé
Pokud je režim snímání nastaven na režim
Custom.
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Poznámka

Nakonfigurujte jednotku tak, aby splňovala provozní podmínky pro funkce, které chcete použít, a poté povolte připojení pomocí
RCP/MSU. Pokud jsou provozní podmínky upraveny po povolení připojení, může dojít k neúmyslnému chování.

5-041-958-43(1) Copyright 2022 Sony Corporation

Ovládací
panel Funkce jednotky Provozní podmínky

MASTER
BLACK

Nastavení úrovně hlavní korekce černé

Pokud je režim snímání nastaven na režim
Custom.
H/V Ratio a Crispening jsou povoleny, když je
možnost [Paint/Look] > [Detail] > [Manual
Setting] nastavena na [On] v nabídce kamery.

DETAIL

Zapínání/vypínání funkce detailů
Nastavení úrovně detailů
Nastavení H/V Ratio
Nastavení Crispening

User Matrix

Zapíná/vypíná funkci korekce uživatelské
matrice
Nastavení korekčních hodnot matrice (R-G /
R-B / G-R / G-B / B-R / B-G)

Multi Matrix

Zapíná/vypíná funkci korekce vícenásobné
matrice
Nastavení odstínu a sytosti barvy použité pro
korekci vícenásobné matrice

Knee

Zapínání/vypínání funkce korekce
senzitometrické křivky
Zapínání/vypínání automatické funkce
senzitometrické křivky
Nastavení bodu senzitometrické křivky a sklonu
senzitometrické křivky

BARS Zapínání/vypínání pruhů barev

SHUTTER

Zapínání/vypínání funkce závěrky
Nastavení hodnoty času závěrky
(zapnutí/vypnutí automatické závěrky,
nastavení úhlu závěrky, nastavení pomalé
závěrky, nastavení ECS není podporováno.)

Poznámka

V závislosti na nakonfigurované hodnotě
rychlosti závěrky se nemusí zobrazit
nastavení závěrky RCP.

Nastavení závěrky RCP nemusí být
zobrazeno správně, pokud nelze závěrku
ovládat z RCP.

Pokud je zapnuta automatická závěrka, bude
automatická závěrka nadále fungovat, i když
zapnete/vypnete závěrku nebo změníte hodnotu
rychlosti závěrky pomocí RCP.
Když je závěrka nastavena na [Angle],
zapnutí/vypnutí závěrky nebo změna nastavení
času závěrky z RCP není podporována.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

O ovládání pomocí dálkového ovladače RM-IP500 (volitelné)

Jednotku můžete ovládat pomocí dálkového ovladače Sony RM-IP500 se softwarem verze 2.2 nebo novější. Zařízení
komunikují prostřednictvím protokolu VISCA over IP (LAN).
V závislosti na cílové položce, kterou chcete ovládat, se možná budete muset dívat na obrazovku jednotky. Připravte
monitor, který lze použít ke kontrole zobrazení na obrazovce.
Následující operace jsou podporovány dálkovým ovladačem RM-IP500.

Výběr cílové kamery
Nastavení seřízení obrazu (posun, naklápění, zoom)
Nastavení zaostření (vylučuje ovládání dotykem)
Registrace a odvolání přednastavených pozic
Ovládání nabídky jednotky (kromě webové nabídky)
Nastavení jasu
Nastavení vyvážení bílé
Nastavení vyvážení černé
Nastavení vstupní úroveň hlasitosti zvuku.
Spuštění/zastavení záznamu
Vykonání přiřaditelných funkcí tlačítek jednotky

Podrobnosti o obsluze RM-IP500 naleznete v uživatelské příručce RM-IP500.

Tip

Při použití RM-IP500 použijte panel pro tuto jednotku, který je dodáván s RM-IP500.

RM-IP500 (použití panelu pro tuto jednotku)
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Připojení dálkového ovladače RM-IP500

Podrobnosti o přiřazování funkcí naleznete v uživatelské příručce RM-IP500.

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavte spínač SETUP 3 jednotky do polohy ON, abyste aktivovali komunikaci VISCA over IP.

Poznámka

Nastavení spínače se použije při dalším zapnutí jednotky.

1

Připojte RM-IP500 ke stejné síti jako jednotka.2

Během konfigurace připojení VISCA over IP (LAN) na RM-IP500 postupujte podle pokynů v uživatelské
příručce RM-IP500.

Tuto jednotku přiřaďte pomocí nabídky RM > AUTO IP SETUP > ASSIGN CAM.

3

Podle potřeby přiřaďte funkce této jednotky tlačítkům a ovladačům pomocí následujících položek nabídky
RM RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

O synchronizaci s externím zařízením

Při snímání pomocí více jednotek lze jednotky synchronizovat s konkrétním referenčním signálem nebo časovým kódem
prostřednictvím konektoru kombinace obrazových signálů jednotek (GENLOCK).

Podrobnosti o kombinace obrazových signálů naleznete v části „Synchronizace fáze videosignálu (kombinace
obrazových signálů)“.
Podrobnosti o synchronizaci časových kódů naleznete v části „Uzamčení časového kódu pro jiná zařízení“.

Příbuzné téma

Synchronizace fáze videosignálu (kombinace obrazových signálů)

Uzamčení časového kódu pro jiná zařízení

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronizace fáze videosignálu (kombinace obrazových signálů)

Pro aktivaci kombinace obrazových signálů můžete do konektoru GENLOCK přivést referenční signál.
Vstupní referenční signály, které lze použít, se liší v závislosti na frekvenci systému vybraného formátu záznamu.

Stav externí synchronizace můžete zkontrolovat pomocí možností [Technical] > [Genlock] > [Reference] v nabídce
kamery.

Poznámka

Pokud je referenční signál nestabilní, nelze dosáhnout kombinace obrazových signálů.

Pomocná nosná není synchronizována.
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Systémová frekvence formátu záznamu Podporované vstupní referenční signály

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Uzamčení časového kódu pro jiná zařízení

Nastavte jednotku, která poskytuje časový kód, do režimu, ve kterém se udržuje výstup časového kódu aktivní (například
možnosti Free Run nebo Clock).

Poznámka

Zkontrolujte, zda jsou dodaný referenční časový kód a referenční videosignál ve fázovém vztahu, který odpovídá standardu
časového kódu SMPTE.

Při práci s externím zámkem získá časový kód zámek s externím časovým kódem a v oblasti zobrazení časových dat se zobrazí
hodnota externího časového kódu. Nahrávání však není zahájeno okamžitě. Před záznamem vyčkejte několik sekund, dokud se
generátor časového kódu nestabilizuje.

Pokud frekvence referenčního video signálu a snímková frekvence na jednotce nejsou stejné, nelze získat uzamčení a jednotka
nebude pracovat správně. Pokud k tomu dojde, časový kód nebude úspěšně získávat zámek s externím časovým kódem.

Pokud je zdroj externího časového kódu odpojen, časový kód se vzhledem k referenčnímu časovému kódu může posunout o
jeden snímek za hodinu.

Uvolnění externího zámku
Změňte nastavení [TC/Media] > [Timecode] v nabídce kamery.
Externí synchronizace se také uvolní, pokud se změní systémová frekvence, nebo když spustíte záznam ve zvláštním
režimu záznamu (možnosti Slow & Quick Motion nebo Interval Rec).
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Nastavte následující v položkách [TC/Media] > [Timecode] v nabídce kamery.

Nastavte položku [Mode] na hodnotu [Preset].
Nastavte položku [Run] na hodnotu [Free Run].

1

Stisknutím přiřaditelného tlačítka přiřazeného funkci [DURATION/TC/U-BIT] zobrazíte časový kód na
obrazovce.

2

Připojte referenční video signál HD nebo SD ke konektoru GENLOCK a referenční časový kód ke konektoru
TC IN.

Generátor časového kódu jednotky získá zámek s referenčním časovým kódem a na obrazovce se zobrazí text
„EXT-LK“.
Po uplynutí přibližně deseti sekund po uzamčení časového kódu se stav externího zámku udržuje, i když je odpojen
zdroj externího referenčního časového kódu.

3
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Připojení externího mikrofonu nebo externího zvukového zařízení

Signál můžete připojit z externího mikrofonu nebo externího zvukového zařízení a zvuk integrovat do nahraného videa
nebo výstupního videa jednotky.

Připojte externí mikrofon nebo externí zvukové zařízení pomocí kabelu XLR.

Je-li zvuk nastaven na hodnotu [LINE] pomocí možnosti [Audio] > [Audio Input] > [AUDIO IN Select] v nabídce
kamery, konektor AUDIO IN plní funkci konektoru AUDIO IN CH-1 a AUDIO IN CH-2.

1

Kolík č. Funkce

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Vypněte jednotku a připojte kabel XLR ke konektoru AUDIO IN.2

Nastavte přepínač SETUP 2 a povolte zdánlivé napájení podle potřeby.

Zapněte napájení +48 V (zdánlivé napájení), jak je popsáno níže.
Spínač 2
Nastavuje, zda je během připojení zvukového vstupního zařízení zapnuto/vypnuto napájení +48 V (zdánlivé
napájení).

3

Nastavení Popis

OFF
(výchozí)

Tím se vypne zdánlivé napájení +48 V a nastaví se vstup LINE nebo MIC jako zdroj zvuku CH-1
a CH-2.
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Poznámka

Nastavení tohoto spínače do polohy ON a připojením mikrofonu, který není kompatibilní s napájecím zdrojem +48 V,
můžete poškodit připojené zařízení. Před připojením zařízení zkontrolujte nastavení.

Nastavení Popis

ON
Tím se zapne zdánlivé napájení +48 V a nastaví se mikrofon kompatibilní se zdánlivým
napájením jako zdroj zvuku pro CH-1 a CH-2.

Zapněte jednotku a nastavte typ připojeného zařízení pomocí položek [Audio] > [Audio Input] > [AUDIO IN
Select] v nabídce kamery.

4
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Správa/úprava klipů pomocí počítače

Klipy můžete spravovat/upravovat pomocí počítače.

Import klipů pomocí čtečky karet (volitelná možnost)

Připojte ke svému počítači čtečku karet CFexpress Type A nebo čtečku karet SD a pro import klipů použijte software,
který podporuje formát záznamu této jednotky, například Catalyst Browse.

Použití systému nelineárních úprav

V systému nelineárních úprav je vyžadován software pro úpravy (volitelná možnost), který podporuje formáty
zaznamenané jednotkou.
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453



Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Výstup optického signálu

Výstup signálu SDI lze převést na optický signál připojením modulu SFP+ (volitelně) ke konektoru OPTICAL jednotky.
Použijte modul SFP+, který odpovídá pásmu signálu každého formátu.
Pásmo signálu

4K (59.94p, 50p): 12G
4K (kromě 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (kromě 59.94p, 50p): 1.5G

Poznámka

Použijte modul, který splňuje následující standardy.

Standardy SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Standardy SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Stejný signál jako na výstupním konektoru SDI je odeslán do modulu SFP+.

Jednotka nepodporuje vstup optického signálu.

Pro výstup optického signálu použijte modul SFP+. Podrobné informace o ověřených modulech SFP+ získáte u servisního
zástupce společnosti Sony.
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* Úroveň výkonu I (1,0 W)
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Průvodce nápovědou

Interchangeable Lens Digital Camera
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Připojení indikačního signálu

Toto téma popisuje ovládání indikačního signálu.

Rozsvícení indikační kontrolky pomocí signálu z dálkového ovladače

Indikační kontrolku můžete rozsvítit pomocí příkazu VISCA over IP z externího zařízení, například RM-IP500.
Nastavte možnost [Technical] > [Tally] > [Tally Control] na hodnotu [External] ve webové nabídce nebo v nabídce kamery.

Rozsvícení indikační kontrolky z externího zařízení

Indikační kontrolku jednotky můžete rozsvítit červeně nebo zeleně pomocí externího zařízení, například RM-IP500 nebo
přepínače. Indikaci můžete ovládat pomocí příkazů přenášených po síti nebo pomocí indikačního signálu přivedeného na
konektoru OPTION jednotky.
Nastavte možnost [Technical] > [Tally] > [Tally Control] na hodnotu [External] ve webové nabídce nebo v nabídce kamery.
Při odesílání indikačního signálu na vstup konektoru OPTION zkratování kolíku 7 na GND (buď kolík 4 nebo 5) rozsvítí
kontrolku zeleně, nebo kolíku 8 na GND (buď kolík 4 nebo 5) rozsvítí kontrolku červeně.

Poznámka

Je-li možnost [Tally Control] nastavena na hodnotu [External], indikační kontrolka neukazuje stav záznamu jednotky.

Pokud je současně odeslán na vstup signál červené a zelené indikace, rozsvítí se indikační kontrolka jednotky červeně.

Specifikace kolíků konektoru OPTION

Kolík č. Směr signálu Specifikace signálu

1 – Signál RS-232C TX (pro ovladač objektivu)

2 – Signál RS-232C RX (pro ovladač objektivu)

3 OUT

Výstup zelené indikační kontrolky
Výstup nízké úrovně, když svítí zelená kontrolka.
Hi-Z (výstup s otevřeným kolektorem), když nesvítí zelená kontrolka.

4 – GND (uzemnění)

5 – GND (uzemnění)
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Rozsvícení indikační kontrolky externího zařízení pomocí signálu z jednotky

Indikační kontrolku externího zařízení můžete rozsvítit pomocí signálu z jednotky připojením kolíku 3 a 6 konektoru
OPTION, jak je znázorněno níže.
Příklad připojení kolíků 3 a 6 konektoru OPTION

Poznámka

Na kolíky 7 a 8 nepřivádějte napětí.

Nepřipojujte externí zařízení, které může na konektor OPTION přivést napětí.

Pokud na kolíky 3 nebo 6 použijete přívodní nebo zpětné napětí, které přesahuje jmenovité napětí, může to způsobit poruchu,
kouř nebo požár.

Nastavte výstupní signál pomocí možnosti [Technical] > [Tally] > [Tally Control] ve webové nabídce nebo v nabídce kamery.
[Internal]: Stav operace záznamu jednotky
[External]: Logické A červené/zelené indikační signály přijímané jednotkou prostřednictvím signálů IN nebo dálkových ovladačů.
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Kolík č. Směr signálu Specifikace signálu

6 OUT

Výstup červené indikační kontrolky
Výstup nízké úrovně, když svítí červená kontrolka.
Hi-Z (výstup s otevřeným kolektorem), když nesvítí červená kontrolka.

7 IN
Vstup zelené indikační kontrolky externího ovládání
Zkrat na zem (kolík 4 nebo 5) způsobí, že se kontrolka jednotky rozsvítí zeleně.

8 IN
Vstup červené indikační kontrolky externího ovládání
Zkrat na zem (kolík 4 nebo 5) způsobí, že se kontrolka jednotky rozsvítí červeně.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Výstup sledovacích dat (free-d)

Jednotka může odesílat informace o posunu / naklápění / zoomování, zaostřování a sledování clony synchronizované se
synchronizačním signálem.
Výstup dat odpovídá protokolu free-d, průmyslovému standardu. Můžete vybrat výstupní metodu, volbu mezi
konstantním výstupem a výstupem na vyžádání od klientů. Vyberte metodu výstupu podle svého systému VR/AR.

Formát výstupu dat

Tip

Technické podrobnosti jsou uvedeny v příručce „Příručka integrace pro free-d.“ V případě potřeby kontaktujte obchodního
zástupce společnosti Sony.

Sledovací data, která je výstupem jednotky, obsahují následující data podle formátu uvedeného v Type D0/D1 protokolu
free-d.
Type D0 – poll/command

Zkontrolujte, zda je jednotka zapnuta.1

Nastavte metodu výstupu sledovacích dat.

Pro konstantní výstup

Pro výstup na vyžádání od klientů

2

Nastavte možnost [Technical] > [Tracking Data Output] > [Transfer Mode] na hodnotu [Always] ve webové
nabídce.

1.

Nastavte ID jednotky v položce [Camera ID].2.
Zadejte výstupní cílovou IP adresu v položce [Destination Address].3.
Zadejte číslo cílového výstupního portu v [Destination Port].4.
Stiskněte tlačítko [OK].5.

Nastavte možnost [Technical] > [Tracking Data Output] > [Transfer Mode] na hodnotu [On Demand] ve webové
nabídce.

1.

Nastavte ID jednotky v položce [Camera ID].2.
Zadejte číslo portu pro naslouchání požadavkům klientů v [Listen Port].3.
Stiskněte tlačítko [OK].4.

Symbol Obsah Popis

<D0> Message type

<CA> Camera ID

<CD> command

Podporuje tyto příkazy:

00 Stop stream mode
01 Start stream mode
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Type D1 – camera position/orientation data

Poznámka

V následujících situacích mohou být sledovací data zpožděna nebo hodnoty nemusí být aktualizovány:

Při výstupu videa ve formátu RAW
Když je zapnuta funkce Pohyb S&Q
Při zobrazení nabídky kamery
Při zobrazení obrazovky miniatur
Při přehrávání nahraných klipů
Při zobrazení webové nabídky
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Symbol Obsah Popis

<CK> Checksum

Symbol Obsah Popis

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Úhel posunu (−170° až +170°)

<TH><TM><TL> Camera Tilt Angle Úhel naklopení (−30° až +195°)

<RH><RM><TL> Camera Roll Angle Není podporováno (vždy 0)

<XH><XM><XL> Camera X-Position Není podporováno (vždy 0)

<YH><YM><YL> Camera Y-Position Není podporováno (vždy 0)

<HH><HM><HL> Camera Height Není podporováno (vždy 0)

<ZH><ZM><ZL> Camera Zoom Ohnisková vzdálenost

<FH><FM><FL> Camera Focus Vzdálenost ostření

<SH><SL> Spare/User Defined Poloha clony

<CK> Checksum
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Připojení ovladače objektivu

Můžete ovládat zoom objektivu s ručním zoomem z webové aplikace, pomocí RM-IP500 (volitelně) nebo infračerveného
dálkového ovladače, a to připojením běžně dostupného ovladače objektivu (volitelně), který je kompatibilní s touto
jednotkou.
Podrobnosti o připojení ovladače objektivu. naleznete v uživatelské příručce ovladače objektivu.
Podrobnosti o nastavení zoomu pomocí ovladače objektivu naleznete v části „Nastavení zoomu pomocí ovladače
objektivu“.

Poznámka

Před použitím ovladače objektivu si pečlivě přečtěte uživatelskou příručku ovladače objektivu a ujistěte se, že plně rozumíte jeho
použití. Společnost Sony nenese odpovědnost za žádné nároky jakéhokoli druhu vyplývající z použití ovladače objektivu.

Funkce Clear Image Zoom není k dispozici, pokud je aktivován ovladač objektivu. Doporučujeme nastavit poměr funkce Clear
Image Zoom na 1,0× nebo tuto funkci vypnout.

Pokud je ovladač objektivu povolen, operace snímkování kamery nelze nahrávat nebo přehrávat.

Příbuzné téma

Nastavení zoomu pomocí ovladače objektivu
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Interchangeable Lens Digital Camera
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Nastavení zoomu pomocí ovladače objektivu

Následujícím postupem připojte ovladač objektivu (volitelně) a upravte zoom.

Zjištění stavu ovladače objektivu
Stiskněte tlačítko  (Stav kamery) ve společné oblasti obrazovky webové aplikace a zobrazte obrazovku stavu kamery.

Připojte ovladač objektivu k OPTION konektoru na bloku konektoru jednotky.

Podrobnosti o přídavných zařízeních naleznete v uživatelské příručce ovladače objektivu.

1

Nastavte ovladač objektivu pro objektiv s proměnlivou ohniskovou vzdáleností.

Podrobnosti naleznete v uživatelské příručce ovladače objektivu.

2

Zajistěte otáčení/naklápění jednotky a připojte objektiv s proměnlivou ohniskovou vzdáleností.

Podrobnosti viz také kapitola „Upevnění objektivu“.

3

Nastavte ovladač objektivu tak, aby mohl ovládat objektiv s proměnlivou ohniskovou vzdáleností.4

Udržujte rovnováhu hlavy kamery ve směru dopředu/dozadu tak, aby byla posuvná základna vodorovně.

Podrobnosti naleznete v uživatelské příručce ovladače objektivu a v části „Upevnění objektivu“.

5

Nastavte možnost [Technical] > [Lens Controller] > [Setting] na hodnotu [On] ve webové nabídce a
stiskněte tlačítko [OK].

Jednotka se restartuje. Počkejte, dokud nebude dokončena operace resetování posunu/naklápění.

6

Stiskněte tlačítko  (Inicializovat ovladač objektivu) na kartě  (Others) na ovládacím panelu
fotoaparátu na obrazovce živého provozu webové aplikace.

Ovladač objektivu se pohybuje a detekuje rozsah zoomu. Podrobnosti naleznete v uživatelské příručce ovladače
objektivu.
Když se indikace  (Chyba ovladače objektivu) změní na  (Ovladač objektivu je připraven) v levém horním
rohu obrazového panelu kamery, příprava je dokončena.

Poznámka

Při inicializaci ovladače objektivu si všimněte provozního rozsahu objektivu.

7

Zoom můžete nastavit pomocí posuvníku [Zoom] ve webové aplikaci nebo tlačítek ovládání zoomu na
infračerveném dálkovém ovladači.

8
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Na této obrazovce můžete zkontrolovat stav ovladače objektivu.

Poznámka

Při výměně objektivu inicializujte ovladač objektivu.

Funkce Clear Image Zoom není k dispozici, pokud je aktivován ovladač objektivu. Doporučujeme nastavit poměr funkce Clear
Image Zoom na 1,0× nebo tuto funkci vypnout.

5-041-958-43(1) Copyright 2022 Sony Corporation

Stav Popis

Off Použijte elektrický zoom v objektivu E-Mount.

Communication
Error

Došlo k chybě komunikace mezi jednotkou a ovladačem objektivu.
Zkontrolujte připojení mezi jednotkou a ovladačem objektivu, poté postupujte podle pokynů k
obsluze ovladače objektivu a inicializujte ovladač objektivu.

Uninitialized Proveďte inicializaci.

Initializing Počkejte na dokončení inicializace.

Initialization
Failed

Zkontrolujte připojení mezi jednotkou a ovladačem objektivu, poté postupujte podle pokynů k
obsluze ovladače objektivu a inicializujte ovladač objektivu.

Working Ovládejte zoom pomocí ovladače objektivu.

Rotation Error
Uložený rozsah pohybu zoomu a rozsah pohybu objektivu se nemusí shodovat. Proveďte
inicializaci ovladače objektivu.

System Error Zkontrolujte připojení mezi jednotkou a ovladačem objektivu, postupujte podle pokynů k obsluze
ovladače objektivu a inicializujte ovladač objektivu nebo vypněte jednotku a ovladač objektivu.Unknown Error
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bezpečnostní opatření k použití

Bezpečnostní opatření při přepravě a balení
Při přepravě nebo balení jednotky dodržujte následující podmínky a vyhněte se jejímu vystavení silným vibracím nebo
rázům.

Sejměte objektiv a na tělo přístroje nasaďte kryt.
Po přesunutí hlavy kamery (A) dopředu otočte páku zámku hlavy kamery (B) ve směru šipky, abyste zajistili hlavu
kamery.

Orientujte hlavu kamery tak, aby směřovala dopředu, a uzamkněte ji pomocí zamykací páky posunu/naklápění.

Odpojte spojovací kabely.

Kondenzace
Pokud jednotku přenesete z chladného místa na teplé nebo pokud dojde k náhlému zvýšení okolní teploty, může se na
vnějším povrchu jednotky nebo uvnitř vytvořit vlhkost. Tento jev se nazývá kondenzace. Pokud dojde ke kondenzaci,
vypněte jednotku a před dalším použitím vyčkejte, než kondenzace zmizí. Při použití jednotky v případě výskytu
kondenzace hrozí poškození jednotky.

Jevy obrazového snímače CMOS kamery

Poznámka

V obrazech se mohou vyskytnout následující jevy, které jsou specifické pro obrazové snímače. Neznamenají žádnou poruchu.

Bílé skvrny
I když jsou obrazové snímače vyráběny vysoce přesnými technologiemi, mohou se na obrazovce v ojedinělých
případech vyskytovat bílé skvrny, způsobené například kosmickým zářením atd.
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To souvisí s principem obrazových snímačů a nejedná se o poruchu. APR provádějte pravidelně.
Bílé skvrny je možné pozorovat obzvláště v následujících případech:

Při provozování zařízení při vysoké okolní teplotě;
Když zvýšíte zesílení (citlivost) zařízení.

Kmitání
Pokud natáčíte při osvětlení zářivkami, sodíkovými výbojkami, rtuťovými výbojkami nebo LED diodami, může obraz
na displeji kmitat nebo se mohou měnit jeho barvy.

Jednotky pohonu objektivu a posunu/naklápění
Pokud není objektiv a mechanismus pohonu posunu/naklápění delší dobu v činnosti, může se viskozita maziva
použitého uvnitř součástí zvýšit, čímž se zabrání pohybu mechanismu. Objektiv a mechanismus posunu/naklápění
používejte pravidelně.

Spotřební součásti
Ventilátor a vestavěné baterie jsou spotřební díly, které vyžadují pravidelnou výměnu.
Když jednotku používáte za pokojové teploty, činí běžný cyklus výměny zhruba 5 let. Cyklus výměny však
představuje pouze obecné vodítko a neznamená, že je životnost těchto dílů zaručená.
Podrobnosti o výměně dílu získáte v servisu Sony nebo od svého prodejce.

Očekávaná životnost síťového adaptéru a elektrolytického kondenzátoru za běžných provozních teplot a při běžném
používání (8 hodin denně; 25 dní v měsíci) činí přibližně 5 let. Pokud způsob používání běžné používání překročí,
může se očekávaná životnost odpovídajícím způsobem snížit.

Doporučuje se provádět pravidelnou kontrolu a udržovat tak jednotku v řádném a provozuschopném stavu a prodloužit
tak její životnost. Další informace o kontrolách vám poskytne prodejní zástupce společnosti Sony.

Informace o vestavěném dobíjecím akumulátoru
Jednotka má vestavěný dobíjecí akumulátor pro uložení data, času a dalších nastavení i po dobu vypnutí jednotky.
Vestavěný dobíjecí akumulátor se začne nabíjet po 24 hodinách, pokud bude jednotka připojena k síťové zásuvce
pomocí napájecího adaptéru, nebo v případě napájení prostřednictvím PoE++, a to bez ohledu na to, zda je jednotka
zapnutá nebo vypnutá. Dobíjecí akumulátor se zcela vybije asi po 2 měsících, pokud nepřipojíte napájecí adaptér k
napájení. Používejte jednotku až po nabití akumulátoru. I když však nabíjecí akumulátor nebude nabitý, nebude to mít
žádný vliv na činnost jednotky, pokud nebudete chtít zaznamenávat datum.

Umístění při používání a uskladnění
Přístroj uskladněte na rovném a dobře větraném místě.
Jednotku nepoužívejte ani neskladujte na následujících místech:

Místa vystavená dešti nebo vodě (včetně míst pod okapy)
Venkovní prostředí a místa, která přesahují 40 °C
Uvědomte si, že v létě v teplém klimatu může teplota uvnitř vozidla s uzavřenými okny snadno překročit 50 °C.
Místa studenější než 0 °C.
Vlhká nebo mokrá místa; Oblasti, kde hrozí vystavení jednotky dešti;
Místa s vibracemi nebo rázy
Oblasti, kde je generováno záření, rentgenové záření a silné magnetické pole.
V blízkosti rozhlasových nebo televizních vysílačů, které generují silné elektromagnetické pole;
Dlouhodobě na místech vystavených působení přímého slunečního záření nebo v blízkosti topných těles.

Poznámka k laserovým paprskům
Laserové paprsky mohou poškodit obrazový snímač CMOS. Pokud snímáte scénu, která zahrnuje laserový paprsek,
buďte opatrní, abyste laser nenasměřovali přímo do obrazového snímače CMOS kamery. Obzvláště pak platí, že vysoce
výkonné laserové paprsky z lékařských nebo jiných zařízení mohou způsobit poškození v důsledku odraženého nebo
rozptýleného světla.

Ochrana před elektromagnetickým rušením z přenosných komunikačních zařízení
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Použití přenosných telefonů a dalších komunikačních zařízení v blízkosti této jednotky může způsobit poruchy a rušení
audio a video signálů. Doporučuje se, aby přenosná komunikační zařízení umístěná v blízkosti této jednotky byla
vypnutá.

Neumísťujte tento produkt blízko lékařských přístrojů
Tento přístroj (včetně doplňků) obsahuje magnet/y, které mohou interferovat s kardiostimulátory, shunty s
programovatelnou chlopní, užívanými při léčbě hydrocefalu nebo jinými lékařskými přístroji. Neukládejte tento produkt v
blízkosti osob, které tyto lékařské přístroje používají. Pokud používáte některý z těchto lékařských přístrojů, poraďte se s
lékařem předtím, než budete používat tento produkt.

Bezpečnostní opatření
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA ŠKODY ŽÁDNÉHO DRUHU, KTERÉ JSOU DŮSLEDKEM
NEIMPLEMENTOVÁNÍ SPRÁVNÉHO ZABEZPEČENÍ V PŘENOSOVÝCH ZAŘÍZENÍ, NEVYHNUTELNÝCH ÚNIKŮ
DAT, KTERÉ JSOU DŮSLEDKEM SPECIFIKACÍ PŘENOSOVÝCH PARAMETRŮ, NEBO PROBLÉMY
ZABEZPEČENÍ JAKÉHOKOLIV DRUHU.
V závislosti na provozních podmínkách mohou být třetí strany v síti schopny k jednotce přistupovat. Pokud jednotku
připojíte do sítě, nezapomeňte si ověřit, že síť je řádně chráněna.
Z bezpečnostního hlediska se při používání jednotky připojené k síti důrazně doporučuje přistupovat k ovládacímu
oknu prostřednictvím webového prohlížeče a změnit tovární přednastavené hodnoty omezení přístupu. Doporučuje
se nastavit heslo s dostatečně dlouhým řetězcem znaků, který ostatní těžko uhodnou, a bezpečně jej uložit.
V případě připojování tohoto produktu k síti se připojte pomocí systému, který poskytuje funkci ochrany, jako je
například směrovač nebo brána firewall. V případě připojení bez takové ochrany se mohou vyskytnout problémy se
zabezpečením.

Napájecí zdroj
Přístroj není vybaven spínačem napájení. Chcete-li jednotku vypnout, zkontrolujte, zda byly všechny operace
ukončeny a zda je jednotka v pohotovostním stavu, a poté odpojte síťový adaptér. Pokud používáte napájecí zdroj
PoE++, odpojte kabel LAN.
Pokud je to možné, použijte napájecí zdroj z místa, kde je snadné zasunout a vyjmout napájecí zástrčku.
Pokud používáte zásuvku v prašném místě, pravidelně čistěte oblast kolem zásuvky, abyste zabránili jejímu
zadrhnutí.
Pokud zařízení nepoužíváte, odpojte napájecí zdroj.

Bezpečnostní opatření pro pohyblivé součásti
Ujistěte se, že do pohyblivých částí nevniká cizí látka.
Při ručním pohybu součástí nepoužívejte nadměrnou zátěž. Pokud tak učiníte, může dojít k poruše.
Během pohybu nezasahujte do činnosti pohyblivých částí. Pokud tak učiníte, může dojít ke zranění nebo poruše.
Pohyblivé části nemusí pracovat normálně, pokud jednotka není používána po delší dobu. Pravidelně ovládejte
funkce posunu/naklápění jednotky.

Opatření pro nepřetržitý provoz
Jednotku lze napájet 24 hodin denně, 365 dní v roce (pohotovostní režim).
Vždy proveďte test snímání a ověřte, zda jednotka pracuje normálně.

Nepřetržité snímání po dobu delší než 24 hodin není zaručeno.
Pokud snímáte déle než 24 hodin, přepněte jednotku do pohotovostního režimu a poté ji restartujte.

Upozorňujeme, že společnost Sony nenese žádnou odpovědnost za kompenzaci za obsah snímků, pokud nejste
schopni fotografovat kvůli jakékoliv poruše při používání této jednotky.
Před použitím si vždy ověřte, že jednotka pracuje správně. SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA
ŽÁDNÉ ŠKODY JAKÉHOKOLIV DRUHU, KROMĚ JINÉHO VČETNĚ KOMPENZACE NEBO NÁHRADY JDOUCÍ NA
ÚČET ZTRÁTY STÁVAJÍCÍHO NEBO BUDOUCÍHO ZISKU V DŮSLEDKU ZÁVADY TÉTO JEDNOTKY, BUĎ
BĚHEM ZÁRUČNÍ DOBY, NEBO PO JEJÍM UPLYNUTÍ A TO Z JAKÉHOKOLIV DŮVODU.
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA NÁROKY JAKÉHOKOLIV DRUHU, VZNESENÉ UŽIVATELI
TÉTO JEDNOTKY NEBO TŘETÍMI STRANAMI.
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA UKONČENÍ NEBO PŘERUŠENÍ JAKÝCHKOLIV SLUŽEB
SOUVISEJÍCÍCH S TOUTO JEDNOTKOU, KTERÉ MOHOU BÝT DŮSLEDKEM JAKÝCHKOLIV OKOLNOSTÍ.
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Bezpečnostní opatření pro funkci záznamu
Vždy proveďte testovací záznam a ověřte si, že proběhl úspěšně. SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA
ŠKODY JAKÉHOKOLIV DRUHU, KROMĚ JINÉHO ZA KOMPENZACE NEBO NÁHRADY V DŮSLEDKU PORUCHY
TÉTO JEDNOTKY, NEBO JEJÍHO ZÁZNAMOVÉHO MÉDIA NEBO JINÉHO MÉDIA ČI ZÁZNAMOVÉHO SYSTÉMU
POUŽITÉHO K ZÁZNAMU OBSAHU JAKÉHOKOLIV DRUHU.
Před použitím si vždy ověřte, že jednotka pracuje správně. SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA
ŽÁDNÉ ŠKODY JAKÉHOKOLIV DRUHU, KROMĚ JINÉHO VČETNĚ KOMPENZACE NEBO NÁHRADY JDOUCÍ NA
ÚČET ZTRÁTY STÁVAJÍCÍHO NEBO BUDOUCÍHO ZISKU V DŮSLEDKU ZÁVADY TÉTO JEDNOTKY, BUĎ
BĚHEM ZÁRUČNÍ DOBY, NEBO PO JEJÍM UPLYNUTÍ A TO Z JAKÉHOKOLIV DŮVODU.
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA NÁROKY JAKÉHOKOLIV DRUHU, VZNESENÉ UŽIVATELI
TÉTO JEDNOTKY NEBO TŘETÍMI STRANAMI.
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA ZTRÁTU, OPRAVY NEBO REPRODUKOVÁNÍ JAKÝCHKOLIV
DAT ZAZNAMENANÝCH V SYSTÉMU INTERNÍHO ÚLOŽIŠTĚ, NA ZÁZNAMOVÝCH MÉDIÍCH NEBO JINÝCH
MÉDIÍCH ČI SYSTÉMECH ÚLOŽIŠTĚ.
SPOLEČNOST SONY NEBUDE ODPOVĚDNÁ ZA UKONČENÍ NEBO PŘERUŠENÍ JAKÝCHKOLIV SLUŽEB
SOUVISEJÍCÍCH S TOUTO JEDNOTKOU, KTERÉ MOHOU BÝT DŮSLEDKEM JAKÝCHKOLIV OKOLNOSTÍ.

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Výstupní formáty a omezení

Toto téma popisuje výstupní formáty a omezení.

Poznámka

Rozlišení výstupního formátu je omezeno nastaveními [Project] > [Rec Format] > [Frequency], [Codec] a [Video Format] ve
webové nabídce nebo v nabídce kamery.

Rozlišení výstupního formátu je rovněž omezeno kombinací snímkové frekvence S&Q. Kromě níže uvedené tabulky výstupních
formátů konektoru SDI OUT/HDMI OUT se výstup na HDMI změní na Full HD nebo nižší, pokud jsou splněny všechny následující
podmínky.

Možnost [Shooting] > [S&Q Motion] > [Setting] je nastavena na hodnotu [On]
Možnost [Shooting] > [S&Q Motion] > [Frame Rate] je nastavena na hodnotu vyšší než 60fps.

Pokud jsou splněny podmínky výše, možnosti volby výstupu HDMI 4096×2160P a 3840×2160P pro [Monitoring] > [Output
Format] > [SDI/HDMI] budou šedé a nebude možné je vybrat.

Obraz není odeslán na výstup, pokud je nakonfigurováno vyšší rozlišení než rozlišení obrázku přehrávání.

Výstupní formáty na konektoru SDI OUT/HDMI OUT

Když je systémová frekvence 50/59.94 Hz

Nastavení Volitelný výstupní formát

Režim
záznamu/přehrávání

Rozlišení výstupu RAW /
Rozlišení interního

záznamu
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(výchozí)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(výchozí)
1920×1080i
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Když je systémová frekvence 25/29.97 Hz

Nastavení Volitelný výstupní formát

Režim
záznamu/přehrávání

Rozlišení výstupu RAW /
Rozlišení interního

záznamu
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(výchozí)

1920×1080P
(výchozí)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(výchozí)

1920×1080P
(výchozí)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(výchozí)

1920×1080P
(výchozí)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Výstup zastaven)
720×480P2)

720×576P3)

Zobrazení na obrazovce nelze překrýt.1)

Když je systémová frekvence 59.942)

Když je systémová frekvence 503)
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Když je systémová frekvence 23.98 Hz

Nastavení Output Format (výstupní rozlišení)

Režim záznamu/přehrávání Rozlišení výstupu RAW /
Rozlišení interního záznamu SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (výchozí)

3840×2160
(RAW) (3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (výchozí)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (výchozí) 1920×1080i (výchozí)

3840×2160

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (výchozí) 1920×1080i (výchozí)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Nastavení Output Format (výstupní rozlišení)

Režim záznamu/přehrávání Rozlišení výstupu RAW /
Rozlišení interního záznamu SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (výchozí)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (výchozí)
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Když je systémová frekvence 24 Hz

5-041-958-43(1) Copyright 2022 Sony Corporation

Nastavení Output Format (výstupní rozlišení)

Režim záznamu/přehrávání Rozlišení výstupu RAW /
Rozlišení interního záznamu SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (výchozí) 1920×1080P (výchozí)

3840×2160
3840×2160 (2SI) 3840×2160P

1920×1080P

1920×1080P (výchozí) 1920×1080P (výchozí)

1920×1080 1920×1080P (výchozí) 1920×1080P (výchozí)

Nastavení Output Format (výstupní rozlišení)

Režim záznamu/přehrávání Rozlišení výstupu RAW /
Rozlišení interního záznamu SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (výchozí)

XAVC-I 4096×2160 4096×2160 (2SI)
1920×1080P (výchozí)

4096×2160P
1920×1080P (výchozí)
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Odstraňování poruch

Napájecí zdroj

Výstup obrazu

Příznak Příčina Řešení

Jednotka
není zapnuta.

Napájecí adaptér není pevně připojen ke konektoru
DC IN.

Pevně zasuňte napájecí kabel co nejdále.

Napájecí kabel není pevně zasunut do síťového
adaptéru nebo síťové zásuvky.

Pevně zasuňte napájecí kabel co nejdále.

Kabel LAN není pevně připojen mezi napájecí zdroj
PoE++ a jednotku.

Zkontrolujte, zda je kabel zasunutý, až
zacvakne.

Kabel LAN je připojen k konektoru OPTION, nikoliv
však ke konektoru LAN.

Připojte kabel LAN ke konektoru LAN
správným způsobem.

Jednotka je připojena k napájecímu zdroji, který
nepodporuje napájení PoE++ (shoda s normou
IEEE802.3bt, typ 4, třída 8).

Připojte k napájecímu zařízení, které
podporuje napájení PoE++ (shoda s normou
IEEE802.3bt, typ 4, třída 8).

Celková spotřeba energie přesahuje maximální
jmenovité hodnoty napájecího zdroje PoE++.

Viz uživatelská příručka napájecího zdroje
PoE++.

Připojen je síťový kabel s dimenzováním dle
kategorie, která nepodporuje napájení PoE++.

Použijte síťový kabel kategorie 5e nebo vyšší,
připojený ke konektoru sítě LAN.

Kamera, napájecí zdroj PoE++ a periferní zařízení
nejsou připojeny k uzemnění.

Připojte kameru, napájecí zdroj PoE++ a
periferní zařízení k uzemnění.

Příznak Příčina Řešení

Žádný obraz není na
výstupu.

Připojená zařízení nejsou připojena správně.
Připojte správně připojená
zařízení.

Počáteční nastavení nebylo dokončeno.
Dokončete počáteční
nastavení pomocí webové
aplikace.

Na výstupu z konektoru
HDMI není žádný obraz.

Je nakonfigurován signál, který není podporován
výstupním cílovým zařízením HDMI.

Změňte nastavení výstupního
formátu HDMI nebo použijte
zařízení, které podporuje
výstupní signál.

Používá se kabel, který nepodporuje standard výstupu
HDMI.

Použijte kabel, který
podporuje používaný standard
výstupu HDMI.
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Dálkový ovladač

Infračerveném dálkový ovladač

Příznak Příčina Řešení

Na výstupu z konektoru
SDI není žádný obraz.

Používáte kabel, který nepodporuje standard výstupu
SDI.

Použijte kabel, který
podporuje používaný standard
výstupu SDI.

Monitor připojený ke konektoru SDI nepodporuje výstupní
signál.

Použijte monitor, který
podporuje standard výstupu
SDI.

Formát záznamu je nastaven na výstup RAW.
Změňte formát záznamu na
jiné nastavení než výstup
RAW.

Výstup HDMI je nastaven na rozlišení SD.
Výstup HDMI nastavte na jiné
rozlišení než SD.

Z optického vlákna není
přiváděn žádný obraz
nebo je obraz zkreslený.

Použitý modul nesplňuje normy SFF nebo SMPTE nebo
nesplňuje úroveň výkonu I (1,0 W).

Další informace naleznete v
části „Výstup optického
signálu“.

Při použití externí
synchronizace není
žádný obraz na výstupu
nebo je zkreslený.

Externí synchronizační signál vhodný pro
nakonfigurovaný formát videosignálu není přiváděn na
vstup.

Přiveďte na vstup externí
synchronizační signál vhodný
pro nakonfigurovaný formát
videosignálu.

Zvuk obsahuje šum.

Kamera, napájecí zdroj PoE++ a periferní zařízení nejsou
připojeny k uzemnění.

Připojte jednotku, napájecí
zdroj PoE++ a periferní
zařízení k uzemnění.

Jednotka se používá v prostředí se zařízeními, která
vytvářejí silná elektrická a magnetická pole (jako jsou
antény televizních/rozhlasových vysílačů, amatérské
radiové vysílače, motory klimatizace, transformátory
napájení).

Udržujte jednotku mimo dosah
zařízení, která vytvářejí silná
elektrická a magnetická pole.

Objektiv, podpěra objektivu a jednotka pohonu jsou v
kontaktu s jednotkou nebo objektem v okolním prostředí
a vydávají neobvyklý hluk.

Připevněte objektiv
správným způsobem.

Zkontrolujte, zda v
blízkosti kamery nejsou
nějaké překážky.

Příznak Příčina Řešení

Infračervený dálkový
ovladač po stisknutí
nepracuje.

Obsluha infračerveného dálkového
ovladače je zakázána.

Nastavte možnost [Technical] > [IR Remote] >
[Setting] na hodnotu [On] ve webové nabídce.

Baterie byla vybita nebo je polarita
baterie nesprávná.

Používejte infračervený dálkový ovladač v
blízkosti infračerveného snímače jednotky.
Pokud kontrolka LED napájení bliká, vyměňte
baterii.

Počáteční nastavení nebylo
dokončeno.

Dokončete počáteční nastavení pomocí
webové aplikace.
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RM-IP500

Webová aplikace

Příznak Příčina Řešení

Provozní rychlost
posunu/naklápění je
pomalá.

Rychlost posunu/naklápění z
infračerveného dálkového ovladače je
nastavena na normální režim.

Nastavte spínač SETUP 4 do polohy ON na
bloku konektorů jednotky.

Operace byla zaměřena na
jinou než zamýšlenou
kameru.

Infračervený signál byl přijat jinou
kamerou než zamýšlenou kamerou.

Nastavte možnost [Technical] > [IR Remote] >
[Setting] ne hodnotu [Off] ve webové nabídce
kamery, kterou nechcete ovládat.

Příznak Příčina Řešení

Kameru nelze ovládat prostřednictvím
dálkového ovladače RM-IP500.

Napájení kamery není
připojeno.

Zkontrolujte, zda kontrolka POWER jednotky
svítí zeleně nebo oranžově.

Kamera nebo dálkový
ovladač nejsou připojeny
k síti.

Zkontrolujte připojení jednotky a dálkového
ovladače.

Počáteční nastavení
kamery nebylo
dokončeno.

Dokončete počáteční nastavení pomocí
webové aplikace.

Komunikace VISCA over
IP není povolena.

Nastavte spínač SETUP 3 do polohy ON na
panelu konektorů jednotky a restartujte
jednotku.

IP adresa kamery se
změnila.

Zkontrolujte IP adresu kamery pomocí položek
[Network] > [Wired LAN] ve webové nabídce
nebo v nabídce kamery.

IP adresa kamery byla změněna pomocí
AUTO IP SETUP na dálkovém ovladači
RM-IP500.

Od spuštění kamery
uplynulo nejméně 20
minut.

Restartujte jednotku. IP adresu lze změnit
pomocí AUTO IP SETUP během prvních 20
minut po spuštění jednotky.
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Příznak Příčina Řešení

Nelze se připojit pomocí webového
prohlížeče.

Není připojen kabel sítě
LAN kategorie 5e nebo
vyšší.

Připojte kabel sítě LAN kategorie 5e nebo
vyšší.

Jednotka není správně
připojena k síti LAN nebo
připojena síť nepracuje
normálně.

Zkontrolujte, zda kontrolka Link LED
konektoru LAN svítí. Pokud kontrolka Link
LED nesvítí, kontaktujte správce sítě.

Napájení kamery není
připojeno.

Další informace naleznete v části „Napájení“
výše.

Pro jednotku není
nakonfigurována platná IP
adresa.

Proveďte resetování sítě.

Konfigurovaná IP adresa je
používána na jiném
zařízení.

Zkontrolujte, zda jsou adresy IP periferních
zařízení jedinečné.

Konfigurovaná maska
podsítě neodpovídá použité
podsíti hlavní sítě.

Proveďte resetování sítě.

K jednotce je přistupováno
na stejné místní síti
prostřednictvím proxy
serveru.

Změňte konfiguraci tak, aby se nepoužíval
proxy server.

Konfigurovaná výchozí
brána pro jednotku je
nesprávná.

Proveďte resetování sítě.

Zadaná adresa URL je
nesprávná.

Zadejte správnou adresu URL a zkuste to
znovu.

Port HTTP je nesprávný.

Zobrazte nabídku kamery na externím
monitoru a zkontrolujte nastavení položek
[Network] > [Wired LAN] > [HTTP Port].
Pokud je nakonfigurována hodnota jiná než
80, přidejte k názvu hostitele nebo IP adrese
zadané ve webovém prohlížeči číslo portu
HTTP.
Příklad: Pokud je port http nastaven na 8080,
zadejte http://<IP adresa>:8080

Číslo portu HTTP jednotky
je filtrováno nebo
blokováno.

Změňte číslo portu HTTP jednotky na port,
který není filtrován ani blokován.

Stará mezipaměť
webového prohlížeče má
nepříznivé účinky.

Vymažte mezipaměť z webového prohlížeče.
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Příznak Příčina Řešení

Nelze se připojit k webové aplikaci
pomocí 2D kódu (QR kód).

Používané zařízení
nepodporuje mDNS.

Použijte zařízení, které podporuje mDNS.
Pokud používáte zařízení, které nepodporuje
mDNS, zadejte adresu IP přímo do webového
prohlížeče.

Tablet nebo počítač je
připojen k jiné síti než
kamera.

Připojte tablet nebo počítač ke stejné místní
síti jako jednotka.

Ručním zadáním adresy URL se nelze
připojit k webové aplikaci.

Používané zařízení
nepodporuje mDNS.

Použijte zařízení, které podporuje mDNS.

Tablet nebo počítač je
připojen k jiné síti než
kamera.

Připojte tablet nebo počítač ke stejné místní
síti jako jednotka.

Obrazovka ověřování se zobrazuje
nepřetržitě.

Nebylo zadáno správné
uživatelské jméno nebo
heslo.

Zadejte registrované uživatelské jméno a
heslo. Pokud jste zapomněli informace o
registrovaném uživateli, viz „Spínač RESET“ v
části „Blok konektorů“, kde je popsána
inicializace informací o uživateli pro síťové
připojení.

Uživatelské jméno a heslo
mohou být změněny
uživatelem přihlášeným
pomocí jiného webového
prohlížeče.

U správce jednotky zkontrolujte správné
uživatelské jméno a heslo.

Obrázek kamery se ve webové aplikaci
nezobrazuje.

Výstup HDMI kamery je
nastaven na 720×480 nebo
720×576.

Změňte rozlišení výstupu HDMI jednotky.

Připojen je monitor HDMI,
který nepodporuje výstupní
signál HDMI kamery.

Odstraňte monitor HDMI nebo použijte
monitor HDMI, který podporuje nastavení
výstupu HDMI.

Jednotka byla restartována
a relace byla odpojena.

Počkejte asi minutu a znovu načtěte webový
prohlížeč.

Stará mezipaměť
webového prohlížeče má
nepříznivé účinky.

Vymažte mezipaměť z webového prohlížeče.

Rozlišení obrazu kamery zobrazeného
ve webové aplikaci je nízké.

Rozlišení video streamu 3
používaného webovou
aplikací je nastaveno nízko.

Zvyšte hodnotu pomocí položek [Stream] >
[Video Stream] > [Size 3] ve webové nabídce.

Po stisknutí tlačítka [Menu] se nabídka
kamery nezobrazí.

Nabídka kamery je
nakonfigurována tak, aby
nebyla integrována do
výstupního signálu HDMI.

Nastavte možnost [Monitoring] > [Output
Display] > [HDMI/Stream] na hodnotu [On] ve
webové nabídce.
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Snímání

Kamera

Příznak Příčina Řešení

Hodnota nastavení na obrazovce
nastavení není správně
aktualizována/zobrazena.

Obrazovka nastavení
webové aplikace
automaticky neodráží
nastavení změněná v jiné
webové aplikaci.

Stiskněte tlačítko [Reload] v dolní části
obrazovky nastavení webové aplikace Web
App. Hodnoty nastavení na zobrazené
obrazovce nastavení se znovu načítají a
aktualizují.

Nastavení dočasných
internetových souborů mají
vliv.

Vymažte mezipaměť z webového prohlížeče.

Nelze stáhnout konfigurační soubor
nebo protokol.

Funkce stahování souborů
webového prohlížeče je
zakázána.

Povolte funkci stahování souborů webového
prohlížeče.

Obrazovka nastavení webové aplikace
je přístupná, ale nemůže provádět
operace na obrazovce živého provozu
a obrazovce přehrávání.

Obrazovka ovládání
webové aplikace je
uzamčena.

Přepněte spínač zámku ovládání vpravo
nahoře ve webové aplikaci do polohy 
(Operace odemčení).

Zobrazování obrazovky webové
aplikace nějakou dobu trvá.

Streamovaný obraz
jednotky je prohlížen více
uživateli současně.

Snižte počet uživatelů, kteří mohou
přistupovat k webové aplikaci současně.

Obraz je zkreslený nebo trhavý.

Informace o videu nejsou
správně přenášeny z
důvodu přetížení
komunikační cesty.

Snižte přenosovou rychlost streamování,
nastavte [Video Stream 3] > [Size] na
nejmenší možnost nebo snižte rychlost,
abyste vytvořili zálohu v komunikačním
pásmu.

Na tabletu je spuštěno více
webových prohlížečů a
zabírají paměť.

Zavřete všechny webové prohlížeče, které
pracují na pozadí.

Je otevřeno příliš mnoho
karet webového prohlížeče,
což zpomaluje provoz.

Zavřete všechny karty, které nejsou
používány.

Nadměrná akumulace
mezipaměti webového
prohlížeče a historie
prohlížení zpomaluje
provoz.

Vymažte mezipaměť webového prohlížeče.

Příznak Příčina Řešení

Obraz vypadá zkresleně na začátku a na
konci operace posunu/naklápění.

Obraz může být zkreslený, pokud je
zapnuta funkce stabilizace obrazu
objektivu.

Vypněte funkci stabilizace
obrazu objektivu.

Úhel pohledu se změnil bez obsluhy
uživatelem.

Došlo k „dýchání“ objektivu.
Další informace naleznete v
části „Kompenzace dýchání“.

Nelze ovládat zaostření, zoom nebo
clonu.

Nesprávné nastavení spínačů na
objektivu může být nesprávné.

Viz také „Kontrola spínačů
objektivu“.
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Posun/naklápění

Příznak Příčina Řešení

Nelze resetovat
posun/naklápění.

Zamykací páka
posunu/naklápění je v poloze
LOCK.

Posuňte páku zámku posunu/naklápění do polohy pro
UNLOCK.

Kamera se nezastaví v
očekávané poloze.

Blok kamery není vyvážený.
Přesuňte blok kamery dopředu/dozadu do vhodné
polohy, jak je popsáno v části „Upevnění objektivu“, a
poté jednotku znovu zapněte.

Je připojen objektiv, který
nepodporuje posun/naklápění.

Přečtěte si informace o kompatibilitě objektivu,
připojte objektiv podporující posun/naklápění a
jednotku znovu zapněte.

Nelze provést resetování
posunu/naklápění.

Proveďte resetování posunu/naklápění, jak je
popsáno v části „Resetování posunu/naklápění“.

Na hlavu kamery byla
aplikována neočekávaná síla,
která způsobila chybu ovládání
posunu/naklápění.

Při stisknutí tlačítka
 (Posun-Naklápění

výchozí) se kamera
nevrací na přední stranu.

Režim montáže na strop byl
aktivován.

Nastavte možnost [Pan-Tilt] > [P/T Direction] >
[Ceiling] ve webové nabídce podle aktuální instalace
a poté jednotku znovu zapněte. Při montáži na strop
se blok konektorů nachází na předním panelu
kamery.

Funkce posunu/naklápění
je omezena.

Je nakonfigurován limit rozsahu
posunu/naklápění.

Podle potřeby zrušte nastavení meze
posunu/naklápění, jak je popsáno v části „P/T Range
Limit“.

Na hlavu kamery působila
neočekávaná síla, která
způsobila chybu
posunu/naklápění.

Proveďte resetování posunu/naklápění, jak je
popsáno v části „Resetování posunu/naklápění“.

Operace posunu/naklápění
se pohybovala v opačném
směru.

Nastavení režimu montáže na
strop se liší od aktuálního stavu
upevnění.

Nastavte možnost [Pan-Tilt] > [P/T Direction] >
[Ceiling] ve webové nabídce podle aktuálního
způsobu instalace.

Nastavení související se
směrem posunu/naklápění bylo
změněno.

Zkontrolujte nastavení [Pan-Tilt] > [P/T Direction] ve
webové nabídce.

Obraz se na začátku a na
konci operace
posunu/naklápění
nepohybuje plynule.

Nastavení zrychlení/zpomalení
operace posunu/naklápění je
příliš vysoké.

Snižte nastavení zrychlení/zpomalení operace
posunu/naklápění, aby byl pohyb na začátku a na
konci operace posunu/naklápění plynulejší, a to
pomocí položek [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] ve webové nabídce nebo nabídce
kamery. Všimněte si, že to bude znamenat, že
objektiv trvá déle, než dosáhne maximální rychlosti.
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Příznak Příčina Řešení

Operace posunu/naklápění
zastavena.

Blok kamery není vyvážený.
Přesuňte blok kamery dopředu/dozadu do vhodné
polohy, jak je popsáno v části „Upevnění objektivu“, a
poté jednotku znovu zapněte.

Nastavení křivky náběhu
(zrychlení/zpomalení) je pro
připojený objektiv příliš vysoké.

Je-li připojen velký objektiv, snižte hodnotu [Pan-Tilt]
> [P/T Acceleration] > [Ramp Curve] ve webové
nabídce nebo v nabídce kamery.

Používá se velká čočka. Kontaktujte zástupce podpory společnosti Sony.

Jednotka je při provozu
posunu/naklápění
zablokovaná.

Upínací páka upevňovacího
šroubu stojanu podpěry
objektivu zasahuje kameru.

Otočte upínací pákou upevňovacího šroubu stojanu
podpěry objektivu tak, aby směřovala nahoru.

Upínací páka podpěry objektivu
zasahuje kameru.

Otočte upínací pákou podpěry objektivu tak, aby
směřovala nahoru.

Zamykací páka hlavy kamery
zasahuje kameru.

Zkontrolujte, zda je uzamykací páka hlavy kamery v
poloze LOCK.

Během operace
posunu/naklápění dochází
k neobvyklému hluku.

Kamera není v rovnováze.
Přesuňte hlavu kamery dopředu/dozadu do vhodné
polohy tak, aby byla posuvná základna vodorovně.

Nastavení křivky náběhu
(zrychlení/zpomalení) je pro
připojený objektiv příliš vysoké.

Je-li připojen velký objektiv, snižte hodnotu [Pan-Tilt]
> [P/T Acceleration] > [Ramp Curve] ve webové
nabídce nebo v nabídce kamery.

Hlava kamery není připevněna
ve stanovené poloze a během
provozu je slyšet pohyblivý hluk.

Nastavte zamykací páku hlavy kamery do polohy pro
LOCK.

Nelze uložit
přednastavenou polohu.

Předvolbu nelze uložit, pokud je
funkce Clear Image Zoom
funkční.

Nastavte poměr Clear Image Zoom zpět na hodnotu
1×. (uveďte, kde se poměr nezobrazuje vpravo od

 (Poměr zoomu))

Seřízení obrazu je
posunuto při přehrávání
přednastavené polohy.

Teplota prostředí se mohla
výrazně změnit mezi uložením
přednastavené polohy a jejím
opětovným přehráním.

Uložte přednastavenou polohu znovu.

Kalibrace objektivu se
neprovádí.

Nastavte kalibraci pomocí položky [Technical] >
[Lens] > [Lens Calibration] v nabídce kamery.

Je připojen jiný objektiv než ten,
který byl připojen během
uložení předvolby. Nebo je
poloha zoomu pro ruční zoom
odlišná.

Uložte přednastavenou polohu znovu.
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Záznam/přehrávání

Příznak Příčina Řešení

Ovládací panel seřízení
obrazu webové aplikace je
šedý a nelze jej ovládat.

Funkce posunu/naklápění není
k dispozici během zobrazení
obrazovky miniatur a během
přehrávání.

Zobrazte obrazovku ovládání přehrávání a ukončete
zobrazení obrazovky miniatur nebo zastavte
přehrávání.

Funkce posunu/naklápění není
k dispozici, pokud obraz kamery
nelze zobrazit ve webové
aplikaci.

Další informace naleznete v části „Webová aplikace“
v části „Odstraňování poruch“.

Zamykací páka
posunu/naklápění je v poloze
LOCK.

Posuňte páku zámku posunu/naklápění do polohy pro
UNLOCK.

Možnost „Execute Pan-Tilt
Reset“ se zobrazí pod
ovládacím panelem
seřízení obrazu ve webové
aplikaci.

Na hlavu kamery působila
neočekávaná síla, která
způsobila chybu
posunu/naklápění.

Proveďte resetování posunu/naklápění, jak je
popsáno v části „Resetování posunu/naklápění“.

Příznak Příčina Řešení

Záznam se nespouští,
když stisknete tlačítko
START/STOP záznamu.

Paměťová karta je plná.
Vyměňte paměťovou kartu za jinou, na které
je dostatek prostoru.

Paměťová karta vyžaduje přeformátování.
Přeformátujte paměťovou kartu, jak je
popsáno v části „Obnovení paměťových
karet“.

Kontrolka záznamu/signalizace je
nakonfigurována jako indikační kontrolka,
takže stav záznamu nemůže být stanoven
kontrolkou.

Nakonfigurujte kontrolku záznamu/signalizace
tak, aby plnila funkci jako kontrolka záznamu,
jak je popsáno v části „Připojení indikačního
signálu“.

Není možné provést
zvukový záznam.

Mikrofon není připojen.
Připojte mikrofon nebo zvukové zařízení do
konektoru AUDIO IN na bloku konektorů.

Nastavení [Master Input Level] je na
minimální hodnotě.

Nastavte [Master Input Level].

Zaznamenaný zvuk je
zkreslený.

Vstupní úroveň hlasitosti zvuku je příliš
vysoká.

Upravte položky [CH1 Input Level] na hodnoty
[CH4 Input Level] a [Master Input Level].

Při používání mikrofonu v hlučném prostředí,
například při živé hudbě, nejprve upravte
[AUDIO IN CH1 MIC Ref.] a [AUDIO IN CH2
MIC Ref.].

Zaznamenaný zvuk má
příliš vysokou úroveň
šumu.

Vstupní úroveň hlasitosti zvuku je příliš
nízká.

Upravte nastavení [Audio Input Level] a
[Audio] > [Audio] > [Audio Input] > [AUDIO IN
CH1 MIC Ref.] nebo [AUDIO IN CH2 MIC
Ref.].
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Přenos souborů

IP streamování

Příznak Příčina Řešení

Není možné přehrávat
klipy.

Klip je právě upravován.

Klipy není možné přehrát, pokud jste změnili
název příslušného souboru nebo složky, nebo
pokud se klip používá v počítači. Nejedná se o
poruchu.

Klip byl zaznamenán pomocí jiné kamery
než této jednotky.

Klipy zaznamenané pomocí jiné kamery než
je tato jednotka nemusí být možné přehrávat
nebo zobrazovat ve správném formátu.
Nejedná se o poruchu.

Příznak Příčina Řešení

Nahrávání souboru se
nezdařilo.

Uživatelské jméno a heslo serveru
jsou neplatné.

Uživatelské jméno a heslo serveru mohou být
neplatné. Zadejte správné položky.

Příznak Příčina Řešení

Streamování není k dispozici.

Uživatelské jméno nebo heslo
zadané v klientské aplikaci
pro zobrazení streamování z
jednotky je nesprávné.

Pokud je formát streamování z jednotky
nastaven na [RTSP], [SRT-Listener] nebo
[NDI|HX], je nutné zadat uživatelské jméno a
heslo nastavené pro tuto jednotku v klientské
aplikaci. Zadejte správné uživatelské jméno a
heslo.

Streamovací protokol není
nastaven.

Ve webové nabídce vyberte cílový protokol
pomocí položek [Stream] > [Stream Setting].

Bylo nastaveno šest nebo
více relací RTSP.

Nastavte počet relací na pět nebo méně.

Číslo portu UDP není
nastaveno správně.

Nastavte číslo portu a další nastavení cílového
protokolu pomocí položek [Stream] > [Stream]
> [Stream Setting] ve webové nabídce.

Komunikace UDP je
zablokována.

Zkontrolujte nastavení bezpečnostního
softwaru.

Zvuk není streamován.
Streamování zvukového
výstupu je nastaveno na
hodnotu [Off].

Nastavte možnost [Stream] > [Audio Stream] >
[Setting] na hodnotu [On] ve webové nabídce.

Streamování bylo odpojeno.

Nastavení protokolu nebo
nastavení kodeku
streamování bylo během
streamování změněno.

Před zahájením streamování nastavte
nastavení protokolu a kodeků streamování.

Velikost obrazu [Video Stream 1]
nelze nastavit na hodnotu
4096×2160 nebo 3840×2160.

Velikost obrazu je 1920×1080,
pokud je možnost [Output
Format] nastavena na HDMI.

Velikost obrazu pro streamování nelze nastavit
na vyšší hodnotu než je velikost obrazu HDMI.
Změňte velikost obrazu HDMI pomocí položek
[Monitoring] > [Output Format] ve webové
nabídce.
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Spojení s externími zařízeními

Externí synchronizace

Tally

Příznak Příčina Řešení

Snímkovou frekvenci [Video
Stream 1] nelze nastavit na 60 fps
ani 50 fps.

Snímková frekvence
streamování je nastavena na
29.97 nebo nižší.

Snímková frekvence používaná pro
streamování je omezena systémovou frekvencí.
Změňte systémovou frekvenci pomocí položek
[Rec Format] > [Frequency] ve webové
nabídce.

Stream [Video Stream 3] není
přístupný.

[Video Stream 3] nepodporuje
RTSP/SRT/NDI.

Použijte možnost [Video Stream 1] nebo [Video
Stream 2].

Obrazovka RTSP/SRT není
správně aktualizována/zobrazena.

Číslo portu používané pro
RTSP nebo SRT je filtrováno
nebo blokováno.

Změňte číslo portu RTSP nebo SRT na port,
který není filtrován nebo blokován zařízeními
přijímajícími stream. Nebo změňte číslo portu,
který má být použit pro RTSP nebo SRT na
jednotce.

Obraz je zkreslený nebo trhavý.

Informace o videu nejsou
správně přenášeny z důvodu
přetížení komunikační cesty.

Snižte přenosovou rychlost datového toku nebo
nastavte kodek [Video Stream 2] ([Codec 2]) na
hodnotu [Off] pro vytvoření zálohy v
komunikačním pásmu.

Pořadí video paketů se v
rámci komunikačního kanálu
změnilo.

Použijte stejného poskytovatele internetových
služeb na straně jednotky i na straně příjemce.

Není rozpoznáno jako zařízení
NDI.

Streamovací protokol není
nastaven na NDI|HX.

Pro detekci jednotky jako zařízení NDI musí být
streamovací protokol nastaven na NDI|HX.
Nastavte možnost [Stream] > [Stream Setting]
na hodnotu [NDI|HX] ve webové nabídce.

Nelze použít jako zařízení NDI.
Není nainstalována licence
NDI|HX.

Nainstalujte licenci NDI|HX. Pomocí položek
[Stream] > [Stream] > [Stream Setting] >
[NDI|HX] > [License] ve webové nabídce
můžete zkontrolovat, zda je k dispozici licence
NDI|HX.

Příznak Příčina Řešení

Nelze synchronizovat
s externím zdrojem.

Externí synchronizační signál vhodný
pro nakonfigurovaný formát
videosignálu není přiváděn na vstup.

Přiveďte na vstup externí synchronizační signál
vhodný pro nakonfigurovaný formát videosignálu.

Jednotka je dvojitě zakončená.

Jednotka je vybavena vestavěným 75 Ω
zakončovacím odporem. Připojte přímo ke zdroji
signálu (jeden na jednoho) nebo použijte
rozdělovač (splitter).
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Ovladač objektivu

Příbuzné téma
Výstup optického signálu

Blok konektorů

Kompenzace dýchání

Kontrola spínačů objektivu

Upevnění objektivu

Resetování posunu/naklápění

P/T Range Limit

Obnovení paměťových karet

Příznak Příčina Řešení

Indikační
kontrolka se
nerozsvítí.

Jas indikační kontrolky je nastaven na
hodnotu Off.

Nastavte vhodný jas pomocí položek [Technical] > [Tally]
> [Tally Lamp Brightness] ve webové nabídce.

Kontrolka záznamu/indikace je
nakonfigurována jako kontrolka
záznamu.

Nakonfigurujte kontrolku záznamu/indikace tak, aby plnila
funkci jako indikační kontrolka, jak je popsáno v části
„Připojení indikačního signálu“.

Je připojen ovladač RM-IP500 a
komunikace VISCA over IP je
zakázána.

Nastavte spínač SETUP 3 do polohy ON na bloku
konektorů jednotky.

Konektor OPTION je připojen
nesprávně nebo cílový kolík není
zkratován na GND.

Zkratujte kolík 7 nebo 8 konektoru OPTION ke GND, jak
je popsáno v části „Připojení indikačního signálu“.

Příznak Příčina Řešení

[Communication Error] se
zobrazuje v části  (Stav
kamery).

Kamera nemůže
komunikovat s
ovladačem objektivu.

Zkontrolujte připojení mezi jednotkou a ovladačem objektivu
a poté jednotku a ovladač objektivu zapněte.

[Rotation Error] se zobrazuje
v části  (Stav kamery).

Ovladač objektivu
vykazuje chybu
otáčení.

Uložený rozsah pohybu zoomu a rozsah pohybu objektivu
se nemusí shodovat. Proveďte inicializaci ovladače
objektivu.
Pokud problém přetrvá, kontaktujte zástupce výrobce
ovladače objektivu.

[System Error] se zobrazuje
v části  (Stav kamery).

Ovladač objektivu
vykazuje systémovou
chybu.

Zkontrolujte připojení mezi jednotkou a ovladačem objektivu,
postupujte podle pokynů k obsluze ovladače objektivu a
inicializujte ovladač objektivu nebo vypněte jednotku a
ovladač objektivu.
Pokud problém přetrvá, kontaktujte zástupce výrobce
ovladače objektivu.

[Unknown Error] se
zobrazuje v části  (Stav
kamery).

Vyskytla se neznámá
chyba v ovladači
objektivu.

Zkontrolujte připojení mezi jednotkou a ovladačem objektivu,
postupujte podle pokynů k obsluze ovladače objektivu a
inicializujte ovladač objektivu nebo vypněte jednotku a
ovladač objektivu.
Pokud problém přetrvá, kontaktujte zástupce výrobce
ovladače objektivu.

481
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Chybové/výstražné zprávy

Pokud se na jednotce vyskytne výstraha, upozornění nebo provozní stav, který vyžaduje potvrzení, zobrazí se v panelu
obrazu kamery zpráva a rozblikají se kontrolky POWER a NETWORK na předním panelu a kontrolka záznamu/indikace.

Poznámka

Indikace blikání kontrolky záznamu/indikace je povolena pouze tehdy, když je možnost [Technical] > [Tally] > [Tally Control]
nastavena na hodnotu [Internal] a možnost [Tally Lamp Brightness] není nastavena na hodnotu [Off] ve webové nabídce nebo v
nabídce kamery.

Chybová hlášení

Pokud kontrolka POWER a NETWORK blikají, jak je popsáno níže, proveďte následující opatření.

Jednotka přestane pracovat, když se zobrazí následující zpráva.

Výstražné zprávy

Pokud se zobrazí následující zprávy, postupujte podle uvedených pokynů.

Kontrolka
POWER

Kontrolka
NETWORK Příčina a řešení

Bliká pomalu
oranžově

Bliká pomalu
zeleně

Jednotka nemůže pracovat normálně. Další informace naleznete v části
[Maintenance] > [System Log] ve webové nabídce. Pokud problém přetrvává i po
uvedení jednotky do pohotovostního režimu nebo vypnutí a následném opětovném
zapnutí, kontaktujte servisního zástupce společnosti Sony.

Bliká rychle
oranžově

Bliká rychle
zeleně

Vyskytla se porucha jednotky. Kontaktujte servisního zástupce společnosti Sony.

Zobrazení
zprávy

Kontrolka
záznamu/indikace Příčina a řešení

E +
chybový
kód

Velmi rychle bliká

Signalizuje neobvyklý stav jednotky. Záznam se zastaví, i když je v panelu
obrazu kamery zobrazen symbol ●REC.
Vypněte jednotku a zkontrolujte, zda se nevyskytuje nějaký problém s
připojenými zařízeními, kabely nebo médii. Pokud chyba přetrvává, když je
jednotka znovu zapnuta, kontaktujte servisního zástupce společnosti Sony.
Zobrazení chybové zprávy nebo výstražný zvukový signál se nemusí projevit v
závislosti na stavu jednotky.

Zobrazení zprávy Kontrolka
záznamu/indikace Příčina a řešení

Temperature High Bliká
Vnitřní teplota přístroje je vysoká.
Vypněte videokameru a ponechte ji vychladnout, až poté ji můžete
znovu používat.
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Upozornění a provozní zprávy

Zobrazení zprávy Kontrolka
záznamu/indikace Příčina a řešení

Media Temperature
High

Bliká
Teplota karty CFexpress je vysoká.
Vyměňte kartu a ponechte ji vychladnout, až poté ji můžete znovu
používat.

Voltage Low Bliká Napětí DC IN je nízké (úroveň 1). Zkontrolujte napájecí zdroj.

Insufficient Voltage Velmi rychle bliká
Napětí DC IN je příliš nízké (úroveň 2). Záznam je zakázán.
Připojte jiný napájecí zdroj.

Media Near Full Bliká Zbývající kapacita paměťové karty se snižuje.
Při nejbližší příležitosti ji vyměňte.

Media Full Velmi rychle bliká
Není možné nahrávat nebo kopírovat klipy, protože na paměťové
kartě není žádná zbývající kapacita.
Ihned vyměňte.

Clips Near Full Bliká
Počet dalších klipů, které mohou být zaznamenány na paměťové
kartě, se snižuje.
Při nejbližší příležitosti ji vyměňte.

Clips Full Velmi rychle bliká
Maximální počet klipů, které mohou být zaznamenány na paměťové
kartě, byl dosažen.
Záznam ani kopírování dalších klipů nejsou možné. Ihned vyměňte.

Last Clip Recording Bliká
Právě nahrávaný klip je poslední klip, který může být zaznamenán,
protože byl dosažen maximální počet klipů.
Připravte si novou paměťovou kartu.

Media(A) Life Near
End1) Bliká

Paměťová karta se blíží konci své životnosti. Při nejbližší příležitosti
ji vyměňte.

Media(A) Life End1) Velmi rychle bliká Paměťová karta dosáhla konce své životnosti. Ihned vyměňte.

Media(A) Near
Full1) Bliká Při používání funkce Simul Rec

Media(A) Full1) Velmi rychle bliká Při používání funkce Simul Rec

Media(A) Clips
Near Full1) Bliká Při používání funkce Simul Rec

Media(A) Clips
Full1) Velmi rychle bliká Při používání funkce Simul Rec

Media(A) Last Clip
Rec1) Bliká Při používání funkce Simul Rec

(Žádné zobrazení) Bliká

Vyskytla se neznámá chyba v ovladači objektivu.
Zkontrolujte stav kamery ve webové aplikaci.
Podrobné informace naleznete v systémovém protokolu ve webové
aplikaci.

„(B)“ se zobrazuje pro kartu ve slotu B.1)
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Následující upozornění a provozní zprávy se mohou zobrazit uprostřed obrazovky. Při řešení tohoto problému postupujte
podle následujících pokynů.

Zpráva na displeji Příčina a řešení

Backup Battery End
Please Change

Zbývající kapacita záložního akumulátoru je nedostatečná.
Pro dobití záložní baterie připojte jednotku k napájecímu zdroji po dobu
nejméně 24 hodin.

Unknown Media(A)1)

Please Change

Byla vložena paměťová karta, která byla rozdělena na oddíly, nebo
obsahuje více klipů, než kolik jich jednotka dokáže zpracovat.
Kartu nelze v této jednotce použít a musíte ji proto vyměnit.

Cannot Use Media(A)1)

Unsupported File System

Byla vložena karta používající odlišný systém souborů, nebo
neformátovaná karta.
Kartu nelze v této jednotce použít a musíte ji proto vyměnit, nebo ji
zformátovat přímo ve jednotce.

Media Error
Media(A) Needs to be Restored1)

Na paměťové kartě se vyskytla chyba a kartu je proto nutné vyměnit.
Přeformátujte paměťovou kartu.

Media Error
Cannot Record to Media(A)1)

Paměťová karta může být poškozena a již není možné ji používat pro
záznam.
Je však možné přehrávání, takže se doporučuje, abyste si zhotovili
kopii záznamů a paměťovou kartu vyměnili.

Media Error
Cannot Use Media(A)1)

Paměťová karta může být poškozena a již není možné ji používat pro
záznam ani přehrávání.
Kartu nelze v této jednotce použít a musíte ji proto vyměnit.

Media(A) Error1)

Recording Halted
Playback Halted

Záznam a přehrávání byly zastaveny, protože během používání
paměťové karty se vyskytla chyba.
Pokud problém přetrvává, paměťovou kartu vyměňte.

Media Reached Rewriting Limit
Change Media(A)1)

Paměťová karta dosáhla konce své životnosti.
Zhotovte si zálohu a ihned kartu vyměňte. Pokud budete v používání
karty pokračovat, nemusí být karta schopna záznamu ani přehrávání.
Podrobnosti naleznete v uživatelské příručce paměťové karty.

The specified address is invalid.
Stanovená adresa je neplatná.
Zkontrolujte, zda je nastavení správné.

Cannot Use Specified Port Number Stanovené číslo portu je neplatné.
Zkontrolujte, zda je nastavení správné.

Lens I/F Error(xx:xx)

Během připojení objektivu E-Mount byla v komunikaci I/F objektivu
zjištěna chyba objektivu.
Zkontrolujte stav spojení s objektivem E-Mount.
Pokud problém přetrvává, kontaktujte svého servisního zástupce
společnosti Sony a poskytněte mu chybový kód (pět znaků v závorce).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Byl dosažen maximální počet přenosů.
Odstraňte všechny nežádoucí úkoly. Nastavení cíle pro automatické
nahrávání pro soubory proxy může být rovněž nesprávné. Zkontrolujte,
zda je nastavení správné.

Fan Stopped

Ventilátor přestal pracovat.
Zkontrolujte, zda v něm není žádný prach ani cizí předměty.
Pokud chyba přetrvává i po odstranění prachu nebo cizích předmětů,
kontaktujte servisního zástupce společnosti Sony.
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Informace o chybě streamování RTMP

Na jednotce se mohou zobrazit následující chybové informace. Podle potřeby proveďte následující kroky.

Chybové informace o streamování SRT

Na jednotce se mohou zobrazit následující chybové informace. Podle potřeby proveďte následující kroky.

„(B)“ se zobrazuje pro kartu ve slotu B.1)

Chybový kód
Popis Řešení

RTMP RTMPS

1002
1004

2002
2004

Nelze se připojit k serveru
RTMP.

Zkontrolujte, zda je nastavení serveru URL správné.
Zkontrolujte připojení sítě.

1003 2003
Nelze analyzovat název
domény.

Zkontrolujte, zda je nastavení serveru URL správné.
Zkontrolujte připojení serveru DNS.

–
2005
2008

Chyba disku CRL
Zkontrolujte, zda je nastavení serveru URL správné.
Ujistěte se, že je cíl připojení důvěryhodný.

2006 Chyba certifikátu CA
Zkontrolujte, zda je nastavení hodin správné.
Zkontrolujte, zda je certifikát CA správný.

– 2007

Certifikát CA není
nainstalován.
Chyba ověření certifikátu
serveru.

Nainstalujte certifikát CA.
Ujistěte se, že je cíl připojení důvěryhodný.

4002 Relace RTMP byla odpojena.
Jednotka mohla být odpojena na straně serveru RTMP.
Zkontrolujte, zda nastavení odpovídá doporučenému parametru
kodeku služby.

4003
Kvalita připojení k síti je
nízká.

Zkontrolujte připojení sítě.

Ostatní Jiné chyby.

Chybový
kód Popis Řešení

Volající SRT

1001 Neočekávaná chyba
Jednotka nemusí pracovat normálně. Jednotku
vypněte a zapněte.

1002
Komunikace byla odpojena z důvodu změny
nastavení

Komunikace byla odpojena, protože byla změněna
nastavení.
Navažte znovu připojení.

5001 Neočekávaná chyba
Jednotka nemusí pracovat normálně. Jednotku
vypněte a zapněte.

5005 Připojení se nezdařilo Zkontrolujte, zda je nastavení cíle připojení správné.

5006 Chyba šifrování Zkontrolujte, zda je nastavení šifrování správné.
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Chybový
kód Popis Řešení

Volající SRT

5007 Neočekávaná chyba Jednotka nemusí pracovat normálně. Jednotku
vypněte a zapněte.5008 Neočekávaná chyba

5009 Přenos se nezdařil
Jednotka byla během komunikace odpojena.
Zkontrolujte připojení sítě.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Seznam položek nabídky

V následujících tabulkách jsou uvedeny položky nabídky jednotky.

Legenda
„Nabídka kamery“ a „Webová nabídka“
●: Je k dispozici
▲: Některé položky jsou k dispozici
–: Není k dispozici

„All File“ a „Scene File“
Ano: Položka uložená v souboru ALL nebo souboru scény
Ne: položka není uložena.

„All Reset (except for Network Settings)“
Když je vykonána položka [Reset]> [Reset] > [All Reset (except for Network Settings)] ve webové nabídce:
Ano: Inicializovaná položka (vylučuje síťová nastavení)
Ne: Nevztahuje se

„Network Reset“
Když je vykonána položka [Reset]> [Reset] > [Network Reset] ve webové nabídce:
Ano: Inicializovaná položka (nastavení sítě)
Ne: Nevztahuje se

„Factory Default“
Ano: Položka se obnoví na výchozí tovární nastavení
Ne: Nevztahuje se

Shooting

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Ano Ano Ano Ano Ano

ND Filter ● – Ano Ano*1 Ano Ne Ano

Shutter ● – Ano Ano Ano Ne Ano

Iris ● – Ano Ano Ano Ne Ano

Auto Exposure ● – Ano Ano*2 Ano Ne Ano

White ● – Ano Ano*3 Ano Ne Ano

White Setting ● – Ano Ne Ano Ne Ano

Offset White ● – Ano Ne Ano Ne Ano

Focus ● ▲ Ano Ne Ano Ne Ano

S&Q Motion ● – Ano Ne Ano Ne Ano
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Project

Paint/Look

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Ano Ne Ano Ne Ano

Noise
Suppression

● – Ano Ano Ano Ne Ano

Flicker Reduce ● – Ano Ne Ano Ne Ano

SteadyShot ● – Ano Ne Ano Ne Ano

[Mode] nelze použít*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] nelze použít*2

[Preset White] nelze použít*3

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Ano Ne Ano Ne Ano

Rec Format ● ● Ano Ne Ano*1 Ne Ano

Cine
EI/Flex.ISO Set

● – Ano Ne Ano Ne Ano

Simul Rec ● ● Ano Ne Ano Ne Ano

Proxy Rec ● ▲ Ano Ne Ano Ne Ano

Interval Rec ● ● Ano*2 Ne Ano Ne Ano

Picture Cache
Rec

● ● Ano*2 Ne Ano Ne Ano

SDI/HDMI Rec
Control

● – Ano Ne Ano Ne Ano

Assignable
Button

● – Ano Ne Ano Ne Ano

All File – ● Ne Ne Ne Ne Ne

[Frequency] nelze použít*1

[Setting] nelze použít*2

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Ne Ne Ne Ne Ne

Base Look ● ▲ Ano*1 Ne Ano*1 Ne Ano*1

Reset Paint
Settings

● – Ne Ne Ne Ne Ne
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Pan-Tilt

TC/Media

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Ano Ano Ano Ne Ano

Knee ● – Ano Ano Ano Ne Ano

Detail ● – Ano Ne Ano Ne Ano

Matrix ● – Ano Ano Ano Ne Ano

Multi Matrix ● – Ano*2 Ano*2 Ano Ne Ano

Data LUT importovaná jako základní vzhled nelze použít*1

[Axis] nelze použít*2

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Ne Ne Ano Ne Ne

P/T
Acceleration

● ● Ne Ne Ano Ne Ne

P/T Range
Limit

– ● Ne Ne Ano Ne Ne

P/T Direction – ● Ne Ne Ano Ne Ne

P/T Preset – ● Ne Ne Ano Ne Ne

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Ano*1 Ne Ano Ne Ano

TC Display ● – Ano Ne Ano Ne Ano

Users Bit ● – Ano*1 Ne Ano Ne Ano

HDMI TC
Out

● – Ano Ne Ano Ne Ano

Clip Name
Format

● – *2 Ne Ano Ne Ano

Update
Media

● – Ne Ne Ne Ne Ne

Format
Media

● – Ne Ne Ne Ne Ne

Media Life ● – Ne Ne Ne Ne Ne

[Setting] nelze použít*1
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Monitoring

Audio

Thumbnail

Technical

[Auto Naming] lze použít, [Camera ID] nelze použít*2

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format ● ● Ano Ne Ano Ne Ano

Output
Display

– ● Ano Ne Ano Ne Ano

Display
On/Off

● – Ano Ne Ano Ne Ano

Video Signal
Monitor

● – Ano Ne Ano Ne Ano

Marker ● – Ano Ne Ano Ne Ano

Položka
(úroveň

2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Ano Ne Ano Ne Ano

Audio
Output

● ▲ Ano Ne Ano Ne Ano

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Ne Ne Ne Ne Ne

Set Clip Flag ● – Ne Ne Ne Ne Ne

Lock/Unlock
Clip

● – Ne Ne Ne Ne Ne

Delete Clip ● – Ne Ne Ne Ne Ne

Transfer Clip ● – Ne Ne Ne Ne Ne

Transfer Clip
(Proxy)

● – Ne Ne Ne Ne Ne

Filter Clips ● – Ne Ne Ne Ne Ne

Customize View ● – Ano Ne Ano Ne Ano
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Network

Stream

Položka
(úroveň

2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Ne *1 Ne Ano

Genlock ● – Ne Ne Ne Ne Ne

Tally ● ● Ano Ne Ano Ne Ano

Rec
Review

● – Ano Ne Ano Ne Ano

Zoom ● – Ano Ne Ano Ne Ano

IR
Remote

– ● Ne Ne Ano Ne Ano

Lens ● – Ano Ne Ano Ne Ano

APR ● – Ne Ne Ne Ne Ne

[Type] lze použít, [Setting] nelze použít*1

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Ne Ne Ne Ne Ano

User – ● Ne Ne Ne Ano Ano

Wired LAN*1 ▲ ● Ne Ne Ne Ano Ne

File Transfer ● ▲ Ano Ne Ano Ano Ano

FTP Server 1 – ● Ne Ne Ano Ne Ano

FTP Server 2 – ● Ne Ne Ano Ne Ano

FTP Server 3 – ● Ne Ne Ano Ne Ano

SSL – ● Ne Ne Ne Ano Ano

Referer Check – ● Ne Ne Ne Ano Ano

Brute Force
Attack Protection

– ● Ne Ne Ne Ano Ano

Nelze nakonfigurovat pomocí nabídky kamery (pouze zobrazení)*1

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Ne Ne Ano*1 Ne Ano*1
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Maintenance
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Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Ano Ne Ano Ne Ano

Audio
Stream

– ● Ano Ne Ano Ne Ano

[NDI|HX] > [License] nelze použít*1

Položka
(úroveň 2)

Nabídka
kamery

Webová
nabídka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Ano Ne Ano Ne Ano

Accessibility – ● Ano Ne Ne Ne Ano

Clock Set ● ● Ano*1 Ne Ano*2 Ne Ano

Reset – ● Ne Ne Ne Ne Ne

Hours Meter ● – Ne Ne Ne Ne Ne

Information – ● Ne Ne Ne Ne Ne

System Log – ● Ne Ne Ne Ne Ano

HTTP Access
Log

– ● Ne Ne Ne Ne Ano

Service – ● Ne Ne Ne Ne Ne

EULA – ● Ne Ne Ne Ne Ne

Software – ● Ne Ne Ne Ne Ne

Informace o datu a čase nelze použít*1

[Time Zone], informace o datu a čase nelze použít*2
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Přednastavená pozice uložených položek

„Ano“ znamená, že nastavení je uloženo v přednastavené pozici, zatímco „Ne“ znamená, že nastavení není uloženo.

Položky posunu/naklápění

Položky zoomu

Položky ostření

Umístění na displeji Položka Uložit cíl

Ovládací panel seřízení obrazu obrazovky živého provozu
Poloha posunu/naklápění Ano

[Pan-Tilt Speed] Ne

[Pan-Tilt] ve webové nabídce

[P/T Speed] Ne

[P/T Acceleration] Ne

[P/T Range Limit] Ne

[P/T Direction] Ne

[P/T Preset] > [Pan-Tilt] Ne

[P/T Preset] > [Default] > [Pan-Tilt Speed] Ano1)

Hodnoty nastavení při ukládání přednastavené polohy jsou uloženy jako hodnoty této přednastavené polohy. Po uložení hodnot lze hodnoty
změnit pro každou přednastavenou polohu. Podrobnosti viz kapitola „Změna rychlosti přechodu (posun / naklápění / zoom) přednastavených
poloh pomocí webové aplikace“.

1)

Umístění na displeji Položka Uložit cíl

Ovládací panel seřízení obrazu obrazovky živého provozu
Poloha zoomu (vzdálenost zaostření) Ano

[Zoom Speed] Ne

[Pan-Tilt] > [P/T Preset] > [Default] ve webové nabídce
[Zoom Sync] Ano1)

[Zoom Speed] Ano1)

[Technical] > [Zoom] v nabídce kamery. [Zoom Type] Ne

Hodnoty nastavení při ukládání přednastavené polohy jsou uloženy jako hodnoty této přednastavené polohy. Po uložení hodnot lze hodnoty
změnit pro každou přednastavenou polohu. Podrobnosti viz kapitola „Změna rychlosti přechodu (posun / naklápění / zoom) přednastavených
poloh pomocí webové aplikace“.

1)
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Příbuzné téma
Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení přednastavené polohy

5-041-958-43(1) Copyright 2022 Sony Corporation

Umístění na displeji Položka Uložit
cíl

Panelu obrazu kamery obrazovky živého
provozu

Sledování stanoveného předmětu v režimu sledování AF v
reálném čase

Ne

Specifikované souřadnice pro bodové zaostření Ne

Karta  (Focus) na obrazovce živého
provozu

spínač [Touch Focus] Ne

spínač [Auto Focus] Ano

Stav tlačítka [Focus Hold] Ne

Stav tlačítka [Push AF/MF] Ne

[Face/Eye Detection AF] Ano

[AF Subj. Shift Sens.] Ano

[AF Transition Speed] Ano

Focus position Ano1)

[Shooting] > [Focus] ve webové nabídce.

[Push AF Mode] (včetně nastavení pomocí přiřaditelných
tlačítek)

Ne

[Touch Function in MF] Ne

[AF Assist Control] Ne

[Pan-Tilt] > [P/T Preset] > [Default] ve
webové nabídce

[Focus Recall] Ano2)

[MF Speed] Ano2)

[Shooting] > [Focus] v nabídce kamery.

Velikost oblasti zaostření a poloha oblasti zaostření nastavené
pomocí [Focus Area]

Ano

Nastavení polohy oblasti zaostření pomocí [Focus Area (AF-S)] Ano

Není obnoveno, pokud je spínač [Auto Focus] nastaven do polohy On. Obnoveno, když je nastaveno na hodnotu Off.1)

Hodnoty nastavení při ukládání přednastavené polohy jsou uloženy jako hodnoty této přednastavené polohy. Po uložení hodnot lze hodnoty
změnit pro každou přednastavenou polohu. Podrobnosti viz kapitola „Změna rychlosti přechodu (posun / naklápění / zoom) při obnovení
přednastavené polohy“.

2)
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bloková schémata

Audio Input

Audio Output

5-041-958-43(1) Copyright 2022 Sony Corporation
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aktualizace softwaru objektivu E-Mount

Software objektivu E-Mount můžete aktualizovat pomocí jednotky.
Postupujte podle webových stránek pro objektivy, které lze aktualizovat, a odpovídající software.
Software se aktualizuje pomocí webové nabídky.

Poznámka

Neprovádějte následující akce, dokud není aktualizace dokončena.

Odpojení sítě
Sejmutí objektivu
Vypnutí napájení

Pokud se zobrazí zpráva informující, že aktualizace se nezdařila, zkontrolujte zobrazený popis a zkuste aktualizovat znovu.

5-041-958-43(1) Copyright 2022 Sony Corporation

Upevněte objektiv E-Mount k jednotce.1

Zkontrolujte možnost [Maintenance] > [Information] > [Lens] > [Model Name] a [Version Number] ve webové
nabídce.

Na straně se zobrazí číslo verze softwaru objektivu E-Mount.
Zkontrolujte číslo verze softwaru a podle potřeby software aktualizujte.

2

Stáhněte soubor pro aktualizaci softwaru objektivu pro Windows (přípona .exe) do zařízení se spuštěnou
webovou aplikací.

3

V nabídce [Maintenance] > [Information] > [Lens] > [Version Up] stiskněte tlačítko [Choose File] a vyberte
stažený aktualizační soubor.

4

Postupujte podle pokynů na obrazovce.5
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Připevnění krytu uvolňovacího tlačítka objektivu

Neúmyslnému sejmutí objektivu můžete zabránit připevněním krytu uvolňovacího tlačítka objektivu dodaného se
stropním držákem CIB-PCM1 (volitelně) k uvolňovacímu tlačítku objektivu.

Poznámka

To však nebrání úplnému vyjmutí objektivu.

Příbuzné téma

Upevnění objektivu

5-041-958-43(1) Copyright 2022 Sony Corporation

Připojte objektiv.

Další informace o upevnění objektivu naleznete v části „Upevnění objektivu“.

1

Posuňte zamykací páku posunu/naklápění do polohy LOCK pro uzamčení posunu/naklápění hlavy kamery.2

Přesuňte blok kamery do polohy, aby bylo možné připevnit kryt vysunutí objektivu.3

Nasaďte kryt vysunutí objektivu tak, aby zakrýval uvolňovací tlačítko objektivu.4

Zajistěte kryt vysunutí objektivu pomocí upevňovacího šroubu pro vysunutí objektivu.5
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Licence

Licence pro patentové portfolio MPEG-4 AVC

TENTO PRODUKT JE LICENCOVÁN NA ZÁKLADĚ LICENCE PRO PATENTOVÉ PORTFOLIO AVC PRO OSOBNÍ
POUŽITÍ SPOTŘEBITELEM NEBO PRO JINÉ POUŽITÍ ZA KTERÉ NENÍ ZÍSKÁVÁNA ODMĚNA ZA NÁSLEDUJÍCÍ:
(i) KÓDOVÁNÍ VIDEA V SOULADU S VIZUÁLNÍM STANDARDEM AVC („VIDEO AVC“), A/NEBO
(ii) DEKÓDOVÁNÍ VIDEA AVC, KTERÉ BYLO KÓDOVÁNO SPOTŘEBITELEM ZABÝVAJÍCÍM SE OSOBNÍ ČINNOSTI,
A/NEBO KTERÉ BYLO ZÍSKÁNO OD POSKYTOVATELE VIDEA S LICENCÍ PRO POSKYTNUTÍ VIDEA AVC.
ŽÁDNÁ LICENCE NENÍ UDĚLENA NEBO JE PŘEDPOKLÁDANÁ PRO JAKÉKOLIV JINÉ POUŽITÍ. DALŠÍ
INFORMACE LZE ZÍSKAT OD SPOLEČNOSTI MPEG LA, LLC. DALŠÍ INFORMACE NALEZNETE NA WEBU
HTTP://WWW.MPEGLA.COM

Získání softwaru podle licence GPL/LGPL

Tento produkt používá software, na který se vztahuje licence GPL/LGPL. Ta vás informuje o tom, že máte právo mít
přístup k zdrojovému kódu těchto softwarových programů, upravovat jej a redistribuovat za podmínek licence GPL/LGPL.
Zdrojový kód je poskytnut na Internetu. Použijte následující adresu URL a postupujte podle pokynů ke stažení.
https://oss.sony.net/Products/Linux/
Byli bychom rádi, kdybyste nás ohledně obsahu zdrojového kódu nekontaktovali.

Zdrojový kód μT-Kernel

Tento produkt používá zdrojový kód μT-Kernel podle T-License 2.1 udělené organizací TRON Forum (www.tron.org).
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Technické údaje

Obecné

Hmotnost
Přibližně 4,6 kg (pouze tělo)
Přibližně 6,0 kg (včetně objektivu SELP28135G)

Rozměry
Další informace naleznete v části „Vnější rozměry“.

Požadavky na napájení
19,5 V DC
PoE++ (shoda s IEEE802.3bt typ 4, třída 8)

Spotřeba
19,5 V DC: 80,0 W (maximálně)
PoE++: 71,3 W (maximálně) 

Provozní teplota
0 °C až 40 °C

Skladovací teplota
−20 °C až +60 °C

Formát záznamu (video)
XAVC Intra
Režim XAVC-I 4K/QFHD: VBR, přenosová rychlost 600 Mb/s (maximálně), MPEG-4 AVC/H.264
Režim XAVC-I HD: CBG, 223 Mb/s (maximálně), MPEG-4 AVC/H.264

XAVC Long
Režim XAVC-L QFHD: VBR, přenosová rychlost 150 Mb/s (maximálně), MPEG-4 H.264/AVC
Režim XAVC-L HD 50: VBR, 50 Mb/s (maximálně), MPEG-4 H.264/AVC
Režim XAVC-L HD 35: VBR, 35 Mb/s (maximálně), MPEG-4 H.264/AVC

Formát záznamu (zvuk)
LPCM 24 bitů, 48 kHz, 4 kanály

Snímková frekvence záznamu

XAVC Intra
Režim XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Režim XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Režim XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Režim XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Režim XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Režim XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Čas záznamu/přehrávání
XAVC Intra
Režim XAVC-I QFHD: 59.94P, přibližně 30 minut (pomocí CEA-G160T)
Režim XAVC-I HD: 59.94P, přibližně 78 minut (pomocí CEA-G160T)

XAVC Long
Režim XAVC-L QFHD: 59.94P, přibližně 115 minut (pomocí CEA-G160T)
Režim XAVC-L HD 50: 59.94P, přibližně 155 minut (pomocí CEA-G80T)
Režim XAVC-L HD 35: 59.94P, přibližně 210 minut (pomocí CEA-G80T)

Poznámka

Doba záznamu/přehrávání se může lišit v závislosti na podmínkách použití a vlastnostech paměti. Časy záznamu a přehrávání
slouží k nepřetržitému záznamu jednoho klipu. Skutečné časy mohou být kratší v závislosti na počtu zaznamenaných klipů.

Sekce pohonu posunu/naklápění

Minimální rychlost posunu: 0,02°/s
Minimální rychlost naklápění: 0,02°/s
Maximální rychlost posunu: 60°/s
Maximální rychlost naklápění: 60°/s
Rozsah posunu: −170 stupňů až +170 stupňů
Rozsah naklápění: −30 stupňů až +195 stupňů.
Kritérium hluku: NC35 nebo nižší
Přednastavené polohy: 100

Část kamery

Zobrazovací zařízení
celý snímek 35mm, 35,6 × 23,8 mm, snímač Exmor R CMOS

Počet obrazových bodů
Přibližně 12,9 megapixelů (pixelů celkem)
Přibližně 10,3 megapixelů (efektivních pixelů)

Automatické zaostřování
Metoda detekce: detekce fáze / detekce kontrastu

Interní filtry ND
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineárně stavitelný ND: 1/4ND až 1/128ND

Citlivost ISO
ISO 800/12800 (režim Cine EI, zdroj světla D55)

Připevnění objektivu
E-Mount

Zeměpisná šířka
15 a více zastávek
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Čas závěrky
64F až 1/8000 s (23.98P)

Úhel závěrky
5,6° až 360°, 2 až 64 snímků

Pomalý a rychlý pohyb
XAVC QFHD: 1 snímek/s až 120 snímků/s
XAVC HD: 1 snímek/s až 240 snímků/s
XAVC 4K: 1 snímek/s až 60 snímků/s
XAVC HD (S35): 1 snímek/s až 120 snímků/s

Vyvážení bílé
2000 K až 15000 K

Zesílení
−3 dB až +30 dB (přírůstky po 1 dB)

Základní vzhled
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Část audio

Vzorkovací frekvence
48 kHz

Kvantizace
24bitová

Frekvenční odezva
Vstup XLR, režim MIC: 20 Hz až 20 kHz (±3 dB nebo méně)
Vstup XLR, režim LINE: 20 Hz až 20 kHz (±3 dB nebo méně)

Dynamický rozsah
Vstup XLR, režim MIC: 80 dB (typicky)
Vstup XLR, režim LINE: 90 dB (typicky)

Zkreslení
Vstup XLR, režim MIC: 0,08% nebo nižší (vstupní úroveň −40 dBu)
Vstup XLR, režim LINE: 0,08% nebo nižší (vstupní úroveň +14 dBu)

Část vstupu/výstupu

Vstupy
DC IN

Kompatibilní s EIAJ, 19,5 V DC

AUDIO IN

Typ XLR, 5 kolíky, zásuvka
Přepínatelný, LINE / MIC / MIC +48 V.
MIC: reference −30 dBu až −80 dBu
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GENLOCK IN

Konektor BNC, 1,0 Vp-p, 75 Ω

TC IN

Konektor BNC

Výstupy
SDI OUT

Konektor BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Konektor Type A

Výstupní konektor OPTICAL

Ve shodě s SFP+
* Jednotka nepodporuje vstup optického signálu.

Vstup/výstup
Konektor LAN

RJ-45, 1000BASE-T

Konektor OPTION

Konektor vstupu/výstupu indikačního signálu RJ-45

Část slotu médií

Slot pro karty CFexpress Type A / SD (2)

Dodávané příslušenství

Síťový adaptér (1)
Napájecí kabel (1)
Infračerveném dálkový ovladač (1)
Kryt těla (1) (připevněný k jednotce)
Upevňovací deska kabelu HDMI (1)
Než začnete tuto jednotku používat (1)
Záruční list (1)

Vnější rozměry

Rozměry jsou přibližné hodnoty.
Jednotka: mm

Tělo kamery
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Stropní držák
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Konstrukční a technické údaje se mohu lišit bez předchozího upozornění.
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Průvodce nápovědou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obchodní známky

 je obchodní známka společnosti Sony Corporation.
XAVC a  jsou registrované obchodní známky společnosti Sony Group Corporation.
Pojmy HDMI a HDMI High-Definition Multimedia Interface a rovněž logo HDMI jsou obchodní známky nebo zapsané
obchodní známky společnosti HDMI Licensing Administrator, Inc. ve Spojených státech a dalších zemích.
Microsoft a Windows jsou registrované obchodní známky nebo obchodní známky společnosti Microsoft Corporation
ve Spojených státech amerických a/nebo jiných zemích.
Mac a macOS jsou registrované obchodní známky společnosti Apple Inc. v USA a dalších zemích.
Logo „Catalyst Browse“ je obchodní známka nebo registrovaná obchodní známka společnosti Sony Group
Corporation.
IOS je obchodní známka nebo registrovaná obchodní známka společnosti Cisco v USA a dalších zemích a používá
se na základě licence.
iPadOS, Safari a iPad jsou obchodní známky společnosti Apple Inc., registrované v USA a dalších zemích.
Android a Google Chrome jsou obchodní známky nebo registrované obchodní známky společnosti Google LLC.
Wi-Fi je registrovaná obchodní známka organizace Wi-Fi Alliance.
Logo SDXC je obchodní známka společnosti SD-3C, LLC.
CFexpress a logo CFexpress Type A jsou obchodní známky asociace CompactFlash Association.
NewTek™ a NDI® jsou obchodní známky nebo registrované obchodní známky společnosti NewTek, Inc.
JavaScript je registrovaná obchodní známka společnosti Oracle a/nebo jejích přidružených společností.
Intel, logo Intel a Intel Core jsou obchodní známky společnosti Intel Corporation nebo jejích dceřiných společností.
QR Code je obchodní známka společnosti Denso Wave Inc.
Všechny ostatní názvy společností a výrobků jsou registrované obchodní známky nebo obchodní známky svých
odpovídajících vlastníků. Položky chráněné obchodní známkou nejsou v tomto dokumentu značeny symbolem ®
nebo ™.
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